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PREFACE 
 
This publication is for soldiers holding military occupational specialty (MOS) 25M skill levels 
(SLs) 1 through 3 and for trainers and first line supervisors.  It contains standardized training 
objectives, in the form of task summaries, to train and evaluate soldiers on critical tasks which 
support unit missions during wartime.  Trainers and first-line supervisor should ensure soldiers 
holding MOS 25M10/20/30 have access to this publication.  It should be made available in the 
soldier’s work area, unit learning center, and unit libraries. 
 
This manual applies to both Active and Reserve Component soldiers. 
 
The proponent for this publication is the US Army Signal Center and Fort Gordon.  Send 
comments and recommendations on DA Form 2028 directly to Commander, US Army Signal 
Center and Fort Gordon, ATTN:  ATZH-DTM-I, Fort Gordon, Georgia  30905-5074. 
 
Unless this publication states otherwise, masculine nouns and pronouns do not refer exclusively 
to men. 
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CHAPTER 1 
 

INTRODUCTION 
 
1-1.  GENERAL 
 

a.  This manual identifies the individual MOS training requirements for soldiers in MOS 
25M.  Commanders, trainers, and soldiers should use it to plan, conduct, and evaluate 
individual training in units.  This manual is the primary MOS reference to the self-development 
and training of every 25M soldier. 
 

b.  Use this manual with the soldier’s manual of common tasks (STP 21-1-SMCT and STP 
21-24-SMCT), Army training and evaluation programs (ARTEPs), and FM 25-101, Battle-
Focused Training, to establish effective training plans and programs which integrate soldier, 
leader, and collective tasks. 
 
1-2.  TASK SUMMARIES 
 

a.  Task summaries outline the wartime performance requirements of each critical task in 
the soldier’s manual (SM).  They provide the soldier proficiency on training.  As a minimum, task 
summaries include information you must know and the skills that you must perform to standards 
for each task.  The format for the task summaries included in this SM is as follows: 
 

(1)  Task title.  The task title identifies the action to be performed. 
 

(2)  Task number.  A 10-digit number identifies each task or skill.  Include this task 
number, along with the task title, in any correspondence relating to the task.  To determine 
which tasks are testable at each skill level, refer to Chapter 2, Part 2, Critical Tasks.  The first 
two numbers of the last four of each task DO NOT indicate the skill levels testable for that 
particular task. 
 

(3)  Conditions.  The task conditions identify all the equipment, tools, references, job aids, 
and supporting personnel which the soldier needs to perform the task in wartime.  This section 
identifies any environmental conditions that can alter task performance, such as visibility, 
temperature, and wind.  This section also identifies any specific cues or events (a chemical 
attack or identification of a threat vehicle) which trigger task performance. 
 

(4)  Standards.  The task standards describe how well and to what level you must perform 
a task under wartime conditions.  Standards are typically described in terms of accuracy, 
completeness, and speed. 
 

(5)  Training and evaluation.  This section may contain the training information outline 
(performance steps in ASAT), evaluation preparation, and evaluation guide (performance 
measures in ASAT).  The training information outline/performance steps include detailed 
training information.  The evaluation preparation subsection indicates necessary modification to 
task performance in order to train and evaluate a task that cannot be trained to the wartime 
standard under wartime conditions.  It may also include special training and evaluation 
preparation instructions to accommodate these modifications and any instructions that should 
be given to the soldier before evaluation.  The evaluation guide/performance measures identify 
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the specific actions that the soldier must do to successfully complete the task.  These actions 
are listed in a Pass/Fail format for easy evaluation.  Each task contains a feedback statement 
(Evaluation Guidance in ASAT) that indicates the requirements (for the number of performance 
measures passed) for receiving a GO on the evaluations. 
 

(6)  References.  This section identifies references that provide more detailed and 
thorough explanations of task performance requirements than that are given in the task 
summary description. 
 

b.  Additionally, some task summaries include safety statements and notes.  Safety 
statements (danger, warning, and caution) alert user to the possibility of immediate death, 
personal injury, or damage to equipment.  Notes provide a small, extra supportive explanation 
or hint relative to the performance measures. 
 
1-3.  SOLDIER’S RESPONSIBILITIES 
 

Each soldier is responsible for performing individual tasks that the first-line supervisor 
identifies based on the unit’s mission essential task list (METL).  The soldier must perform the 
task to the standards listed in the SM.  If a soldier has a question about how to do a task, or 
which tasks in the manual he must perform, it is the soldier’s responsibility to ask the first-line 
supervisor for clarification.  The first-line supervisor knows how to perform each task, or can 
direct the soldier to the appropriate training materials. 
 
1-4.  NCO SELF-DEVELOPMENT AND THE SOLDIER’S MANUAL 
 

a.  Self-development is one of the key components of the leader development program.  It 
is a planned progressive and sequential program followed by leaders to enhance and sustain 
their military competencies.  It consists of individual study, research, professional reading, 
practice, and self-assessment.  Under the self-development concept, the NCO, as an Army 
professional, has the responsibility to remain current in all phases of the MOS.  The SM is the 
primary source of the NCO to use in maintaining MOS proficiency.   
 

b.  Another important resource for NCO self-development is the Army Correspondence 
Course Program (ACCP).  Soldiers should refer to DA Pamphlet 351-20, Army Correspondence 
Course Program Catalog, for information on enrolling in this program and a list of courses, or 
write to:  Army Institute for Professional Development, US Army Training Support Center, ATTN:  
ATIC-IPS, Newport News,  VA 23628-0001. 
 

c.  Unit learning centers are valuable resources for planning self-development programs.  
They can help access enlisted career maps, training support products, and extension training 
materials, such as field manuals (FM), technical manuals (TM), and training extension course 
(TEC) lessons.  It is the soldier’s responsibility to use these materials to maintain performance. 
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1-5.  TRAINING SUPPORT 
 

This manual includes the following appendixes and information which provide additional 
training support information. 
 

(1)  Appendix A, Excerpt from the Electronic Imaging Course. 
 

(2)  Appendix B, Drafting Tools and Techniques. 
 

(3)  Appendix C, Three Dimensional Drawing. 
 

(4)  Appendix D, Letter Graphics Projects. 
 

(5)  Appendix E, Electronic Page Layout. 
 

(6)  Appendix F, Hypertext Markup Language (HTML). 
 

(7)  Appendix G, Organize Graphics Work Flow. 
 

(8)  Appendix H, Evaluating a Graphics Project. 
 

(9)  Appendix I, Still Photography Editing and Processing System (SPEPS). 
 

(10) Appendix J, Project Evaluation Checklist. 
 

(11) Appendix K, Drawing the Human Form. 
 

(12) Appendix L, DA Form 5164-R (Hands-on Evaluation). 
 

(13) Glossary.  The glossary is a single comprehensive list of acronyms, abbreviations, 
definitions and letter symbols. 
 

(14) References.  This section contains two lists of references, required and related, which 
support training of all tasks in this SM.  Required references are listed in the conditions 
statement and are required for the soldier to do the task.  Related references are materials that 
provide more detailed information and a more thorough explanation of task performance. 
 
1-6.  OPTIONAL INFORMATION 
 

a.  All soldiers and NCOs in MOS 25M should be acquainted with the skill and training 
progression for the Combat Documentation/Production Specialists, training problems unique to 
MOS 25M, and the career management field (CMF) structure. 
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b.  The career progression chart for MOS 25M is shown in Figure 1-1.  It shows the entry 
level soldier and the path he must follow to SL5.  There are no decision points for the 25M 
soldier. 

 
c.  The tasks in this SM are common in commercial industry.  In some cases, a specific 

piece of equipment or software is identified.  However, any commercial equipment or software 
available can be used following the manufacturer’s operating instructions manual, as long as 
the equipment or software used meets job standards.  Unlike most table(s) of organization and 
equipment (TOE) units, visual information units may not be equipped with the same model or 
type of equipment or software.  It is necessary that the soldier have an opportunity to train by 
using the same type of equipment or software referenced in this SM.  Keep in mind that the self-
development test is based on specific information contained in this manual.  Many tasks in the 
combat documentation production specialist field must be learned through on-the-job training.  
Some of the latest techniques strongly recommended that all soldiers have access to 
commercial technical production literature available at post libraries or through local purchase. 
 

d.  Emphasis on battle focus for the multimedia illustrator needs to be on tasks related to 
receiving, processing, and transmitting digital imagery; decision graphics; preparing map 
overlays; preparation of command presentations; field maintenance and operation of the 
SPEPS; and deploying field portable computer systems.  Training assignments must include 
graphic documentation of the unit, while training for its wartime mission. These activities would 
include historical documentation, combat operation decision-making processes, news coverage, 
and training exercises. 
 

e.  Comments or questions on material in this manual may be directed to the Branch Chief, 
US Army, Signal Corps Regimental NCO Academy Detachment, ATTN:  ATZH-SDT-T, Chief 
Training Development, Fort Meade, MD 20755-5805, telephone DSN 923-5805/5802 or 
commercial (301) 677-5805/5802. 
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Figure 1-1.  Skill level and training progression, MOS 25M. 
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CHAPTER 2 
 

TRAINER’S GUIDE (TG) 
 
2-1.  GENERAL 
 

a.  The TG identifies the essential components of a unit training plan for individual training.  
Units have different training needs and requirements based on differences in environment, 
location, equipment, dispersion (actual manning of graphic shops), and similar factors.  
Therefore, the TG is a guide used for conducting unit training and not as a rigid standard. 
 

b.  The TG provides information necessary for planning training requirements for this MOS. 
 

(1)  Identifies subject areas in which to train soldiers. 
 

(2)  Identifies the critical tasks for each subject area. 
 

(3)  Specifies where soldiers are trained. 
 

(4)  Recommends how often each task should be trained to sustain proficiency. 
 

(5)  Recommends a strategy for training soldiers to perform higher level tasks. 
 
2-2. BATTLE FOCUSED TRAINING 
 

As described in FM 25-100, Training the Force, and FM 25-101, Battle Focused Training, 
the commander must first define the METL as the basis for unit training.  Unit leaders use the 
METL to identify the collective, leader, and soldier tasks that support accomplishment of the 
METL.  Unit leaders then assess the status of training and lay out the training objective and the 
plan for accomplishing needed training.  After preparing the long- and short-range plans, 
leaders then execute and evaluate training.  Finally, the unit’s training preparedness is 
reassessed and the training management cycle begins again.  This process ensures the unit 
has identified what is important for the wartime mission, the training focus is applied to the 
necessary training, and training meets established objectives and standards. 
 
2-3.  RELATIONSHIP OF SOLDIER TRAINING PUBLICATIONS (STPs) 
TO BATTLE FOCUSED TRAINING 
 
 a.  The two key components of enlisted STPs are the TG and SM.  The TG and SM give 
leaders important information to help in the battle focused training process.  The TG relates 
soldier and leader tasks in the MOS and SL to duty positions and equipment.  It provides 
information on where the task is trained, how often training should occur to sustain proficiency, 
and who in the unit should be trained.  As leaders go through the assessment and planning 
stages, they should use the TG as an important tool in identifying what needs to be trained. 
 
 b.  The execution and evaluation of soldier and leader training should rely on the Armywide 
training objective and standards in the SM task summaries.  The task summaries ensure that 
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soldiers in any unit or location have the same definition of task performance, and that trainers 
evaluate the soldiers to the same standard. 
 
 c.  The following diagram shows the relationship between battle focused training and the 
use of the TG and SM.  The left-hand side of the diagram (taken from FM 25-101) shows the 
soldier training process, while the right side of the diagram shows how the STP supports each 
step of this process. 
 
 BATTLE FOCUS PROCESS                                                   STP SUPPORT PROCESS  
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OBJECTIVES  

USES TG TO SET 
OBJECTIVES  

USES SM TASK SUMMARY 
AS STANDARD FOR 

EVALUATION  

USES SM TASK SUMMARY 
AS SOURCE FOR 

TASK PERFORMANCE  

 EXECUTES TRAINING 
 AND CONDUCTS 
 AFTER-ACTION REVIEW  

USES SM TO DETERMINE 
TRAINING PREPARATION  

USES TG TO RELATE 
SOLDIER TASKS TO STRATEGY  

EVALUATES TRAINING 
AGAINST ESTABLISHED 

STANDARDS  

DETERMINES STRATEGY 
AND PLANS FOR TRAINING  

CONDUCTS PRE-EXECUTION 
CHECKS  



STP-11-25M13-SM-TG 

2-3 

2-4.  TRAINER’S RESPONSIBILITIES 
 

Training soldier and leader tasks to standard and relating this training to collective mission-
essential tasks is the NCO trainer’s responsibility.  Trainers use the steps below to plan and 
evaluate training. 
 

(1)  Identify soldier and leader training requirements.  The NCO determines which tasks 
soldiers need to train on using the commander’s training strategy.  The unit’s METL and ARTEP 
and MOS Training Plan (MTP) in the TG are sources for helping the training define the 
individual training needed. 
 

(2)  Plan the training.  Training for specific tasks can usually be integrated or conducted 
concurrently with other training or during “slack periods.”  The unit’s ARTEP can assist in 
identifying soldier and leader tasks that can be trained and evaluated concurrently with 
collective task training and evaluation. 
 

(3)  Gather the training references and materials.  The SM task summary list all 
references which can assist the trainer in preparing for the training of that task. 
 

(4)  Determine risk assessment and identify safety concerns.  Analyze the risk involved 
in training a specific task under the current conditions at the time of scheduled training.  Ensure 
that your training preparation takes into account those cautions, warnings, and dangers 
associated with each task. 
 

(5)  Train each soldier.  Show the soldier how the task is done to standard and explain 
step-by-step how to do the task.  Give each soldier one chance to do the task step-by-step. 
 

(6)  Emphasize training at mission-oriented protection posture (MOPP) level 4.  
Soldiers may have difficulty performing even the very simple tasks in a nuclear/chemical 
environment.  The combat effectiveness of the soldier and the unit can degrade quickly when 
trying to perform in MOPP4.  Practice is the best way to improve and ensure performance. 

 
(7)  Check each soldier.  Evaluate how well each soldier performs the tasks in this 

manual.  Conduct these evaluations during individual training sessions or while evaluating 
soldier proficiency during the conduct of unit collective tasks.  Use the information in the MTP as 
a guide to determine how often to train the soldier in each task to ensure that soldiers sustain 
proficiency. 
 

(8)  Record the results.  The leader book referred to in FM 25-101, Appendix B, is used to 
record task performance and gives the leader total flexibility on the method of recording training.  
The trainer may use DA Forms 5164-R (Hands-On Evaluation) and 5165-R (Field Expedient 
Squad Book) as part of the leader book.  The forms are optional and locally reproducible.  STP 
21-24-SMCT contains a copy of the forms and instructions for their use. 
 

(9)  Retrain and evaluate.  Work with each soldier until he can perform the task to specific 
SM standards. 
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2-5.  EVALUATION GUIDE 
 

An evaluation guide exists for each task summary in the SM.  Each evaluation guide 
contains one or more performance measures that identify what the trainer needs to observe to 
score a soldier’s performance.  Each step is clearly identified by a P (pass) and F (fail), located 
under the result column on each evaluation guide.  Some tasks involve a process that the 
trainer must evaluate an “end product” resulting from doing the task.  The following are some 
general points about using the evaluation guide to evaluate soldiers. 
 

(1)  Review the guide to become familiar with the information on which the soldier will be 
scored. 
 

(2)  Ensure that the necessary safety equipment and clothing needed for proper 
performance of the job are on hand at the training site. 
 

(3)  Prepare the test site according to the Conditions section of the task summary.  Some 
tasks contain special evaluation preparation instructions.  These instructions tell the trainer what 
modifications must be made to the job conditions to evaluate the task.  Reestablish the test site 
to the original requirements after evaluating each soldier to ensure that conditions are the same 
for each soldier. 
 

(4)  Advise each soldier of the information in the Brief Soldier section of the task summary 
before evaluating. 
 

(5)  Score each soldier according to the performance measures and Evaluation Guidance 
section in the task summary. 
 

(6)  Record the date and task performance (GO or NO-GO) in the leader book. 
 
2-6.  TRAINING TIPS FOR THE TRAINER 
 

a.  Prepare yourself. 
 

(1)  Get training guidance from your chain of command on when to train, which soldiers to 
train, availability of resources, and training site. 
 

(2)  Get the training objective (tasks, conditions, and standards) from the task summary in 
this manual. 
 

(3)  Ensure you can do the task.  Review the task summary and references in the 
References section.  Practice doing the task or, if necessary, have someone train you on the 
task. 
 

(4)  Choose a training method.  Some tasks provide recommended training methods. 
 

(5)  Prepare a training outline consisting of informal notes on what you want to cover during 
your training session. 
 

(6)  Practice your training presentation. 
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b.  Prepare the resources. 
 
 (1)  Obtain the required resources identified in the conditions statement for each task. 
 

(2)  Gather equipment and ensure it is operational. 
 
 (3)  Coordinate the use of training aids and devices. 
 

(4)  Prepare the training site according to the conditions statement and Evaluation 
Preparation section of the task summary, as appropriate. 
 

c.  Prepare the soldiers. 
 

(1)  Tell the soldier what task to do and how well it must be done.  Refer to the standard 
statement and Evaluation Preparation section for each task, as appropriate. 
 

(2)  Caution soldiers about safety, environment, and security. 
 

(3)  Provide any necessary training on basic skills that soldiers must have before they can 
be trained on the task. 
 

(4)  Pretest each soldier to determine who needs training in what areas by having the soldier 
perform the task.  Use DA Form 5164-R and the evaluation guidance in each task summary to 
make this determination. 
 

d.  Train the soldiers who failed the pretest. 
 

(1)  Demonstrate how to do the task or the specific performance steps to those soldiers 
who could not perform to SM standards.  Have soldiers study the appropriate materials. 
 

(2)  Have soldiers practice the task until they can perform it to SM standards. 
 

(3)  Evaluate each soldier using the evaluation guide. 
 

(4)  Provide feedback to those soldiers who fail to perform it to SM standards and have 
them continue to practice until they can perform to SM standards. 
 

e.  Record results in the leader book. 
 
2-7.  MOS TRAINING PLAN 
 

One of the key components of the TG is the MOS Training Plan (MTP).  The MTP has two 
parts to assist the commander in preparing a unit training plan which satisfies integration, cross-
train, train-up, and sustainment training requirements for soldiers in this MOS. 
 

(1)  Part One of the MTP shows the relationship of an MOS SL between duty position and 
critical tasks.  The critical tasks are grouped by task commonality into subject areas.   
 

(a)  Section I list subject area numbers and titles used throughout the MTP.  The subject 
areas define the training requirements for each duty position within an MOS and relate duty 
positions to subject areas and cross-training and train-up/merger requirements. 
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• Duty position column.  Contains the MOS duty positions, by skill level, which have 

different training requirements. 
 

• Subject area column.  Lists by subject area number, the subject areas in which the 
soldier must be proficient for that duty position. 

 
• Cross-train column.  Lists the recommended duty position for which soldiers should be 

cross-trained. 
 

• Train-up/merger column.  Lists the corresponding duty position for the next higher SL 
or MOS the soldier will merge into upon promotion. 

 
(b)  Section II identifies the total training requirements in terms of subject areas listed in 

Section I for each duty position in an MOS. 
 

(2)  Part Two lists by subject areas, the critical tasks to be trained in an MOS, task number, 
task title, location, sustainment training frequency, and training SL. 
 

• Subject area column.  Lists the subject area number and title in the same order as in 
the MTP, Part One, Section I. 

 
• Task numbers column.  Lists the task numbers for all tasks included in the subject 

area. 
 

• Task titles column.  Lists the task title. 
 

• Training location column.  Identifies the training location where the task is first trained 
to STP standards.  If the task is first trained to standard in the unit, the word “Unit” will 
be in this column.  If the task is first trained to standard in the training base, it will 
identify the resident course where the task was taught.  Figure 2-1 contains a list of 
training locations and their brevity codes. 

 
 
 
 
 
 

Figure 2-1.  Training locations. 

 AIT   Advanced Individual Training 
 BNCOC  Basic Noncommissioned Officer Course 
 UNIT  Trained in the Unit  
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• Sustainment training frequency column.  Indicates the recommended frequency at 
which tasks should be trained to ensure soldier maintains task proficiency.  Figure 2-2 
identifies the frequency codes to use in this column. 

 
 
 
 
 

Figure 2-2.  Sustainment training frequency codes. 
 

• Sustainment training SL column.  Lists the SL of the MOS for which soldiers must 
receive sustainment training to ensure they maintain proficiency to SM standards. 

 
• Drill/ARTEP column.  Lists drill and ARTEP tasks by number that the individual critical 

task supports.  This establishes the crosswalk between individual and collective 
training. 

 
MOS TRAINING PLAN 

MOS 25M  
PART ONE:  SUBJECT AREAS AND DUTY POSITIONS 

 
SECTION 1.  SUBJECT AREA CODES 

 
Skill Level 1 
 
1.  Equipment Operation 
2.  Illustration/Multimedia 
 

 
Skill Level 2 
 
3.  Facility Administrator 
 

 
Skill Level 3 
 
4.  Facility Manager 
 

 
 
 

MOS TRAINING PLAN 
MOS 25M 

PART ONE 
 

SECTION II.  DUTY POSITION TRAINING REQUIREMENTS 
 

SL 
 

DUTY 
POSITION 

SUBJECT 
AREAS 

 
CROSS-TRAIN 

 
TRAIN-UP MERGER 

 
SL1 

 
Multimedia 
Illustrator 

 
1-3 

 
NA 

 
25M2  

Multimedia Illustrator 
SL2 Multimedia 

Illustrator 
1-3 NA 25M3  

Multimedia Illustrator 
SL3 Multimedia 

Illustrator 
1-4 NA 25Z4  

Visual Information 
Operations Chief 

 

AN  Annually 
SA  Semiannually 
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DUTY POSITION TASKS 

PART TWO.  CRITICAL TASKS  

Skill Levels 1-3 MOS 25M 

Subject Area Task Number Title Training 
Location 

Sust 
Tng 
Freq 

Sust 
Tng SL 

1. Equipment 
Operation 

113-578-4002 RECEIVE A DIGITAL IMAGE VIA SATELLITE 
IN SUPPORT OF A COMBAT MISSION 

AIT AN 1-3 

 113-578-4003 RECEIVE A DIGITAL IMAGE VIA LANDLINE 
IN SUPPORT OF A COMBAT MISSION 

AIT AN 1-3 

 113-578-4004 PROCESS A DIGITAL IMAGE IN SUPPORT 
OF A COMBAT MISSION 

AIT AN 1-3 

 113-626-2001 INITIALIZE STILL PHOTOGRAPHY EDITING 
AND PROCESSING SYSTEM (SPEPS) IN A 
TACTICAL ENVIRONMENT 

AIT AN 1-3 

 113-626-2002 PERFORM PREVENTIVE MAINTENANCE 
CHECKS AND SERVICES (PMCS) ON STILL 
PHOTOGRAPHY EDITING AND 
PROCESSING SYSTEM (SPEPS) 

AIT AN 1-3 

2. Illustration/ 
Multimedia 

113-578-6015 WRITE A VISUAL INFORMATION CAPTION AIT AN 1-3 

 113-579-1037 PREPARE CHARTS AIT AN 1-3 
 113-579-1054 CONSTRUCT A TECHNICAL DRAWING AIT AN 1-3 
 113-579-4015 CREATE AN ILLUSTRATION AIT AN 1-3 
 113-579-5060 PREPARE TACTICAL GRAPHIC OVERLAYS AIT AN 1-3 
 113-579-5065 PREPARE ILLUSTRATIONS FOR DISPLAY AIT AN 1-3 
 113-579-8005 DESIGN AN ELECTRONIC PAGE LAYOUT AIT AN 1-3 
 113-579-8006 CREATE AN ELECTRONIC ILLUSTRATION AIT AN 1-3 
 113-579-8007 CREATE AN ELECTRONIC MULTIMEDIA 

VISUAL 
AIT AN 1-3 

3. Facility 
Administrator 

113-578-4005 TRANSMIT A  DIGITAL IMAGE VIA 
SATELLITE IN SUPPORT OF A COMBAT 
MISSION 

AIT AN 1-3 

 113-578-4006 TRANSMIT  A DIGITAL IMAGE VIA LANDLINE 
IN SUPPORT OF A COMBAT MISSION 

BNCOC SA 2-3 

 113-578-4007 PERFORM UPDATE OF A DIGITAL ARCHIVE UNIT AN 2-3 
 113-578-4008 PREPARE COLOR SEPARATIONS FOR 

REPRODUCTION 
BNCOC AN 2-3 

 113-578-6017 MAINTAIN A TECHNICAL REFERENCE 
LIBRARY 

UNIT AN 2-3 

 113-579-6003 ASSIGN GRAPHICS PROJECTS BNCOC AN 2-3 
 113-579-6005 INVENTORY GRAPHICS SUPPLIES AND 

EQUIPMENT 
UNIT AN 2-3 

 113-579-6006 ESTABLISH DRAWING RESEARCH FILE 
(MORGUE FILE) 

BNCOC AN 2-3 

 113-579-7002 EVALUATE A GRAPHICS PROJECT BNCOC AN 2-3 
3. Facility 
Administrator 
(cont) 

113-579-8008 COMBINE VISUALS FOR A MULTIMEDIA 
PRESENTATION   
 

BNCOC AN 2-3 
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DUTY POSITION TASKS 

PART TWO.  CRITICAL TASKS  

Skill Levels 1-3 MOS 25M 

Subject Area Task Number Title Training 
Location 

Sust 
Tng 
Freq 

Sust 
Tng SL 

4. Facility 
Manager 

113-579-7003 WRITE A GRAPHICS FACILITY STANDING 
OPERATING PROCEDURE (SOP) 

BNCOC AN 3 

 113-579-8009 ESTABLISH A WEBSITE BNCOC AN 3 
 113-579-8010 MAINTAIN A WEBSITE BNCOC AN 3 
 113-579-8011 ESTABLISH A DIGITAL ARCHIVE FILE BNCOC AN 3 
 113-626-2003 PREPARE STILL PHOTOGRAPHY EDITING 

AND PROCESSING SYSTEM (SPEPS) FOR 
TACTICAL DEPLOYMENT 

BNCOC AN 3 
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CHAPTER 3 
 

MOS/SKILL LEVEL TASKS 
 

Skill Level 1 
Subject Area 1:  Equipment Operation 

 
RECEIVE A DIGITAL IMAGE VIA SATELLITE IN SUPPORT OF A COMBAT MISSION 

113-578-4002 
 
Conditions:  In a tactical or garrison environment, given a sending station; image in JPEG 
format; computer with modem; graphic imaging software, such as Adobe PhotoShop and 
communication software, such as Timbuktu or White Night that is compatible with sender's 
communication software; Magnaphone MX-2020P portable satellite or equivalent; compass; 
azimuth and elevation angle charts; hardware and software manuals; telex and telephone 
country codes; a telephone; all cables and connectors required by hardware manufacturer; and 
a compatible power source. 
 
Standards:  The standards are met when an uncorrupted copy of the image file is saved in a 
JPEG format. 
 
Performance Measures Results 

 1. Assemble magnaphone. P F 
 a. Assemble antenna following manufacturer's instructions. P F 
 b. Choose correct azimuth and elevation angle. P F 
 c. Power up magnaphone.  Terminal responds with a menu when system is 

warmed up. 
P F 

 d. Choose proper land earth station for satellite being used. P F 
 e. Ensure strong signal with signal strength meter. P F 
 f. Call international operator to test signal strength (11#). P F 

 2. Connect computer to the magnaphone using computer's modem and cables. P F 

 3. Open Timbuktu/remote communication software. P F 

 4. Set proper baud rate and script settings. P F 
 a. Go to communication settings. P F 
 b. Set proper baud rate to match customers' settings (9600 bits per second 

(bps) recommended for satellite transmission). 
P F 

 c. Click on CONNECT VIA button. P F 
 d. Set proper script for satellite transmission. P F 

 5. Answer incoming call.  Click on the EXCHANGE FILES button. P F 

 6. When transfer of files is complete, click on DONE button. P F 

 7. Click on HANG UP button in the CONNECTED TO menu. P F 
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Performance Measures Results 

 8. Open file in PhotoShop to check quality of the file. P F 

 9. If file is corrupted, notify sender. P F 

 10. Repeat the process if necessary. P F 
 
 
Evaluation Guidance:  Score the soldier GO if all steps are passed (P).  Score the soldier NO-
GO if any step is failed (F).  If the soldier fails any step, show what was done wrong and how to 
do it correctly.  Have the soldier practice until he can correctly perform the task. 
 
References 

Required Related 
 Appendix A (25M) 
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RECEIVE A DIGITAL IMAGE VIA LANDLINE IN SUPPORT OF A COMBAT MISSION 
113-578-4003 

 
Conditions:  In a tactical or garrison environment, given a sending station; computer with 
modem; graphic imaging software, such as Adobe PhotoShop and communication software, 
such as Timbuktu or White Night that is compatible with sender's communication software; 
hardware and software manuals; telex and telephone country codes; a telephone, class A 
access to local telephone company; all cables and connectors required by hardware 
manufacturer; and a compatible power source. 
 
Standards:  The standards are met when an uncorrupted copy of the image file is saved in a 
JPEG format. 
 
Performance Measures Results 

 1. Connect computer to local telephone line using computer's modem and cables. P F 

 2. Open Timbuktu/remote communication software. P F 

 3. Set proper baud rate and script settings. P F 

 4. Answer incoming call. P F 

 5. When transfer of files is completed, click on DONE button. P F 

 6. Click on HANG UP button in the CONNECTED TO menu. P F 

 7. Open file in PhotoShop to check quality of the file. P F 

 8. If file is corrupted, notify sender. P F 

 9. Repeat the process if necessary. P F 
 
 
Evaluation Guidance:  Score the soldier GO if all steps are passed (P).  Score the soldier NO-
GO if any step is failed (F).  If the soldier fails any step, show what was done wrong and how to 
do it correctly.  Have the soldier practice until he can correctly perform the task. 
 
References 

Required Related 
 Appendix A (25M) 
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PROCESS A DIGITAL IMAGE IN SUPPORT OF A COMBAT MISSION 
113-578-4004 

 
Conditions:  In a tactical or garrison environment, given a computer; all connecting cables; 
Kodak driver for Adobe PhotoShop or equivalent installed on computer; continuous tone printer, 
such as Kodak XL 7720 digital; images from a digital camera, such as Kodak DCS 200; and a 
DA Form 3903-R requesting images either be processed and stored on a diskette or printed. 
 
Standards:  The standards are met when the finished product is saved in the requested format 
or printed out to the requester's satisfaction. 
 
Performance Measures Results 

 1. Connect camera to computer system. P F 
 a. Ensure that the computer and camera are turned off before connecting 

them. 
P F 

 b. Connect per manufacturer's directions. P F 
 c. Turn the camera on. P F 
 d. Wake up the system by lightly pressing the SHUTTER RELEASE button. P F 
 e. Turn on the computer. P F 
 f. Launch Adobe PhotoShop or equivalent graphics package. P F 
 g. Pull down the PhotoShop file menu and choose the camera from the 

ACQUIRED submenu and wait until the dialogue box appears. 
P F 

 2. Acquire an image. P F 
 a. Click on the ACQUIRE button or double click on the thumbnail image (not 

the preview image). 
P F 

 b. Wait until the camera dialogue box closes and the image appears in the 
PhotoShop window. 

P F 

 c. Edit the image as necessary. P F 

 3. Save the image. P F 
 a. Save the image to diskette, if requested.  Archive the image if appropriate. P F 
 b. Save the image to a temporary directory if printing. P F 

 4. Printing the image. P F 
 a. Print image. P F 
 b. Compare output with the image on the monitor. P F 
 c. Make color corrections as necessary.  Depending on system, adjustments 

may be made on the printer or within the graphic package. 
P F 

 5. Complete DA Form 3903-R. P F 
 
 
Evaluation Guidance:  Score the soldier GO if all steps are passed (P).  Score the soldier NO-
GO if any step is failed (F).  If the soldier fails any step, show what was done wrong and how to 
do it correctly.  Have the soldier practice until he can correctly perform the task. 
 
References 

Required Related 
 Appendix A (25M) 
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INITIALIZE STILL PHOTOGRAPHY EDITING AND PROCESSING SYSTEM (SPEPS) IN A 
TACTICAL ENVIRONMENT 

113-626-2001 
 
Conditions:  Given a SPEPS, a generator or local power source, a portable satellite with 
International Maritime Satellite (INMARSAT) terminal or landline, a graphic system, to include 
but not limited to an automated data processor with CD-ROM, video monitor, flatbed scanner, 
35mm slide scanner, modem, communications interface, color printer, writable compact disk, zip 
drive or Bernoulli, selected software, accessories TC 11-6, TM 9-2320-280-10, TM 9-6115-642-
10, TM 9-6115-660-13&P, graphic shop’s SOP, and all reference materials related to each 
piece of equipment, such as manufacturers' manuals. 
 
Standards:  The standards are met when the SPEPS unit is fully operational. 
 
Performance Measures Results 

 1. Identify power source. P F 
 a. Local power source 110 VAC. P F 
 b. Generator. P F 

 2. Install grounding rod and wire for both generator and S-250 shelter as stated in 
TC 11-6. 

P F 

 3. Run power cable from generator to S-250 shelter. P F 

 4. Perform checks on power setup and circuit board before turning on main power 
switch to the S-250 shelter. 

P F 

 5. Set up satellite IAW manufacturer’s manual. P F 

 6. Connect phone lines, landlines, and satellite to modem. P F 

 7. Turn power to S-250 shelter on. P F 
 a. In cold weather, turn on heater to dry out any moisture in equipment and 

circuits. 
P F 

 b. In hot or humid weather, turn on air-conditioning unit to cool down and 
reduce the amount of moisture in the air. 

P F 

 8. Turn on power to the equipment and conduct an operations check. P F 
 
 
Evaluation Guidance:  Score the soldier GO if all steps are passed (P).  Score the soldier NO-
GO if any step is failed (F).  If the soldier fails any step, show what was done wrong and how to 
do it correctly.  Have the soldier practice until he can correctly perform the task. 
 
References 

Required Related 
Manufacturers’ Manuals Appendix A (25M) 
TC 11-6  
TM 9-2320-280-10  
TM 9-6115-642-10  
TM 9-6115-660-13&P  
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PERFORM PREVENTIVE MAINTENANCE CHECKS AND SERVICES (PMCS) ON STILL 
PHOTOGRAPHY EDITING AND PROCESSING SYSTEM (SPEPS) 

113-626-2002 
 
Conditions:  In a tactical or garrison environment, given a SPEPS, to include but not limited to 
an automated data processor with CD-ROM, video monitor, flatbed scanner, 35mm slide 
scanner, modem, communications interface, color printer, writable compact disk, zip drive or 
Bernoulli, selected software, and accessories; DA Pam 738-750, TC 11-6, TM 9-2320-280-10, 
TM 9-6115-642-10, TM 9-6115-660-13&P, and all reference materials related to each piece of 
equipment, such as manufacturers’ manuals; graphic shop’s SOP, a soft cloth, mild cleaner, 
vacuum, and DA Form 2404. 
 
Standards:  The standards are met when PMCS is done in compliance with appropriate 
manuals and equipment is operational.  Document equipment that is found to be non-
operational on a DA Form 2404 and turn in for repair. 
 
Performance Measures Results 

 1. Ensure electronic equipment is properly grounded. P F 

 2. Visually inspect all equipment for damage or missing parts. P F 

 3. Inspect the surge suppressor for serviceability. P F 

 4. Plug all electronic equipment into the surge suppressor to protect against 
power surges and spikes. 

P F 

 a. Ensure power switch is in the OFF position before plugging in equipment. P F 
 b. Always turn off electrical equipment before unplugging it. P F 

 5. Clean equipment as needed. P F 
 a. Wipe equipment free of dust and dirt using a soft cloth and mild cleaner. P F 
 b. Vacuum dust from air vents as needed. P F 

 6. Inspect cables for cracks or loose wires; allow enough room for cables to hang 
or lay without bending or crimping. 

P F 

 7. Conduct periodic software maintenance. P F 
 a. Organize files into folders.  Do not allow files to float around in the system 

folders, main directory, and root directory. 
P F 

 b. Optimize disk space by periodically defragging the hard drive. P F 
 c. Run a background diagnostic program to identify potential problems. P F 

 8. Perform an operational check by editing and processing digital imagery. P F 

 9. Troubleshoot any problems by referring to manufacturers’ manuals first.  If 
problems continue, contact a representative of the product for further 
assistance. 

P F 

 10. Prepare DA Form 2404 on all equipment. P F 
 a. Annotate all deficiencies and parts required and turn into maintenance for 

repairs. 
P F 

 b. If no deficiencies are found, initial and date the form. P F 
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Evaluation Guidance:  Score the soldier GO if all steps are passed (P).  Score the soldier NO-
GO if any step is failed (F).  If the soldier fails any step, show what was done wrong and how to 
do it correctly.  Have the soldier practice until he can correctly perform the task. 
 
References 

Required Related 
DA Pam 738-750 Appendix A (25M) 
Manufacturers’ Manuals  
TC 11-6  
TM 9-2320-280-10  
TM 9-6115-642-10  
TM 9-6115-660-13&P  
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Subject Area 2:  Illustration/Multimedia 
 

WRITE A VISUAL INFORMATION CAPTION 
113-578-6015 

 
Conditions:  In a tactical or garrison environment, given a blank DD Form 2537, pen or marker, 
negative preservers and negatives, photo prints or illustrations, Message 0206010833Z Dec 95, 
and DA Pam 25-91. 
 
Standards:  The standards are met when the visual information identification number (VIRIN) is 
legibly written on the border area of the negative/print/illustrations in the sequence prescribed.  
The written caption must contain who, what, where, when, why, and/or how, so that the 
event/illustration is fully explained. 
 
Performance Measures Results 

 1. Review DD Form 2537. P F 
 a. Project/exercise/event title. P F 
 b. VIRIN. P F 
 c. Date recorded. P F 
 d. Camera operator. P F 
 e. Media/film type. P F 
 f. Tape/roll/disc number. P F 
 g. Classification of media. P F 
 h. Classification of caption. P F 
 i. Classification authority. P F 

 2. Synopsis/cover story. P F 
 a. Location. P F 
 b. Description of project/activity/exercise/event. P F 

 3. Individual imagery descriptions. P F 
 a. Camera number. P F 
 b. Time code (HR:MIN:SEC/negative/slide number). P F 
 c. Description (who, what, when, where, how, and why). P F 
 d. Classification of scene/image. P F 
 
 
Evaluation Guidance:  Score the soldier GO if all steps are passed (P).  Score the soldier NO-
GO if any step is failed (F).  If the soldier fails any steps, show what was done wrong and how to 
do it correctly.  Have the soldier practice until he can correctly perform the task. 
 
References 

Required Related 
DA Pam 25-91  
MSG 0206010833Z Dec 95  
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PREPARE CHARTS 
113-579-1037 

 
Conditions:  Given DA Form 3903-R with chart requirements; markers or a lettering device 
(typewriter, Leroy lettering instrument, Kroy, computer, or the equivalent); flat surface large 
enough to support paper, such as a Field Drafting Kit or drawing board; drawing tools, such as a 
T-square or straightedge; protractor; compass; ruler; pencils (standard and nonreproducible 
blue); pens; ink; masking tape; erasers (steel or vinyl); acetate (if requested on DA Form 3903-
R); paper, such as poster board or flip chart; tape (Chartpak), and/or toning material. 
 
Standards:  The standards are met when the chart presents the data in a manner acceptable to 
the requester. 
 
Performance Steps 

 1. General construction. 
 a. The title is the first element considered.  Titles should be centered at the top of the 

chart and in capital letters.  It should be clear and concise.  Under no circumstance 
should the clarity of the title be sacrificed for brevity.  The phrase or phrases of the title 
should not be broken at the end of each line.  It should be laid out so that each line 
represents a single thought. 

 b. The organization of the body of the table is as important as the layout of the title.  Poor 
planning leads to confusion or misrepresentation of data.  The arrangement must 
present the data simply and clearly.  Data must be arranged alphabetically, 
geographically, chronologically, or in some other logical order, depending upon the 
intended use of the table and the data presented. 

 (1) Column is the term for vertical listings. 
 (2) Row is the term for horizontal listings. 
 (3) Boxhead contains the captions (titles) of the columns. 
 (4) Captions must clearly describe the data in the columns. 
 c. Footnotes are used to clarify items in the table that require further explanation.  A 

reader's attention is usually directed to a footnote by an asterisk (*) or some other 
symbol.  Never use one symbol to identify different footnotes.  If a footnote applies to 
more than one entry, however, place its symbol after each entry to which the footnote 
applies. 

 2. Types of charts. 
 a. Bar chart. 
 (1) Determine the reference frame.  If the values are both positive numbers, the entire 

graph can be constructed in quadrant I.  See Figure 3-1. 



STP 11-25M13-SM-TG 

3-10 

Performance Steps 
 

III IV

II I
Y

Y

X X

The axis of the
ordinates, or
the axis of Y,
or the Y-axis Ordinate, or Y

coordinate or
"The Y"

Origin

Abscissas or
X coordinate,

or "The X"

The axis of the
abscissas, or
the axis of X,
or the X-axis

P

 
 

Figure 3-1.  Reference frame with x-axis and y-axis. 
 

 (2) Determine on which axis to plot the different sets of values.  As a general rule, plot 
constant values along the x-axis and the dependent values along the y-axis.  In 
Figure 3-2, the years are constant value and the cost values are the dependent 
values. 
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Figure 3-2.  Typical bar chart. 
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Performance Steps 
 (3) Select the paper size and scale of the bar graph.  When laying out a bar graph, try 

to fill the entire page proportionately.  Remember to allow for margins around the 
graph for text and explanatory notes. 

 (4) Layout the x-axis.  The intervals between the bars and spaces are drawn equally 
except for the front and back spaces.  These two spaces are drawn half the width 
of the bar.  To do this correctly, determine the total number of spaces needed, 
number of bars plus number of whole spaces.  The scale is placed at a 
convenient angle that covers the number of spaces needed as shown in Figure 3-
2.  The zero of the scale is placed at point A and the last point on line AC falls on 
line BC, with line BC being any length.  Using a scale, mark off the number of 
equally divided spaces you need.  Place a half bar width space before the first 
bar.  If there is too many constant values to give a full bar's width space between 
bars, spaces may be reduced to no less than half of a bar's width, making the 
beginning and ending space a quarter of a bar's width. 

 (5) Layout the y-axis.  Determine the largest value that will be shown.  Determine 
what scale to use, keeping in mind that the increments should not be so close or 
so great that the information is lost. 

 (6) Plot the given data.  Bar charts are not intended to be precise.  They are 
comparisons of approximates.  If the chart is to be perfectly accurate, label the top 
of each bar with its value.  A horizontal line is never drawn through a bar. 

 (7) Finish the chart. 
 (a) Ink in all the lines on the chart.  Use thicker lines for the outside box.  Use 

thinner lines for the scales that run horizontally across the chart. 
 (b) Pattern tapes, opaque tapes, or zip-tone patterns, if available, can be used 

for the bars.  Pattern tapes are made in regular and irregular arrangements of 
design.  Some are in the pattern of hatch marks or repeated designs.  Pattern 
tapes also come in many colors.  Opaque tapes are solid rolls of color.  Zip-
tone is a transparent adhesive sheet.  The sheet is covered with different 
patterns, dots, lines, or solid colors.  You apply this sheet to areas of a chart, 
creating different tonal effects. 

 (c) Add the lettering and figures, centering each in its appropriate place. 
 b. Pie charts. 
 (1) Determine what percent of the whole each component represents.  Add up the 

total units.  The total units equal 100 percent.  Divide each separate unit by total 
units.  You will get a decimal for an answer.  Multiply the answer by 100 to get its 
percentage of the whole. 
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Performance Steps 
 (2) Determine how many degrees of the circle will be needed to represent the item.  

There are 360 degrees in a circle, therefore 3.6 degrees equals 1 percent.  
Multiply each percentage by 3.6 to determine the number of degrees needed for 
that item.  See Figure 3-3 

 

650.0
32.5%
 117O

400.0
20.0%
    72O

300.0
15.0%
    54O

150.0
  7.5%
    27O

500.0
25.0%
    90O

 
 

Figure 3-3.  Pie chart shows how to determine what percent of the whole  
each component represents. 

 
 (3) Start constructing the actual pie chart.  Select the paper size and circle size.  

When doing the layout, fill the paper proportionally, allowing for text, legends, and 
other information.  If more than one pie chart is used on the same presentation, 
make them the same size. 
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Performance Steps 
(a) Draw a circle with a compass.  Use a protractor to lay out each segment.  The 

largest segment should start at 12 o'clock and go clockwise from largest to 
smallest.  See Figure 3-4. 

 

 
 

Figure 3-4.  Example of the layout of the segments of a pie chart beginning  
with the largest to the smallest. 

 
(b) Lay out the text on the chart.  The lettering on a pie chart should indicate the  

percentage and how it relates to each sector.  Do not indicate the number of 
degrees of a sector.  If a sector is too small to enclose the lettering, place the 
lettering close enough to the sector so that the reader can read it without 
taking his eyes off of the circle.  When it is not possible to letter directly on the 
sectors, place a legend in the lower right hand corner. 

 (4) Finish the chart. 
(a) Verify the data and your calculations. 
(b) Ink in all the lines on the chart.  Crosshatch or color the individual sectors. 
(c) Ink in or use Chartpak for the text. 

 c. Organization charts. 
 (1) Organization charts should be limited to be effective.  The chart should show lines 

of authority, responsibility, span of control, and functional authority.  The military 
uses three basic types of organizational charts:  structural, functional, and 
positional, as well as combinations of the three types. 

 (a) The structural organizational chart is the most common and simplified method 
of presenting the organizational plan.  It shows the basic control relationships 
and reporting responsibilities of a unit.  The textual information it contains is 
minimum.  This chart can be devised for any organization, regardless of size.  
See Figures 3-5 and 3-6. 
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Performance Steps 
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Figure 3-5.  Large structural organizational chart. 
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Figure 3-6.  Small structural organizational chart. 
 

 (b) A functional organizational chart is used to show the role of the components 
of an organization and what they represent.  The blocks of the chart contain 
statements of what each component does within the organization.  See 
Figure 3-7. 
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Performance Steps 
 

 
Figure 3-7.  Functional organizational chart. 

 
 (c) The position chart (or billet assignment) is used to show the various positions 

held by each individual within an organization.  These charts will show 
names, billets, and titles or grades of personnel as they fit into the 
organization; or show billet, titles, and grades without reference to names of 
individuals involved.  See Figure 3-8. 
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1 PNC HEAD

3 PN1 TEST ADMINISTRATOR
2 PN3 TEST CLERK
3 PN3 TEST SCORER
4 PN2 PROCTOR

SELECTION AND
ASSIGNMENT BRANCH

CLASSIFICATION DIVISION

CLASSIFICATION OFFICER - LT
ASST CLASSIFICATION OFFICER - LTJG

 
 

Figure 3-8.  Position chart. 
 

 (2) In selecting what type of chart you should develop, determine what information 
the chart needs to convey and then determine the simplest format to express that 
information.  You may prefer to combine all three of the basic types into one chart 
if the organization is small and simple.  If too much information is presented, the 
chart will be too difficult to read and may be confusing. 

 (3) An organizational chart should conform to a distinct format.  The arrangement of a 
chart should contain five main points:  simplicity, clarity, completeness, symmetry, 
and unity. 

 (a) Simplify an organization chart by eliminating the confusing or complicating 
elements.  Do not simplify just for the sake of making it easier to construct. 

 (b) Clarity is related to simplicity.  A chart with only a limited number of 
organizational component blocks joined by a small number of lines can be 
simple.  Lines should never cross.  Blocks must be labeled and titles not 
omitted.  Figures 3-9 and 3-10 illustrate good examples of organizational 
charts and contain other suggestions to simplify the chart layouts. 
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Figure 3-9.  Organizational chart with a limited number of  
organizational component blocks. 

 
 

SPECIAL SERVICES
DEPARTMENT

RECREATION
DIVISION

ATHLETICS
DIVISION

RECREATION
FUND

DIVISION

STATION
NEWSPAPER

DIVISION
 

 
Figure 3-10.  A simple organizational chart layout. 

 
 (c) Unity means each component is interrelated to the other components in a 

chart.  This is done by a connecting line or through other organizational 
components.  No branch section, unit, or staff element can exist by itself, 
unconnected to the organization.  Each element must be clearly subordinate 
to command authority. 
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 (4) An organization chart intended for use by only local activities may be prepared on 

any size paper.  However, if the chart is to be reproduced, prepare it on an 8 1/2 x 
11 sheet of paper.  A chart to be reproduced by photographic means should be 
prepared according to the print shop's requirements. 

 (a) Lettering may be produced by typing, Leroy, Chartpak, or any means 
available. 

 (b) Layout lines are drawn with nonreproducible blue pencil.  When the layout is 
finalized, retrace the lines with ink or tape.  Line weights may the same 
throughout, but for easier reading and a better looking chart, use heavier line 
weight for authority blocks. 

 (c) Block sizes may vary, but in a structural chart, the top block is the largest with 
the other blocks decreasing in size at each lower level.  In order to achieve 
balance and clarity in structural charts and other types of organizational 
charts, when suitable, make the blocks proportional in size.  This is a general 
rule and need not apply to other types of organization charts. 

 (d) When drawing a functional chart, you must allow more space for the 
functional statements than would be available under this rule.  Here the block 
size for the lower echelon may have to be increased when drawing position 
charts. 

 (5) An organization chart uses the following line convention types.  See Figure 3-11. 
 

Existing Full-Time
Subdivision

Full-Time Subdivisions
to be Abolished

Inactive Command
Components (Functions
Performed by Another

Activity)

Existing Full-Time
Subdivisions to be

Created

 
 

Figure 3-11.  Block line breaks in organizational chart squares. 
 

 (a) A solid rectangle for existing full-time subdivisions. 
 (b) A hidden line (- - -) rectangle for existing full-time subdivisions to be created. 
 (c) Alternating dot-dot-dash blocks for full-time subdivisions to be abolished. 
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 (d) Dotted line rectangles are used for inactive command components whose 

functions are currently being performed by another activity or will be manned 
up on mobilization.  There are many variations that can be used for other 
situations.  Do not forget to label the dot-dot-dash and the dot-dot-dot blocks 
and explain them in the legend. 

 (6) When an individual occupies two or more billets, place an asterisk (*) in the 
appropriate blocks.  See Figure 3-12. 

 

A

B C

ADMINISTRATIVE
ASSISTANT*

ADMINISTRATIVE
ASSISTANT*

ADMINISTRATIVE
ASSISTANT*

* Part-time splitting of function.
  Same person performs the duties of
  Administrative Assistant to A, B, and C.  

 
Figure 3-12.  An example of an organizational chart that shows an individual  

occupying two or more billets. 
 

 (7) The authority lines are shown as solid vertical or horizontal lines that start from 
and enter into the center of each block.  Never use diagonal lines.  Construct lines 
so that they do not cross each other.  This only complicates the chart.  Unit blocks 
directly under a section block are connected with authority lines centered on the 
unit as shown. 

 (8) Draw hidden lines (- - -) to connect the blocks to denote liaison or 
intercommunication between two components. 
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 1. Check DA Form 3903-R. P F 
 a. Type of chart required. P F 
 b. Purpose. P F 
 c. Time constraints. P F 
 d. Size required. P F 

 2. Check for existing guidance (facility SOP and supervisor). P F 

 3. Check for available equipment and supplies. P F 

 4. Lay out and letter chart with a pencil or nonreproducible blue pencil. P F 

 5. Check the chart for accuracy. P F 
 a. Spacing. P F 
 b. Spelling. P F 
 c. Uniformity. P F 
 d. Completeness. P F 
 e. Correctness. P F 
 f. Positioning of elements. P F 
 g. Data. P F 

 6. Ink in or use tape (such as Chartpak) to produce the lines/graphics. P F 

 7. Inspect the chart for compliance with DA Form 3903-R. P F 

 8. Complete DA Form 3903-R. P F 
 
 
Evaluation Guidance:  Score the soldier GO if all steps are passed (P).  Score the soldier NO-
GO if any step is failed (F).  If the soldier fails any step, show what was done wrong and how to 
do it correctly.  Have the soldier practice until he can correctly perform the task. 
 
References 

Required Related 
 Appendix B (25M) 
 Appendix D (25M) 
 Appendix J (25M) 
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CONSTRUCT A TECHNICAL DRAWING 
113-579-1054 

 
Conditions:  Given DA Form 3903-R with technical drawing requirements; FM 5-553; field 
drafting kit; drawing paper; drafting tools, such as T-square or straightedge; protractor; 
compass; ruler; pencils (standard and nonreproducible blue); pens; ink; masking tape; erasers 
(steel or vinyl); acetate (if requested on DA Form 3903-R); paper, such as poster board or flip 
chart; tape (Chartpak); and/or toning material. 
 
Standards:  The standards are met when drawings are without smudges, lines are opaque and 
consistent for the length of the entire line, and if drawn to scale, the drawing is accurate to within 
1/32 of an inch. 
 
Performance Steps 

1. A technical drawing is a broad term that applies to any drawing used to express ideas or 
concepts where accurate proportions and/or relationships are essential.  An inaccurate 
drawing is worthless.  The three types of drawings you need to be familiar with are 
orthographic, isometric, and oblique (see Figure 3-13).  As an illustrator, you may be 
called upon to produce an accurate orthographic drawing of a captured piece of 
equipment, or just the opposite, create an isometric drawing from a blue print. 

 

Isometric Oblique

Orthographic  
 

Figure 3-13.  Three types of technical drawings. 
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 2. General construction. 
 a. Lines.  There are many different kinds of lines used on a technical drawing.  Visible, 

hidden, leader, center, and phantom lines are the most common.  Each has a specific 
thickness, consistency, pattern, and use that is defined below.  An example of each is 
given in Figure 3-14. 

 

 
 

Figure 3-14.  Four types of lines commonly used on technical drawings. 
 

 (1) Visible lines are heavy, thick black lines approximately .02 inches thick.  Visible 
lines are uniform in color and density and are used to define the visible edges of 
an object. 

 (2) Leader lines are thin black lines about .01 inches thick.  Leader lines should be 
noticeably thinner and are used when dimensioning an object. 

 (3) Center lines are thin black lines drawn in a long line-space-short line-space 
pattern approximately half as thick as visible lines.  The long sections can be 
drawn at any convenient length, but the short sections must be approximately 1/8- 
inch long and the intermittent spaces should be approximately 1/16-inch long.  
Except for this line-space pattern, centerlines are identical to leader lines and are 
used to define the center of all or part of an object.  Most commonly used to 
define the center of holes, centerlines may also be used to help dimension an 
object. 

 (4) Phantom lines are thin black lines drawn in a long line-space-short line - space - 
short line-space-long line pattern, approximately half the thickness of the visible 
line.  The long sections may be varied in length, but the short lines must be 1/8-
inch long and the intermittent spaces should be approximately 1/16-inch long.  
These lines are used to show something that is relative to, but not really a part of 
the object being drawn. 

 b. Lettering.  There are a few acceptable styles of letters and numbers, such as Arial and 
Helvetica, for a technical drawing.  Either style is acceptable.  The height should be 
either 1/8-inch or 3/16-inch, although the individual drawing requirements should be 
taken into consideration when deciding on letter height. 

 c. Creating a parallel line to a specified distance.  Set a compass to distance G.  Set the 
compass anywhere along line A-B.  Draw an arc on one side of line A-B.  Draw 
another arc on the same side of line A-B as the first arc.  Draw a line tangent to both 
arcs.  See Figure 3-15. 
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X

X

X

X

X

X

X

X

G

A

B

G

G

G

B

B

B

A

A

A

Anywhere along Line A-B

Anywhere
along line A-B

Given: Line A-B and distance G.

Problem: Construct a line parallel to line A-B at
distance G.

2. Construct another arch of radius G as shown. 3. Construct a line tangent to both arcs.

1. Using a compass set anywhere along line A-B,
construct an arch of radius G as shown.

Line parallel to line A-B
at distance G

 
 

Figure 3-15.  Creating a parallel line to a specified distance. 
 

 d. Bisecting a line.  Set a compass to a radius that is greater than 1/2 the length of line A-
B.  Place the compass at one end of line A-B and draw an arc through line A-B.  Place 
the compass at the opposite end and repeat the process.  Draw a line through the two 
points created by the intersecting arcs.  See Figure 3-16. 
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X

X

X

X

X

X

X

X

A

B

R

R

R

B

B B

A

A A

4 4

3 3
5

Given: Line A-B.

Problem: Divide line A-B into two equal parts.

1. Construct an arch of radius R. Use point A as

2. Construct an arch of radius R. Use point B as center. 4. Connect points 3 and 4 with a construction lin

R = any radius of greater length than 1/2 line A-

3. Define the intersection of the arcs as points 3 and 4. 5. Define point 5 where line 3-4 intersects line A
    Line A-5 = line 5-B.

 
 

Figure 3-16.  Bisecting a line. 
 

 e. Divide a line into any number of equal parts.  Construct a line A-X at any acute angle 
to line A-B.  Mark off five equal spaces along line A-X and construct line B-5.  Any size 
space may be used as long as it remains equal.  Draw lines 4-F, 3-E, 2-D, and 1-C 
parallel to line B-5.  See Figure 3-17. 
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Given: Line A-B

Problem: Divide line A-B into five equal parts. 1. Construct a line A-X at any acute angle to
    line A-B.

2. Mark off five equal spaces along line A-X and
    construct line B-5. 3. Draw lines 4-F, 3-E, 2-D, and 1C parallel to

    line B-5.

1-C = C-D = D-E = E-F = F-BNOTE:  Any size spaces may be used as long
as they are all equal in length.

A

B

A

X

B

Any acute angle

A

X

B

1 2 3
4 5

A

X

B

1

C

D

E

F

2 3
4 5

Five
 equal sp

aces

X

X

X

X

X

X

X X

X

 
 

Figure 3-17.  Dividing a line into any number of equal parts. 
 

 f. Bisecting an angle.  Draw an arc through angle A-B-C.  Using points 1 and 2, construct 
two more arcs.  Draw points 1 and 2, construct two more arcs.  Draw a line from B 
through 3.  See Figure 3-18. 
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A A

A A

B C C

C C

Given: Angle A-B-C.
1. Construct an arc of radius R. Use point B as
    center.

Problem: Bisect angle A-B-C. 2. Using points 3 and 4 as centers, construct 
    two more arcs of radius R as shown.

3. Define points 3 and 4 where the arc
    intersects lines B-A and B-C. 5. Construct line B-5.

4. Define the intersection of the
    two arcs as point 5.

Angle A-B-5 = Angle 5-B-C

B

B B

3

3 3

4

4 4

5 5

R

R

R

 
 

Figure 3-18.  Bisecting an angle. 
 

 g. Dimensioning guidelines. 
 (1) Place dimensions so that there are no misunderstanding as to which surface is 

being dimensioned. 
 (2) Be sure that all surfaces are addressed and that no edges are left out. 
 (3) Dimensions should be at a constant height, either 1/8-inch or 3/16-inch. 
 (4) Do not attempt to stuff a dimension in a space or an angle that is too small.  It is 

more important that the dimension is legible. 
 (5) Unless it is absolutely unavoidable, do not place dimensioning lines within an 

object being defined. 
 (6) Do not double dimension.  One dimension per edge is sufficient.  Giving the same 

dimension on another view may cause confusion. 
 (7) A dimension line should be placed no closer than 3/8-inch to the object.  

Dimensions should be evenly spaced. 
 (8) Attempt to keep all leader lines at the same angle.  Leader lines should not 

change direction until after they have extended beyond the outside edge object 
and any other dimension or extension lines.  End a leader line in a short horizontal 
line, leading the reader's eye to the appropriate note or dimension. 

 (9) Be consistent when using fractions or decimals.  Do not mix the two.  This applies 
to lettering as well.  Use either an unidirectional or an aligned approach. 
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 (10) Always specify whether a hole or an arc dimension is a diameter (DIA) or a radius 

(R).  Dimension holes on views where they appear as circles. 
 (11) Do not run extension or dimension lines through other extension or dimension 

lines unless absolutely unavoidable.  This applies to leader lines as well. 
 (12) Always include overall dimensions except on objects that have rounded ends. 

 3. Orthographic projections are views of an object that are perpendicular to the object surface 
and the drawing surface.  There are an infinite number of possible projections, the most 
logical being top, bottom, left side, right side, front, and back.  In an effort to avoid 
confusion, use the top, the front and the right side as the views for a technical drawing. 

 a. Drawings are divided into zones.  Each zone contains one orthographic view with all 
the information for that view.  The zones are separated by crossed-construction lines 
called principal plane lines which are similar to a mathematical coordinate system.  
They are omitted on finished drawings.  See Figure 3-19. 

 

Top Top

Front
Front

Front
Right
Side

Right
Side

Right
Side

Principal
Plane Lines

Top

Principal
Plane Lines

Right Side
View Zone

Front View
Zone

Top View
Zone

 
 

Figure 3-19.  Principal plane lines and how they were developed initially. 
 

 b. Reduced to its simplest form, projection theory may be used to transfer a single point 
from one view to another. 

 (1) Project the front view of point 1 into the right side view zone.  Drawing a horizontal 
principal plane line does this.  The tendency here is to draw the projection line too 
short, meaning extension may be required later on.  All that is known at this point 
is that the right side view is somewhere along the projection line. 

 (2) Draw a line 45 degrees up and to the right from the intersecting point of the 
principal lines.  This is called a miter line. 
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 (3) Project the top view of point 1 into the right side view zone.  This is done by 

drawing a horizontal construction line to the right, parallel to the horizontal 
principal plane line until it touches the 45-degree miter line.  When the projection 
line touches the miter line, it goes from horizontal to vertical.  To continue the 
projection line, draw a vertical construction line, parallel to the vertical principal 
plane line, extending down into the right side view zone.  Draw the projection line 
through and beyond the horizontal projection line. 

 (4) The intersection of the two projection lines is the right side view of point 1.  Label 
it. 

 (5) The projection of lines between views follows directly from point projection theory.  
Simply keep in mind that a line is the visible connection of two or more points. 

 (6) Project point 1 into the right side view.  See Figure 3-20. 
 

Right Side

Right Side

Top

Front

1

1

1 1

1 1

Miter Line (at 45  )

 
 

Figure 3-20.  Projection of point 1 into the right side view. 
 

 (7) Project point 2 into the right side view. 
 (8) Connect points 1 and 2 with an object line.  This is the right side view of line 1-2. 
 c. As line projection theory is derived from point projection theory, plane projection theory 

follows directly from line projection theory.  Remember that a plane is the area 
enclosed within a series of lines interconnected end to end. 

 (1) Identify the lines that define the plane 1-2, 2-4, 4-3, and 3-1. 
 (2) Project the individual points 1, 2, 3, and 4 into the right side view.  See  
  Figure 3-21. 
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2

22

1 1

1

4 4

3 3

 
 

Figure 3-21.  Projection of individual points 1, 2, 3, and 4 into the  
right side view. 

 
 (3) Draw in the object lines, the lines that will define the plane. 

 4. An isometric drawing is a three-dimensional representation of an object that does not use 
perspective.  It is used to convey technical information of an object.  All isometric drawings 
are based on a 120-degree axis system.  The object in an isometric drawing is position so 
that the front, top, and right side appear as shown in Figure 3-22.  All dimensional values 
for the axis or lines parallel to the axis are taken directly from the orthographic views.  This 
includes the basic height, width, and length of the object. 

 

Pictorial

Isometric  
 

Figure 3-22.  A comparison between an isometric drawing and  
a pictorial drawing. 

 
 a. Lightly lay out a rectangular box whose measurements correspond to the dimensions 

given in the orthographic views. 
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 b. Lightly lay out the specific shape of the object.  Transfer measurements for the axis or 

line parallel to the axis directly from the orthographic views to the isometric drawing.  
See Figure 3-23. 

 

 
 

Figure 3-23.  Transferring measurements from the orthographic view to  
the isometric drawing. 

 
 c. Check your work to verify measurements. 
 d. Erase all construction lines and smudges. 
 e. Darken in all final lines. 

 5. Oblique drawings are easier to draw than isometric drawings, but they contain more 
inherent visual distortion.  See Figure 3-24. 
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Figure 3-24.  Oblique drawing. 
 

 a. The basic reference system for oblique drawings is the 90-degree relationship 
between the left-hand axis and the vertical axis.  Because of this 90-degree 
relationship, the front view and all surfaces parallel to it are almost identical to the front 
view of an orthographic drawing.  This makes it easier to transfer information between 
the two different front views. 

 b. The receding lines may be drawn at any convenient angle.  Upward and to the right at 
either 30 degrees or 45 degrees is most commonly used.  The choice of which 
receding angle to use depends on which angle best shows the object. 

 c. Dimensional values are directly transferable from view of the orthographic drawings to 
the front view of the oblique drawing.  Transfer circles as circles, not as ellipses as in 
isometric drawings.  Angles directly transfer.  Dimensional values for all other views 
are not directly transferable.  They can only be transferred from the orthographic views 
to the receding axis of the oblique drawing. 

 d. Oblique drawings do not normally include hidden lines, although they may be used if 
special emphasis is required. 

 
 
Performance Measures Results 

 1. Check DA Form 3903-R. P F 
 a. Type of drawing required. P F 
 b. Size required. P F 
 c. Time restraints. P F 

 2. Check for available equipment and supplies. P F 

 3. Lay out drawing with a pencil or nonreproducible blue pencil. P F 
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 4. Check accuracy. P F 
 a. Angles (plus or minus 1/2 degree). P F 
 b. Line length and placement (plus or minus 1/32 degree). P F 
 c. Dimensions. P F 
 d. Spelling. P F 
 e. Appropriate line type. P F 
 f. Uniform line weights. P F 

 5. Ink in drawing. P F 

 6. Remove all construction lines and smudges. P F 

 7. Complete DA Form 3903-R. P F 
 
 
Evaluation Guidance:  Score the soldier GO if all steps are passed (P).  Score the soldier NO-
GO if any step is failed (F).  If the soldier fails any step, show what was done wrong and how to 
do it correctly.  Have the soldier practice until he can correctly perform the task. 
 
References 

Required Related 
FM 5-553 Appendix B (25M) 
 Appendix C (25M) 
 Appendix D (25M) 
 Appendix J (25M) 
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CREATE AN ILLUSTRATION 
113-579-4015 

 
Conditions:  In a tactical or garrison environment, given a completed DA Form 3903-R, 
burnisher, pastels, pencils, pens, oil paints, watercolors, tempera or acrylics, erasers, various 
brushes, drawing surface, poster board or paper, and subject. 
 
Standards:  The standards are met when the finished project is accepted by the requester.  
The subject must be in the appropriate perspective view, as specified in DA Form 3903-R, true 
to form, proportion, contour, and shading.  Effective use of the principles of color, balance, and 
harmony must be applied.  Drawing must be free of smudges and extraneous marks. 
 
Performance Measures Results 

 1. Check DA Form 3903-R. P F 
 a. Purpose. P F 
 b. Time restraints. P F 

 2. If not stated, choose media (medium). P F 

 3. Sketch thumbnail. P F 

 4. Lay out the rough. P F 

 5. Have client approve rough if requested. P F 

 6. Complete the comprehensive. P F 
 a. Lightly sketch the basic forms. P F 
 b. Establish proportions. P F 
 c. Verify proportions. P F 
 d. Use foreshortening techniques. P F 

 7. Refine and draw in the contours. P F 

 8. Apply shading. P F 

 9. Erase extraneous marks. P F 

 10. Correct any flaws (as needed). P F 

 11. Complete DA Form 3903-R. P F 
 
 
Evaluation Guidance:  Score the soldier GO if all steps are passed (P).  Score the soldier NO-
GO if any step is failed (F).  If the soldier fails any steps, show what was done wrong and how to 
do it correctly.  Have the soldier practice until he can correctly perform the task. 
 
References 

Required Related 
 Appendix B (25M) 
 Appendix C (25M) 
 Appendix D (25M) 
 Appendix J (25M) 
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PREPARE TACTICAL GRAPHIC OVERLAYS 
113-579-5060 

 
Conditions:  In a tactical or garrison environment, given acetate or overlay materials, map, 
technical pens and/or markers, FM 21-31, FM 101-5-1, and flat drawing surface or light table. 
 
Standards:  The standards are met when overlays are registered, free of extraneous marks, 
and display all information legibly. 
 
Performance Steps 

 1. Place and temporarily tape overlay material over the map area to be annotated. 

 2. Trace the grid register marks nearest the two opposite corners of the overlay.  Label each 
mark with the proper grid coordinates. 

 3. Plot overlay information using pen, pencil, or colored markers.  Take care not to tear 
overlay material. 

 4. Add standard military and topographical symbols. 

 5. Add marginal information. 
 
 
Performance Measures Results 

 1. Register overlay to map using grid intersections in opposite corners, labeling 
each with the grid coordinates. 

P F 

 2. Plot data from information sheet using appropriate symbols and colors. P F 

 3. Print marginal information. P F 
 
 
Evaluation Guidance:  Score the soldier GO if all steps are passed (P).  Score the soldier NO-
GO if any step is failed (F).  If the soldier fails any step, show what was done wrong and how to 
do it correctly.  Have the soldier practice until he can correctly perform the task. 
 
References 

Required Related 
FM 101-5-1 Appendix D (25M) 
FM 21-31  
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PREPARE ILLUSTRATIONS FOR DISPLAY 
113-579-5065 

 
Conditions:  In a tactical or garrison environment, given DA Form 3903-R, illustration, drawing 
board, matting materials, mounting tissue, plain poster board or foam core, brown paper, 
squeegee, protective paper, tacking iron, metal straightedge, ruler, pencil, T-square, mat 
cutters, paper trimmer, rubber cement, dry mount press, and frame. 
 
Standards:  The standards are met when the illustration is mounted with no ripples, bubbles, 
tears, or blemishes; the mat opening is neat, is the correct size and shape, has a uniform bevel, 
and is without extraneous cuts, marks or blemishes. 
 
Performance Steps 

 1. General.  A well-mounted and matted illustration or photograph adds a professional 
appearance to completed artwork and displays.  Appearance often makes a major first 
impression of a display of any type, graphics facility, or headquarters.  You should cut your 
mats to standard frame sizes (8 x 10, 10 x 12, 12 x 16, 16 x 20 inches, and so forth), if 
possible.  This allows for easy framing.  Methods of mounting illustrations and cutting mats 
of different types and the tools used are discussed below. 

 2. Dry mount press.  This is sometimes called a hot press.  It offers clean, fast, and 
permanent mounting.  The following tells how to use this method. 

 a. Pencil mark on the mount the locations for placing the illustration or print edge. 
 b. Once marked, place a sheet of translucent mounting tissue on the back of the 

illustration.  With a heated electric tracking iron, fasten the adhesive sheet and attach 
temporarily (task) at its center. 

 (1) Dry mounting tissue is thin paper coated on both sides with a shellac or gum 
adhesive.  The tissue is dry, not sticky, and very easy to handle.  The tissue is 
odorless and chemically inert so that it will not stain artwork.  Being moisture-
proof, it will not wrinkle an illustration or print.  It is well suited for a broad range of 
paperweights and gives a strong, flexible, permanent bond between artwork and 
mount. 

 (2) Experiment with the press to find the best temperatures for mounting different 
papers.  When using more than one sheet of adhesive, DO NOT OVERLAP them!  
At the overlap point, there will be a visible, undesirable ridge on the photo or 
illustration. 

 c. Trim the adhesive sheets evenly with the artwork, because tissue extending beyond 
the artwork edge sticks to the press.  Place the artwork, with adhesive sheet attached, 
to the previously marked mount and tack with the tacking iron.  While holding the 
artwork in place, lift one corner and tack the adhesive sheet to the mount, being 
careful not to drag the iron. 

CAUTION:  Original artwork that uses a heat sensitive media (crayon, colored or grease pencil, 
Zip-a-Tone, and so forth) should not be mounted with a dry-mount (hot) press.  Because of the 
heat involved, artwork may be damaged or destroyed!  Use a print if possible. 
 d. Place tacked artwork, adhesive tissue, and mount face up in the press.  Cover artwork 

with a sheet of kraft paper for protection.  Apply heat and pressure according to 
manufacturer's recommendations.  Any bubbles in the mounted print may be 
punctured with a pin and repressed. 
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 3. Rubber cement mounting.  Rubber cement should be about the consistency of honey if it is 
to flow properly and hold permanently.  Rubber cement dries quickly when exposed to air.  
Rubber cement manufacturers offer a thinner that can be mixed into thickened cement until 
achieving the desired consistency.  If thinned too much, the cement will not hold as well. 

CAUTION:  Rubber cement and thinner are highly flammable and toxic!  Do not use near open 
flames or in unventilated areas.  DO NOT breathe fumes for an extended period of time. 
 a. Though some pieces previously mounted using this process were successfully 

removed, it is strongly discouraged.  Removal is not only tedious and time-consuming, 
but it usually damages the artwork and makes the mounting board useless. 

 b. A rubber cement pickup (made of crepe latex) is very useful in removing excess 
cement.  It is rubbed gently over the dry cement, easily picking up the cement in hard-
to-get-at areas.  If a pickup is not available, rub the dry cement off with a clean finger 
or a dry ball of rubber cement. 

 c. The wet mount and dry mount methods are the two ways of using rubber cement in 
mounting.  The latter should not be confused with the dry mount press. 

 (1) The wet mount method lets you move the artwork while positioning it on the 
mounting board. 

 (a) Apply rubber cement evenly to the underside of the piece being mounted.  
Place the wet piece directly on the mounting board and adjust its location. 

 (b) After you have accurately located the piece, cover with a piece of 
nonadhesive tissue.  Using a triangle as a squeegee, start at one corner and 
press the print into place, squeezing out the excess cement.  Remove the 
tissue paper. 

 (c) After the excess cement dries, remove it with the rubber cement pickup. 
 (2) Dry mounting, though not completely permanent, holds extremely well.  This 

method of mounting requires positioning of the artwork exactly in place before 
attaching it to the mounting board.  With this method both surfaces are covered 
evenly with rubber cement and allowed to dry.  When dry, the two surfaces 
instantly stick to each other upon contact. 

 (a) Trim the artwork being mounted to the desired size and mark the required 
position exactly on the mounting board.  Apply rubber cement to both 
surfaces and allow them to dry. 

NOTE:  Often bubbles can be removed by puncturing with a pin and adding pressure or 
heat, depending on the original method used. 
 (b) When the rubber cement is dry, place a sheet of tracing paper over the 

cemented mounting board, leaving about one quarter of an inch exposed at 
the top.  This sheet keeps the two cemented pieces from sticking. 

 (c) Next, position the piece being mounted and carefully, but firmly, press it to 
the exposed area on the mounting board.  Slowly withdraw the tracing paper 
and gently smooth the piece against the mounting board, working from the 
center outward until the piece is firmly attached.  Remove any excess cement 
with the pickup. 

 (d) For mounting large pieces of art or drawings made on flimsy paper, a two 
slip-sheet method divides the work area and makes handling easier. 
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 4. Matting for artwork and prints.  Mats usually have opening edges that are beveled to a 45-
degree angle and are usually permanent.  The bevel edges add a professional look and 
improves the overall appearance of the display.  Try to cut the mats to a standard frame 
size (8 x 10, 10 x 12, 11 x 14, 12 x 16, 16 x 20, 20 x 24, and so forth) if sizing is a 
possibility. 

 a. Standard mats are used when illustrations are to stand on their own and can be 
framed and covered with glass for display.  Borders are even on opposite sides of the 
opening, with no extra space for a caption.  A mat for an illustration and a long 
narrative caption should be planned as one unit for matting.  The caption should be 
placed close to the illustration, but should not touch or overlap. 

CAUTION:  Be extremely careful using the blades for this task.  The blades are very sharp and 
will cut you as easily as the mat board. 
 b. Optically-centered mat.  This type mat prevents the illusion of the photo or illustration 

from falling through the bottom of the mat.  Use these for subject renderings and 
portraits or photographs.  They can add a more professional appearance to your 
labeled display work. 

 (1) Place artwork measurements on the mat, starting from upper left corner of the mat 
as shown by the dotted line in Figure 3-25. 

 
Step 1.  Place measurements
from upper left corner of the 
mat as shown by the dotted line.

Step 2.  Divide the remainder
in half.  Draw a light line
(AB) down the mat.

Step 3.  Divide the remainder
in half.  Draw a light line
(CD) across the mat.

Step 4.  Draw a light 
line from point D
towards point F.
The intersection of
line AB with line
DF is where to 
base your opening 
lines for cutting.

Step 5.  Using a mat cutter,
carefully cut out the opening.

B

D

E

F

C

A

 
 

Figure 3-25.  Optically centered mat. 
 

 (2) Divide the remainder of the mat width in half.  Draw a light line (AB) down the mat. 
 (3) Divide the remainder of the mat height in half.  Draw a light line (CD) across the 

mat. 
 (4) Draw a light line from point D towards point F.  The intersection of line AB with line 

DF is where to base your opening lines for cutting the opening. 
 (5) Using a mat cutter and straightedge carefully cut out the opening. 
 c. Oval mat.  This type of mat is usually reserved for special displays of artwork or 

portraits, and for giving an antique flavor to a display.  An oval mat's center must be 
laid out carefully.  See Figure 3-26. 
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 Center
 CL

1/2 Height

1/2 Width

 
 

Figure 3-26.  Oval opening mat. 
 

 (1) Calculate the opening height, width, and distance for the border edge. 
 (2) One-half the mat board's height and width equals the mat’s center point.  Subtract 

the border thickness and you will have the opening measurements for adjusting 
the oval mat cutter. 

 (3) Set the oval mat cutter according to the manufacturer's instructions and cut the 
opening. 

 d. Multiple opening mat.  This type has any combination of openings requiring you pay 
close attention to the layout.  Multiple opening mats are usually used for displays with 
multiple illustrations grouped together for ease and simplicity of viewing.  You may 
choose a formal or informal layout depending on the occasion or display.  See Figure 
3-27. 

 

  Formal layout.  Informal layout.  
 

Figure 3-27.  Multiple opening mats. 
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 5. Mat cutting tools.  All mat cutting requires specific tools for a professional-appearing end 
product.  All mats should have an evenly beveled edge which requires the use of a mat 
cutter.  There are many cutters you may use for a specific purpose.  Each has its own uses 
and instructions. 

 a. Before removing the opening, view the rear of the mat to ensure all cuts are complete.  
If any are not, carefully use a small craft knife (X-Acto) to complete the cut. 

 b. After the opening is removed, erase all guidelines. 

 6. Mounting illustrations.  Once the mat and opening are cut to correct specifications, the 
illustration may be mounted.  There are many methods to mount an illustration; we will 
discuss two.  The first is a temporary one, and the second is more permanent.  Each uses 
a mat, a backing sheet, and a final sheet of backing material which is usually corrugated 
cardboard; each has its own positive and negative points; and each is suitable for framing 
as needed.  The following applies to unmounted artwork. 

 a. The temporary method is the easiest.  With the mat and illustration face down, the 
illustration is mounted with tape directly to the back of the mat. 

 (1) A transparent tape such as Magic Transparent Tape by 3M does an excellent job.  
Masking tape is easy to obtain but dries out causing a shift of the art within the 
mat.  Some masking tape adhesives stain and are undesirable. 

 (2) Once attached, place a white backing sheet and a sheet of plain mat board or 
corrugated cardboard on the back.  The white backing allows the illustration to be 
seen better, and the cardboard gives additional strength to the entire unit. 

 b. More permanent methods use the same number of sheets plus the illustration, but in a 
different manner.  After positioning the illustration accurately on the white backing 
sheet, the corners of the artwork are traced for adhering. 

 (1) The illustration is removed, and the center area of the backing sheet is sprayed 
with an aerosol adhesive.  Using the previous corner marks, carefully reattach the 
illustration.  Once completed, the package is assembled. 

 (2) Another method uses mounting tapes (rolls) or sheets.  These tapes and sheets 
are sticky on both sides.  Depending on the brand, sometimes you need to peel 
the backing from the tape or sheet.  Follow the instructions for temporary 
mounting; with the mat and illustration face down, apply the double-stick tape and 
mount the illustration directly to the back of the mat. 

 
 
Performance Measures Results 

 1. Review DA Form 3903-R for requirement. P F 

 2. Dry mount or hot press method. P F 
 a. Mark the location for artwork placement on the mount. P F 
 b. Tack center of mounting tissue to back of artwork with tacking iron. P F 
 c. Trim off excess mounting tissue to fit artwork with one corner in place. P F 
 d. Align artwork with adhesive sheet to previously marked mount and tack 

one corner of adhesive sheet to mount. 
P F 

 e. Place tacked artwork, adhesive sheet, and mount face up in the preheated 
hot press. 

P F 

 f. Apply heat and pressure according to press manufacturer's 
recommendations. 

P F 

 3. Wet mount and dry mount methods using rubber cement. P F 
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 a. Wet mount. P F 
 (1) Apply rubber cement to the back of the artwork. P F 
 (2) Place artwork on previously marked mount and adjust the position if 

necessary. 
P F 

 b. Dry mount (should not be confused with the dry-mount press). P F 
 (1) Apply rubber cement to both artwork and mount allowing the surface 

to dry. 
P F 

 (2) When dry, carefully place the two surfaces together. P F 
 (3) Remove excess cement with a rubber cement pickup. P F 

 4. Mat artwork and prints. P F 
 a. Determine the correct size of mat to be cut. P F 
 b. Determine the size of opening. P F 
 c. Lay out cutting guidelines. P F 
 d. Using a mat cutter and straightedge carefully cut out the opening. P F 
 e. Before removing the opening, view the rear of the mat to ensure all cuts 

are complete.  If not, carefully use a X-Acto knife to complete the cut. 
P F 

 f. After the opening is removed, erase all guidelines. P F 
 
 
Evaluation Guidance:  Score the soldier GO if all steps are passed (P). Score the soldier NO-
GO if any step is failed (F). If the soldier fails any step, show what was done wrong and how to 
do it correctly.  Have the soldier practice until he can correctly perform the task. 
 
References 

Required Related 
 Appendix B (25M) 
 Appendix C (25M) 
 Appendix D (25M) 
 Appendix J (25M) 
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DESIGN AN ELECTRONIC PAGE LAYOUT 
113-579-8005 

 
Conditions:  In a tactical or garrison environment, given a completed DA Form 3903-R and a 
computer system with desktop publishing software, such as PageMaker. 
 
Standards:  The standards are met when the final product satisfies the requester’s needs. 
 
Performance Steps 

 1. General.  A disorganized page easily disrupts readers, such as bold headlines that clash, 
distracting borders, odd-shaped and poorly positioned photos, and a lack of consistency.  
The intent of a well-designed page is to make finding and understanding the message as 
easy as possible for the reader.  While there is no one layout for all situations, there are a 
few basic concepts and several guidelines that can be applied to all layouts.  Most, if not 
all, design problems can be solved by applying the basic guidelines and a creative 
imagination. 

 2. Basic concepts. 
 a. Appropriateness relates to proportion, audience, and overall design.  The success of a 

layout is rooted in choosing the appropriate elements to include in the design.  The 
appropriateness of proportion must be considered.  The size of a graphic must relate 
to the page and the elements that surround it.  The amount of emphasis wanted is also 
a factor in choosing correct proportions. 

 b. Consistency is necessary not only within the page, but page to page as well as issue 
to issue.  The basic elements, margin, alley, typeface, and type size should remain the 
same throughout the layout, unless there is a need to emphasize an element.  
Inconsistency will be noticed and will probably annoy the reader, causing them to 
focus on the layout not the message. 

 c. Balance/unity.  Balancing a layout does not mean each element is equal in size and 
emphasis, just the opposite.  A layout with all elements being equal is static and boring 
and is without a focal point.  A dominant element unifies the layout by providing that 
focal point.  The placement of graphics and white space is important.  They are used 
to lead the reader's eyes and help to keep their interest. 

 3. Guidelines. 
 a. Type readability. 
 (1) Serif type is more readable than sans serif when used in large blocks, such as the 

text of a story. 
 (2) The larger the x-height, the larger the type appears to be, making the text easier 

to read. 
 (3) The leading, or ledding, is the white space between the lines of type.  The general 

rule is the larger the x-height and type size, the more leading is needed for ease 
of reading.  One or two points more of leading than text is a good ratio, such as 
10-point type with 11-point leading or 10-point type and 12-point leading. 

 (4) Font style affects readability.  Vertical (Roman) type is considered to be more 
readable than italic or boldface type for large bodies of text.  Italics or boldface 
should only be used to emphasize a word as short phrases; and sparingly at that. 

 b. Optimum line length is based on the size of the font.  Line length or column width is 
equal to one and a half to two times the point size. 

 c. Body type. 
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 (1) Use serif type. 
 (2) Use 9- to 11-point type size. 
 (3) Use a font with large x-height. 
 (4) Keep paragraphs short. 
 (5) Use either justified or ragged, do not mix. 
 (6) Stay within the optimum line length. 
 (7) Keep alleys 1 to 1 1/2-pica wide. 
 (8) Avoid italics and boldface. 
 
 
Performance Measures Results 

 1. Used a serif type face. P F 

 2. Body of text is 9- to 11-point type. P F 

 3. There is one dominant element per page. P F 

 4. Alleys are 1 to 1 1/2-pica wide. P F 

 5. Margins are consistent.  Columns are optimum lengths for chosen type. P F 

 6. Justification is consistent. P F 

 7. Leading is one to two points more than type size. P F 
 
 
Evaluation Guidance:  Score the soldier GO if all steps are passed (P).  Score the soldier NO-
GO if any step is failed (F).  If the soldier fails any step, show what was done wrong and how to 
do it correctly.  Have the soldier practice until he can correctly perform the task. 
 
References 

Required Related 
 Appendix A (25M) 
 Appendix E (25M) 
 Appendix J (25M) 
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CREATE AN ELECTRONIC ILLUSTRATION 
113-579-8006 

 
Conditions:  In a tactical or garrison environment, given a completed DA Form 3903-R and a 
computer system with graphic software, such as PowerPoint or Premiere. 
 
Standards:  The standards are met when the final product satisfies the requester’s needs. 
 
Performance Measures Results 

 1. Check DA Form 3903-R. P F 
 a. Purpose. P F 
 b. Project suspense. P F 
 c. Presentation time restraints. P F 
 d. Desire medium, film, slides, paper, or screen. P F 

 2. Create thumbnail sketches and have requester approve if necessary. P F 

 3. Choose appropriate software package. P F 

 4. Create computer rough from thumbnail. P F 

 5. Have requester approve rough if necessary. P F 

 6. Make any necessary changes. P F 

 7. Complete the illustration. P F 

 8. Do quality control checks. P F 
 a. Check data accuracy. P F 
 b. Check spelling. P F 

 9. Output final to requested medium. P F 

 10. Make corrections as necessary. P F 

 11. Complete DA Form 3903-R. P F 
 
 
Evaluation Guidance:  Score the soldier GO if all steps are passed (P).  Score the soldier NO-
GO if any step is failed (F).  If the soldier fails any step, show what was done wrong and how to 
do it correctly.  Have the soldier practice until he can correctly perform the task. 
 
References 

Required Related 
 Appendix A (25M) 
 Appendix E (25M) 
 Appendix J (25M) 
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CREATE AN ELECTRONIC MULTIMEDIA VISUAL 
113-579-8007 

 
Conditions:  In a tactical or garrison environment, given a completed DA Form 3903-R; 
computer system with necessary hardware, such as scanner or digital camera; graphic 
software, such as PhotoShop, Premiere, Illustrator, or CorelDraw; and any artwork, 
photographs, video or audio to be included in the visual. 
 
Standards:  The standards are met when the final product satisfies DA Form 3903-R 
requirements and is approved by the requester. 
 
Performance Measures Results 

 1. Check DA Form 3903-R. P F 
 a. Purpose. P F 
 b. Project suspense. P F 
 c. Presentation time restraints. P F 
 d. Request final medium. P F 

 2. Create thumbnail sketches and have requester approve if necessary. P F 

 3. Choose appropriate software package. P F 

 4. Create computer rough from thumbnail. P F 

 5. Have requester approve rough if necessary. P F 

 6. Ensure all imported files are compatible with intended system. P F 

 7. Make any necessary changes. P F 

 8. Complete multimedia visual. P F 

 9. Do quality control checks. P F 
 a. Check data accuracy. P F 
 b. Check spelling. P F 
 c. Check visuals on intended computer system for possible discrepancies. P F 

 10. Make corrections as necessary. P F 

 11. Complete DA Form 3903-R. P F 
 
 
Evaluation Guidance:  Score the soldier GO if all steps are passed (P).  Score the soldier NO-
GO if any step is failed (F).  If the soldier fails any step, show what was done wrong and how to 
do it correctly.  Have the soldier practice until he can correctly perform the task. 
 
References 

Required Related 
 Appendix A (25M) 
 Appendix E (25M) 
 Appendix J (25M) 
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Skill Level 2 
Subject Area 3:  Facility Administrator 

 
TRANSMIT A DIGITAL IMAGE VIA SATELLITE IN SUPPORT OF A COMBAT MISSION 

113-578-4005 
 
Conditions:  In a tactical or garrison environment, given a receiving station with operator; 
computer with modems; graphic imaging software, such as Adobe PhotoShop; communication 
software, such as Timbuktu or White Night that is compatible with sender's communication 
software; Magnaphone MX 2020P portable satellite or equivalent; compass; azimuth and 
elevation angle charts; hardware and software manuals; telex and telephone country codes; a 
telephone; all cables and connectors required by hardware manufacturer; and a compatible 
power source. 
 
Standards:  The standards are met when an uncorrupted copy of the image file is received. 
 
Performance Measures Results 

 1. Assemble magnaphone. P F 
 a. Assemble antenna following manufacturer's instructions. P F 
 b. Choose correct azimuth and elevation angle. P F 
 c. Power up magnaphone.  Terminal responds with a menu when system is 

warmed up. 
P F 

 d. Choose proper land earth station for satellite being used. P F 
 e. Ensure strong signal with signal strength meter. P F 
 f. Call international operator to test signal strength. P F 

 2. Connect computer to the magnaphone using computer's modem and cables. P F 

 3. Open Timbuktu/remote communication software. P F 

 4. Set proper baud rate and script settings. P F 
 a. Go to communication settings. P F 
 b. Set proper baud rate to match customer’s settings (9600 bps 

recommended for satellite transmission). 
P F 

 c. Click on CONNECT VIA button. P F 
 d. Set proper script for satellite transmission. P F 

 5. Dial customer by inputting phone number and clicking on the DIAL button. P F 

 6. When connection is made, click on the EXCHANGE FILES button. P F 

 7. Choose file to be sent and click on COPY button. P F 

 8. When transfer of files is complete, click on DONE button. P F 

 9. Click on HANG UP button in the CONNECTED TO menu. P F 
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Evaluation Guidance:  Score the soldier GO if all steps are passed (P).  Score the soldier NO-
GO if any step is failed (F).  If the soldier fails any step, show what was done wrong and how to 
do it correctly.  Have the soldier practice until he can correctly perform the task. 
 
References 

Required Related 
 Appendix A (25M) 
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TRANSMIT A DIGITAL IMAGE VIA LANDLINE IN SUPPORT OF A COMBAT MISSION 
113-578-4006 

 
Conditions:  In a tactical or garrison environment, given a receiving station with operator; 
computer with modem; graphic imaging software, such as Adobe PhotoShop; communication 
software, such as Timbuktu or White Night that is compatible with sender's communication 
software; hardware and software manuals; telex and telephone country codes; a telephone, 
class A access to local telephone company; all cables and connectors required by hardware 
manufacturer; and a compatible power source. 
 
Standards:  The standards are met when an uncorrupted copy of the image file is received. 
 
Performance Measures Results 

 1. Connect computer to local telephone line using computer's modem and cables. P F 

 2. Open Timbuktu/remote communication software. P F 

 3. Set proper baud rate and script settings. P F 

 4. Dial customer by inputting phone number and clicking on the DIAL button. P F 

 5. When connection is made, click on the EXCHANGE FILES button. P F 

 6. Choose file to be sent and click on COPY button. P F 

 7. When transfer of files is complete, click on DONE button. P F 

 8. Click on HANG UP button in the CONNECTED TO menu. P F 
 
 
Evaluation Guidance:  Score the soldier GO if all steps are passed (P).  Score the soldier NO-
GO if any step is failed (F).  If the soldier fails any step, show what was done wrong and how to 
do it correctly.  Have the soldier practice until he can correctly perform the task. 
 
References 

Required Related 
 Appendix A (25M) 
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PERFORM UPDATE OF A DIGITAL ARCHIVE 
113-578-4007 

 
Conditions:  Given an established digital archive; images and/or digital files to be added to 
archive; computer system with removable data storage capability, such as a Syquest drive, 
Bernoulli drive, or a CD-ROM writer; and graphic/compression software, such as PhotoShop. 
 
Standards:  The standards are met when files are added to the archive, cataloged, and are 
retrievable from the archive. 
 
 
Performance Measures Results 

 1. If scanning in an image. P F 
 a. Determine area to be scanned. P F 
 b. Decide scanning resolution. P F 
 c. Acquire image. P F 
 d. Save file in the same format as other archived files. P F 

 2. All files. P F 
 a. Check file size of the file being added to archive. P F 
 b. Check diskette to verify there is enough space for new file, leaving at least 

10 percent of diskette free. 
P F 

 c. Save file to diskette in established format. P F 

 3. Check copied file for corruption. P F 

 4. Catalog new file. P F 
 
 
Evaluation Guidance:  Score the soldier GO if all steps are passed (P).  Score the soldier NO-
GO if any step is failed (F).  If the soldier fails any step, show what was done wrong and how to 
do it correctly.  Have the soldier practice until he can correctly perform the task. 
 
References 

Required Related 
 Appendix A (25M) 
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PREPARE COLOR SEPARATIONS FOR REPRODUCTION 
113-578-4008 

 
Conditions: Given a digital image; computer with color printer (if final is printed out); and 
graphic software, such as Adobe PhotoShop or equivalent, with manuals. 
 
Standards: The standards are met when the image printed from the color separations creates a 
product that satisfies the requester's needs and requirements. 
 
Performance Steps 

 1. A color separation is an image that was converted from RGB color to process or printing 
colors CMYK.  Although it is possible to manually convert an image into the four different 
color separations, it is highly recommended that a graphic package, such as Adobe 
PhotoShop, be used to create the separations.  The process is much quicker and much 
more accurate and depending on the printing shop doing the printing, it may be required.  
The following information is based on Adobe PhotoShop 3.0.  If using another graphic 
software package, follow the instructions outlined in the user's manual. 

 2. In order for the printout to match the display on the screen, the monitor needs to be 
calibrated.  To prevent the monitor from introducing a color cast to images, the monitor 
must be adjusted to make the grays as neutral as possible.  Follow the instructions in the 
user's manual for calibrating the monitor. 

 3. Separating an image. 
 a. Open the image. 
 b. Choose CMYK Color from the Mode menu.  This converts the image from RGB to 

CMYK. 
 c. Save the image with a different file name to indicate that it is the CMYK version of the 

image. 
 d. Compare the two images.  Reopen the RGB version of the image and place it next to 

the CMYK image.  There shouldn't be much difference between the two images.  If the 
image has colors outside the CMYK gamut, then the RGB colors were converted to 
their nearest CMYK equivalents. 

 4. Identifying out-of-gamut colors. 
 a. Ensure the Info palette is in view. 
 b. Position the cursor in the bright blue at the top of the right window.  In the Info palette, 

the CMYK numbers display exclamation points that indicate the out-of-gamut color. 
 c. Choose Gamut Warning from the Mode menu.  Adobe PhotoShop builds a color 

conversion table and identifies the out-of-gamut colors by displaying a neutral gray 
color.  The new gradient turns gray.  This warning color can be changed to make it 
stand out more from the image. 

 (1) Choose Preferences from the File menu, then choose Gamut Warning from the 
submenu. 

 (2) Click the medium-gray color swatch, then choose a bright green from the Color 
Picker and click OK. 

 (3) Leave the opacity at 100 percent, then click OK.  All of the out-of-gamut areas 
turn bright green. 
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 5. Correcting out-of-gamut colors.  Once out-of-gamut colors are identified, they can be 
corrected using different techniques.  Adobe PhotoShop can make the conversions 
automatically by converting to CMYK mode.  If the conversion isn't close enough, try one of 
the following. 

 a. For a small area, use the sponge tool. 
 (1) Double-click the dodge tool in the toolbox, then choose Sponge from the Tool 

menu in the Toning Tools Options palette. 
 (2) Make sure Desaturate is selected in the palette mode menu and change the 

opacity to 80 percent. 
 (3) Click the Brushes palette tab, then choose a large, soft-edged brush. 
 (4) Drag the sponge through the bright green area.  Watch both windows.  As the 

colors become less saturated, they come into the CMYK gamut and the bright 
green warning color disappears.  In the RGB window, the out-of-gamut color 
changes to a less saturated color.  Be careful not to desaturate too much or the 
color may become muddy. 

 b. For a distinct area, use the Color Range command. 
 (1) Choose Revert from the File menu and click Revert.  The file reverts back to the 

last-saved version. 
 (2) Choose Color Range from the Select menu.  The Color Range dialog box 

appears. 
 (3) Choose Out Of Gamut from the Select pop-up menu in the Color Range dialog 

box.  The out-of-gamut areas in the preview box turn white. 
 (4) Click OK to close the Color Range dialog box.  All the out-of-gamut pixels are 

selected. 
 (5) Choose Adjust from the Image menu and Hue/Saturate from the submenu. 
 (6) Drag the dialog box out of the way of the image. 
 (7) Drag the Lightness slider to the left to -33. 
 (8) Drag the Saturation slider to the left until the bright green gamut warning goes 

away.  Click OK. 
 (9) Choose None from the Select menu.  This process brings the image into the 

range of printable colors. 
 (10) Save the changes. 

 6. Customizing separation options.  The separation of an image is controlled by the settings in 
the Monitor Setup.  Printing Inks Setup, Separation Setup, and Separation Tables dialog 
boxes.  These options DO NOT affect the RGB images.  These setting affect image data 
only when the file is converted from RGB to CMYK.  Changes made to any of these 
settings after the image is converted to CMYK will not show.  The image must be 
reconverted to CMYK for the changes to take effect. 

 a. Adjusting for printing inks and paper. 
 (1) Choose Preferences from the File menu and Printing Inks Setup from the 

submenu. 
 (2) Ensure SWOP (Coated) is selected in the Inks Colors pop-up menu in the Printing 

Inks Setup dialog box.  SWOP (stand web offset proofing) ink is the default 
setting.  This is the same setting used when separating an image.  By choosing 
the same ink, the difference caused by changing the dot gain is clearly visible.  
Check with the print shop to obtain the ink type and the dot-gain information. 
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 (3) Enter the dot gain and click OK.  Dot gain is a printing characteristic that causes 

dots to be printed larger than they should be, producing darker tones or color than 
expected.  Different printers and papers have different dot gains. 

 b. Creating trap.  Trap is the overlap needed to ensure that a sight misalignment or 
movement of the plates during printing does not affect the final appearance of the 
printed image.  Overprinting colors slightly to prevent tiny gaps from appearing in the 
printed image is known as adding traps.  Adobe PhotoShop traps by spreading.  A 
spread trap overlaps a lighter color onto a darker color. 

 (1) Zoom in on an area in which the colors blend too much.  This happens with thin 
light areas on darker backgrounds, as yellow letters on a dark blue background. 

 (2) Choose Trap from the Image menu, enter a value, and click OK. 
 (3) If the affect is too great or not enough, choose UNDO to return to the original 

image.  Choose another value and check the effect it has.  The effect can 
sometimes be too subtle to see on a composite view of the image, but it shows up 
very clearly on the yellow channel. 

 (4) Once a value is chosen, save the file. 

 7. Printing a separated image. 
 a. Open the image to be printed. 
 b. Choose Print from the File menu. 
 c. Ensure that the Print Color/Grayscale option is selected. 
 d. Select the Print Separations option to print the file as four separations, then click Print.  

The image prints on four separate pieces of paper or film. 
 e. Close the file without saving changes. 
 
 
Performance Measures Results 

 1. Convert image from RGB to CMYK. P F 

 2. Save image with a different file name, indicating it is the CMYK version. P F 

 3. Identify out-of-gamut colors. P F 

 4. Correct any out-of-gamut colors. P F 

 5. Set ink type and dot gain settings. P F 

 6. Create traps if necessary. P F 

 7. Save file to diskette in established format. P F 

 8. Print image. P F 
 a. Open file. P F 
 b. Choose Print from File menu. P F 
 c. Select the Print Color/Grayscale option. P F 
 d. Select the Print Separation option. P F 
 e. Click Print. P F 
 f. Close file without saving changes. P F 
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Evaluation Guidance:  Score the soldier GO if all steps are passed (P).  Score the soldier NO-
GO if any step is failed (F).  If the soldier fails any step, show what was done wrong and how to 
do it correctly.  Have the soldier practice until he can correctly perform the task. 
 
References 

Required Related 
 Appendix A (25M) 
 Appendix J (25M) 
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MAINTAIN A TECHNICAL REFERENCE LIBRARY 
113-578-6017 

 
Conditions:  Given publications request; TOE or TDA listing; section SOP; DA Pams 25-30, 25-
33, and 25-40; DA Forms 17 and 17-1; an established technical library; a publications checklist 
and any recently received publications or updates; and a place to store the reference material 
that allows for control of the material, such as a locking cabinet or storage room. 
 
Standards:  The standards are met when control procedures for checking out reference 
materials are in place, reference materials are organized by category, and reference 
materials/updates not on hand were ordered, either through the military publications system or 
from the equipment/software manufacturer. 
 
Performance Measures Results 

 1. Inventory and list the technical publications on hand or on order. P F 

 2. Determine which publications required by the section are not on hand or on 
order. 

P F 

 3. Prepare DA Form 17 and DA Form 17-1 if needed, listing all required 
publications identified in performance measure 2. 

P F 

 4. Post newly received publication updates in the appropriate publications. P F 

 5. Place new publications in the library, using established filing system. P F 
 
 
Evaluation Guidance:  Score the soldier GO if all steps are passed (P).  Score the soldier NO-
GO if any step is failed (F).  If the soldier fails any step, show what was done wrong and how to 
do it correctly.  Have the soldier practice until he can correctly perform the task. 
 
References 

Required Related 
DA Pam 25-30 AR 25-400-2 
DA Pam 25-33 AR 380-19 
DA Pam 25-40  
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ASSIGN GRAPHICS PROJECTS 
113-579-6003 

 
Conditions:  Given multiple DA Form 3903-R with varying complexities and priorities regarding 
the work, such as suspense dates and security classifications. 
 
Standards:  The standards are met when projects are scheduled to ensure that project 
suspense dates are met by the most cost-effective use of personnel, materials, time, and 
equipment.  Classified documents are handled IAW to AR 380-5. 
 
Performance Measures Results 

 1. Review DA Form 3903-R. P F 
 a. Job description. P F 
 b. Purpose and use of job. P F 
 c. Time constraints (deadline). P F 
 d. Size requirement. P F 
 e. Security classification. P F 

 2. Determine if more information is needed. P F 

 3. Check availability of materials and equipment. P F 

 4. Check security requirements (if needed). P F 

 5. Determine subordinate's experience level. P F 

 6. Assign work order. P F 

 7. Record new projects on job board. P F 

 8. Periodically check project, assuring the requirements are understood. P F 

 9. Perform a final review of the project for accuracy and completeness. P F 

 10. Have corrections made as necessary. P F 
 
 
Evaluation Guidance:  Score the soldier GO if all steps are passed (P).  Score the soldier NO-
GO if any step is failed (F).  If the soldier fails any steps, show what was done wrong and how to 
do it correctly.  Have the soldier practice until he can correctly perform the task. 
 
References 

Required Related 
 Appendix G (25M) 
 AR 190-13 
 AR 25-1 
 AR 25-400-2 
 AR 380-19 
 AR 380-5 
 DA Pam 25-91 
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INVENTORY GRAPHICS SUPPLIES AND EQUIPMENT 
113-579-6005 

 
Conditions:  Given hand receipt(s) for the graphics facility equipment, listing of durable and 
expendable supplies to be inventoried, applicable supply catalog, suspense dates for 
completion, AR 710-2, and AR 735-5. 
 
Standards:  The standards are met when inventories accounting for all equipment and supplies 
are completed IAW AR 710-2 and AR 735-5. 
 
Performance Steps 

 1. Conduct a physical count of supplies and equipment on hand to ensure that all government 
property is accounted for, being properly used, and maintained.  Establish and maintain 
accounts for material in storage, on hand, in transit, or on consignment.  AR 710-2 and AR 
735-5 contain the guidelines for accountability of equipment and supplies. 

 2. There are various inspections and inventories that can be made to verify equipment and 
materials. 

 a. Receipt and issue of property inventory is conducted when receiving property from a 
supply support activity (SSA). 

 b. Annual inventories are conducted once a year or every 12 months. 
 c. Joint inventories are conducted when the hand-receipt holder is replaced.  All property 

listed on hand receipts is inventoried by the incoming and outgoing primary hand- 
receipt holder.  Thirty days is allotted to conduct the joint inventory.  When the 
inventory cannot be completed in the allotted time, request extension in writing to the 
commander/supervisor. 

 d. Cyclic inventories can be conducted monthly, quarterly, or semiannually.  Inventory 10 
percent of the property book items monthly, 25 percent quarterly, or 50 percent 
semiannually. 

 3. When a receipt, turn-in, and/or issue of property is made, perform the following: 
 a. Check the document number and unit name on the receipt document. 
 b. Check the item to ensure it matches the description on the receipt document. 
 c. Count all items. 
 d. Check end items for completeness. 
 e. Ensure serial numbers on equipment match the serial numbers on documents. 
 f. Make a visual check of the condition of the items. 
 g. If serviceability of an item is questionable, notify the property book officer (PBO). 

 4. Various inventories are made by comparing the status of items on the property books and 
hand receipts.  Use a replenish expendable items as necessary.  Accountable items, 
however, must be accountable by stock number and quantity. 

 5. Equipment and materials can vary from expendable items, such as pencils, erasers, paper, 
and viewgraph material, to nonexpendable items like chairs, tables, computers, and 
projectors.  Without these inventories, there would be no way to account for the contents of 
the facility. 

 a. Expendable and durable items are usually consumed during normal usage and require 
no formal accountability after issue. 

 b. Nonexpendable items require property book accountability after issue. 
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Performance Steps 

 6. Once the inventory is made, correctly annotate the appropriate forms and take any 
corrective actions as needed.  To efficiently operate a graphics facility, it is important to 
know what material and equipment is on hand, what may be needed, and how it may be 
ordered. 

 7. When an item on order is no longer needed, a cancellation request will be sent immediately 
to the SSA. 

 8. The Self-Service Supply Center (SSSC) is designed to improve supply and financial 
operations by reducing the workload.  The SSSC uses summary dollar accounting for 
selected supplies issued to customers on a self-service basis.  Only one SSSC is 
authorized at an installation. Local purchases, as a source of supply, may be employed at 
the direct support agency (SA)/general support agency (GSA) and the SSA level to satisfy 
requests submitted by supported units/maintenance activities. 

 9. On-hand property book items within allowances are turned in only if found to be 
unserviceable and determined to be nonrepairable by the supporting maintenance facility 
personnel. 

 a. Turn in excess serviceable repair parts immediately. 
 b. Turn in unserviceable repairables with a turn-in document and a request document. 

 10. Once the inventory is made, correctly annotate the appropriate forms and take any 
corrective actions as needed according to AR 735-5. 

 11. When property becomes lost, damaged, or destroyed, immediately report all discrepancies 
to supervisor or commander.  If an item cannot be accounted for, the person who signed for 
the item may be held accountable for its cost.  The report states in writing, the 
circumstances of the loss or damage, and a listing and description of the property involved.  
Use adjustment methods by processing: 

 a. Department of the Army Report of Survey, DA Form 4697. 
 b. Statement of Charges/Cash Collection Voucher, DD Form 362. 
 c. Inventory adjustment report, DA Form 444. 

 12. The senior 25M is usually the responsible NCO in the graphics facility and should be fully 
aware of all regulations pertaining to the supply and accountability of graphic materials.  
Local SOP may dictate additional requirements. 

 
 
Performance Measures Results 

 1. Compare document numbers to the receipt document. P F 

 2. Confirm item description matches description on the receipt document. P F 

 3. Physically count all items. P F 

 4. Check serial numbers on items with serial numbers of the items.  Make a visual 
check of the condition of the items. 

P F 

 5. If serviceability of an item is questionable, contact PBO. P F 
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Evaluation Guidance:  Score the soldier GO if all steps are passed (P).  Score the soldier NO-
GO if any step is failed (F).  If the soldier fails any step, show what was done wrong and how to 
do it correctly.  Have the soldier practice until he can correctly perform the task. 
 
References 

Required Related 
AR 710-2  
AR 735-5  
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ESTABLISH DRAWING RESEARCH FILE (MORGUE FILE) 
113-579-6006 

 
Conditions:  Given illustrations, photos, graphics, and so forth, file folders and labels, 
containers in which to file folders, and an area for storing the containers. 
 
Standards:  The standards are met when files are labeled with general headings; a consistent, 
understandable classification system is in place; and all artwork is laid flat (not folded or 
creased) and labeled. 
 
Performance Measures Results 

 1. Collect applicable illustrations and/or photographs. P F 

 2. Establish classification system. P F 

 3. Label pictures IAW classification system. P F 

 4. File material IAW classification system. P F 
 
 
Evaluation Guidance:  Score the soldier GO if all steps are passed (P).  Score the soldier NO-
GO if any step is failed (F).  If the soldier fails any step, show what was done wrong and how to 
do it correctly.  Have the soldier practice until he can correctly perform the task. 
 
References 

Required Related 
 Appendix A (25M) 
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EVALUATE A GRAPHICS PROJECT 
113-579-7002 

 
Conditions:  Given a graphic project under development, the illustrator(s) involved with the 
project, graphics section SOP with established standards, and DA Form 3903-R with project 
requirements. 
 
Standards:  The standards are met when the finished product meets the requirements of the 
DA Form 3903-R, basic principles of color theory, layout, design, and composition. 
 
Performance Measures Results 

 1. Review DA Form 3903-R for project requirements. P F 

 2. Evaluate project against the graphics checklist, using all sections that apply. P F 
 a. Design. P F 
 (1) Unity. P F 
 (2) Balance. P F 
 (3) Rhythm. P F 
 (4) Dominance. P F 
 b. Text. P F 
 (1) Proofing. P F 
 (2) Hierarchy. P F 
 (3) Legibility. P F 
 (4) Readability. P F 
 c. Graphics. P F 
 (1) Color. P F 
 (2) Quality. P F 
 (3) Size. P F 
 (4) Appropriateness. P F 
 (5) Following instructions. P F 
 (6) Overall effect. P F 
 (7) Neatness. P F 

 3. In the event the project does not meet the standard: P F 
 a. Indicate any area that fails to meet established standards. P F 
 b. Explain how to bring the project up to established standards. P F 
 c. Review project again. P F 
 d. Repeat until project meets established standards. P F 
 
 
Evaluation Guidance:  Score the soldier GO if all steps are passed (P).  Score the soldier NO-
GO if any step is failed (F).  If the soldier fails any step, show what was done wrong and how to 
do it correctly.  Have the soldier practice until he can correctly perform the task. 
 
References 

Required Related 
 Appendix H (25M) 
 Appendix J (25M) 
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COMBINE VISUALS FOR A MULTIMEDIA PRESENTATION 
113-579-8008 

 
Conditions:  Given completed DA Form 3903-R; computer system with necessary hardware, 
such as a scanner or digital camera; graphic software, such as PowerPoint or Premiere; and 
any artwork, photographs, video, or audio to be included in the visual. 
 
Standards:  The standards are met when the final product satisfies DA Form 3903-R 
requirements and is approved by the requester. 
 
Performance Steps 
NOTE:  Although PowerPoint 4.0 is used, the principals should apply to any presentation 
package. 

 1. When PowerPoint opens, it presents you with a "Creating a New Presentation..." dialog 
box. 

 a. Select Template to use one of the built-in templates.  Select Blank Presentation if there 
is an established format that must be followed.  Click OK. 

 b. Choose the slide layout from the AutoLayout dialog box. 
 (1) If there isn't a layout that fits your needs, choose a blank slide.  This will not lock 

in the slide layout for the entire presentation.  You are presented this same dialog 
box every time you add a new slide. 

 c. Click OK. 

 2. Master slides. 
 a. Color schemes, graphics, and text set on the Master Slide are present throughout the 

entire presentation. 
 b. The Master Slide can be accessed by holding down the shift key while clicking on the 

SLIDE button in the lower left of the screen.  Do not hold down the shift key when 
clicking on the button to return to Slide. 

 c. The options under the Format menu changes, depending on which slide view is 
chosen. 

 3. Text slides. 
 a. To create an Outline, click on the OUTLINE VIEW button in the lower left corner of the 

screen (next to the SLIDE button). 
 b. Outlines can be imported into a PowerPoint presentation.  PowerPoint recognizes 

Microsoft Word files as well as other word processors. 
 c. Using Builds allows you to control just how the text is presented to the audience. 
 (1) Click the SLIDE SORTER button, next to the OUTLINE button in the lower left. 
 (2) Click the slide, a black outline appears, confirming which slide was selected. 
 (3) Choose the effects desired from the Build menu.  Choose to simply build the body 

of text a line at a time or to have the previous line dim with each subsequent new 
line. 

 (4) Click OK. 

 4. Graphic slides. 
 a. AutoShapes.  PowerPoint has a collection of shapes that can easily be added to a 

slide. 
 (1) Click on the AUTOSHAPES button on the left side toolbar.  A submenu appears 

with 24 different shapes. 
 (2) Click on a shape.  The pointer becomes a cross. 
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 (3) Click where you want the shape to start.  Hold down the mouse and draw out the 

shape.  Release the mouse where you want the shape to end. 
 b. FreeForm drawing. 
 (1) Click on the FREEFORM drawing button, left side toolbar.  The pointer becomes a 

cross when over the slide. 
 (2) Place the cursor where you want to begin the drawing. 
 (3) Hold down the mouse.  The cross becomes a pencil. 
 (4) As long as the mouse is held down, you can use the pencil.  When the mouse is 

release, the cross appears.  This allows a straight line to be created from the point 
the mouse was released. 

 (5) To create a closed form, bring the pencil near the start position and release the 
mouse and then click. 

 (6) To create an open form, double click where you want the drawing to end. 

 5. Editing objects. 
 a. To change an object's color. 
 (1) Select the item. 
 (2) Select Colors and Lines menu from the Format menu.  This menu allows you to 

choose the fill color, the line color, and/or the line style. 
 (3) Make selections and click OK. 
 b. Change the size of an object. 
 (1) Click on the object to be edited. 
 (2) Click on and drag any of the control handles (small squares that surround the 

object) to resize the object. 
 (3) To keep the original proportions, hold down the shift key while dragging a corner. 
 c. An object’s position can be changed by simply clicking on the object and dragging it to 

a new position. 
 d. Orientation. 
 (1) An object can be flipped or rotated in 90-degree increments using the Rotate/Flip 

option under the Draw menu. 
 (2) The Free Rotate Tool, located under the Rotate/Flip option, allows the object to be 

freely moved in 360 degrees around its center. 

 6. Inserting Items. 
 a. PowerPoint allows you to import art from either Microsoft Clip Art collection or from 

other art sources.  Images in the following formats can be added:  *.wmf, *.hgl, *.cgm, 
*.eps, *.tif, *.pcx, *.adi, *.dxf, *.gif, *.cdr, *.wpg, *.plt, *.pcd, *.pic, *.pct, *.drw, *.tga, 
*.dib, *.bmp. 

 (1) Clip art. 
 (a) Choose Clip Art from under the Insert menu. 
 (b) Scroll through the art and make a selection.  Click OK. 
 (c) Position and size the clip art in the same manner as any other object. 
 (2) Photos or other types of art work. 
 (a) Choose Picture from under the Insert menu. 
 (b) Navigate to the disk or directory (folder) and select the file to be added.  Click 

OK. 
 (c) Position and size the clip art in the same manner as any other object. 
 (3) Charts/graphs. 
 (a) When adding a new slide, you can opt for the type of slide that you need and 

then double click on the slide to launch the appropriate software package. 
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 (b) If you are inserting a chart or graph into an existing slide, click on the CHART 

or GRAPH button on the formatting toolbar.  The appropriate package 
launches. 

 (c) Graphs.  Choose the type of graph needed.  Fill in the data and verify the 
data.  Edit as necessary.  Under File, choose Exit and Return to Presentation.

 (d) Choose the chart style from the Style menu.  Create the chart and verify the 
data.  Edit as necessary.  Under File, choose Exit and Return to Presentation.

 (4) Video clips. 
 (a) From the Insert menu, choose either Movie or Object. 
 (b) Choose either Create New or Create from File.  Navigate to the file location. 
 (c) Select file and click OK. 

 7. Arranging slides, transitions, and builds. 
 a. The easiest way to arrange your slides is in the Slide Sorter view. 
 (1) Switch to the Slide Sorter view (button is in the bottom left corner). 
 (2) Click on the slide to be moved.  It is highlighted with a black frame. 
 (3) Drag the slide to its new position.  Release the mouse. 
 b. Transitions are the effects used to go from one slide to the next. 
 (1) It is best to pick one and use it throughout the presentation to avoid distracting the 

audience.  Depending upon the presentation system, some effects can be very 
time-consuming.  Choose one that will not keep the presenter or the audience 
waiting. 

 (2) If the presentation is to be set to a recorded sound track, the timing option may be 
used to synchronize the slide's screen time with the audio track. 

 (3) Switch to the Slide Sorter view and select a slide or a group of slides.  You can 
also set the transition from the Slide view.  Choose Transitions from the Tools 
menu.  This only affects the slide in view. 

 (4) Choose the transition effect desired from the Transition Effect menu.  No 
Transition Effect is the default. 

 (5) If you choose Transition from the Tools menu, you will find more options, to 
include the Advance options.  Make selections and click OK. 

 (6) A small slide with an arrow appears under the slide or slides to indicate that a 
transition was selected. 

 (7) Switch to Slide Show to view the transition effects and to check the timing if the 
Auto Advance option is used. 

 (8) Make any necessary adjustments. 
 c. Builds are essentially transitions within a slide.  They are used to display one line of 

text at a time and/or to dim a previous line of text. 
 (1) Build options can be set the same way transitions are set, either one slide at a 

time or a group at a time. 
 (2) The same cautions apply to builds as to transitions; keep it consistent and keep it 

moving. 
 (3) Switch to the Slide Sorter view and select a slide or a group of slides.  You can 

also set the build from the Slide view.  Choose Build from the Tools menu.  This 
only affects the slide in view. 

 (4) Choose the effect desired from the Build menu. 
 (5) The Build icon (three small butted lines) appears under the slide or slides to 

indicate that a build effect was selected. 
 (6) Switch to Slide Show to view the build effects. 
 (7) Make any necessary adjustments. 
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 8. Output. 
 a. Computer screen is the easiest method of giving a PowerPoint presentation.  If more 

than one or two people will be viewing the presentation, a large monitor or a projection 
system connected to the computer is necessary.  To display to screen, open the saved 
presentation and click on the Slide Show button (bottom left).  The presentation 
begins.  Depending on the transitions selected, it either advances automatically or the 
presenter clicks the mouse. 

 b. Printed presentations are created by choosing Print from the File menu.  A print dialog 
box appears.  There are several options, such as builds.  If there are slides with builds, 
the presentation may be printed with or without the builds.  Make selections and click 
OK. 

 c. Film.  Depending on your system's capabilities, a presentation may be saved to 35mm 
slide film or to video tape.  Follow the manufacturer's instructions. 

 
 
Performance Measures Results 

 1. Check DA Form 3903-R. P F 
 a. Purpose. P F 
 b. Project suspense. P F 
 c. Presentation location. P F 
 d. Request final medium. P F 

 2. Create thumbnail sketches and have requester approve if necessary. P F 

 3. Create computer rough from thumbnail. P F 

 4. Have requester approve rough if necessary. P F 

 5. Ensure all imported files are compatible with presentation system. P F 

 6. Make any necessary changes. P F 

 7. Complete multimedia visuals. P F 

 8. Perform quality control check. P F 
 a. Check for data accuracy. P F 
 b. Check spelling. P F 
 c. Check visuals on intended computer system for possible discrepancies. P F 

 9. Make necessary corrections. P F 

 10. Complete DA Form 3903-R. P F 
 
 
Evaluation Guidance:  Score the soldier GO if all steps are passed (P).  Score the soldier NO-
GO if any step is failed (F).  If the soldier fails any step, show what was done wrong and how to 
do it correctly.  Have the soldier practice until he can correctly perform the task. 
 
References 

Required Related 
 Appendix A (25M) 
 Appendix J (25M) 



STP 11-25M13-SM-TG 

3-64 

 

Skill Level 3 
Subject Area 4: Facility Manager 

 
WRITE A GRAPHICS FACILITY STANDING OPERATING PROCEDURE (SOP) 

113-579-7003 
 
Conditions:  Given unit's TDA/TOE, list of available personnel and equipment, DA Pam 25-91, 
FM 101-5, and higher headquarters' SOP. 
 
Standards:  The standards are met when the unit commander approves the SOP. 
 
Performance Measures Results 

 1. Determine which important activities or procedures recur. P F 
 a. Observe subordinates when they perform selected procedures. P F 
 b. Research and take notes on all current SOPs, publications, and directives 

that pertain to the procedures. 
P F 

 c. Compare notes in previous steps. P F 
 d. Ensure all steps are included in the procedures and meet all requirements 

of existing publications and directives. 
P F 

 e. Select the one procedure that prevails. P F 

 2. Modify procedures as necessary to make it efficient. P F 

 3. Write all the following sections required for an SOP. P F 
 a. Purpose.  Statement of the general coverage and uses, including 

applicability and special contingency. 
P F 

 b. Scope.   A section/paragraph explaining to whom the SOP applies. P F 
 c. Definition.  Explains terms and acronyms. P F 
 d. Responsibilities.  Explains the major functions of the supervisor and any 

subordinates involved in the procedure. 
P F 

 e. Procedures.  A step-by-step explanation of how the process is done.  Also 
included in this section are performance standards and quality assurance 
information.  (Express performance and quality standards in measurable 
terms, such as quantity, quality, cost, timelessness, and effort.) 

P F 

 f. Files (if any).  State what files will be set up, how they will be maintained, 
and where they will be located. 

P F 

 g. References (if needed).  List all of the publications that govern, guide, or 
pertain to the procedure. 

P F 

 h. Annex.  Include examples, records, and formats.  They should be labeled 
alphabetically, in sequence. 

P F 

 i. Appendix.  Use for frequently referenced publications or extracts of 
publications that are used during the procedure.  An appendix is labeled 
alphabetically, in sequence. 

P F 

 4. Compare your draft SOP to all steps and modify the draft.  References make it 
necessary to conform to all current policies. 

P F 

 5. Submit the draft SOP for approval and revise if necessary. P F 



STP 11-25M13-SM-TG 

3-65 

 
Performance Measures Results 

 6. Prepare a final SOP.  Include a signature block of the person who authorized 
the SOP. 

P F 

 7. Determine the number of copies needed and reproduce the SOP. P F 

 8. Distribute copies of the SOP and file a copy. P F 
 
 
Evaluation Guidance:  Score the soldier GO if all steps are passed (P).  Score the soldier NO-
GO if any step is failed (F).  If the soldier fails any step, show what was done wrong and how to 
do it correctly.  Have the soldier practice until he can correctly perform the task. 
 
References 

Required Related 
DA Pam 25-91 Appendix A (25M) 
FM 101-5  
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ESTABLISH A WEBSITE 
113-579-8009 

 
Conditions:  Given a computer with scanner; a text editor, such as Notepad in Windows or 
BBEdit on a Macintosh; web page designing or HTML software, such as FrontPage, PageMill, 
or HomePage; file server with web server software; graphic image software, such as Adobe 
PhotoShop; and a web browser, such as Netscape or Internet Explorer. 
 
Standards:  The standards are met when the web page meets all DA web information service 
guidelines, can be properly viewed with a web browser, and is approved by the requester. 
 
Performance Steps 
NOTE:  It is not possible to address all of the different web authoring software packages 
available today.  This is a very basic approach to producing a web page.  You are 
encouraged to use a commercial package and to experiment.  For the sake of instruction, 
Netscape is used as the example of a web browser. 

 1. Review HQDA web guidance, "Guidance for the Management of Army Websites," which is 
available on the U.S. Army homepage.  Check periodically for changes or updates to the 
policy. 

 2. Provide the following information or hyperlinks to the following information: 
 a. Organization missions and functions. 
 b. Organizational structure, listing, or hyperlinking to parent and subordinate command or 

organization websites. 
 c. Provide electronic mail address, phone number, or mail address for the website's point 

of contact. 
 d. Provide a hyperlink to the U.S. Army homepage (http://www.army.mil). 

 3. Security. 
 a. Ensure that privacy and security issues have been addressed before posting 

organizational charts containing individuals names and other personal information. 
 b. No classified, sensitive, For Official Use Only (FOUO), Freedom of Information Act 

(FOIA)-exempt information, or information that cannot be released under the Privacy 
Act will be made available to the public through WWW. 

 4. Webmaster responsibilities. 
 a. Institute a review process to ensure that information provided on the website is current, 

timely, and cleared for public release. 
 b. The homepage is registered with the U.S. Army homepage webmaster. 
 c. Ensure that websites do not have hyperlinks to commercial sites or personal 

homepages or websites.  Use of commercial logos or trademarks is prohibited. 
 d. Ensure that information published represents the official Army position and is properly 

cleared for public dissemination. 
 e. Provide the highest possible level of assurance that information made available to or 

received from the public does not contain malicious software code such as viruses, 
trojan horses, logic bombs, bacteria, and worms; and if it does, to sufficiently notify the 
user before the download begins. 

 f. Respond to user email and direct queries or requests for information to the responsible 
party within the organization. 

 
 



STP 11-25M13-SM-TG 

3-67 

Performance Measures Results 

 1. Review the Guidance for the Management of Army Websites at 
www.army.mil/DA _web_guidance.htm for changes to the policy. 

P F 

 2. Ensure all information is: P F 
 a. Accurate. P F 
 b. Represents the official Army position. P F 
 c. Properly cleared for public dissemination. P F 

 3. Ensure appropriate security and access controls are in place. P F 

 4. Provide a hyperlink to the U.S. Army homepage. P F 

 5. Register homepage with the U.S. Army homepage webmaster. P F 

 6. Provide email, phone number, or mail address of the point of contact 
responsible for the website content. 

P F 

 7. Ensure that commercial logos or trademarks are not used. P F 
 
 
Evaluation Guidance:  Score the soldier GO if all steps are passed (P).  Score the soldier NO-
GO if any step is failed (F).  If the soldier fails any step, show what was done wrong and how to 
do it correctly.  Have the soldier practice until he can correctly perform the task. 
 
References 

Required Related 
Website Guidance Appendix A (25M) 
 Appendix F (25M) 
 Appendix J (25M) 

 



STP 11-25M13-SM-TG 

3-68 

MAINTAIN A WEBSITE 
113-579-8010 

 
Conditions:  Given a computer; web page designing or HTML software, such as FrontPage, 
PageMill, or HomePage; and a file server with web server software. 
 
Standards: The standards are met when the web page meets all DA web information service 
guidelines and all information is correct, current, and can be properly viewed with a web 
browser. 
 
Performance Measures Results 

 1. Ensure all information is: P F 
 a. Accurate. P F 
 b. Timely. P F 
 c. Represents the official Army position. P F 
 d. Properly cleared for public dissemination. P F 

 2. Ensure appropriate security and access controls are in place. P F 

 3. Provide a hyperlink to the U.S. Army homepage. P F 

 4. Provide email, phone number, or mail address of the point of contact 
responsible for the website content. 

P F 

 5. Ensure that commercial logos or trademarks are not used. P F 

 6. Respond to user emails and direct queries or requests for information to the 
appropriate individual. 

P F 

 
 
Evaluation Guidance:  Score the soldier GO if all steps are passed (P).  Score the soldier NO-
GO if any step is failed (F).  If the soldier fails any step, show what was done wrong and how to 
do it correctly.  Have the soldier practice until he can correctly perform the task. 
 
References 

Required Related 
Website Guidance Appendix E (25M) 
 Appendix F (25M) 
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ESTABLISH A DIGITAL ARCHIVE FILE 
113-579-8011 

 
Conditions:  Given a computer with a mass storage device, such as Bernoulli or Syquest, with 
compatible diskettes, digital images, graphic and/or compression software, and containers to 
store diskettes. 
 
Standards:  The standards are met when images are saved in JPEG format and a filing system 
is created that will store, catalog, and retrieve files with a given computer system. 
 
Performance Measures Results 

 1. Collect applicable graphic image files. P F 

 2. Establish cataloging system. P F 

 3. File images using cataloging system. P F 

 4. Label diskettes IAW cataloging system. P F 

 5. Store diskettes. P F 
 
 
Evaluation Guidance:  Score the soldier GO if all steps are passed (P).  Score the soldier NO-
GO if any step is failed (F).  If the soldier fails any step, show what was done wrong and how to 
do it correctly.  Have the soldier practice until he can correctly perform the task.  
 
References 

Required Related 
 Appendix A (25M) 
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PREPARE STILL PHOTOGRAPHY EDITING AND PROCESSING SYSTEM (SPEPS) FOR 
TACTICAL DEPLOYMENT 

113-626-2003 
 
Conditions:  Given an operations order (OPORD); a SPEPS; a portable satellite; a graphic 
system, to include but not limited to an automated data processor with CD ROM, zip drive, or 
Bernoulli; video monitor; flatbed scanner; 35mm slide scanner; modem; communications 
interface; color printer; writable compact disk; selected software and accessories; and an S-250 
shelter mount or crush-proof shipping containers with security devices; TC 11-6; TM 9-2320-
280-10; TM 9-6115-642-10; TM 9-6115-660-13&P; all reference materials related to each piece 
of equipment, such as manufacturers' manuals; and graphic shop’s SOP. 
 
Standards:  The standards are met when equipment is packed and secured in crush-proof 
shipping containers or an S-250 shelter mount. 
 
Performance Measures Results 

 1. Inventory all equipment and required manuals prior to packing. P F 

 2. Perform an operation and serviceability check on each item. P F 

 3. Check serviceability and continuity of all cables, to include spares. P F 

 4. Inventory and inspect spare boards, accessories, and components. P F 

 5. Inspect the grounding rod and wire. P F 

 6. Inventory and inspect all tools. P F 

 7. Pack and secure equipment in shipping containers with standard military tie-
down and security locking devices or mount in the S-250 shelter to prevent 
damage. 

P F 

 
 
Evaluation Guidance:  Score the soldier GO if all steps are passed (P).  Score the soldier NO-
GO if any step is failed (F).  If the soldier fails any step, show what was done wrong and how to 
do it correctly.  Have the soldier practice until he can correctly perform the task. 
 
References 

Required Related 
Manufacturers’ Manuals Appendix A (25M) 
TC 11-6 Appendix I (25M) 
TM 9-2320-280-10  
TM 9-6115-642-10  
TM 9-6115-660-13&P  
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APPENDIX A 
 

(Excerpt From) 

ELECTRONIC IMAGING COURSE 
 
 
A-1.  INTRODUCTION TO COMPUTERS 
 

a.  History of desktop publishing. 
 
 (1)  No one knows exactly when humans first started communicating using the written word, but we 
do know that the Phoenicians started using some form of a written alphabet at about 2000 BC.  There 
were no printing presses or even paper (the Chinese invented paper at about 100 AD), so the 
Phoenicians wrote on clay tablets or on animal skins. 
 
 (2)  All books were handwritten before the printing press was invented.  They were either orally 
transcribed or copied word for word out of other books.  These books, called illuminated manuscripts, 
were extremely detailed and ornate, and were very rare and costly.  This all changed in the 1440s. 
 
 (3)  Johannes Gutenberg, a goldsmith from Mainz, Germany, invented the first moveable type press.  
Gutenberg's press used individual cast lead pieces with raised letters that could be arranged into words 
and sentences.  This new invention made books much easier and faster to produce and opened up the 
world to literature.  Using movable type was much faster than hand illuminating, but required skilled 
labor.  Typesetters, the people who picked the individual letters out and arranged them to print correctly, 
were only so fast, making this method time-consuming. 
 
 (4)  In the 1800s printing presses became much faster by replacing much of the manual labor with 
horse, waterwheel and steam power.  In the early 1800s the invention of roll paper (called a web) made it 
much easier to print; thus widely distributed newspapers were born. 
 
 (5)  The line-casting machine of the late 1880s was the next major change in publishing.  This 
machine allowed an operator to type the lines into a keyboard, and the machine then set the type by 
pouring hot metal into the mold.  This created an entire metal line of type called a slug.  This process is 
known as hot type. 
 
 (6)  It also became easier to print photographs by using a process called half-toning.  Half toning is a 
process where the grays in a photo are reproduced by variable sized dots of black ink.  The larger the 
black dot, the darker the area will appear on the printed page.  In the 1920s this process was combined 
with color photography dyes and the four-color printing process was born.  In four-color printing, each 
page is printed four times.  Each time it is printed, a different ink color is used.  There are only four inks 
used, and all colors can be reproduced by combining these colors.  The colors are cyan, magenta, 
yellow, and black and are called CMYK colors. 
 
 (7)  Cold type is the next step in printing.  In this process, different letters are stored on transparency 
films and are projected onto a light sensitive emulsion.  By using different projection lenses, type printed 
at different sizes.  This process quickly replaced hot type in the 1950s. 
 (8)  Digital typesetting began to replace this cold type process in the 1970s.  Type can be quickly 
written, set, and printed by using computers and digital technology. 
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b.  Traditional publishing process. 
 
 (1)  Traditionally, creating a document involved several distinct steps.  These steps were usually 
accomplished by different people working separately to complete the project.  Creating a document 
usually involves bringing words, graphics, and photos together into one cohesive, easy to look at layout. 
 
 (2)  First, the words.  A writer writes the story, usually using a computer as a word processor.  A 
hard copy or printed copy of the story is given to the editor, who checks it for accuracy and 
completeness.  The editor returns it to the writer, who makes any necessary changes. 
 
 (3)  At the same time the writer is working on the story, a photographer and a graphic artist are also 
at work.  The photographer is taking pictures, developing film, and making prints to accompany the story.  
A graphic artist is creating any graphics or illustrations that is needed to go with the text and 
photographs. 
 
 (4)  A designer is hard at work deciding how all of these elements will be combined onto the page.  
The designer decides where each element, such as pictures, words, or illustrations will go and decides 
what type of headlines, columns, graphic elements, and other design elements to use. 
 
 (5)  After each respective person has completed his or her part, all the work is sent to the paste-up 
artist, who literally cuts and pastes the elements into one layout to be printed. 
 
 (6)  After the pasted layout is approved, it goes to the copy camera where films are made.  The films 
then go to the printing press where the final pages are printed. 
 

c.  Desktop publishing process. 
 
 (1)  Although the final product is similar, the process for creating a document electronically is 
different, as well as much easier and faster.  The writer still creates the story, but instead of printing a 
copy for the editor, the writer electronically transmits the story to the editor.  The editor can then edit and 
make changes immediately.  When the story is completed, it is again electronically transmitted; this time 
to the designer. 
 
 (2)  The photographer and graphic artist also use computers.  The photographer takes pictures 
using a digital camera, and the images are instantly available for editing and enhancement.  There is no 
need to make prints.  The final pictures are electronically transmitted to the designer.  The graphic artist 
uses his or her computer to create the illustrations.  The artist uses many of the traditional tools, but the 
tools are all electronic rather than manual.  When the illustrations are complete, they too are sent to the 
designer electronically.  Nothing has been printed thus far. 
 
 (3)  You will note that we keep saying that each element of the story is sent to the designer.  In 
electronic publishing, there is no paste-up artist.  The designer does the layout on the computer and 
integrates all the elements without the need for hard copies, cutting, or gluing. 
 

(4)  Once the design is completed, films are made on a special high-resolution printer called an 
imagesetter.  These films are then sent to the printer who prints the final pages. 

d.  Desktop publishing tools. 
 

(1)  To create documents on a computer we must first have a computer!  When buying a computer 
with the intent to use it for desktop publishing, there are several things to consider.  First is speed.  
Different computers work at different speeds.  For electronic publishing we need a computer that is as 
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fast as we can afford.  We will be using files that are very large and a slow computer may take quite a 
long time to accomplish normal tasks.  Second, we should consider memory.  Electronic publishing files 
do get large, and more memory will make even a slow computer seem as if it is running faster.  Get as 
much as you can!  To do any serious electronic publishing you should consider 24 megabytes (MB) of 
memory to be a minimum. 
 

(2)  A computer monitor is a high-resolution television that displays your work.  A monitor may be 
one of the most important pieces of hardware that you use, because you spend all day looking at it.  
When considering a monitor, one of the most important considerations is size.  A larger monitor makes it 
easy to see the entire page or layout at one view.  A smaller monitor forces you to scroll around to see 
the entire document which does not allow you to get the feel of how all the elements of the page work 
together.  Consider a 17-inch monitor to be the minimum for electronic publishing, but most professionals 
use a 21-inch. 
 

(3)  A scanner is a device to let you get photos, art, or text into the computer.  Much like a copier, a 
scanner copies whatever you put into it and presents it on the screen.  The two types of scanners are the 
flatbed and film.   

 
(a)  A flatbed scanner scans flat objects such as pages, photos, and flat artwork.  These are 

extremely useful for placing existing art or pictures into a new layout.   
 
(b)  Drum and transparency are two types of film scanners.  Transparency scanners are usually 

smaller and faster than drum scanners.  Drum scanners are more expensive, but much higher quality.  
Both types are used to take negatives or slides and scan them for use in the computer. 
 

(4)  As we have said, electronic publishing files can get large.  We also regularly move these files 
from one computer to another, usually in different locations.  What we use to accomplish this are large, 
removable, portable storage devices.  These can be external hard disks that can be moved or removable 
cartridge systems.  Removable cartridge systems are good for backing up information for future 
reference, as well as for storing files while moving from computer to computer. 
 

(5)  Printers are used to produce proof prints and tests before outputting films in the imagesetter.  
Any high quality printer can be used, although the best use PostScript, which is a type of printing 
language that most electronic publishing software use.  You would also want a fast printer.  Who wants 
to wait all day to see how a layout looks? 
 

(6)  Software is what makes the computer do all of its neat tricks.  There are many different types 
and brands of software, but only a few such as word processing, page layout, illustration, and image 
editing are really needed. 
 
 (a)  Word processing is software that lets the computer act as an expensive fancy typewriter.  It 
allows you to enter words and then rearrange them.  You can also do spell and grammar checks and 
most have a built-in dictionary and thesaurus.  You can also do advanced functions like finding a certain 
word or group of words and replacing them with something else. 
 (b)  Page layout software is the heart of an electronic publishing system.  You can create document 
layouts and import words, graphics, and pictures from other programs.  You can add headlines, boxes, 
colors, and many other graphic devices.  These applications make it very easy to try new ideas and 
different layouts with just a push of a button. 
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 (c)  Graphics/Illustration software turns the computer into a powerful artist's canvas.  You can use 
many tools to draw shapes and lines and create complex illustrations.  There are many options for filling 
and colors.  Images can be combined, altered, and saved. 
 
 (d)  Image Editing software is used to integrate photographs into the computer.  Using image editing 
software, you can easily get a picture from a digital camera or scanner and do all the traditional 
darkroom effects.  You can lighten, darken, crop, enlarge, dodge, burn, and color correct.  Image editing 
software also allows the user to create composite photos by combining two or more images into one new 
photo illustration.  
 

e.  Computer basics. 
 

(1)  A computer translates keyboard punches and mouse movements into commands and actions by 
using the binary system.  The binary system is a system of codes that allows all computers to speak the 
same language, the language of 1s and 0s.  The binary system is a collection of 1s and 0s arranged in a 
code to represent other information.  Each 1 or 0 is called a bit, and it is the smallest part of information 
that a computer uses.  A 1 represents an on bit signal to the computer, and a 0 is an off bit.  These 1s 
and 0s act as switches that tell the computer to do something. 
 
 (2)  A 1 or a 0 cannot represent all the letters, numbers, and symbols that we use.  Each bit is 
always part of a larger group called a byte.  A byte is a grouping of eight bits, and looks something like 
01101001.  There are 256 different possible combinations of these 1s and 0s (28= 256).  It is in this 
format of eight bits that all the letters, numbers, punctuation, and special characters of the English 
language can be created.  Other languages (Japanese for instance) require more bits in a byte, because 
they have more characters.  Japanese binary code is based on bytes with 16 bits. 
 
 (3)  We also speak about memory size and disk capacity in terms of bytes.  It would be extremely 
inconvenient to say, "I have 32,000,000 bytes of memory."  So abbreviations were formulated.  First, 
1,000 bytes is abbreviated as 1 Kilobyte or 1 K.  Next, 1,000,000 bytes is called 1 Megabyte or 1 Meg.  
Finally, 1,000,000,000 bytes is called 1 Gigabyte or 1 Gig.  There are higher levels, but these three are 
enough most of the time.  So in the example of 32,000,000 bytes, it would be much easier to say, "I have 
32 Meg of memory." 
 

(4)  Temporary and permanent storage are two ways the computer records and stores information 
for use in the future. 
 
 (a)  Temporary storage is memory that the computer uses to store information while the power is on.  
Sometimes called volatile memory because it is not permanent.  Random access memory (RAM) is one 
type of temporary memory.  RAM is where the computer stores applications and files that are currently 
being used.  RAM is extremely fast for the computer to access, this causes the computer to run much 
faster than it has to when using other types of storage.  RAM chips come on little cards called single in-
line memory modules (SIMMs).  Users can buy and install new SIMMs, which will make all of your 
computing faster.  Remember, anything stored in RAM is destroyed when the computer is shut down. 
 (b)  Video random access memory (VRAM) is special RAM memory that is dedicated to running the 
video output.  Adding more VRAM makes the screen redraw faster and allows a higher color bit depth to 
be displayed. 
 
 (c)  Permanent storage is used to store things that you want to use again.  Permanent storage 
allows you to keep documents and files and to move them from one computer to another.  Floppy disks 
are one type of permanent storage.  New disks hold about 1.4 MB of data, but older disks with capacities 
of 800 K or 400 K are still around.  New disks are called high density (HD) and can be identified by the 
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HD letters on the top.  They also have an extra hole on the top left of the disk as you are facing it.  
Floppy disks are relatively slow, so it is not practical to work from a floppy.  Floppies are very convenient 
for moving and storing small files, because they are small, cheap, and reliable. 
 
 (d)  Hard disks are another type of permanent storage.  Hard disks are usually internally installed in 
a computer, although external and portable units are available.  While floppies are designed mainly to 
store files and documents, hard disks are also used to store applications that will be used regularly.  
Hard disks come in many different capacities; from 80 MB up to many gigabytes (GB), but the most 
common is in the 250 to 750 MB range.  Hard disks are much faster than floppies, but not nearly as fast 
as RAM. 
 
 (e)  Removable media are similar to floppies in that they can be removed from the drive and taken to 
a different computer for use, although they have much higher storage capacity.  There are many different 
types and brands of removable media, and capacities from 44 MB up to 500 MB are not uncommon.  
Common types of removable media are magneto optical that uses lasers and magnetic coding to store 
data; Syquest that uses magnets and platters similar to normal hard disks; digital tape that uses 
magnetic tape similar to that of audio tape; and many others.  Most removable disks are not as fast as 
hard disks but are much faster than floppies.  These are all ideal for moving and storing large files and 
for transporting large files to other computers.  Additionally, removable disks are good for backing up 
important information and archiving, especially digital tape, which can hold very large amounts of data.  
Some hold more than 8 GB, but they are somewhat slow. 
 
 (f)  Read only memory (ROM) is permanent memory installed in the computer.  This memory is 
similar to RAM, except RAM is erased when the computer is turned off.  ROM usually holds operating 
instructions and codes that tell the computer to act a certain way.  Although very important for the 
computer, the user does not have to think much about ROM because we cannot really affect it. 
 
 (g)  Compact disk-read only memory (CD-ROM) uses a system of lasers and binary information 
stored on a thin metal and plastic disk that holds about 650 MB of data.  Much like a record player 
needle, the laser tracks around the disk reading the small pits and lands that represent the 1s and 0s of 
the binary code.  Although hardware is now available to write your own CDs, most people do not have it 
so they rely on disks made by others.  CDs hold lots of information and are excellent for storing large 
databases and images.  Once recordable CDs are more economical, they will be ideal for storing huge 
amounts of information. 
 

f.  Central processing unit (CPU). 
 
 (1)  The CPU is essentially the brain of the computer.  Millions of tiny switches, resistors, and wires 
are microscopically etched on a small piece of silicon that replaces the vacuum tubes and wires of the 
first computers.  All information that a computer handles travels through the CPU.  When you push a 
button on the keyboard, a small chip in the keyboard converts the letter into the binary code.  The code 
then goes to the CPU, which decides what to do with the information.  The CPU decides whether it 
should display a letter on the screen or execute a command. 
 
 (2)  Intel or Motorola makes the two main types of current CPUs.  Typically, Intel chips are used in 
IBM PCs and compatible clones.  Intel chips are identified by a code name, the most recent being the 
Pentium and before that the 486, 386, and others.  The higher the number, the newer or faster the chip. 
 
 (3)  Motorola makes chips that are used in Macintosh computers.  These too are identified by code 
numbers.  The 68040 is the most recent with 68030 and 68020 being older models. 
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 (4)  Both of these chips were originally based on a system called Complex Instruction Set 
Computing (CISC).  This technology has been around for a while and is on the verge of being replaced 
by a newer technology called Reduced Instruction Set Computing (RISC).  Motorola was the first to 
switch to the newer, faster CPUs.  RISC processors are much faster at certain operations, although they 
generally require more RAM and hard disk space.  A new chip that uses this RISC technology is the 
PowerPC chip, made by a joint venture between IBM, Apple, and Motorola.  Currently Apple uses it in 
their Power Macintosh line of computers, although IBM has recently introduced their version of the RISC 
processor.  These new chips will eventually replace the Intel and Motorola designs. 
 

g.  Monitors. 
 
 (1)  A monitor is a high-resolution television that the computer uses to display work.  Both televisions 
and monitors work by displaying picture elements or pixels.  A pixel is the smallest individual unit of an 
image.  Pixels are a combination of three primary colors–red, green, and blue.  Depending on how bright 
each dot of red, green, and blue is determines what color appears on the screen.  Depending on how the 
pixels are arranged determines what the screen looks like. 
 
 (2)  Pixels are formed by three cathode ray emitters, in a cathode ray tube, one for each color.  
These emitters are at the back of the monitor and point toward you as you face the screen.  As the 
emitters shoot beams of electrons toward you, they strike a phosphor coating on the back of the glass 
picture tube.  The charged energy causes the phosphor to glow briefly, and this glow forms the image 
you see. 
 
 (3)  One concern with monitors is resolution.  Resolution is the measurement of the number of pixels 
on a screen at any one time.  The more pixels on the screen at one time, the more detail the image will 
have.  Some monitor and computer configurations are able to change resolutions.  These monitors are 
called multisynch and are useful because you can have one resolution set to allow you to see an entire 
image and then change resolution to see just a single part of an image. 
 
 (4)  A second monitor concern is bit depth.  Bit depth is the number of colors that the monitor is 
capable of displaying at any one time.  For example, 1-bit color has only two colors, black or white; 4-bit 
color is 16 colors (or shades of gray).  Common bit depths are 16 bit (32,768 colors or shades) and 24 bit 
(16,777,210 colors or shades).  It is important to have a higher bit depth because the higher the bit 
depth, the more detail that will be visible.  This is especially useful in image editing and illustration 
software. 
 
 (5)  A concern with bit depth is that it is dependent on the VRAM the computer has, so you may be 
limited to lower bit depth if you do not have enough VRAM.  Also, the higher the bit depth you have set, 
the more computations the computer takes to redraw the screen, so everything may run slower.  It is a 
good idea to set the bit depth as low as possible so as not to waste speed. 
 
 (6)  The third concern with monitors is the scanning frequency.  The cathode ray tube draws the 
screen starting at the top left (as you look at it) working to the right.  When they get to the end of the first 
line, they move back to the beginning of the second line (just as we read).  The beams scan each line of 
the screen, one pixel at a time.  The phosphor glows long enough to make it seem as if the screen is lit 
continuously.  When the entire screen has been drawn, the beam moves back to the top and starts over.  
The screen is redrawn in this manner 60 to 75 times per second!  This is called scanning frequency.  If it 
redraws any slower than this, you would see the screen flicker.  Scanning frequencies are represented 
by a number of hertz or cycles per second.  So a monitor with a scanning frequency of 65 Hz redraws 
the screen 65 times per second. 
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h.  Input devices. 
 

(1)  A keyboard is probably the most common type of input device.  A keyboard is a collection of 
switches and a small microchip that converts the keypunches into binary code.  Every time you push a 
key a circuit is completed, which sends a signal to the CPU and either causes an action or displays a 
character on the screen.  The keyboard that is most common today is called the QWERTY keyboard, 
named for the keys in the top left row (Q, W, E, R, T and Y).  The keyboard is laid out as it was in the 
early 1800s to slow typists down by forcing the fingers to move a long distance between keystrokes.  
Early typists got to be faster than their typewriters, causing many jams, so designers figured out this 
layout to slow them down.  There are other key layouts, most notably the Dvorak keypad, which put the 
most common letters under the fingers.  Although the Dvorak layout has proven to be a much faster way 
to type, old habits die slow and it has not caught on yet. 
 

(2)  A mouse is a device that an operator uses to control the pointer.  It is much easier using a 
mouse than using arrow buttons to move to a specific spot on the screen.  A mouse also allows the user 
to point at specific areas of the screen to do an action without having to remember specific commands or 
codes.  A mouse has at least one button on it that can be used to select objects or perform a task.  Some 
mice have buttons that can be programmed to perform other functions.  The only hard thing about a 
mouse is to remember that the cord points away from the user.  A mouse works by being moved; as the 
user moves the mouse, a ball in the base of the mouse moves.  This ball turns two spindles that rotate 
two small shutters and a beam of light passes through the shutters.  As the mouse moves, the light 
pulses on and off and the computer translates this into a movement. 
 

(3)   A graphics tablet resembles a large clipboard or notebook with a nonwriting pen called a stylus.  
The user moves the pointer around on the screen using the stylus.  Once a person gets used to a 
graphics tablet, he or she can work much more accurately than when drawing with a mouse.  Some 
tablets have a clear covering for placing artwork under while tracing.  Tablets work by detecting 
disruptions in a magnetic field created by the stylus.  Stylus can be corded or cordless; however, most 
have batteries. 
 

(4)  There are many other input devices available.  The three listed above are the most common for 
our purposes.  Other common devices include trackballs, touch-screens, and joysticks. 
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 (a)  Trackballs resemble a large, upside down mouse.  Instead of pushing the mouse around, which 
rolls the ball, the user of a trackball actually moves the ball.  Like mice, trackballs have buttons, some of 
which can be programmed.  Trackballs are generally not as accurate as a mouse for fine detailed work, 
but require less motion for general everyday use. 
 
 (b)  Touch screens are simple monitors that can sense where you touch them.  These are useful for 
demonstrations or displays where an entire keyboard would be distracting or impractical. 
 
 (c)  Joysticks are exactly like the controls that many video games use.  While great to use if you are 
pretending to fly a fighter jet, these are not very convenient for work. 
 

i.  Operating systems.  An operating system is a piece of computer software that tells the CPU how 
to act.  All computers must have some type of operating system.  There are many types of operating 
systems on the market. 
 

(1)  Microsoft-Disk Operating System (MS-DOS) is the operating system that most IBM PC and 
compatible computers use.  MS-DOS, usually referred to as DOS, is a command line interface, meaning 
when you use it; all you see is the screen prompt C:\.  At this prompt you must enter coded commands to 
execute functions.  Needless to say this is not a very user-friendly interface, so Microsoft developed an 
application called Windows. 
 
 (2)  Windows, which is a copy of the Macintosh interface, is called a Graphical User Interface (GUI. 
pronounced gooey).  Windows provides the user with graphical buttons and menus and converts the 
operator's input into the appropriate DOS commands.  Although Windows is much easier to use than 
DOS, it has several problems.  First, having to run both DOS and Windows uses lots of RAM and hard 
disk space that is not available to other applications.  Second, Windows is not as intuitive or easy to 
learn and use as a Macintosh. 
 

(3)  While using Windows, you must have DOS also running.  With the Macintosh Operating System, 
all you have is a graphical interface.  The operating system is designed from the ground up to be both 
graphical and easy to use.  This type of system runs faster and is much easier to use because there is 
not that underlying DOS that can cause problems.  Additionally, there is currently only one manufacturer 
of Macintosh system hardware.  This assures continuity from machine to machine.  Although most 
computer experts agree that Macs are faster and easier to use, due to different marketing schemes, 
most companies, including the Federal Government, use DOS-based computers. 
 

(4)  UNIX is an operating system similar to MS-DOS.  Although rare on personal computers, UNIX is 
common on high-end graphics workstations (Sun and Silicon graphics) as well as on mainframe 
computers. 
 

(5)   The Commodore PET was one of the first home computers, but it was discontinued and 
replaced by the Amiga line.  While the Amiga never became generally successful, it does have a large 
following of dedicated users that are attracted to its powerful video and graphics capabilities.  The Amiga 
runs on a proprietary operating system similar to DOS, with a graphical interface. 
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A-2.  MACINTOSH FUNDAMENTALS 
 

a.  Macintosh setup.  A Macintosh is one of the easiest computers to set up and operate.  
Macintosh hardware is based on a plug and play theory, which means all you should have to do is plug 
in a piece of equipment for it to work.  Other computers require you to change the system software 
configuration to use a new device. This is unnecessary with the Macintosh.  There are some basic rules 
and guidelines that must be followed step by step to set up the Macintosh. 
 
 (1)  Unpack the equipment.  Be careful not to damage the box or any of the packing material.  If it 
is necessary to return a computer, you must do it in the original packing; therefore, keep all original 
packing material for at least a week to assure that the equipment is working properly.  If space allows, 
you should keep the packing material forever, because this is the best way to ship equipment.  While 
unpacking the boxes, look for an inventory sheet in each box, which tells you what should be in the box.  
Check to ensure that you have all of the proper cords, manuals, and warranty cards.  Once you are sure 
that you have all of the inventory items, clean up the work area and remove all of the packing material 
and boxes. 
 
 (2)  Connect the equipment.  Look in the owner’s manual for exact instructions on connections, but 
follow these general guidelines. 
 

(a)  The first step that Apple recommends is to plug the computer's power cord into the computer 
and then into a three-prong grounded power supply.  This assures that the computer is grounded and no 
static electricity damage will occur during the rest of the setup. 
 

(b)  Plug the monitor's power cord into the monitor first and then the computer's power outlet or 
another grounded outlet, depending on what type of power cord your monitor has. 
 

(c)  Attach the monitor's cable to the monitor and the computer's monitor port.  The type of monitor 
you have and which Macintosh you use will determine which of the two monitor ports you use, the 
standard or the Audiovision. 
 

(d)  Attach the mouse and keyboard. First, attach the Apple Desktop Bus (ADB) cable to the ADB 
port on the back of the computer and then plug the other end into the keyboard.  The mouse attaches to 
the extra ADB port on the keyboard.  You can customize this configuration if you have other ADB 
devices (trackballs, graphics tablets, and so forth) as long as one device is plugged into the Mac and the 
others are chained together.  You must never have the Mac turned on when you plug or unplug ADB 
devices. 
 

(e)  Attach any external devices.  Modems and printers attach to the icons marked for these devices.  
Small Computer System Interface (SCSI, pronounced scuzzy) devices get attached through a chain of 
cables. 
 

• A SCSI chain is several devices linked together that all connect to one port of the computer.  
SCSI connections are the hardest part of setting up a Macintosh, but remembering several rules 
makes things much easier.  The first rule for chaining SCSI devices is that each device must 
have a unique number, called a SCSI ID.  You can have a total of seven devices attached to a 
Macintosh in a SCSI chain.  The CPU is assigned SCSI ID 0 and the internal hard disk is usually 
SCSI ID 7.  As long as every other device has a different number, everything should work.  ID 
numbers are set on each device with a wheel, DIP switch or other mechanism.  Consult the 
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owner’s manual of the specific piece of equipment for instruction on how to set the SCSI ID 
number. 

 
• The second concern with a SCSI chain is called termination.  SCSI works by sending a small 

electrical current down the chain of devices, which then lets the Mac know what devices are 
attached.  Terminators act as bumpers at the beginning and end of the chain, absorbing extra 
electrical signals and preventing data error.  The first and last device of a SCSI chain must be 
terminated.  There are two ways to terminate a device.  The first is external termination, which 
utilizes a small electrical device attached to the empty plug on the last device.  The second 
method is called internal termination, which utilizes a built in switch to turn the built in terminator 
on or off.  When creating a SCSI chain, you should try to use the shortest cables possible.  If 
unnecessarily long cables are used errors may occur.  More about SCSI chains will be 
discussed in the Troubleshooting section. 

 
 (3)  Turn the power on.  Turn the power to the power strip or surge suppresser on, and then turn 
the monitor on.  If you plugged the monitor into the computer, this will be the only time you have to turn 
the monitor on.  From now on, it will come on when the computer is turned on.  Turn on each external 
device.  Once all external devices are on, push the Power On key on the Mac's keyboard.  If everything 
works correctly, you should here a chord tone and eventually you will see the desktop. 
 

b.  Desktop components.  When you first start up a Macintosh, the first screen you come to is 
called the Desktop or Finder.  Finder and Desktop are interchangeable.  The Finder or Desktop is the 
heart of the Macintosh system software.  What makes a Mac so easy to use is that all there is to the user 
interface is the Finder.  From here you can do just about anything that the Mac is capable of. 
 

(1)  Across the top of the Desktop screen is the Menu Bar.  Each item here has functions that can be 
accessed by pulling down menus.  The Menu Bar provides access to all of the commands and functions 
of the Finder. 

 
(2)   At the right side of the Menu Bar is a balloon shaped icon with a question mark in it.  This is the 

Help Menu.  By pulling down on this icon with the pointer you can turn on Balloon Help.  If Balloon Help 
is turned on when you use the mouse to point to things on the screen, the Mac displays a balloon with 
information.  This is helpful when using the Mac for the first time or when using a new piece of software.  
However, be aware that not all software applications are programmed with Balloon Help; so if nothing 
appears, it is because the software is not programmed for Balloon Help. 
 

(3)  At the top, far right of the Finder window is the Application Menu.  The Application Menu icon 
looks like a small Macintosh computer.  This is where you can change from application to application.  
For example, if you had both Microsoft Word and Adobe PageMaker running, only one of them would be 
active at any one time.  To switch from one to the other, you would pull down on the Application Menu to 
the one that you wanted to use.  Notice that the application that is currently active has a check mark 
beside it.  This menu is extremely useful when you have several applications open and are switching 
back and forth often.  Also in the Application Menu are options to Hide (current application) and Hide 
Others.  These options allow you to clean up the screen by hiding any of the applications. 
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(4)  On the Desktop itself are several icons.  The Startup Disk is at the top right corner, beneath the 
Application Menu.  This icon represents the disk that contains the system software that started up the 
computer.  If you have other disks attached to the computer, icons representing them should appear 
beneath the Startup Disk icon. 
 

(5)   Just as the name implies, the Trash Can is where you put files and applications to be thrown 
away or deleted.  One nice thing about a Mac is that it does not automatically remove these files.  When 
you put files into the Trash Can, they stay in until you choose Empty Trash from the Special Menu.  This 
is good when you accidentally put a file into the trash that you do not want to delete.  It is good to get in 
the habit of emptying the trash at regular intervals, so that the trash file does not get too large. 
 

(6)   The pointer is the little arrow that you control with the mouse. 
 

c.  Mouse techniques.   Using a mouse is relatively easy.  Just push the thing around and push 
the button.  However, there are several special things to learn. 
 

(1)  Pointing is a basic mouse operation.  Put the mouse on a flat surface; a mouse pad or special 
surface works best.  Ensure that the cord faces away from you and move it around.  Notice that the on-
screen pointer moves in conjunction with the mouse.  The pointer only moves when the mouse is 
touching the surface.  This is handy for when you get to the end of the mouse pad because all you have 
to do is pick the mouse up and move it back to the center of the pad.  The pointer will not move until you 
place the mouse back down and roll it. 
 

(2)  Clicking is used to select an object.  First, move the mouse so that the pointer is on what you 
want to select and push the mouse button in a rapid click.  Do not hold the button in.  If you have done 
this properly, what you pointed at is now selected. 
 

(3)   Double clicking is used to open a folder or disk or to launch an application.  To double click, 
point at the desired folder, disk, or application and push the mouse button two times in quick succession 
(click-click).  If done correctly, the folder or disk opens or the application launches (starts running). 
 

(4)  Click and hold when you want to see the contents of a pull down menu.  First you use the mouse 
to point to the menu, and then you click and hold the mouse button in.  The menu should appear and 
stay until you release the mouse button. 
 

(5)  Dragging is used to reposition icons or to move things around on the screen.  To drag, you first 
select the object by single clicking on it.  Next, you click and hold on the object, keeping the mouse 
button pressed in, you move the mouse around to place the object.  When you have placed the object 
where you want it, release the mouse button to drop it. 
 

(6)  Modified clicking is a technique where you use regular clicking in conjunction with pressing a 
keyboard button.  For example, to select more than one icon, you can use shift-click.  To accomplish this 
you first single click on the first icon.  Next you point to the second icon; press and hold the Shift key and 
click on the second icon.  Both icons are now selected and you can release the Shift key.  There are 
many different combinations of modified clicks that we will learn. 
 

d.  Pull down menus.  Across the top of the Desktop is a Menu Bar that allows you to perform many 
functions and actions.  The first menu is on the far left and is called the Apple Menu. 
 

(1)  The Apple Menu is a list of available applications and desk accessories (DAs).  Users can 
customize their Macintosh by adding things to the Apple Menu.  To add an item you place an alias 
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(something like a bookmark) of the item in the Apple Menu Items folder in the System Folder.  By having 
an alias of commonly used applications or folders in the Apple Menu, you can easily open a folder or 
application by pulling down the Apple Menu, instead of having to open many folders and disks and finally 
double clicking on the desired object. 
 
 (2)  DAs are miniature programs that help the user, such as a calculator, map, puzzle, CD remote, 
and many others. 
 

(3)  To the right of the Apple Menu is the File Menu.  The File Menu has many different functions, 
but only several are commonly used.   

 
(a)  First, it allows you to create new folders (use the New Folder option) to file documents in.   
 
(b)  Second, it allows you to create aliases (use Make Alias) of folders, applications, or files.  Aliases 

are bookmarks that can be placed anywhere to make it easy to locate deeply hidden or often used items.   
 
(c)  Next, the File Menu has a Find command.  As it sounds, Find is used to search a disk for a 

particular file name.  Select Find and enter what you want to search for in the field.  To narrow the 
search, click More Choices to add more variables.  This feature is extremely useful when you remember 
the file name (or part of it) but forgot where on the disk the item is located.  If the first search does not 
locate the right file, choose Find Again to look for the next item that matches the search data.  Continue 
this until you locate the correct file.   

 
(4)  As you can see, there are other options in the File Menu, but those listed above are the most 

important ones.  Read in your owner’s manual or other reference about the other options.  Also, notice 
the keyboard shortcuts beside most of the commands under the File Menu.  These are shortcuts that you 
can use instead of pulling down the menu and dragging to the desired command.  These commands all 
use a modifier key in conjunction with a regular key.  For example, to create a new folder you could 
select New Folder from the File Menu or use the keyboard shortcut: Command-N.  The Apple key 
represents the Command or Apple key.  The Mac uses many different keyboard shortcuts and most are 
universal from application to application, so try to get in the habit of using them for repetitive tasks.  
Keyboard shortcuts can save time. 
 

(5)  To the right of the File Menu is the Edit Menu.  The Edit Menu contains basic editing functions, 
such as Undo, Cut, Copy, Paste, Clear, Select All, and Show Clipboard. 
 
 (a)  The Undo command reverses the last action done.  If you make a mistake, you can use the 
Undo command to return you to where you were before you made the mistake.  Some applications have 
multiple layers of undo. Which means that you can undo many things a layer at a time until you get back 
to your work at a previous point.  This is useful when you want to try out several different versions of a 
document or file.  If an application only has a single Undo, you must select Undo immediately after 
making a mistake because you cannot go back and undo the mistake later.  The keyboard shortcut is 
Command-Z. 

(b)  The Cut command removes the selected object.  If used in a word processor application, Cut 
removes whatever text is selected.  The Cut information is stored in the Clipboard until something else is 
cut.  The keyboard shortcut is Command-X. 
 
 (c)  The Copy command copies selected objects.  Whatever is selected is copied to the Clipboard, 
without affecting the original.  The keyboard shortcut is Command-C. 
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 (d)  The Paste command pastes whatever is in the Clipboard to where the insertion point is located.  
Paste is used in conjunction with Cut and Copy to remove or copy information from one area and place 
or paste it somewhere else.  The keyboard shortcut is Command-V. 
 
 (e)  The Clear command is much like the Cut command, in that it removes selected items.  Unlike 
Cut, the Clear command removes the selection without pasting it to the Clipboard.  If you clear 
something, it is gone.  There is no keyboard shortcut. 
 
 (f)  Select All selects everything in a window.  When used in the Finder, it selects all of the folders, 
files, or applications in a window.  When used in an application, it selects all of the text, graphics, or 
images in the document.  The keyboard shortcut is Command-A. 
 
 (g)  The Clipboard is where items that were cut or copied are stored until needed.  As we have 
learned, only one item can reside in the Clipboard at any one time.  Whenever you Cut or Copy 
something, it deletes the item currently in the Clipboard and replaces it with what you cut.  To see what is 
in the Clipboard, select Show Clipboard from the Edit Menu.  There is no keyboard shortcut for this 
command. 
 

(h)  These are all of the commands that are in the Edit Menu in the Finder.  As you learn more 
applications, there will be more commands added to this menu, but the above commands are common to 
most programs. 

 
(6)  The View Menu controls how items are displayed in the Finder.  You may want to control how 

the contents of windows are displayed, and you would use this menu to do that. 
 
 (a)  By Small Icon and By Icon are similar options.  By Icon is the standard Macintosh view.  This 
displays all of the contents of a disk or folder by normal, large icons.  By Small Icon uses the same icons 
but reduces them to approximately one-half the size.  This is convenient when you want to display many 
icons in one small window. 
 
 (b)  By Name, By Size, By Kind, By Label, and By Date are all options used to list contents of folders 
or disks in the corresponding order.  Depending on which option you have selected, it rearranges the 
order.  These lists use a small icon to represent folders and files.  If an item is a folder, it will have an 
arrow beside it.  You can click on this arrow to collapse or expand the list.  Expand means to show the 
contents of the folder and collapse means to hide the contents. 
 

(7)  The Label Menu color-codes files, folders, or disks.  This is extremely useful when working on a 
project with many different files.  You can assign one color to all of the files and quickly locate or identify 
related files.  To assign a label, you first select the item or items and then pull down the Label Menu and 
drag to the color that you want.  To change the colors on the menu or to change the captions that go with 
these colors, use the Label Control Panel found in the Control Panel Folder. 
 

(8)  The Special Menu contains several miscellaneous but important commands.   
 
 (a)  The Clean Up Window reorganizes all of the icons in a window.  After you've been moving icons 
around, the window may appear cluttered or messy.  Use the Clean Up command to rearrange all of the 
icons according to the settings found in the Views Control Panel.  There are many different combinations 
available in the Views Control Panel.  You can choose to stagger icons or not or to always snap to grid, 
along with many other options for the List View Menu option. 
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 (b)  Empty Trash permanently removes items that were put in the Trash Can.  Remember, once you 
choose Empty Trash, these items are gone.  
 
 (c)  Eject Disk removes a disk.  First select the disk and then choose Eject Disk from the Special 
Menu, or use the keyboard shortcut Command-E.  Another way to eject a disk is to drag its icon to the 
Trash Can.  This does NOT affect any of the files on the disk; all it does is cause the disk to eject. 
 
 (d)  Erase Disk totally removes all of the contents of a disk and should be used with extreme caution. 
 

(e)  Restart restarts the computer if needed.  Remember that restarting erases any files not saved so 
save all files before doing this. 
 

(f)  Shut Down turns off the computer.  Never turn a computer off by turning the power off or using 
the emergency switch on the back.  By properly using the Shut Down command, you let the computer 
clear its memory and save system files for the next time you use it. 

 
e.  Macintosh windows.  The Macintosh uses windows to display information.  A window is simply 

a box that information appears in.  To fully understand a Mac, you must be able to identify parts of a 
window and tell how to use them. 
 
 (1)  Across the top of the window is the Title Bar.  In this area you will see the title of the window 
displayed.  If the window represents a disk or folder you will see the name of the disk or folder.  If it is a 
file, you will see the filename. 
 
 (2)  At the upper left corner of the Title Bar is a small box called the Close button, and the only thing 
it does is close the window.  When you are done using a window, you should click on this box to get rid 
of the window.  
 
 (3)  Just below the Title Bar is the Information Bar.  In this bar on the far left is the number of items in 
the disk or folder.  In the middle is how much information is stored on the disk that contains the window.  
On the right is how much space is left on the disk. 
 
 (4)  In the upper right corner of the window of the Title Bar is the Zoom button.  When clicked, this 
button can shrink the window to as small as it can get while still displaying all of the files.  If the monitor is 
not big enough to show all of the files, it will fill the screen.  If clicked again, it will either expand or 
collapse the window to the last size set by the user. 
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 (5)  Vertically across the right side of the window is the Vertical Slider.  If there are more files than 
the window can display, this area will be medium gray and will have a Slider Bar button in it.  Scroll 
Arrows at the top and bottom allow the user to scroll up or down to view more items.  You can also drag 
the Slider Bar button up or down to quickly reposition the contents.  Additionally, you can click in the gray 
area, either above or below the button, to quickly move up or down one page at a time. 
 
 (6)  The Resize button is in the lower right corner of the window.  This button can be dragged around 
to change the size of the window.  Whatever size is set with this button will be the default size for the 
window, when the Zoom button is clicked. 
 
 (7)  Horizontally across the bottom of the window is the Horizontal Slider.  It is just like the Vertical 
Slider, except this slider works side to side, repositioning the contents of a window. 
 

f.  Selection techniques.  No matter what type of application you are using, you need to know how 
to select objects. Clicking, Shift-Clicking, using Marquees and Select All are four basic techniques to 
select objects. 
 

(1)  Clicking is done to select a single item.   You just point at it and click once.  Sometimes, when 
you click on the name of an item, it will become selected.  This is used to rename an object.  Just point at 
the name, click and after a moment the name will be selected and you can type a new name. 
 

(2)  To select more than one item, click on the first item and then shift-click on other items to add to 
the selection.  If you do not use the Shift key, the first item will become deselected so remember to use 
this key. 
 

(3)  To select a group of items that are close together, position the pointer outside the group and 
drag a box or marquee around the group.  Watch out not to select other unintended objects when using 
this method. 
 

(4)  The Select All command selects all of the items in a window. 
 

g.  Dialog boxes. 
 
 (1)  A Dialog Box is another type of window.  Sometimes the Macintosh needs more information to 
complete a command, so it presents a Dialog Box.  Dialog boxes come in many different shapes and 
sizes, but there are common contents to all.  Dialog Boxes that appear when you are saving a file usually 
have an area where you can enter the name you wish to save the file as. 
 
 (2)  Disk and Directory indicators are either icons or windows that show where the specified file is 
located.  These usually have pull down menus that allow you to change the current disk or directory. 
 
 (3)  Radio buttons are round buttons that allow you to make only one selection.  If there are several 
options to choose from but you are only allowed to choose one, you will be presented with radio buttons. 
 
 (4)  Check boxes are often used to allow the user to select options.  You can check as many of 
these small, square boxes as you wish. 
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 (5)  Buttons are oval and have text in them and are used to execute commands.  Examples of 
buttons are Save, Print, and Open.  Usually one of the buttons in a Dialog Box will have a thick double 
oval around it.  This is the default button, and you do not need to click the mouse on it.  With a default 
button, you can just push Return/Enter key to execute this command. 
 

h.  Alert boxes.  Occasionally the Mac will warn you that what you are about to do may be 
irreversible or the computer may display an error message.  These boxes are called Alert Boxes.  One 
typical Alert Box is displayed when you select Empty Trash.  The Mac warns you how many items are in 
the trash and asks you if you are sure you want to permanently remove these items.  You will encounter 
many other Alert Boxes.  Typical Alert Boxes are System Crashes, System Errors, Out of Memory, and 
many others. 
 

i.  System folder.  Located on the disk that the Macintosh started up from is a folder called the 
System Folder.  This folder contains all of the Macintosh system software that makes a Mac a Mac.  
Without this folder and its contents, the computer would not start up or operate.  Depending on which 
model Macintosh you use and what other software you have, you may have more or less in your System 
Folder.  Some common items found in the System Folder are listed below. 
 

(1)  The Apple Menu Items folder stores items that you wish to appear in the Apple Menu.  Common 
items placed here are aliases to often-used folders, files, or applications.  DAs are also placed in the 
Apple Menu for quick access. 
 

(2)  Control Panels are mini programs that allow you to set options and functions of the Macintosh.  
Control Panels must be in the Control Panels folder to be active. 
 

(3)  Extensions are small programs that add features or functions to the Macintosh.  When you start 
up the Mac, you see the Extensions appear across the bottom of the screen as they load.  For an 
Extension to work, it must be loaded at start up.  To be loaded at start up, an Extension must in the 
Extensions Folder in the System Folder. 
 

(4)  Preferences are small files that are created by applications, control panels, and extensions.  
When you personalize an application or use a control panel or extension to set up how the Mac will work, 
a Preferences file is created to save these settings.  All of these Preferences files are stored in the 
Preferences Folder in the System Folder. 
 

(5)   The Finder file in the System Folder is the actual program that creates the desktop and makes 
the Mac work.  This file must be in the System Folder. 
 

(6)  Items placed in the Start up Items Folder will automatically open when the computer is turned 
on.  This is useful if you use the same applications everyday.  You can simply place an alias of these 
applications in the Start up Items Folder and when the Mac starts up, the files, folders, or applications 
open. 
 

(7)  The Clipboard is where items that were cut or copied are stored until they are needed.  
Remember, only one item can be stored in the Clipboard at a time.  An item can be a single word, 
groups of words, a graphic, a picture, or whatever. 
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(8)  The Scrapbook File is similar to the Clipboard except it can hold more than one item.  You can 
open this file and scroll through the contents.  If you use a graphic, letterhead, or group of text (name, 
address, and so forth) often, it may save time to copy these items to the Scrapbook.  When the item is 
needed, all you have to do is copy and then paste the item.  
 

(9)  The Notepad is just that, a notepad.  It can be used just like a paper pad to store short notes 
and messages.  You can cut, copy and paste to and from the notepad. 
 

(10)  The System File is a folder that is used to store system resources.  Resources can be sounds, 
keyboard layouts, or other small bits of information that help the Mac work properly.  You must have this 
file for the Mac to work properly. 
 

(11)  Fonts are different styles of letters and characters.  All fonts must be stored in the Fonts Folder 
in order to be used.  Once new fonts are added, you must restart the Mac to access them. 

 
(12)  Simple Text is a rudimentary word processing program.  It is usually found in the System 

Folder.  It can be used to open and view Read Me files, graphics, sounds, animation's and Quick Time 
videos.  While it's not necessary, it is a good idea to keep Simple Text around to use to view these files. 
 

j.  Basic control panels.  As you have learned, control panels are small programs that allow you to 
adjust system-related settings, such as the time and date settings of the Mac's internal clock.  There are 
many control panels available to you, but these are the basic ones that come with the Mac system 
software.  Remember that control panels must be in the Control Panels Folder in the System Folder to 
be used. 
 

(1)  The General Controls control panel sets basic Finder options.  You can change the color and 
pattern of the desktop work area, the rate of insertion point blinking, the rate of menu blinking, and the 
date and time. 
 

(2)  The Date/Time control panel also sets the date and time of the Mac's internal clock.  Additionally 
you can change the date and time format.  You can decide if you would rather use a 24-hour clock or use 
the names of months instead of numbers. 
 

(3)  The Keyboard control panel sets the keyboard layout if you have more than one installed.  You 
can also set the key repeat and delay rate.  These are the rates that characters appear at if you hold a 
key down. 
 

(4)  The Mouse control panel customizes the actions of the mouse.  You can change the speed of 
the mouse, as well as the double-click speed. 
 

(5)  The Color control panel customizes the color of windows and highlighted text. 
 

(6)  The Labels control panel sets the color and captions that go with the labels in the Labels Pull 
Down menu. 
 

(7)  The Sound control panel controls all of the Mac's sound functions and contains a pull down 
menu with several options.   

 
(a)  The first is Alert Sound.  This is where you can set the sound and volume that will be used as an 

alert.  An alert is a sound that is played when the Mac wants to get your attention or inform you of an 
error.  You can use the Add and Remove commands to add or delete alert sounds. 
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 (b)  The second option is Sound In.  This is where you designate where sound input will come from.  
Use the Options button to select either Microphone, AV connector, or Internal CD. 
 
 (c)  Next is the Sound Out option that is used to select how sound will be played back.  You can 
choose the speed (in kHz) for sound playback as well as sound bit depth and stereo or mono sound. 
 
 (d)  The last option is Volumes.  This is where you set the volumes for the Mac's sound.  You have 
two sliders–one controls the volume of the built-in speaker, while the other sets the volume of the 
headphone jack on the back of the Mac. 
 

(8)  The Numbers control panel controls how the Mac handles numbers.  You can set what character 
to use as the decimal separator (usually a ".”), as well as what to use to separate the thousands place 
(usually a ",").  Additionally, you can decide what symbol to use with currency and where it will be placed. 
 

(9)  The Views control panel sets how information in windows is displayed.  We have discussed the 
use of the Views Pull Down Menu, the Views control panel is where you set the preferences.  You can 
select font and size of title information, as well as options for list and icon views. 
 

(10)  The Start Up Disk control panel is used to select which disk to start from at the next restart.  
The disk you select must have system software on it. 
 

(11)  The PC Exchange control panel is used when accessing files from an IBM PC system.  PC files 
have a code attached to the end of the file name, which is called a suffix.  Different suffixes represent 
different types of files.  For example, .txt means that it is a text file.  Using this control panel, you can set 
which application on the Mac will be used to open files with different suffixes.  You may have the control 
panel set so that MS Word opens all files with the .txt suffix, while PhotoShop opens all files with the .gif 
suffix. 
 

(12)  The Chooser is a desk accessory found in the Apple Menu that allows the user to select which 
external device to use.  When it is opened, the Chooser will show icons of all of the printers that are 
installed in the Mac.  There will also be icons for faxing and file sharing if these items were installed.  The 
user then clicks on the icon that he wants to use.  For example, to print to the Laser printer, you would 
open the Chooser and select the LaserWriter icon.  To use the Color Printer you would select that icon. 
 

k.  Memory control.  To set how the Mac uses memory, you use several different tools that are part 
of the Mac's system software.   
 

(1)  First, there is the Memory Control Panel, which is broken down into four items.   
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(a)  The first is the control of the cache.  A cache is a portion of RAM that is set aside for often-used 
instructions.  You can purchase separate cache cards that add more memory to be totally devoted to this 
purpose, or you can allot some of the internal RAM as a cache.  This makes the computer run faster, 
because common instructions and functions are stored here instead of on the relatively slow hard disk. 
 
 (b)  The Modern Memory Manager is the portion of the Memory Control Panel used to control 
whether or not the Mac uses the modern memory functions.  This should always be ON unless you are 
using old system software (System 6.0) on a new Mac. 
 
 (c)  Virtual Memory (VM) is when the computer uses a portion of the hard disk as RAM.  It stores 
things that it would normally put in RAM on the hard disk, if it needs the space.  While using this may 
allow you to open more applications, it is much slower than real RAM; it should not be used as primary 
memory. 
 
 (d)  Using VM, you use the disk as RAM.  With a RAM disk, you use RAM as a disk.  You create a 
RAM disk and it put files or applications in it just like another disk.  It is extremely fast, but it uses up a 
large part of critical RAM. 
 

(e)  To find memory information about a Mac you use the About This Mac item under the Apple 
Menu.  This window provides you with the total amount of RAM installed in the Mac.  It also shows you 
other information about the Mac, such as the system software version number and how much RAM each 
application is allocated and how much it is currently using. 
 

(2)  When you first turn the computer on, the system software is the first to use RAM.  As you open 
applications, they too use RAM.  As you close applications, not all RAMs go back to the available pool.  
Eventually, there is not enough RAM in one continuous block to open anything, which is called memory 
fragmentation.  Memory fragmentation is graphed in what is called the System Heap.  This is an 
imaginary graph of how the computer's memory is handled.  To monitor memory usage, use the About 
this Macintosh window, which list all of the open applications and how much RAM each one is using.  
The Largest Unused Block section shows the largest block of RAM that is free.  If the total amount of 
RAM in use plus the Largest Unused Block is less than the Total Memory, then you have memory 
fragmentation.  The only way to recover fragmented memory is to restart the computer.  The best way to 
avoid memory fragmentation is to launch often-used applications first.  If you use a word processor off 
and on throughout the day, it is best to launch it at startup and leave it on in the background.  Open other 
applications as needed but try to close the last opened application first.  This will keep the Largest 
Unused Block as big as possible. 
 

(3)  Each application is allotted a certain amount of memory to work with.  The user can change this 
allocation to his needs.  To find out how much memory an application is allotted, first make sure it is not 
running, then select it (single click) and choose Get Info from the File Menu.  A window appears that has 
information about the selected item.  At the top of this window is the name, icon, type of item, where it is 
located, when it was created and modified, and the version numbers.  Then there is a comment box that 
you can type in.  At the bottom is the Memory Requirements information, which has three amounts in it.   
 

(a)  Suggested Size is the first amount that the author of the application thinks is the best for 
general-purpose use.  This is just a suggestion, so we do not have to go by this. 
 
 (b)  Minimum Size is the second amount.  This is the size that you set to define the minimum amount 
of memory an application is given.  Generally, you do not want to set this much lower than the 
recommended amount.  If you are having problems with an application and keep getting a warning of a 
Type 1 Error or an Out of Memory Error, then you have the minimum set too low and should increase it. 
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 (c)  Preferred Size is the last amount.  This is the amount of memory that you set as the preferred 
amount.  The computer will allocate this amount to the application (if this much is available!).  Usually at 
installation the software is set to amounts that work best; but if you have problems, try setting the 
minimum to the recommended amount and the preferred to twice the minimum. 
 

l.  Network control panels. 
 
 (1)  One of the benefits of a Macintosh over a DOS-based computer is networking.  Networking, or 
connecting two or more computers, is built in on the Macs; while on a DOS machine, it is purchased 
separately.  The Macintosh comes with a built-in network connection called Localtalk or AppleTalk.  The 
printer or modem port is the connector for this and you can easily connect two (or more) Macs together 
using this connection. 
 
 (2)  Another type of network is Ethernet.  Most new Macs come with a built-in Ethernet connection, 
or they can be purchased separately.  Ethernet is MUCH faster than Localtalk and is used for high-speed 
networks. 
 

(3)  To set up a Mac Localtalk network just connect two computers at the printer or modem ports.  
An Ethernet connection requires a Hub, which is a box that fits between the two computers, and then 
wires go from the hub to the computers.  Once you have physically connected the computers, you must 
use the system software to tell them that they are connected.  To do this, there are four control panels. 
 

(a)  The Network control panel is pretty much straightforward.  All you have to do is select which 
type of network you have connected.  There will be icons for several different network types; all you do is 
select which one you have set up. 
 

(b)  The Sharing Setup control panel is where you set the identity of the Macintosh you are using 
and where you assign an owner and a password for that owner.  You should ensure that every computer 
has a unique, easy to remember name, such as David's Mac.  This makes it easy to see what computer 
you are connected to.  When making up passwords, choose unique but easy to remember passwords.  
Do not use names or other easy to guess passwords.  Try using two unrelated words separated by 
punctuation, such as star!dog.  This type is hard to guess, but easy to remember if you are supposed to 
know it.  There are two sections of this control panel called File Sharing and Program Linking.  These 
sections are used to allow others to access files or applications or both. 
 

(c)  Once you have the Sharing Setup control panel configured, you use the Users and Groups 
control panel to give access to individual users.  You create a user folder for each person that you are 
going to allow access to your computer.  You can set different amounts of access to each user.  You can 
also allow Guest access, which allows users access to use your computer. 
 



STP 11-25M13-SM-TG 

A-21 

(d)  The File Sharing Monitor is a control panel used to monitor who is connected to your computer.  
On the left side of the control panel is an area that shows who is connected.  On the left are icons 
representing the shared items.  On the bottom is a bar graph that represents the file sharing activity.  To 
kick a person off of your machine, double click on the icon of the person that is connected and choose 
disconnect. 
 

m.  Monitor control panel. 
 
 (1)  The Monitor control panel sets the options that deal with the video output.  When you first open 
this control panel, you can choose either color or grayscale.  You also can change the bit depth (number 
of colors displayed) of the monitor.  Depending on how much video RAM your computer has, you may 
have options all the way up to 24 bit or millions of colors. 
 
 (2)  At the bottom of this control panel you have a window with an icon of your monitor in it.  If you 
have more than one monitor attached, you will have more than one icon.  You can drag these icons 
around on the Virtual Desktop to position how information will flow across multiple monitors.  There is 
also a button labeled Identify that will display a number on each monitor, making it easier to identify 
which monitor is which. 
 
 (3)  In a multiple monitor setup, one of the monitors is always the Startup monitor.  In the control 
panel one of the icons will have a small menu bar in it.  The monitor with the menu bar is the startup 
monitor.  To change startup monitors, simply drag the mini menu bar to the desired monitor icon. 
 (4)  There is a button labeled Options which allows you to set the monitor resolution (number of 
pixels on the screen), as well as allowing you to send the image to a TV if you have the proper 
equipment. 
 

n.  Software.   For a computer to be truly productive, you must have other software applications that 
instruct the computer how to do tasks.  There are many different types of software and brand names, but 
most falls into the general categories below. 
 

(1)  Word Processing software is used to write letters, memos, and anything else that you would 
need.  A word processor turns the computer into a fancy typewriter, allowing you to enter text and then 
easily edit and move entire sections around.  Most good word processors have spelling and grammar 
checkers and a thesaurus built in.  Many also allow you to automatically create outlines, glossaries and 
indexes.  Microsoft Word and Word Perfect from Novell are typical word processors. 
 

(2)  Database software is used to keep track of large amounts of information.  You can track 
anything from recipes to parts inventories.  You establish fields of data to track (ingredients, part number, 
and area code) and then enter data for each item to track.  The database software can then cross-
reference, sort, and create reports about the information you have entered.  Foxpro and Filemaker Pro 
are typical data programs. 
 

(3)  Page layout software is designed to make it easy to incorporate text, pictures, and graphics into 
a single document.  This software is used to design and layout anything, from simple newsletters to 
complete books.  Page layout software allows you to create text boxes that flow around graphics and 
have images and illustrations that compliment the design.  Quark Xpress and Adobe PageMaker are 
common page layout applications. 
 

(4)  Image editing software is used to enhance photographs with the computer.  Images can be 
acquired with a digital camera or scanned into this software.  After images are in the application, all 
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normal photographic enhancements (dodging, burning, and cropping) can be done, as well as special 
effects.  Adobe Photoshop and HSC Live Picture are image-editing applications. 
 

(5)  Illustration software is used to create art on the computer.  These software applications have all 
of the functions of painting, drawing, and other normal art techniques.  They can also create layers and 
color gradients, as well as other special effects.  Adobe Illustrator and Macromedia Freehand are 
illustration programs. 
 

(6)  Like Illustration software, 3D-Drawing software is used to draw images.  However, 3D-Drawing 
programs allow the user to set up illustrations in three dimensions.  Users can draw two-dimensional 
illustrations and the computer can add the third dimension.  Users can create shadows, textures, and 
lighting effects.  Stratavision 3D is one example of a 3D-Drawing program. 
 

(7)  Fonts are different styles of letters and characters.  Clip art is professionally drawn pictures of 
every imaginable style.  You can get clip art borders, people, signs, backgrounds, and so forth.  Fonts 
and clip art can be purchased for use with all of the other types of software.  The Image Club is a catalog 
sales company specializing in fonts and clip art. 
 

(8)  Video editing software is used to edit digital video.  Users first digitize the video and then 
rearrange the sequences, add fades, dissolves, and other special effects and create titles.  Once the 
editing is done, the computer reorganizes all of the video into one continuous sequence.  Adobe 
Premiere is used for desktop video editing, while the Avid system is used for professional broadcast 
quality video editing. 
 

(9)  Multimedia is combining text, graphics, video, animation, and sound into one presentation.  
Many multimedia presentations include user interaction, which means that users control how the 
presentation flows by clicking on screen buttons or by typing commands.  Macromedia Director and 
Macromedia Authorware are multimedia production software applications. 
 

(10)  Communications software is a broad category of applications that allow one computer to 
interact with other computers.  Generally a terminal program turns the Mac into a terminal to control or 
access other computers.  There are also applications that allow a computer to access the Internet, the 
global network of computers.  White Knight, Apple Remote Access, and Timbuktu Remote are just a few 
examples of communications software applications. 
 

(11)  Optical character recognition (OCR) software is used to convert scanned pages of text into 
editable text.  When a document is scanned, it is basically just a picture of the document.  With OCR 
software you can convert the picture into text that you can edit in a word processor.  While very useful, 
OCR software is not 100 percent accurate and must be carefully edited. 
 

(12)  Utility software is general software that adds functions and accessories to the Mac.  There are 
many different types of utilities.  Diagnostic software is used to diagnose and repair software and 
hardware problems.  Virus detection utilities are used to scan for computer viruses and repair them if any 
are found. 
 
A-3.  TROUBLESHOOTING 
 
 a.  Troubleshooting is the process that is used when trying to determine the cause of a problem and 
what to do to fix it.  It is important to understand the basics of how things work in order to be able to 
efficiently repair a problem. 
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 b.  One of the most important aspects of troubleshooting is to know what to do to prevent a problem 
from arising.  It is always better to avoid a problem, than to wait for something to happen and then be 
forced to try and figure out what to do.  With computers and other electronic equipment there are a few 
things that you can do to prolong the life of the equipment and prevent malfunctions. 
 

(1)  Preventive maintenance. 
 

(a)  Most electronic equipment comes with grounded plugs.  It is important to never bypass this 
ground and to always have a properly grounded outlet.  Computers are extremely sensitive to electrical 
impulses, and properly grounded plugs and outlets can prevent serious damage to the computer 
hardware.  It is absolutely necessary to be grounded when you are doing any activity inside the opened 
case of a computer (such as installing RAM, removing cards, and so forth). 
 

(b)  One of the most important pieces of electronic equipment to use is the surge suppresser.  
Electrical voltage can vary widely and often you will have surges of high voltage or fluctuations.  This is 
especially common with deployed units and ships where power is being provided by portable generators.  
A surge suppresser is an inexpensive device that filters the electricity before it goes into the computer.  
Suppressers control the actual outgoing voltage and only let regulated amounts into your equipment.  
Additionally, they can convert one outlet into several.  This allows you to plug all of your equipment into 
one receptacle, providing the receptacle has enough amperage.  Most surge suppressers can only 
protect against minor power surges and spikes.  Only uninteruptable power supplies (UPS) can provide 
against serious electrical problems, as well as provide short-battery backup.  UPS are strongly 
recommended to prevent damage to expensive EI equipment. 
 

(c)  Computer equipment is extremely susceptible to shocks and vibrations, especially hard disk 
drives.  You must be extremely careful to never bump or jostle computers or external hard drives while 
they are turned on.  Bumping a hard drive can cause the read-write heads to gouge the surface of the 
disk, ruining the drive and the data stored on it.  If you must move equipment, it is best to shut it down 
and give it a minute to cool down before moving. 
 

(d)   When plugging in or unplugging equipment, the computer must always be shut down.  Never 
unplug a computer that is turned on.  Also, ensure that the power switch is in the OFF position before 
plugging equipment back in.  Damaging power surges often occur when equipment is plugged in while 
turned on. 
 

(e)   It should seem obvious that you should never eat or drink around computers.  Liquid or crumbs 
spilled in a keyboard or on removable media can destroy the hardware or data.  Also, there is a danger 
of electric shock if liquid is spilled on an energized piece of equipment. 
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(f)  It is a very good idea to purchase and use a utility program such as Norton Utilities or MacTools 
Pro.  These programs scan your disks and hardware for potential problems and can fix them before they 
do any damage.  They also provide other utilities to recover deleted data, schedule backups, and 
optimize the disk speed. 
 

(2)  Start-up problems.  One of the most common times for a problem to occur is at start up.  When 
you first switch the computer on, it runs through several self-tests and reports problems in a variety of 
ways.  A very common start-up error is the flashing question mark icon.  This indicates a Small Computer 
Serial Interface (SCSI) error, usually with a hard disk drive.  A SCSI is the system used to connect 
devices, such as disk drives, scanners, and printers to the computer.  SCSI connections are both fast 
and reliable, but can sometimes be problematic.  There are several things to be concerned with when 
attaching SCSI devices or troubleshooting SCSI problems. 
 
 (a)  Each device connected to a SCSI chain must have its own unique ID number.  These numbers 
are usually set with a dial or pushbutton on the unit.  There can be a total of seven devices attached, but 
ID number 0 is reserved for the internal start-up disk and number 7 represents the CPU of the computer 
itself. 
 
 (b)  SCSI chains work by sending a small electrical signal through all of the devices attached to the 
chain.  Each device receives the signal and sends a reply back to the computer.  When the signal gets to 
the last device on the SCSI chain, this signal needs to stop.  If it does not stop, it will reflect back down 
the chain toward the computer, causing errors or malfunctions.  To stop this signal, we use a small 
device called a SCSI terminator.  This is attached to the empty plug on the last device and absorbs the 
signal.  Some devices have what is called internal termination, which means they have a terminator built 
in.  If your devices are internally terminated, you must turn the terminator off (usually there is a switch on 
the device to do this) on all of the devices except the last one. 
 
 (c)  When purchasing cables to use with SCSI equipment you should buy the slightly more 
expensive shielded cables.  These cables have electrical shielding in the insulation to prevent 
interference from other equipment.  You must also be sure that you use the proper cables and that all 
plugs are securely attached and locked in place.  All equipment (including the computer) must be turned 
off when attaching or removing SCSI cables.  You should also use the shortest cables possible for the 
best performance. 
 
 (d)  When starting up a computer with external SCSI devices, it is necessary to power up the 
external devices before starting up the computer.  Failure to do this prevents the computer from 
recognizing the devices, forcing you to restart to use the devices. 
 

(3)  Periodic software maintenance.  Periodic maintenance should be done to prevent problems 
from happening. 
 

(a)  Rebuild the desktop at least monthly. 
 
(b)  Keep only one copy of system software on the start-up disk.  Having more than one system 

folder will cause crashes and hangs. 
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(c)  Organize files into folders and hierarchies.  Have one folder for applications and keep all 
programs there.  Have another folder for documents, pictures, and so on.  Do not have many files just 
floating around in the system folder or loose in the disk's main or root directory.  The better organized 
your files are, the faster the computer can access them and the less likely it is to crash. 

 
(d)  Use a disk utility to periodically defragment (optimize) the drive and run a background diagnostic 

program that always watches for potential problems. 
 
(e)  Do not keep unnecessary System Extensions or Control Panels in the System Folder.  They 

have the potential to cause conflicts, as well as slow down computer operation. 
 

(4)  Hardware maintenance.  While there is no real maintenance to do on the CPU portion of the 
computer, there are a few things that can be done to prolong the life of the equipment. 
 

(a)  First, ensure air vents are clean and clear.  This means do not stack books or papers on top of 
or closely beside the computer.  You must allow air to flow in and around any vents.  This allows the 
internal fan to cool the circuits.  Occasionally vacuum the area around the vents to remove any dust that 
may have collected. 
 

(b)  Second, ensure cables or connectors have plenty of room.  One of the leading causes of 
computer malfunctions is a faulty cable.  Cables can be damaged by being bent or crimped, so allow 
them to attach to the computer and naturally curve away, without forcing them into a small area.  This is 
especially true with monitors that tilt and swivel.  Allow the monitor cable plenty of slack for free 
movement.  Never place cables near heaters or radiators. 
 

(c)  Due to the static electricity nature of monitors, it is important to keep monitors free from dust.  
Again, periodically vacuum any dust from the top and side vents.  To clean the screen, spray a small 
amount of a mild glass cleaner onto a soft cloth and wipe the screen.  Never spray the cleaner directly 
onto the screen, as it will drip down into the electronics. 
 

(d)  It should go without saying to never spill anything into the keyboard.  If, however, a liquid is 
spilled into a keyboard, immediately turn the computer off and turn the keyboard upside down to try to 
drain any excess liquid.  Next, spray the keyboard off with plain water, a bathtub and showerhead is the 
best method.  Lastly, dry the keyboard with a hairdryer set to medium/low heat.  You may be able to 
salvage the keyboard, but do not bet on it.  You should also occasionally vacuum the keyboard to 
remove any dust or crumbs that have accumulated. 
 

(5)  Manufacturer assistance. 
 
 (a)  Most manufacturers have technical support or help lines that can prove to be infinitely helpful 
when troubleshooting any problems; however, you should not immediately call them.  If you are 
experiencing problems, first use the owner's manual to try to diagnose the problem.  Always start at the 
beginning and ensure that all setup and start-up procedures were properly accomplished.  Operator error 
is usually the biggest cause of computer problems. 
 
 (b)  If you have established that you do indeed need technical help, first prepare yourself.  Help lines 
are usually very busy and the representatives do not have time to wait for you.  Before calling you will 
need to know make/model of all equipment being used, serial numbers of any software/hardware, and all 
technical information about your computer, such as the amount of RAM, hard disk size, additional  
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boards or devices installed, system software and version number, list of extra extensions or control 
panels.  Also have an emergency floppy or CD-ROM with system software to start up from.  Once you 
call, quickly describe the problem with as much detail as possible. 
 
 (c)  Usually the representative will try to walk you through several steps while on the phone.  For this 
reason, try to be at the computer when calling.  When they tell you to do something, remember that they 
cannot see your screen.  Be sure to tell them what to expect each step of the way. 
 
A-4.  DIGITAL CAMERAS 
 

a.  Cameras.  While it is common to scan regular film images and prints into the computer for digital 
handling, the real advantages come when using a digital camera.  The full potential of digital 
photography (including the speed, manipulation advantages and minimum of waste) apply when creating 
images with a fully digital system.  While digital cameras can be expensive for high quality systems, the 
savings earned pay for the start-up costs in the long run. 
 

b.  Digital versus traditional photography. 
 
 (1)  Traditional photography starts with a regular camera and silver or dye based film.  After the film 
is exposed, it is removed from the camera and processed in up to seven (for slides) different chemical 
baths, washing, and then drying.  Once the film is dry, projecting the negatives or slides onto 
photographic paper and again processing using chemicals makes prints. 
 
 (2)  This traditional process has several distinct disadvantages.  First is the amount of waste.  If only 
one image is needed when shooting roll film, an entire roll must be used.  This can become costly.  
Second, is the amount of time.  The processing and printmaking steps take a minimum of about 15 
minutes, using expensive automated processing equipment.  Slides take at least an hour.  Third are the 
hazardous chemicals involved in the process.  While not extremely dangerous, most photo chemicals are 
at least mildly caustic, and some are rather hazardous.  Last is storage of the chemicals.  Not only do the 
bulky, unused chemicals require storage, but the hazardous chemical waste also needs to be properly 
disposed of. 
 
 (3)  Digital technology does away with many of these problems.  Images are taken with a standard 
camera that has a Charge Coupled Device (CCD) where the film normally would be located.  After 
images are taken, they can be immediately previewed on the computer.  To transfer an image to the 
computer, just double click on the image.  To print the image, just click on the "Print" button.  There is no 
waste when only a few images are needed.  There are no chemicals to store or dispose of.  (Some 
digital printers use toner cartridges that are meant to be mailed back to the manufacturer, but the storage 
and handling of these is negligible compared to traditional chemicals).  Not only are these disadvantages 
eliminated, but also the entire process is much faster and you have the benefits of being able to 
electronically edit the photos before printing. 
 
 (4)  There are, of course, advantages to silver-based images.  While digital cameras and associated 
equipment can produce outstanding images, they do not have anywhere near the quality of medium and 
large format film.  A second advantage to traditional cameras is durability.  Electronic cameras have yet 
to be developed that can handle extreme weather and exposure conditions such as rain forests and 
arctic conditions. 
 

c.  Electronic cameras. 
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 (1)  A still-video camera is like a video camera without the tape storage drive.  Still-video cameras 
take analog images in two passes, first the even rows, then the odd ones.  This process is called 
interlacing and can result in fuzzy images with fringing on high contrast scenes.  To accommodate this 
interlacing, the still-video camera has smaller light sensitive cells rather than full-frame CCDs used in 
digital cameras. 
 
 (2)  Digital cameras are designed to provide a digital image from the group up.  Since digital 
cameras do not require the extra circuitry needed to interlace the image, the light-sensitive cells can be 
larger and closer together, thus providing a higher quality image. 
 

d.  Charge coupled devices. 
 
 (1)  Digital photography (as well as video technology) is based on CCDs.  A CCD is a multi-layered 
silicon chip.  In one layer a grid of electrodes divides the surface into pixels.  Each electrode is 
connected to a lead that carries voltage.  A color filter layer determines which primary color (red, green, 
or blue) each pixel senses.  The image is electronically formed on a layer of silicon substrate. 
 
 (2)  As a CCD is exposed to light, an electromagnetic reaction occurs.  Light particles pass through 
the CCD, freeing electrons in the silicon substrate.  A voltage applied to the electrode draws the freed 
electrons to gather in special areas (called photo sites) in the substrate.  The stronger the light, the 
greater the number of electrons drawn together at that site.  The CCD transfers captured electrons one 
by one to an analog-to-digital converter, which assigns each site a digital value corresponding to the 
number of electrons that site holds.  In this way the image is saved to the disk.  The number of electrons 
in a photo site determines how light or dark each pixel is in the image. 
 
 (3)  One consideration with CCDs is size.  Since most CCDs are smaller than the normal size of film, 
the effective focal length of the lens is increased.  For example, the Kodak Digital Cameras DCS 200 and 
DCS 420 have a CCD that is 9 x 14 mm.  This is less than the normal film size of the 35mm camera (24 
x 36 mm) that the camera is based on.  Because of this, the effective focal length is increased by 2.5 
times.  So, a 50mm normal lens becomes the equivalent of a 125mm telephoto lens.  In the telephoto 
range this has advantages because a normal 200mm telephoto becomes a long 500mm super telephoto.  
But a 20mm wide angle also becomes a 50mm normal lens.   
 
 (4)  Many photographers use a wide angle often, which is a disadvantage of a digital camera 
system.  This disadvantage can be overcome by using a digital camera with a larger CCD, such as the 
Kodak DCS 460.  However, these large CCDs are more expensive to manufacture, so the cameras are 
very expensive. 
 

e.  Image storage. 
 
 (1)  Another difference between a traditional film-based camera and a digital camera is how the 
image is stored once the photo is taken.  With a film-based camera, the image is stored on the film in the 
form of a latent image.  Each roll can only hold a limited number of images; and when they are all filled, a 
new roll is inserted.  Digital cameras work on a slightly different principle.  After the image is exposed, 
the digital image is written to built-in memory devices. 
 
 (2)  There are several different types of storage devices.  The DCS 200 has a built-in hard disk drive 
that can store about 50 images.  The drawback to a built-in drive is that when the drive is full, you must 
connect the camera to a computer to download or delete images to be able to take more photos.  The 
DC50 has a 1MB hard drive that will store 7 to 22 images, depending on the quality of the image.  This 
camera can also use a PCMCIA card, similar to the DCS 420.  The DCS 420 uses a removable PCMCIA 
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(or PC) card.  This card is about the size of a small stack of credit cards and has a mini hard disk inside.  
This hard disk can be various sizes up to about 230 MB, capable of taking about 60 images per disk.  
The benefit of using a removable PC card is that once one card is full, another can be immediately 
inserted. 
 
 (3)  Some of the less expensive digital cameras store images in battery-powered internal memory 
chips called Erasable Programmable Read Only Memory (EPROM).  The disadvantage to this memory 
option is that you must download the images when the memory is full.  Also if the batteries die, you will 
lose the images. 
 
A-5.  OUTPUT FUNDAMENTALS 
 

a.  Printers.   
 
(1)  While creating documents and images on the computer is fun and challenging, the real reward 

comes from having printed output; which is called a hardcopy–a paper or film print of your work that can 
easily be displayed or reproduced.  While it may sound easy to make a print, there are many different 
facets to the outputting process.  Color management, resolution, and line screen are just a few of the 
complex aspects of printing. 
 

(2)  Basically printers consist of a paper transport system, a marking engine, and a controller.  Paper 
transport is normally belt or roller driven.  The marking engine creates the marks on the page and is 
driven by a print controller. 
 

(3)  To create an image, most printers break the image down into small dots called halftones.  The 
dots in this halftone screen control how much ink is deposited at a specific location.  Varying the size of 
the dot creates the optical illusion of variations of gray or continuous color in the image.  In the case of a 
color printout, four halftone screens are used, which are cyan, magenta, yellow, and black (CMYK); one 
for each of the four process colors. 
 

b.  Types of output. 
 

(1)  Line art is illustrations or pictures made from solid lines and shapes.  Line art is black and white 
only, with no grays, shadings, or colors.  Sometimes line art is printed as a single color, such as red or 
blue, but the art source is always black and white (or a single color on white) lines only.  The text you are 
reading is line art because it's fully black with no shades of gray or color. 
 

(2)  When you take a photo, the resulting image is continuous tone.  To your eye, the picture 
contains even transitions of color across its surface.  Curved elements are smooth in their transition from 
light to dark.  In the case of a close-up photo of a young girl's face, there is no noticeable jump in color  
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between the top and bottom of her cheeks.  This natural appearing graduation is called continuous tone 
because the color transitions are even and smooth.  Photographs are actually made up of dots like a 
computer image, but these tiny particles are so numerous, random, and small that they are undetectable 
without a strong magnifying glass. 
 

(3)  Unfortunately, the most popular printing technology today, the lithographic press, can only print 
a solid ink dot or no ink at all.  To print a continuous tone photograph, a solution was devised that would 
allow continuous tones to print as a series of dots.  The solution is to produce a gray, print only part of a 
dot and leave part of it white.  That way the paper shows through next to each dot.  To the eye, this mix 
of white paper and a black dot appears as a gray.  To create a darker gray, larger black dots let less 
white show through.  To make a lighter gray, smaller dots let more paper show through.  This is called 
halftoning, a term you will hear frequently in publishing. 
 

c.  Printer types. 
 
 (1)  A dot matrix printer uses a set of pins or tiny wires that impact on an inked ribbon.  Dot matrix 
printers have as many as 25 to 30 pins.  The number of pins a printer has, and the number of passes the 
pin set makes for each line of type, determines the quality of the output.  A second type of impact printer 
is the daisy wheel printer.  These printers have high quality (up to 700 dots per inch (dpi)), but don't offer 
graphics printing because each character is on a separate wheel or ball and must be loaded onto the 
print mechanism, whereas dot matrix printers can create any pattern of dots. 
 

(2)  Ink jet printers are low-cost, moderate-quality printers that can print either black and white or 
color output with medium resolution.  They operate by squirting ink under pressure through small holes in 
the print head.  Ink jet printers are quite, reliable, and a good low-cost solution for desktop publishing and 
graphics.  Using Adobe Type Manager's ability to scale fonts, its print quality can be nearly 
indistinguishable from a laser printer.  Ink used on ink jet printers dries fast but not instantly, and care 
should be taken in handling fresh copy to avoid smudges.  A related technology called bubble jet printing 
uses heated bubbles to force ink through the nozzles. 
 

(3)  Laser printers are based on the xerographic process developed for photocopy machines.  The 
printer gets its name from the computer-guided laser that writes the latent image on a photosensitive 
drum.  Electrostatic toner is then attracted by static attraction created by a transfer corona, an electric 
field created by a very hot wire.  Laser printers are graphics page printers, meaning that whole pages are 
composed in RAM either in the printer itself or in the computer and then printed.  Most laser printers are 
built with a CPU to speed up the processing and come with 1 to 2 MB of RAM, often upgradeable.  As 
driving the laser requires considerable data, the instructions must be stored in the laser printer prior to 
the actual printing.  At 300 dpi, 8 million bits of data occupies about 1 MB of RAM.  Most laser printers 
can print from 5 to 10 pages per minute.  Although they are a complex technology, laser printers have 
excellent reliability and can print several hundred thousand pages or more before failure. 
 

(4)  Some of the most common types of color printers are called thermal transfer printers.  Most of 
the high-priced color printers in the $5,000 to $12,000 ranges are based on this technology.  These 
printers use dye, dyed ribbons, colored plastic or wax, or some other material that can be melted onto 
the page.  Often the transfer mechanism in the print head is a set of heated elements similar to those in 
impact printers.  The paper makes three or four passes through the printer to transfer the process colors.  
This may result in registration problems, where the colors do not all line up properly.  Most high quality 
thermal transfer printers lay down all of the colors in a single pass.  
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(5)  The second kind of color printing is called continuous tone or contone.  These have near 
photographic quality because the colors are blended together in a single pixel.  One class of thermal 
transfer printers, dye-sublimation printers, uses nearly the same mechanism as thermal transfer printers 
to achieve high quality contone printing.  These types of printers have resolutions up to about 400 dpi. 
 

(6)  An imagesetter is a precision printer that uses a laser to expose photosensitive paper or film.  
Imagesetters can produce either a piece of lithographic film that is used to make a printing plate, or some 
newer imagesetters can print directly onto a printing plate. 
 

(7)  A film recorder prints directly to a piece of film (from 35mm up to 8x10).  Because film is a 
continuous tone medium, a film recorder offers some of the best resolution output you can achieve from 
computers.  Low-cost film recorders in the $1,000 to $7,000 range employ miniature monochrome CRTs 
inside a sealed light box; less expensive analog recorders use color CRTs inside a box but have the 
limitation of poor resolution. 
 

(8)  A Raster Image Processor (RIP) is a computer, which converts the code from a desktop 
publishing system into a format acceptable to the imager.  It takes the lines and curves that make up 
graphics, plus the bitmaps that make up halftones, and renders them as a series of pixels matched to the 
resolution of the specific imager being used.  The RIP begins by breaking the file into individual objects, 
which it processes one by one until it has built a complete high-resolution bitmap.  The RIP then passes 
the bitmap to the printer, where the actual spots are placed onto the paper.  A major concern with RIPs is 
the speed of the processor.  Because the overall speed of the RIP is dependent on the amount of RAM it 
contains, most new RIPs have increased memory so that it doesn't hold back the rest of the system. 
 

d.  Resolution and dpi. 
 
 (1)  The main difference between an inexpensive ink jet printer and an expensive imagesetter is 
resolution.  Low quality dot matrix printers can create a dot size of around 7 mm (around 150 dpi), which 
is referred to as letter or near-letter quality printers.  Laser printers commonly have dot resolutions of 3.3 
mm or 300 dpi. This moderate quality permits sharp type down to around 6-point size and mediocre 
digital images.  Some newer laser printers can print at higher quality, around 600 dpi. 
 
 (2)  Imagesetters have dot resolutions of 0.4 mm or 2450 dpi!  This is high quality that results in 
sharp type to around 3 point and medium quality digital images.  Put another way, desktop printers 
produce ragged dots; imagesetters produce clean dots. 
 
 (3)  An understanding of resolution is central to effective printing and scanning.  The standard 
measurement of resolution is dpi.  This number specifies the number of dots scanned, displayed, or 
printed within one square inch.  A Macintosh screen has a resolution of 72 ppi (pixels per inch), which 
means that each square inch is composed of 72 by 72 dots (when discussing monitors, these dots are 
called pixels). 
 

(a)  When scanning, the input resolution is the precision at which an image is captured.  This 
resolution is set before the scan is made, although the resolution can be changed from within image 
editing programs. 
 

(b)  The Mac's screen resolution is always 72 ppi.  So, if you are looking at a color image scanned at 
300 dpi on screen and displayed at actual size, you aren't really seeing all of the information because the 
computer monitor can't display it. 
 



STP 11-25M13-SM-TG 

A-31 

(c)  The output resolution is specified when the image is output to film on an imagesetter.  This 
resolution is specified in dpi.  Different models of imaging equipment are capable of different levels of 
resolution, starting at 1270 dpi and going beyond 3000 dpi.  You can output a scan at a higher resolution 
than it was scanned with, but the result looks flat because the additional dots are created through 
interpolation, a mathematical guessing process. 
 

e.  Service bureaus.  Service bureaus are companies that provide computer output in a variety of 
forms as film separations, slides, transparencies, and color proofs.  They can take Postscript files 
created on the desktop computer and generate high-resolution film ready to be reproduced by an offset 
press.  Service bureaus can provide high quality film and imagesetter output because they have many 
customers and invest in expensive printers.  It is not economical for a small organization to purchase an 
imagesetter for only a few prints, when a service bureau may already have the equipment. 
 

f.  Fonts/typefaces. 
 
 (1)  When type was crafted out of lead, a printer's type collection could literally weigh a ton.  Each 
size and style of a typeface was a new font, and a type family consisted of many fonts in different sizes 
and styles.  Transporting a large type library from place to place was unthinkable.  Phototype, which 
succeeded metal type, was produced in only three sizes; small for captions, medium for text, and large 
for displays.  Intermediate sizes were obtained by varying the focal length of the projection lens, but 
many shops used just one size to produce all other type sizes. 
 
 (2)  Phototype is fragile and, like metal type, can wear out with constant use.  Today's digital type is 
easily stored on floppy disks that are easily transported.  Digital technology redefined the term font.  Now 
a single design is scaled to generate all type sizes. 
 
 (3)  Most current digital fonts use one of two core technologies–PostScript, developed by Adobe and 
TrueType, developed jointly by Apple Computer and Microsoft Corporation.  To understand these 
technologies, you need to know how monitors and printers display pictures. 
 
 (a)  Computer displays are made up of a grid of tiny dots called pixels.  Computers display type and 
other images on the screen by turning pixels on or off.  This display method is called a bitmap; a bit 
(short for binary digit) is the smallest unit of information the computer can use, representing one of two 
values on or off. 
 
 (b)  Instead of describing letters as a collection of dots, PostScript and TrueType fonts describe 
each character as a set of mathematical outlines.  A special piece of software called a rasterizer uses 
this single outline description to create many different sizes of bitmaps at the right resolution for the 
output device. 
 
 (c)  The rasterizer may be built into a printer, as with PostScript printers, or it may be a program that 
runs on the computer itself.  Adobe Type Manager (ATM) is a program that rasterizes PostScript fonts 
both for on-screen use and for printing to non-PostScript printers.  The TrueType rasterizer is built into 
the computer's operating systems and is also included in some recent PostScript printers.  PostScript 
fonts consist of a bitmap (screen) font and an outline (printer) font. 

 (4)  All computer platforms use a character set based on the American Standard Code for 
Information Interchange (ASCII), which allows 256 characters.  The upper and lowercase alphabet, 
numerals, and standard punctuation take up the first 128 characters.  These characters are defined the 
same way on all computer platforms.  Each platform handles the remaining 128 extended characters 
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differently (accented characters, ligatures, special punctuation, etc.) so translation between platforms 
can be problematic when using documents with extended characters. 
 

g.  Printing software. 
 

(1)  PostScript language. 
 
 (a)  PostScript provides a consistent format for handling files on different computers.  PostScript is 
actually a programming language for defining pages. 
 
 (b)  The power of PostScript is that it can accommodate a wide variety of images and is device 
independent.  This means that once a file is created in this format, it can be output on any device with a 
PostScript interpreter, and the file will print correctly.  The same Postscript file that produces a page at 
300 dpi on a laser printer can be produced on an imagesetter at 2400 dpi. 
 
 (c)  Adobe has created a standard (called Type l) for describing PostScript fonts.  PostScript 
optimizes the placement and arrangement of the dots on the page so that each character looks good 
printed or displayed at any size. 
 

(2)  QuickDraw.  QuickDraw is the Macintosh's internal screen drawing language, developed by 
Apple and used for representing type and graphics on Macintosh monitors.  QuickDraw's primary 
purpose is to represent information on screen, but it can also output images to printers and other 
devices.  QuickDraw translates this information into representations compatible with a video display.  
QuickDraw can represent complicated images on the screen, but is not as powerful or accurate for 
printing documents as PostScript.  QuickDraw does not create files that can be manipulated like 
PostScript files. 

 
(3)  Adobe Type Manager. 
 
(a)  ATM accurately renders PostScript typefaces on a Macintosh monitor the same way they will 

print.  QuickDraw without ATM cannot render most typefaces smoothly or accurately.  ATM is a system 
extension that replaces QuickDraw type rendering commands with its own.  Without ATM, 12-point type 
may look fine inside word processing software, but larger sizes, italic faces, and characters with swirls 
and flourishes may be barely readable.  With ATM installed, all Type 1 fonts will become fully readable in 
all sizes and formats. 
 
 (b)  ATM is also important for printing on non-PostScript devices, because it can be used to replace 
QuickDraw font routines and produce smooth output for Adobe Type 1 fonts. 
 

(4)  Font handling software. 
 
 (a)  When using a Macintosh, all of your fonts must go in a special folder in the system folder.  When 
you turn the computer on or launch a program, the system software scans this font folder and loads the 
fonts into the application.  The more fonts you have installed, the more system memory is used to 
manage them.  While an average user probably does not have the need for more than a dozen fonts, 
printing professionals may have hundreds of fonts. 
 
 (b)  To free valued RAM space we may use font management software, such as Suitcase II or 
Master Juggler.  These programs allow you to store your fonts anywhere you like.  You create sets of 
fonts to load with each program or document.  This is useful because only needed fonts are loaded, but 
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all are accessible.  Without these utilities, you have to manually move fonts in and out of the font folder 
and then restart the computer, which is a time-consuming process. 
 
 (c)  Menu Fonts is another handy font utility that displays font listings in the actual typeface of the 
font.  Without this software, you must either print out sample sheets or change some text to see the 
actual style of a font.  
 

h.  Quality control/color management. 
 

(1)  Color calibration.  As digital technology becomes more popular, it is even more important to be 
sure that you are producing the best possible results.  One of the most challenging aspects of digital 
photography and graphic design is to ensure that your final output looks as good as it does on the 
computer screen.  There are several things that we can do to help in this process. 
 

(a)  Keeping the light constant.  An important aspect of the calibration process is to maintain 
consistent lighting throughout your workspace.  For example, working in a dimly lit room with neutral 
colored walls minimizes interference from changing daylight and from color reflections from clothing, both 
of which can interfere with perception of color on-screen. 
 

(b)  Accounting for the artist's eye.  Another aspect is calibrating for perception.  Each person 
sees color and tone differently.  What may look good to one person looks bad to another.  The operator 
can compare an image file to several color proof prints of the same file.  With the proof in hand and the 
image on the calibrated monitor screen, you can choose the printed version that most closely matches 
the on-screen image. 

 
(2)  Device calibration. 

 
 (a)  The first step in calibration is to display and output a test target, including a neutral gray wedge, 
flesh tones, and RGB/CMYK color wedges.  Output to as many devices as you have (printers, film 
recorders, copiers, and so forth).  Next, using the screen gamma software supplied with your monitor 
calibrator, adjust the display to match the printed material as closely as possible. 
 
 (b)  If you are using a Macintosh, your monitor should be calibrated with a luminance-measuring 
device, like the ones available from display manufacturers.  This helps to adjust the monitor's CRT guns 
so that they reproduce the correct intensity relative to the input they receive from the video card. 
 
 (c)  Several adjustment tools found in Adobe Photoshop can be used to control the color, brightness, 
and contrast of scanned images before they are turned into custom prints, halftones, and color 
separations.  These tools are Levels, Curves, Brightness/Contrast, Color Balance, and Hue/Saturation 
commands that are primarily found under the Image menu and the Adjust sub-menu. 
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A-6.  IMAGE ACQUISITION WITH SCANNERS 
 

a.  Scanners. 
 
 (1)  Digital photography has many possibilities and uses.  We can store images for years with no 
image loss.  We can quickly and easily file, edit, and print these images.  Special effects are now easily 
within reach.  But what about all of the images taken before the advent of the computer?  What about the 
images that we are still taking with our current film-based cameras? 
 
 (2)  By learning to use scanners, we can transfer the negatives, prints, and slides that we already 
have into the computer and then have all of the digital benefits described above.  Scanners also allow us 
to use any art, image, or text that we already have in our digital documents. 
 

b.  Scanning basics. 
 
 (1)  A scanner converts the analog images that we already have (negatives, slides, flat art, etc.) into 
digital signals that the computer can handle.  The film scanner and flatbed scanner are two basic types 
of scanners. 
 
 (a)  A film scanner can either be a small desktop accessory or a large professional pre-press (called 
a drum scanner) model.  Film scanners transmit a high intensity light through the (positive or negative, 
B&W or color) film.  The light then passes through a series of color filters and a lens onto a light detector, 
where electronics convert the analog image information to digital data.  Slide scanners are typically of a 
higher resolution and have better detail and focus than flatbed scanners.  These types of scanners come 
in many sizes and prices, and can handle film from 35mm up to 4x5 or larger. 
 
 (b)  A flatbed scanner resembles a photocopier.  The lid is lifted and the original image is placed, 
face down, on the glass.  Beneath the glass, a motorized scanhead travels the length of the page on tiny 
rails, illuminating the original and measuring the intensity of the reflected light.  Many flatbed scanners 
now accept an optional transparency adapter for scanning slides and transparencies.  These scanners 
can be used to scan any type of flat art, such as text, illustrations, paintings, and so forth 
 

(2)  There are other types of scanners, those based on video camera chips that are generally low-
end and do not provide high quality images. 
 

c.  CCDs.  A CCD is an electronic chip that reads and measures light and converts it to digital 
signals for the computer.  Linear and array are two types of CCDs used in scanning devices. 
 

(1)  Linear CCD scanners. 
 
 (a)  Scanners employ a linear CCD array, which consists of several thousand CCD elements 
arranged in a row on a single silicon chip.  Reflective originals are lit by a fluorescent or halogen light 
source.  The light source moves the length of the original and then a mirror directs consecutive lines of 
image data onto the stationary CCD array. 
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 (b)  The full width of an image is read line by line as the sensor and light moves the length of the 
scanning area.  Light of a specific color and intensity falling on each CCD element creates a proportional 
electrical charge within it.  An analog-to-digital converter turns the voltages from the CCD array into 
digital values that correspond to image pixels. 
 
 (c)  Grayscale scanners take a single set of light intensity readings from originals.  Color scanners 
capture three sets of readings from color originals by using red, green, and blue filters.  Scanners that 
incorporate a single linear CCD array sometimes rotate an RGB color filter wheel in the len's unit before 
each of the three separate passes of the original are made.  Single-pass scanners may use three linear 
CCD arrays, which are individually coated to filter red, green, and blue.  The same image data is focused 
onto each array simultaneously. 
 

(2)  Array CCDs.  Where a linear CCD moves the length of the image area, an array CCD is larger 
and physically covers the entire image.  Most scanners use linear CCDs.   Arrays CCDs are usually 
found in digital cameras.  Array chips are more expensive to manufacture, because instead of being a 
few thousand pixels long and one pixel wide, they must be the same dimensions as the image to be 
recorded.  They are usually a few thousand pixels in length and width. 
 

d.  Scanning terms.  To most people the world of scanning is completely foreign, with many new 
terms and concepts.  Most of us have worked with computers and traditional photography, so these 
areas are not totally foreign, but scanning is almost completely new to us.  There are several key terms 
that we must first understand to be able to effectively use a scanner. 
 

(1)  Final resolution. 
 
 (a)  When we are preparing to scan, the first concern we have is how the image is going to print or 
display.  It is important to scan with enough detail to get a good output.  It is also important to conserve 
disk space and image processing speed by not scanning too much information into a file.  If we scan at 
the maximum resolution and we are only going to display the image on a screen, we are wasting space 
and time.  This is called overscanning. 
 
 (b)  If we scan a 4x5-inch image at 72 dpi, our file size is about 365 KB; if however, we scan the 
same image at 300 dpi, the file is about 6 MB; requiring about 20 times more storage space and 
processing time.  You can see how important it is to determine the proper scan resolution. 
 
 (c)  Desktop printers have resolutions measured in dpi.  By knowing the dpi of our intended output 
device, we can tailor the scanner settings to only provide enough information to give us a good output.  
The general rule for determining scanning resolution is two times the final output resolution.  For 
example, if our images are printed to a 400 dpi color laser copier, we should set the final resolution to 
800 dpi (400 x 2 = 800) before we scan. 
 
 (d)  Printer resolution depends on the type and brand of printer you are using.  Consult your owner's 
manual for your printer's maximum dpi.  However, most B&W laser printers have an output of 300 or 600 
dpi, while color laser copiers are around 400 dpi.  The Kodak XLS-8600 PS dye sublimation printer has a 
300 dpi output capability. 
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 (e)  You may also hear the term ppi.  This number is sometimes used interchangeably with DPI; 
however, they are not exactly the same.  PPI is the numbers of pixels per inch and should be used when 
referring to a monitor.  Macintosh monitors have a display resolution of 72 ppi, although most people just 
say 72 dpi. 
 
 (f)  Scanners are classified by their maximum resolution; for example one scanner may be a 300-dpi 
scanner while another is a 1200 dpi model.  These numbers mean that the scanner can scan up to the 
maximum indicated dpi value.  Some scanners (as well as some printers) use software technology to 
increase the stated maximums, which is called interpolation.  By analyzing the picture elements of an 
image, scanning software may increase the resolution by adding pixels between other pixels by guessing 
at what color the software thinks the new pixel should be based on the surrounding pixels.  This 
technology helps get better results, but an interpolated 600 dpi scanner will not give as good results as a 
true 600 dpi device.  Some laser printers do the same thing, guess at intermediate pixels, to help 
increase resolution.  Interpolation doesn't add detail to a scan, it just helps smooth information that is 
there and reduces jaggies often seen in computer output. 
 

(2)  Line screen.  High end outputting devices (imagesetters) produce images on four different  
plates or pieces of film.  Each plate represents the information of one of the CMYK colors.  To create the 
image, pictures are printed as a series of dots that is called a halftone screen.  The larger the dot, the 
darker the color appears; if you are preparing scans that will be printed by this process, you need to 
know the halftone screen frequency, expressed in lines-per-inch (LPI).  This number expressed as 135-
line screen is similar to the dpi value above. 
 

e.  Types of images to scan.  We may come across many different types of images that we want to 
scan color, B&W, line art, and so forth.  Knowing how the scanner handles each type of image, we can 
be assured of getting the best quality with the smallest file size. 
 

(1)  Line art.  Line art, drawings, or illustrations that only contain black and white lines and no gray 
tones are easy to scan.  Set your scanner to the Line mode or Black and White.  The only quality issue is 
proper density.  Be sure that once scanned, the desired white areas are white. 
 

(2)  Grayscale.  Black and white photos and shaded art can be scanned as grayscale images.  
Select the proper DPI of your printer and choose how many gray levels you desire.  You again must be 
sure that you have a true white.  You can control this in either your scanning software or image 
enhancement software, but remember it is always better to fix problems in the pre-scan. 
 

(3)  Continuous tone color. 
 

(a)  The most complicated images (and most often scanned) are color images that have many 
different tones.  We need to be sure that we scan correctly to preserve all of the detail of the original.  
Most scanning software has preset values for different film or image types, but we must not rely on these 
automatic features. 
 
 (b)  It is best to perform a pre-scan and then judge the quality.  Use the scanning controls to perfect 
the image before the actual scan.  Although it is possible to correct a bad scan, it is best to get it right the 
first time.  Much like traditional photography, we can make an acceptable print from a poorly exposed 
negative, but we will never get super quality. 
 
 (c)  When scanning images that have previously been halftone printed (art or photos from books and 
magazines), you will sometimes get an odd pattern called a moir pattern.  This is caused by the overlap 
of the halftone screen that the scanner uses and the halftone screen in the printed material.  To reduce 
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this, you must unsharpen the image after scanning.  Some scanners attempt to reduce the moir pattern 
during the scanning process.  Be aware of copyright regulations, when scanning preprinted materials. 
 

f.  OCR.   
 
(1)  OCR is software that can read typed pages.  When we type a page of text into a computer, we 

enter the actual letters that we want displayed.  These letters are converted to a binary code that the 
computer can understand.  We can go back at any time to change parts of the document.  When we 
scan a page of text, all we have is a picture of the page.  The computer sees light and dark areas on a 
blank background, not words and sentences.  We are not able to change this text.  If we use OCR 
software, we may be able to get some editable text.   

 
(2)  OCR software works by comparing the patterns of light and dark areas of the scan to known 

shapes of letters.  The software is programmed to identify lines and curves and compare them to the 
shapes of letters in the alphabet.  Generally, OCR is accurate, but we must always proofread the result.  
There are several things that we can do to increase the accuracy of OCR software. 
 

(a)  First, we should use a mono-spaced font when we plan to OCR a scanned document.  These 
fonts keep each letter the same space from their neighboring letters.  This helps the OCR software 
determine where one letter stops and another starts. 
 

(b)  Second, use a larger point size.  The larger the letters, the more accurate the OCR. 
 

(c)  Last, ensure that you have a clean copy to scan.  You may get better results if you photocopy a 
fax before scanning in for OCR.  Adjusting the density and contrast may also produce better results.  And 
remember, ALWAYS carefully proofread and spell check text that has come from an OCR program. 
 

g.  Scanning with different scanners. 
 

(1)  Nikon Coolscan Film scanner. 
 
 (a)  The Coolscan is a small, desktop scanner that is designed to scan 35mm slides or negatives.  
The Coolscan has a Photoshop plug-in that we will use to acquire images.  The Coolscan is a SCSI 
device that plugs directly into the Macintosh. 
 
 (b)  Film is inserted into the Coolscan emulsion up, either in a slide mount or in the provided film 
strip holder.  Gently push the film in as far as it will go without forcing it.  Now, use the Photoshop 
Acquire option found under the File menu to choose Nikon Scanner.  You will get the Nikon Scanner 
plug-in dialog box. 
 
 (c)  This dialog box provides many options for image type, resolution, cropping, and so forth.  
Consult the Coolscan User's Guide for detailed instructions and Coolscan usage tips. 
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(2)  Apple ColorOne, Microtec 600 ZS, Umax UC1260 scanners.  These scanners are all high-
resolution flatbed scanners that can scan in full color.  They accept material up to 8.5 x 14 inches.  They 
too are SCSI devices that can be chained to other devices attached to the Macintosh.  Like all flatbed 
scanners (and copiers), material to be scanned is placed face down, flush with one corner on the glass 
beneath the cover.  Operation of each of these scanners is similar, but consult the appropriate user's 
manual or software instructions for detailed guidance. 
 

(3)  Color calibration. 
 
 (a)  As we have learned, getting consistent color from the original to the scanned image in the 
computer and then out of the printer is the most challenging part of electronic imaging. 
 
 (b)  Each device has a different procedure for calibration.  Usually, you scan a calibration target or 
image and then print it to your normal output devices.  You next use a monitor calibration program to 
visually change the output of your monitor to make it compare to the original and to the print.  You can 
either visually compare the two samples or use a densitometer to check the actual color values.  Some 
output devices (film recorders and high-end printers) allow you to calibrate their output as well.  Check 
the operator’s manuals for your outputting devices (as well as your scanners) for procedures on 
calibration and consistency. 
 
A-7.  PRESENTATIONS WITH MICROSOFT POWERPOINT 
 

a.  Presentations.  A computer and presentation software together can help you make convincing 
presentations or speeches.  The power of the computer to combine graphic images, text, sound, and 
video is unmatched.  By following basic rules and guidelines, you can make electronic presentations that 
will convey your point in a professional manner.  Presentation software also speeds up the process of 
preparing for a presentation.  On the other hand, improperly used presentation software will make your 
work hard to understand and unwieldy.  There is a fine line between an effective presentation and a 
confusing display. 
 

b.  Preparation.  The key to producing an effective presentation is organization.  It is a good idea to 
sit down and think about a few things before beginning to work: 
 

(1)  Why am I giving this presentation? 
 
 (a)  This is perhaps the most important question to ask before creating a presentation.  Without a 
firm grasp of what the ultimate goal of the presentation is, the entire show will appear unorganized and 
ineffective.  You need to decide not only what the topic is, but also what you want the audience to leave 
with.  Try to create a firm concise statement that will be your goal, for instance— 
 

At the end of my presentation, my audience will have a working knowledge of how a black 
and white laser printer works.  Including how the image is placed on the paper and made 
permanent, how the toner is handled in the printer, and how paper is transported through 
the printer. 

 
(b)  As you can see by the example, we now have a clear goal for our presentation.  We are able to 

refer back to this goal whenever we need to clarify our direction.  Also, we will look at this goal after we 
have finished creating the presentation to see if we did indeed obtain our goal.  
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(2)  How much time do I have to give the show?  We need to know our time limitations before we 
start.  It would be silly to try to produce an effective presentation using the above goal if we knew that we 
only had 15 minutes to give our showing.  We may need to go back and change our goal if we realize 
that we are restricted by time. 
 

(3)  What is my audience's knowledge level?  It is important to know whom you will be presenting 
to before creating anything.  We must have an idea what our audience’s knowledge level is and then try 
to tailor our goal.  Our presentation must be challenging, but not too hard.  We do not want our 
presentation to be too simple either, or the audience may feel as if we are condescending to them. 
 

(4)  What will the presentation media be?  The last thing we need to look at is how we will be 
giving the presentation.  Although a good presentation can be presented in a variety of ways, it is best if 
we know what media will be used.  If we are using a screen, videotape, or video projector, we are able to 
use more video and sound.  If it is going to be printed and handed out, then we will not use color 
because color printing is probably cost prohibitive. 
 

c.  Arrangement.  Once we have a basic knowledge of what our presentation goal is, it is time to 
begin arranging and gathering information.  It is important to gather a wide variety of important related 
materials. 
 

(1)  Information.  The type of information that we use depends on the topic of our presentation.  We 
can use equipment owner’s manuals, magazine/newspaper articles, library books, reports, and factual 
statistics.  The more material and research we have, the more professional our presentation is.  Also, if 
we present facts, data, numbers and figures, our presentations will have more credibility than if we just 
give opinions or statements.  It is also important to find graphics, illustrations, and charts to incorporate 
into the show.  These types of information are easier to understand than long text descriptions or rows 
and columns of numbers.  Remember, the easier it is to understand a presentation, the more information 
the audience will retain. 
 

(2)  Outline.  Now that we know the types of information that we have available to use, we need to 
create an outline.  We should do this in a standard outline format; even better, we should do it in 
Microsoft Word.  Our PowerPoint presentation software allows us to import Word outlines directly into a 
slide show for very easy presentation setup. 
 
 (a)  The outline should begin with some sort of introduction and end with a closing where you restate 
your main points.  Do not put too much information into the outline at this point; concentrate on getting a 
logical smooth flow.  Try to include an entry for every major point that you want to make, and then put 
more and more information into logical sequence under the appropriate headings. 
 
 (b)  Go through all of your references and data and make notes as to where you feel the information 
fits best in the outline.  Do not create any graphs or charts or anything, just get an idea as to where 
information should be placed. 
 
 (c)  Now that we are reasonably well organized, it is time to start creating the presentation using 
Microsoft PowerPoint.  (Although we will learn PowerPoint, the same principles apply to any presentation 
application.) 
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d.  Microsoft PowerPoint.  PowerPoint is an extremely easy to use and effective presentation 
application.  It is part of the Microsoft Office suite of applications that all work together to blend text, 
graphs, and illustrations into one seamless show.  The first step in creating a presentation with 
PowerPoint is to choose a slide background (PowerPoint calls each screen of information a slide).  
PowerPoint has an option called Wizards that automates presentation production; we will not cover this 
option because you have more control if you create the show manually. 
 
 (1)  When you first launch PowerPoint, you are presented with the Start-up dialog box.  From this 
box, we will choose Template to create a new presentation and choose the background template.  
PowerPoint has many built-in colorful backgrounds and templates to choose from.  These templates not 
only are professionally colored and designed; they also have formats for many different types of slides.  
Templates are helpful for creating both beginner and advanced presentations. 
 
 (2)  When you choose Template, you are presented with a dialog box to locate the templates.  They 
are in a folder called Templates.  Inside this folder there are several folders of templates, depending on 
which type of presentation you are doing.  Choose the appropriate type of template (slide, screen, and 
overhead) for the presentation you want to create. 
 
 (3)  Once you have selected the presentation style, you next choose the slide layout for the first 
slide.  Using the preconfigured templates makes presentation production easy.  There are many different 
slide layouts to choose from.  These layouts use different color schemes, design elements, and 
organization to provide you with different feels for your presentations.  All you do is scroll through the 
layouts and double click on the one that you want to use for the first slide.  Generally a title slide is best 
for the first slide, usually the name of the presentation or something similar.  To add this text, simply click 
on the area that is labeled Click to Add Title. 
 
 (4)  You now have a title slide!  Let's take a look at the parts of the PowerPoint presentation window.  
This is the window that we will use to create our presentations. 
 

e.  PowerPoint presentation window. 
 

(1)  On the left edge of the screen is the Drawing Toolbar that provides you with tools you can use to 
create illustrations on your slides.  Most of these tools are self-explanatory and the best way to learn 
them is to just try them out. 
 

(2)  Like all Macintosh programs, there is a menu bar across the top of the screen.  This contains all 
of the normal commands found in a menu bar, such as options for saving, printing, viewing, and so on.  
We will not explain every feature of the menu bar, but will refer to commands as needed. 
 

(3)  Beneath the menu bar is the Standard Toolbar.  As we have said, PowerPoint is part of the 
Microsoft Office, so the Standard Toolbar is similar to other Office applications.  We find icons here to 
save, print, cut, copy, paste, and so forth.  There are also icons that represent importing Excel graphs 
and Word tables.  A zoom box also allows you to quickly change the size of the on-screen image. 
 

(4)  Next is the Formatting Toolbar.  This is located directly under the Standard Toolbar and contains 
all of the standard text formatting options.  There is a font and size window, as well as other normal text 
handling functions. 
 

(5)  The main part of the screen is the presentation window.  This is where the actual slides are 
shown while you are creating them.  In addition to scroll bars, there are five buttons in the lower left 
corner.  These buttons control the on-screen view of the presentation. 
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 (a)  The button on the far left is the Slide View button.  This button is used to view individual slides.  
You also have editing controls to add/change text or graphics in this viewing mode. 
 
 (b)  To the right of the Slide View button is the Outline View button.  This is used to view the 
presentation in outline mode.  From here you can work on the title and body text of each slide.  You can 
also easily import outlines from Word into a presentation. 
 

(c)  The center button is used to view the presentation in slide sorter mode.  This would be similar to 
viewing a group of slides on a light table.  You can move individual or groups of slides around.  This is a 
convenient way to polish a presentation after the text and graphics were entered. 
 
 (d)  PowerPoint allows you to create and print a lecture notes page.  This is a page that has the 
actual slide printed on it, as well as an area for you to enter any notes that you might want to add. 
 
 (e)  The last button on the right is the Slide Show View.  This button is used to view the slide as it will 
appear on the computer screen during an electronic presentation.  By clicking on this screen, the slide is 
enlarged to fill the screen and all menus and toolbars are removed.  Clicking the mouse button will switch 
to the next slide in the show.  This is a convenient way to preview the actual presentation. 
 

i.  Creating a PowerPoint presentation.  Now that we are familiar with the PowerPoint interface 
and we have decided on the basics of the presentation setup, it is time to add information to the body of 
the presentation.  Perhaps the easiest and fastest way to get started is to either import or create an 
outline in the Outline view.  This will give you a basic list of slides that you can then add information to. 
 
 (1)  To create the outline, first click on the Outline View button.  The information you entered onto 
the first slide will be on the first line.  This represents slide number one.  To add a new slide, simply 
press the Return/Enter key; you can now add information to the title of the second slide. 
 
 (2)  When presenting material, it is best to use bullet statements rather than long text blocks.  It is 
hard for an audience to read long passages on a screen.  Ideally, you should have simple bullets only a 
few words long that get your point across.  When you give the presentation, you will be able to expand 
on any points that need to be discussed.  Remember that the slides are designed to enhance your 
presentation, not replace the presentation. 
 
 (3)  To create bullet statements, simply click on the Arrow button on the far right side of the 
Formatting toolbar.  This button demotes the text on the line to the next lower level.  To add a bullet 
character on the line of text, click on the bullet icon, which is also on the Formatting toolbar.  You can 
handle text in all normal ways in the outline mode.  You can change font, size, formatting, and so forth. 
 
 (4)  Now that you have all of your information entered into the outline format, it is best to switch to 
the Slide View mode to look through the slides.  From this view of each slide, you can judge the basic 
flow of the presentation.  You are also ready to format any of the text in any special ways.  Just use the 
Arrow pointer to click and select the text.  You can now change the text size, color, or justification. Once 
you have created enough slides to cover all of your material, you are ready to add graphics and 
illustrations. 

j.  Creating/adding graphics and illustrations. 
  

(1)   PowerPoint makes it easy to draw simple shapes and other objects that you can use in your 
presentation.  Perhaps the easiest way to draw is to use the AutoShapes Toolbar.  Click on the icon in 
the Drawing Toolbar, to get the AutoShapes Toolbar.  This box will give you a selection of 24 commonly 
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used shapes.  Click on the desired shape and then simply drag on the slide window to place and resize 
the shape. 
 

(2)   To draw freehand objects, simply use the Freeform Tool.  With this tool you can click in different 
spots to draw straight lines or drag to draw free curved lines.  Once you have completed your drawing, 
you can handle your drawing in the same manner as any of the AutoShapes. 
 

(3)   Once we have the shape placed, we can then edit its color, size, and position. 
 
 (a)  To change its color, use the arrow icon from the Drawing Toolbar to select the items.  (Click near 
the border of the shape to select it.)  Next, click on the Fill (on/off) button also on the Drawing Toolbar.  
This will fill the item with the default color.  To change the default color or to add a pattern to the color, 
choose Colors and Lines from the Format menu. 
 
 (b)  It is easy to change the size or dimensions of an object. Simply select the object (as above) and 
then drag on any of the control handles (small dots that surround the selected object).  In this manner 
you can resize the object or change it proportionally.  If you hold down the Shift key while dragging a 
corner, the dimensions will stay proportional. 
 
 (c)  Position and rotation are the two ways to change the location of an object.  To reposition the 
object on the slide, select it and then move the cursor into the middle of the object.  Now just drag it 
around on the screen. 
 
 (d)  To rotate the object, again select it and then click on the Free Rotate Tool in the Drawing 
Toolbar.  Dragging from any of the selected corner points will freely rotate the object to any desired 
angle.  You could also select the object and choose Rotate/Flip from the Draw Menu.  This option allows 
you to flip or rotate in 90-degree increments. 
 

(4)  Professionally drawn clip art can make any presentation look better.  PowerPoint allows you to 
import art from either the Microsoft clip art collection or from other art sources.  To add Microsoft art, 
choose Clip Art from the Insert menu.  Just scroll through the art and choose the art to add.  To add 
other art (or photographs) choose Picture from the Insert menu.  Navigate to the appropriate disk or 
folder and select the item to add.  Images in PICT, TIFF, EPS or MacPaint format can be added.  Once 
clip art or photographs are added, they can be resized, moved, or rotated just as other graphics. 
 
 h.  Creating graphs and charts. 
 

(1)  Graphs and charts are used to present data in easy to understand formats.  PowerPoint can 
create graphs using the accompanying Microsoft Chart application. 
 
 (2)  To add a graph/chart, create a new slide and click on the Chart button on the Formatting toolbar.  
The application Microsoft Chart will launch. 
 
 (3)  You will then be presented with a standard example data sheet.  The easiest way to create a 
graph is to change the information in this data sheet to reflect your own needs.  You will need to change 
the actual data, along with the headings and labels.  Clicking in the data field allows you to change each 
entry.  If you are importing information done in Microsoft Excel, you will use the Import Excel Information 
button. 
 
 (4)  There are many different types of charts available.  Depending on your type of information, you 
can create pie graphs, bar graphs (horizontal or vertical), scatter diagrams, and several others.  You can 
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also create either two or three-dimensional charts of each type.  To change the graph type, pull down on 
the Chart Type drop down menu and drag to the desired chart type to preview your data in different chart 
types. 
 
 (5)  You can add legends and labels to the chart using the Add Legend button on the Standard 
Toolbar.  You can also adjust the rotation, elevation, and perspective of 3D graphs by using the 3D View 
option under the Format menu. 
 
 (6)  PowerPoint picks the default color for graphs.  If you desire to change these colors, click on the 
graph color you want to change and then just pick a new color or pattern from the Graph Toolbar. 
 
 (7)  As you can see, PowerPoint has many options for charts and graphs.  We have only briefly 
covered the beginning options.  As we have said before, the best way to learn all of the functions is to 
just experiment. 
 
 i.  Adding Quicktime videos.  Quicktime is Apple computer's standard digitized video format.  
PowerPoint allows you to place these digital videos into a presentation.  Adding video and sound to a 
presentation greatly enhances the impact of a presentation.  To add a Quicktime video to a presentation, 
open a new slide and choose Movie from the Insert menu.  You set the play option in the Play Settings 
dialog box found under the Tools menu. 
 
 j.  Adding organizational charts. 
 

(1)  Organizational charts are used to graphically represent the flow or chain of command within an 
organization.  These types of charts are easy to understand and provide a graphical view of complex 
management or production flows. 
 
 (2)  To add an organizational chart in PowerPoint, create a blank slide and click on the Insert Org 
Chart button on the Standard Toolbar.  The application Microsoft Organization Chart will launch and you 
will have a basic template of an organization chart. 
 
 (3)  Fill in the boxes with the names and titles of people in the organization.  To remove an 
unneeded box, click on it and then hit delete.  To add levels, choose what type of box you wish to add 
and click on it in the Menu Bar.  Then click on the box that you want to attach the new box to. 
 
 (4)  The types of new boxes to add are relatively self-explanatory.  Adding a Subordinate attaches a 
box under the box you select.  CO-Worker adds one to the same level; Manager adds one above; and 
Assistant adds an assistant box to the level you click on. 
 
 (5)  The Menu Bar provides options for colors, line styles, chart types, and other formatting and 
display options. 
 k.  Adding tables.  Creating a table in PowerPoint is exactly like creating one in Word.  As a matter 
of fact, when you choose the Insert Table button from the Standard Toolbar, Microsoft Word will launch 
and you create the table in this application.  You can use all of the AutoFormats as well as any other 
Word functions.  When you are satisfied with the look of the table, simply close the window and you will 
return to PowerPoint.  Now you can reposition and resize the table.  Also you can add a shadow or 
change the line color. 
 
 l.  Arranging slides, transitions, and builds. 
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(1)  Once you have created the bulk of your slides, it is time to rearrange them if necessary.  The 
best way to do this is to first change to Slide Sorter mode.  In this mode you can see the overall view of 
the slides.  Look through them to see if there are any that obviously needs moving.  To move a slide (or 
group of slides), select the slide(s) to be moved and drag until the large marker is where you want the 
slides placed.  It is then a good idea to change to Slide Show mode and watch the entire presentation to 
judge the flow and content.  Go back and add, remove or change any slides that are not easy to 
understand.  When you are satisfied with the flow of the presentation, you should add transitions and 
builds to polish it off. 
 

(2)  Transition effects are used to change from one slide to the next.  PowerPoint offers many 
different transition effects.  To choose which effect to use, select the slide (or group of slides) and then 
use the Transition pull down menu to select from the list.  There are many different dissolves, fades, 
checkerboards, window shades, and the like.  There is also an option for random choice, where 
PowerPoint randomly picks a transition effect.  When using transitions, it is best to pick one and use it 
throughout the entire show to add continuity.  Some of the options require a long time to change from 
slide to slide, so pick one that is fast enough and does not keep you waiting.  There is a timing option 
that you can use to rehearse your show and record the times that you manually leave each slide on 
screen.  PowerPoint will record these times into your presentation and can automatically advance slides 
at the correct time, if you desire.  To use this option, select the Rehearse Timing button on the Slide 
Sorter Toolbar.  To play back using these times, select Slide Show from the View menu and then check 
the Use Slide Timings option. 
 

(3)  Builds are similar to transitions, except builds are used to complete a transition between lines of 
type on an individual slide.  For example, you can have the slide title appear as soon as the slide is on 
the screen, and then you can have the first line of text fly in when you click the mouse button (or at a 
preset time).  The next line will then fly onto the slide when you are ready for it.  Builds are effective 
when used with bullet text.  They keep the audience interested and anticipating the next bit of information 
that you can feed them.  There are several ways to set up a build.   

 
(a)  The first method is to select Build from the Tools menu, while in Slide View mode.  You will be 

presented with a dialog box with several options.  The first line, Build Body Text turns the build on or off.  
Check this box to activate the build.  The second line, Dim Previous Points is used to change the color of 
previous lines of text.  Again, this is helpful in keeping the audience on the correct point.  The last line 
allows you to choose how the text will appear.  Like transitions, there are many options to choose from, 
but it is best to pick a simple one and stay with it. 
 
 (b)  The second way to specify builds is to select the slide or group of slides in the Sorter mode and 
use the pull down menu to select the type of build.  This is used to set a build for a group of slides or an 
individual slide. 
 

m.  Lecture notes and handouts.  Once you have completed the presentation, you may want to 
make handouts for the audience to use during the presentation.  Additionally, you may desire lecture 
notes which can be used by you (or whoever is giving the presentation) during your speech.  PowerPoint 
makes it easy to create both. 
 

(1)  Lecture notes. 
 
 (a)  Lecture notes are simply sheets of paper that have the slide on the top and space for presenter 
notes on the bottom.  To add notes or comments to the slides, click on the Notes Page view button in the 
lower left of the slide window.  You can now enter any information into the Lecture Notes area.  You can 
change the size, font, and style of this text. 
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 (b)  To change the layout of the Lecture Notes page, choose Notes Master from the Master pull out 
menu under the View menu.  Using this function allows you to change the size, shape, and position of 
the slide picture.  You can also add text to the master that will appear on every slide.  You can add or 
change text boxes or text attributes using this function. 
 
 (c)  Lecture notes are often overlooked when creating a presentation.  Properly prepared lecture 
notes will greatly aid in the presentation.  Notes help to keep the presenter on track and focused.  They 
remind you of important things to say or stories to tell.  It is important to have some sort of notes to give a 
professional presentation. 
 

(2)  Handouts. 
 
 (a)  Handouts can be used to give the audience something to take with them.  When you choose 
Handouts from the print dialog box, PowerPoint prints multiple slides on one piece of paper.  You can 
choose from 2, 3, or 6 slides per page.  Handouts are recommended if you use a lot of charts or graphs.  
It is best to give the handouts after the presentation, so that the audience will focus on you during the 
show instead of digging around in the handout. 
 
 (b)  To print handouts, choose Print from the File menu and then select the number of slides to print 
per page in the Print What pull down menu.  To change the format of the handout or to add text to all of 
the pages, choose Handout Master from the Master pull out menu under the View menu.  Now you can 
add or change things, just as in the lecture notes. 
 

n.  Output.  The last step in creating a presentation is output.  As we have discussed, there are 
several different ways to give a presentation.  PowerPoint provides you with options for outputting to 
practically any display type you desire.  The most practical and easiest way to output is to give a 
presentation on a computer monitor. 
 

(1)  Using a computer monitor is easy when only one or two people will see the presentation at a 
time, but a large monitor or projection screen is required for a large class.  To display to a screen, go to 
the first slide and click on the Slide Show button in the lower left corner of the slide window.  The 
presentation will play, using the builds and transitions you have specified.  You can decide whether to 
have the show self-running or to change slides or builds at the click of the mouse button by choosing 
Slide Show from the View menu. 
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(2)  To print a presentation, select Print from the File menu.  You are presented with a dialog box 
asking what you want to print. You have many choices, such as Slides with builds, without builds, notes, 
outlines, and so forth.  You also have other print options, depending on what type of printer you are 
using.  This is how you would make overhead transparencies if your printer is capable of it. 
 

(3)  To create 35mm slides you must have a film recorder.  The method for recording to film depends 
on the type of recorder used.  Some film recorders are used exactly like a printer,  
here you select the recorder from the Chooser, and then just Print.  Other brands require special 
software and may connect to the SCSI port of the computer. 
 

(4)  By putting a presentation on videotape, you can easily and inexpensively transfer the show to 
many others.  To record to video, you must connect a VCR to the computer.  Some Macintoshes (the 
"AV" models) allow you to directly connect the VCR, while non-AV models require a hardware adapter.  
To record to videotape, set up the hardware, press Record on the VCR, and show the presentation.  If 
you connect a microphone, you can add narration and sound.  Be sure to use high quality videotape to 
get the best possible image. 
 
A-8.  COMPRESSION AND ARCHIVING 
 

a.  As we have learned throughout this course, there are many different file formats and types, each 
with their own uses and benefits.  In this section, we will explore the need for standardized file formats 
that can compress the data.  We need to compress these files to conserve space on our storage devices 
and to reduce transmission and copy times.  It is also important to understand the best way to store 
images into image archives for quick and easy access.  An image or file that is stored but cannot be 
located is useless. 
 

b.  Lossy and loss-less are two different types of compression.  As their names indicate, you may 
lose image quality with one and there will be no loss with the other.  There are benefits and 
disadvantages of each type. 

 
(1)  Lossy compression. 

 
(a)  Lossy compression schemes, such as JPEG, squeeze the image data into a much smaller 

space, but may result in less image quality.  As we have said, the JPEG compression algorithm analyzes 
the color values of each pixel in the image and performs an average on them.  To compress an image 
JPEG divides the image into many 8 pixel x 8 pixel blocks.  It then analyzes each of the pixels in the 
block and if there are similarly colored pixels, it will average them into one color.  This averaging process 
results in a final image that has less detail than the original. 
 
 (b)  JPEG compression format has a variable compression rate, meaning that you set the amount of 
compression that you want.  When you choose "Save As..." in Photoshop and then select the JPEG 
option, you will get a dialog box that asks for the quality level you need, from Low Quality to Max Quality.  
These options change the amount of compression as well as the final image quality.  For example, a 
400k TIFF image with maximum JPEG compression is reduced to a 34k file size.  The same image with 
minimum compression (for maximum quality) compresses to about 85k. 
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 (c)  When you are using JPEG compression, you must be willing to sacrifice a loss of image quality.  
Usually this loss is unnoticeable; but if you are printing a JPEG image on a high-resolution printer, you 
will notice the decrease in quality.  Areas of the image that have a gradation of color, such as the sky, 
will usually show banding.  This is where there is not an even, gradual color transition, but rather rows of 
colors that abruptly change to the next color.  JPEG should be avoided on these types of images.  
Whenever you use a lossy compression, you must decide on the trade-off of quality versus transmission 
speed. 
 
 (2)  Loss-less compression. 
 

(a)  There are other options that allow you to compress an image with no loss of image quality.  
These compression algorithms, called loss-less, cannot compress the files as much as a lossy method, 
but they do not lose any image quality either. 
 
 (b)  Huffman encoding is a variable word length encoder.  This means that redundant data is 
identified and grouped together as one code.  For example, binary data such as a string of fifteen 0s can 
be grouped together into one code that represents the number 15, "101."  This saves 12 bits of storage 
or transmission.  When the image is decoded, the "101" is converted back into the long string of fifteen 
0s.  Huffman encoding is primarily used to compress binary data, such as a Postscript file.  Some 
programs do not recognize this type of file; PageMaker is one of them.  Usually Huffman encoding is 
transparent, meaning the user does not know that it is even happening.  There are no options or settings 
pertaining to the use of Huffman encoding.  Programs that use Huffman will compress and decompress 
at the appropriate time and you will not even know it. 
 
 (c)  Limpel-Ziv-Welch (LZW) compression (named for the people who invented it) is very similar to 
the Huffman method, except instead of substituting individual characters, LZW searches and substitutes 
strings of similar data.  Again, this is a loss-less compression so there is no loss of data.  LZW 
compression is most commonly associated with the TIFF file format.  When you save an image in TIFF 
using PhotoShop, you can choose with a check box whether or not to use LZW compression.  The only 
reason not to use LZW is that your file will take slightly longer to open and save, since the computer 
must do the compression and decompression. 
 

c.  File compression programs such as Alladin's StuffIt Deluxe use run-length encoding algorithms 
such as LZW and Huffman encoding to compress files.  These programs are mainly used to compress 
files that will be sent via modem, or for storing files not often used.  These programs are mainly used to 
compress documents such as word processors and presentations or binary files for programs that will be 
transferred.  Since images are usually already compressed with either JPEG or one of the loss-less 
algorithms, using StuffIt will not further reduce the file size. 
 

(1)  While not actually a way to compress a file, BinHexing a file allows it to be transmitted through 
the Internet as a text file.  Macintosh files contain two parts, the resource fork and the data fork.  If you 
try to send a Mac file through an email program, it may not transmit properly.  By BinHexing the file, you 
convert both parts into plain text that can be easily sent through email.  Most email programs actually do 
all of the conversion for you so you do not need to worry about it. 
 

(2)  Much like BinHex, Uuencode converts binary files into text files that can be sent through email.  
Uuencoded files are much more common among non-Mac computers, but some Mac programs and files 
come this way if they are stored on other types of machines.  Again, most email programs automatically 
decode these files, or StuffIt Expander can decode them for you. 

d.  There are applications such as Disk Doubler and Stacker that work on loss-less compression 
schemes but are designed to compress and decompress the entire hard disk that you use.  These 
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programs usually double your hard drive capacity but slow down performance because of the 
transparent compression.  Usually these programs work fine; but if your drive crashes, all information is 
lost because disk recovery programs like Norton Utilities are incompatible and cannot recover driver-
level compressed files. 
 

e.  When you first take a picture, you usually have a use planned for it.  It may be newsworthy or 
perhaps it is simply a photo of a reenlistment or cake cutting.  We usually take these pictures and print 
them to give out or publish.  After the immediate uses are over, what then do we do with the pictures?  
Sometimes they are thrown away or the negatives are filed away (archived) for later use.  When we use 
digital pictures, we can easily store many images in a very small space and have instant access to them.  
Access is the key to archived images.  If we cannot easily locate and get to a picture, what good is even 
keeping it? 
 
 (1)  Archived images must be easy to find, and they must also be high quality.  Kodak has 
developed the PhotoCD format that is ideal for long-term image storing.  PhotoCD format saves each 
image in several different resolutions on one CD-ROM that will last practically forever.  When creating 
PhotoCDs, the user can decide which resolutions to save as.  This determines the number of images 
that can fit on each CD disk.  The different resolution settings are called the ImagePac format.  This 
format allows the CD author to store in up to five different resolution levels, from small low-resolution 
"thumbnail" reference images to huge high-resolution pictures that can be used for printing.  Generally, 
you should store each image in both a low resolution for fast cataloging and at least one high-resolution 
file for actual use. 
 
 (2)  When cataloging with a program such as Adobe Fetch, you attach keywords, captions, 
photographer data, or other information to the image.  This attached data is all automatically cross-
referenced and can be used to search for images based on any known information.  These search 
functions are the key to archiving images because unless it is easy to retrieve, an image is useless. 
 

f.  Adobe Fetch is a cataloging application that is used to catalog, search, and retrieve all types of 
files.  Using Fetch you can catalog images, sounds, digital videos, text, presentation files, and practically 
any other file.  Fetch creates a catalog of files that has a thumbnail image or icon of each cataloged item.  
A user can create an unlimited number of separate catalogs, with up to 100,000 images per catalog.  
Each cataloged item can have an unlimited number of keywords attached to it for fast searching and 
cross-referencing, as well as a 32,000-character caption or description. 
 
 (1)  A feature of Fetch that is invaluable for cataloging images from CD-ROM is that the images in 
the catalog do not have to be on the computer that maintains the catalog.  For example, you catalog all 
of the images from a disk and then remove the disk.  Fetch keeps small file thumbnails on the hard disk, 
allowing you to search and view the contents of the removed CD.  When you try to open a higher 
resolution copy of an image, Fetch will prompt you to insert the needed CD.  This allows you to keep all 
of your images on separate disks, safely stored away, but still searchable and accessible. 
 
 (2)  Fetch is one of the easiest programs to learn and use.  To catalog a disk or folder of files, just 
drag the folder onto the Fetch icon.  The program will launch, scan the disk for files that can be 
cataloged, create thumbnails of them, and then save them all automatically.  You can now remove the 
disk of images. 
 
 (3)  When first using Fetch, you will have to create a catalog for images.  It is a good idea to decide 
on a cataloging scheme before starting.  You should decide on how many or what type of catalogs to 
use.  Perhaps having one catalog for each year, or perhaps one for each type of job (portraits or 
presentations) would be good; however, do not make too many catalogs.  This defeats the purpose of 
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being able to quickly search for documents.  The type and amount of work that you do will control your 
cataloging, but a yearly catalog is a good starter. 
 
 (4)  Once Fetch has cataloged each item, you can view the thumbnails by choosing "Find..." from 
the Search menu.  Click Find All to display all of the items in the catalog.  You will notice icons for the 
items with the file type and location printed below.  Some items such as sounds and text files will just 
have a document icon, not a thumbnail. 
 
 (5)  Key wording is the most time-consuming part of using Fetch and also the most important.  In 
order to effectively search for a file or image, it must be logically keyworded.  This means you must enter 
in words that Fetch will associate with the cataloged item.  When Fetch adds items to a catalog, it 
creates keywords reflecting the item's file type, creation date, size, and so forth.  But this is not enough 
information to efficiently search.  You must select the item and then choose Keywords from the Edit 
menu.  Fetch displays a dialog box that shows the keywords already attached to the item; these cannot 
be edited.  At the top of this dialog box is a line for you to enter words.  Once you enter a keyword, click 
Add to add it to the list of searchable keywords. 
 
 (a)  When adding keywords, it is important to be consistent and thorough.  The catalog is only as 
good as its keywords.  If more than one person is entering keywords, be sure that some rules are made.  
For example, have everyone use the word airplane for a picture of an airplane.  If one person uses 
aircraft and another uses plane, the catalog is hard to use.  However, you can attach more than one 
word to an item so that a search for plane will also find airplane and aircraft, as well as helicopter, jet, F-
16, and A-6 if plane was included with each of these other terms as it should be.  Remember that the 
more keywords used, the better the search is.  See the Adobe Fetch User Guide for in-depth information 
on key-wording strategies. 
 
 (b)  You do not need to enter the same information over and over.  You can select many items (by 
shift clicking) and then choose Keywords to add the same keywords to all selected items.  This is useful 
when you have several shots of the same subject from different angles or at different exposures. 
 
 (6)  There are two methods for searching a Fetch catalog (other than manually browsing through all 
of the images).  You can either do a simple search or a complex search. 
 
 (a)  Selecting Find from the Search menu does a simple search.  Click on the box below the Find 
Items Whose Text to make the search area active and then enter a keyword in the field.  You can use 
the two pull down menus to alternate between searching options.  When you are satisfied with the 
searching setup, click Find.  Fetch searches through all of the images in the catalog and opens a window 
displaying every image that meets the search criteria. 
 
 (b)  A complex search is done the same way as the simple method, but you click the More Choices 
button to enter more than one-search criteria.  This allows you to refine the search for a specific image.  
This is useful if you have a very specific image or desired image in mind.  The simple search finds 
images that match general criteria, while the complex search can narrow this down to a few specific 
images. 
 

g.   Being able to quickly search through large catalogs to find specific images is useful, but 
integrating Fetch with other programs allows you to also directly copy Fetch images into page layout, 
image editing, or any other application.  This is useful when you are creating documents and do not want 
to manually search disk after disk of images.  Fetch may be used with some of the applications listed 
below. 
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(1)  PageMaker 5.0. 
 
 (a)  To transfer images from Fetch into PageMaker, first select the desired images in Fetch.  Then 
choose Copy Reference from the Edit menu in Fetch.  Be sure to choose the Include Thumbnails option.  
Next, switch to PageMaker. 
 
 (b)  In PageMaker, open the Library Palette from the Window menu.  In the Library palette Options 
menu choose Import Fetch Items.  There's now a thumbnail image of the placed item in the Library 
palette.  To place the item into a document, click on it in the Library and then click where you would like 
to place the object. 
 

(2)  PhotoShop 3.0.  To include a thumbnail image and to preview a PhotoShop 3.0 file, choose the 
Preferences option in PhotoShop's File menu.  Choose General preferences and then click the More 
button.  Move to the Image Preview section and click the Always Save option. 
 

(3)  Illustrator 5.5.  To include a thumbnail image and preview an Illustrator file, choose "Save As..." 
from Illustrator's File menu.  Save the image as an EPS file. 
 

(4)  Microsoft Word.  To preview and catalog Word documents they must be saved as either Text 
Only, Text Only With Line Breaks, or Text With Layout.  Fetch will then include these items in catalogs 
and will allow you to preview the first 32,000 characters.  Word documents will have a generic file icon in 
a Fetch catalog. 
 
A-9.  COMMUNICATIONS 
 

a.  History. 
 

(1)  Telegraph.  The first time two machines talked to each other was in 1844 when Samuel Morse 
sent a message from the US Capitol building in Washington, DC to Baltimore, MD, 37 miles away.  This 
was the first use of the telegraph, and it was the beginning of the modern area of communication.  With 
the invention of the telegraph, people hundreds of miles away could now send and receive messages in 
very little time.  Telegraphs allowed users to send a code (Morse code) of information back and forth 
across a single wire.  While not a computer, a telegraph was the precursor to modern communications, 
as we now know it. 
 

(2)  Telephone.  The telegraph, which required the user to know Morse code and to have special 
training, was certainly fast, but it did not bring communications to the individual.  The telephone brought 
communications to the people.  The telephone opened up mass communications.  Introduced in 1876 by 
Alexander Graham Bell, the telephone immediately became a success and is still a favored means of 
communication. 
 

(3)  Teletypewriter.  Around the turn of the century, the teletypewriter became widely used for the 
communication of non-voice messages.  The teletypewriter was ideal to disseminate large amounts of 
information to multiple stations.  A user in New York could type in the information (usually news stories) 
and at the press of a button, automated machines all along the network would begin printing out the 
same story.  Teletypewriters use the Baudot code instead of Morse.  This code is faster than Morse and 
allows the machine to print out a maximum of 62 different characters.  Teletypewriters are still in use to 
some extent today, but have been widely replaced by fax machines and modems. 
 

b.  Modern day communications. 
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(1)  Modem. 

 
 (a)  A modem is a device that allows computers to communicate across telephone lines.  Modem 
stands for modulator/demodulator, and what a modem does is modulate or change the computer's binary 
codes into tones that can travel across the phone lines.  When these tones get to the other computer, 
another modem demodulates these tones back into the computer's binary language. 
 
 (b)  Invented in the late 1950s, the Bell 103 was the first modem.  This modem allowed two 
computers to talk to each other at a rate of 300 bits per second (bps).  Modern modems now talk at more 
than 28,800 bps!  While slow by today's standards, the Bell 103 was an important invention because 
even 300 bps are faster than using the post office. 
 
 (c)  As we have learned, a modem converts the digital 1s and 0s (on and off) into tones or pulses.  
These pulses are then converted back into ones and zeros.  An inherent problem with this type of 
communication is the actual telephone lines.  While voices may sound fine, even the slightest static will 
disrupt data communication.   
 
 (d)  Another problem is speed.  Although 28,800 bps is much faster than 300 bps, it is still relatively 
slow.  At 28,800 bps it will take about 5 minutes to transfer 1 MB of data (at 300 bps it would take 8.6 
hours to transfer the same 1 MB!).  While this is a relatively short amount of time, it can quickly become 
longer with large (more than 50 MB) files.  Also, the longer it takes to transfer a file, the higher the 
chance of static error.  In the future we will have to switch to digital or fiber optic phone lines to increase 
speed.  These types of lines are already available, but still relatively expensive. 
 

(2)  Speed standardization.  
 
 (a)  When any new technology develops, everyone wants to jump on the bandwagon.  This 
happened when modems first began developing.  Everyone was developing and making their own 
modems, but problems started developing.  Different modem makers were each making their modems 
slightly different and these differences caused problems.  Finally the CCITT, a standards organization, 
got together and created some industry wide standards. 
 
 (b)  V.22bis (bis means second in French) was the first standard.  The V.22bis standard was the 
standard for 2400 bps communication.  All modems that used this standard could finally communicate. 
 
 (c)  The next standard was the V.32 standard for 9600 bps communication.  V.32bis standard for 
14,400 bps (sometimes called 14.4 pronounced fourteen dot four) and V.34 standard for 28,800 bps 
(28.8 or just twenty-eight eight) followed this.  Each of these standards assures that modems from  
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different manufacturers can properly work with each other.  You may see a modem labeled V.fast; these 
were produced before the V.34 standard was instituted and may not properly communicate at 28,800 
bps. 
 

(3)  Compression/error control standardization.  In addition to creating standards that control the 
rate of data transmission, the CCITT also created some standards for other telecommunications issues. 
 

(4)  Error control/correction. 
 
 (a)  Error control or error correction is a way to assure that the receiver properly receives the 
information that the sending modem sends.  Modems that use error correction incorporate a code into 
the transmission.  When the receiving modem decodes the message, it will know if any data was lost in 
transmission.  If it discovers missing data, it sends a message to the sender and asks for a rebroadcast 
of the missing area. 
 
 (b)  The two modern CCITT standards for error control/correction are MNP 5 and V.42.  Modems 
that are designed to use these standards will properly communicate with other modems of these 
standards. 
 

(5)  Data compression.  The CCITT also created a standard for data compression.  Compression is 
a way that the modems squash the data before sending it.  They expand the data when it is received.  
This helps to speed up the transfer of information.  However, modems must be able to use the same 
compression formulas.  To assure compatibility, the CCITT created the V.42bis standard for 
compression.  Any two modems that conform to this standard can compress and decompress 
information properly. 
 

c.  Communication terms.  Whenever you learn about a new technology or subject, you must learn 
a new vocabulary.  Communications is certainly no different.  Although it may sound complicated, there 
are not that many new terms. 
 

(1)  Handshaking.  When two modems first connect with each other, they know nothing about each 
other.  They must go through a procedure called handshaking.  When this is happening, they exchange 
information such as their speed standard, compression, or error control.  This process of negotiations 
and familiarization is called handshaking. 
 

(2)  Data bit.  When configuring your communication software, one of the settings you adjust is the 
number of data bits.  When computers send information across telephone lines, they break the data 
down into bits, making it easier for the computers to manage the information.  Different modems use 
different numbers of data bits usually either eight or nine.  To properly communicate, both computers 
must be set at the same number of data bits. 
 

(3)  Stop bit.  While transferring these bits of data, the computer adds a bit called a stop bit on the 
end of the data bit.  The stop bit tells the receiving computer that all of the information in that bit was 
received. 
 

(4)  Networks.  A network is simply more than one computer connected together.  It can be both 
economical and time saving to network computers together.  First, when you have a network of 
computers, you can keep one central printer and connect it to the network.  Whenever anyone prints  
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something, it comes out at the central printer, eliminating the need to have a printer at every station.  A 
network can also save time, because you have one central database or file area and everyone on the 
network can instantly access it without leaving their desk.  There are several different types of networks. 
 

(a)  Local area networks (LANs).  A LAN is the most common type of network.  This is where all of 
the computers in one office or building are linked together.  The computers can all share a printer and 
databases, and the operators can even access information directly from their coworkers' computers.  
There are different types of LANs and each type has its pros and cons. 
 

• LocalTalk or AppleTalk is the built-in networking that the Macintosh comes with.  In a LocalTalk 
network, individual computers directly link to each other.  Although extremely easy to set up and 
convenient when only two or three computers are networked, LocalTalk networks are relatively 
slow (only about 28 Kbps) and unreasonable for large networks. 

 
• Ethernet is a common type of high-speed network.  With an Ethernet network, each computer is 

connected to a central hub that contains a microprocessor.  This hub allows extremely fast 
connections (up to about 10 Mbps).  Ethernet networks are the most common types used in 
LANs. 

 
• Token-Ring is another common network.  A Token-Ring network is similar to Ethernet, but the 

language is slightly different. 
 
• Transmission Control Protocol-Internet Protocol (TCP-IP) is the type of network that the Internet 

uses.  Ethernet and Token-Ring are hardware and software networks, meaning that you must 
have the correct hardware (connectors, wiring, circuit boards) and software language.  TCP-IP is 
a language that is common to all computers connected to the Internet.  TCP-IP can be used over 
Ethernet and Token-Ring, but it is usually just used on the Internet. 

 
(b)  Wide area networks (WANs).  A WAN is nothing more than LANs connected together.  For 

example, a business that has offices in New York and Boston can be connected in a WAN.  Both of 
these offices will have LANs so that coworkers can share printers and data.  If the company decides to 
connect these two separate LANs using fiber optics, special telephone lines, or microwaves, then they 
create a WAN.  While you would not necessarily use a WAN to share a printer, you certainly could set up 
one database so that offices all over the world could have access. 
 

(c)  Commercial networks.  A commercial network is one that individuals or companies pay to 
access.  These networks are setup to make money and offer many different resources.  Users with 
access to a commercial network may be able to use on-line encyclopedias, databases, mailing lists, 
software files, and many other types of resources.  The largest group of users of commercial on-line 
networks is home users.  Several common commercial networks are America Online, Compuserve, 
Delphi, and Genie.  The Bulletin Board System (BBS) is another type of commercial network.  A BBS is 
usually local to one city or area.  A system operator (Sysop) runs a BBS.  The BBS offers services similar 
to the larger commercial services, but on a much smaller scale. 
 

(5)  Internet. 
 
 (a)  The Internet is a vast, mostly unorganized, global network of computers.  In the 1950s the US 
Government wanted a way to link all of its computers together so that in the event of a nuclear war, the 
military would always have access to data stored across the country.  This network became known as 
the Advanced Research Projects Agency Network (ARPANET).  Well, the nuclear war never came so the 
ARPANET dissolved into what is the current Internet. 
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 (b)  In the 1980s the National Science Foundation (NSF) took over the ARPANET and began linking 
college and university computers to the existing network, thus allowing students and staff all over the 
world to access vast databases and resources. 
 
 (c)  In the late 1980s and early 1990s many commercial networks and BBS began providing Internet 
access to home users.  The Internet is now estimated to have about 2.5 million computers permanently 
connected.  In addition to these 2.5 million permanent computers, it is estimated that another 18 million 
computers are connected by either dial-up accounts or through terminals at businesses and colleges. 
 
 (d)  Presently the Internet is going through some dramatic changes that may seriously affect its 
future.  The NSF is turning their high-speed data backbone and supercomputers over to private industry.  
This will allow increasing commercialization and profit making on the global network.  It is still unclear 
how these changes will affect the end user, but the general consensus is that services will generally stay 
the same.  There will most likely be an ever-increasing amount of data available and the Internet will 
continue to grow. 
 
 (e)  Another major concern with the Internet today is censorship.  Since its conception the Internet 
has been unregulated and self controlling.  With all of the current advances and increased popularity, 
there are concerns that there should be more control over what is on the Internet.  Because there are all 
types of explicit material on the global network, censorship would effectively shut down the Internet.  
There are many questions that have no answers when it comes to the censorship issue.  Who would be 
in charge of deciding what material is deemed offensive?  Who would police the Internet?  How do you 
handle a network of computers that spans the globe and many different cultures?  How would you locate 
and prosecute offenders?  When a society begins to pass laws that are unenforceable, as any Internet 
censorship law would be, this only breeds contempt for other laws.  The Internet should remain a free 
forum for the open exchange of thoughts, ideas, and information. 
 

(f)  Unlike the commercial on-line services, the Internet is not set up as one organized unit.  There 
are several key areas of the Internet, and software was developed to make the functions easier.  You will 
need several different applications to accomplish all of the functions available.  
 

(6)  File transfer protocol (FTP). 
 
 (a)  FTP is one of the most used Internet services to transfer files from one computer to another.  A 
file can be anything that is on the computer.  Application programs, photographic images, books, 
documents, video clips, and sounds are all examples of files that can be transferred from one computer 
to another. 
 
 (b)  Various universities and organizations have set up computer sites that offer huge archives of 
files to download.  These sites are usually referred to as anonymous FTP sites.  What this means is that 
anyone can log into these computers and access the files that are stored there.  When you attempt to log 
into these computers, you are asked for a user ID and a password.  Most computer systems that allow 
public access will accept "anonymous" as a user ID and your email address as a password.  When you 
remotely connect to a computer and control its actions like this, it is called a Telnet session.  So, a  
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typical Internet conversation may sound like this:  "Why don't you Telnet to my computer and FTP that 
file."  What this means in plain English is "Why don't you connect your computer to mine through the 
Internet and copy that file."  Telnet and FTP work two ways. 
 

• Not only can you log onto other user's computers, but also they may be able to attach to yours.   
 
• Additionally, not only can you get files using FTP, but you can also send files to others using FTP. 

 
(7)  Gopher, Veronica, and Archie.  These weirdly named Internet functions are used to search for 

information.  To use these, you use a program designed for these functions, log onto a server computer, 
and enter what you are searching for.  The computer then searches through its databases and reports 
what information matches the search query.  The program you use will provide a report listing the 
number of matches, as well as how close of a match it is.  For example, if you search for Apple 
Macintosh Computers, the search program looks for all occurrences of these words.  Therefore, anything 
with any of these words is reported.  An item with all three words is listed first because it is a 100 percent 
match. 
 

(8)  Wide Area Information Servers (WAISs).  The WAIS is similar to Gopher and Veronica, but 
much more powerful.  The WAIS allows you to ask specific questions in plain English and then searches 
vast indexes and reports any matches.  These servers are useful for searching the global network for 
documents on specific topics.  To do research on using a Mac as a graphics workstation for example, 
you would enter "Tell me everything about using a Macintosh computer as a graphics workstation.”  The 
WAIS would then search all of its databases and give you a list of items.  You would read one or two of 
the items, and then you could modify the search by telling the WAIS to "Search for more like this one or 
Search again, but ignore items that are similar to this."  This makes the search more precise and helps 
you find better information. 
 

(9)  World Wide Web (WWW). 
 
 (a)  The WWW or just the Web is the newest and perhaps the most functional Internet feature.  The 
WWW uses a graphical interface to present screens of pictures, text, sounds, and video.  Using the 
WWW you can connect to remote machines and access information.  Many companies, libraries, and 
organizations have created homepages on the WWW.  A homepage is simply a table of contents for the 
information on the WWW.  Each screen or document on the WWW is linked together with hypertext, 
which means that specific keywords, called links, are all joined together.  When you come across a link, 
you can click on it with the mouse to automatically move to another location for more information.  For 
example, if you are at the Apple Computer homepage (located on a computer in Cupertino California), 
and there is a link to monitor resolution (for example), you can click on the text link and automatically 
move to the new computer.  This new link may be on the same computer in California or across the 
globe in Europe, and you would never know it. 
 
 (b)  This hypertext technology makes it quick and easy to find information and related material.  You 
may also find links to FTP sites and searchable databases.  The WWW incorporates most of the 
functions of the Internet into one easy to use format and interface.  The future of global computer 
networks will probably be something like the Web. 
 



STP 11-25M13-SM-TG 

A-56 

(10)  Electronic mail. 
 
 (a)  Electronic mail or simply email allows you to instantly send notes to anyone that has an email 
address.  Much like regular letter mail (called snail mail by the techno-savvy), email is used for anything 
from personal letters to business mail. 
 
 (b)  Email is basically instant.  The time it takes to send a letter and for it to be received can be as 
little as a few seconds to as much as an hour or two.  This makes business run much faster.  Unlike 
regular mail, you can send more than just letters through email.  You can attach any file that you would 
like to an email.  You can send pictures, programs, or other documents without having to mess with 
sending disks or removable media through the mail.  Because email is much faster and easier then snail 
mail, people have a tendency to be short and to the point.  You must be careful not to mistake this for 
rudeness. 
 
 (c)  Another concern with email is quoting.  Since it is extremely easy and quick to send and reply to 
email, people quote messages in replies.  Quoting helps to refresh the memory of the person who you 
send email to.  It is easy to forget what you say, but if you selectively quote parts of the message in a 
reply, it can jog a memory. 
 

(11)  Newsgroups. 
 
 (a)  Newsgroups, or Usenet News or Internet News as they are sometimes called, are similar to 
electronic bulletin boards.  There are thousands of different newsgroups; each one devoted to a different 
topic.  You subscribe to groups that interest you and when you read the news, you read all new 
messages.  After the first time, every time you log onto the news server, you only see messages that are 
new or you haven't read.  You can post reply to messages or just read other people’s postings. 
 
 (b)  Newsgroups are moderated or unmoderated.  One person controls moderated newsgroups.  
When you post something to a moderated group, the moderator first reviews the posting and decides if 
the entire group should see it.  Unmoderated groups have no control and everything that is posted is 
sent to everyone.  This can lead to problems of having the same questions or information posted over 
and over. 
 
 (c)  Newsgroups are sorted using a hierarchy system.  One typical newsgroup is comp.mac.sys, 
which the first part (comp) means that this group is under that computer topic; it is next broken down into 
the Macintosh (Mac) subdivision; and finally the system (sys) subtopic.  There are many different major 
topics, but Computers (comp), Alternate (alt), Social (soc), Science (sci), Recreation (rec), and News 
(news) are the major topics.  Each one of these is broken down into many different very specific 
individual newsgroups. 
 

(12)  Mailing lists.  Mailing lists are similar to newsgroups, but instead of logging onto a central 
repository to read new messages, mailing lists are delivered through email.  Mailing lists work much like 
traditional snail mail mailing lists.  You sign up (or automatically get signed up) on a list and every time 
someone sends something to the mailing list, it goes to everyone on the list.  There are many topics 
similar to those on the Internet News. 
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(13)  Internet relay chat (IRC). 
 
 (a)  The IRC is similar to a CB radio.  You log onto an IRC computer server, and you can 
automatically "talk" back and forth to anyone else logged onto the IRC around the world. 
 
 (b)  When you log on, you are presented with a list of several hundred channels, each one with a 
different topic.  You can join a channel (or more than one) and see in real-time what people are typing 
back and forth.  There are channels devoted to every imaginable topic, from debates over which 
computer are best (Mac or Windows) to cybersex channels where people from around the world discuss 
explicit sexual matters!  (Not for the faint hearted!) 
 
 (c)  The IRC can be lots of fun to use to meet people from around the world, but it can also be used 
to get quick advice to problems.  For example, you can sign onto a channel devoted to graphic arts and 
ask professionals how to accomplish certain tasks. 
 

d.  Internet concerns. 
 

(1)  Addresses. 
 
 (a)  The Internet is new to most people, so there are lots of new terms and information to learn.  The 
first thing we must understand is Internet addressing. 
 
 (b)  Every computer or user on the Internet has a unique address to identify it.  There are several 
different types of addresses, and they must not be confused.  The most common type of address is an 
email address, which looks something like this:  bob_jones@one.af.mil.  The part before the @ is the 
name of the specific user, Bob Jones in this example.  Notice that there is no capitalization or spaces.  
The _ (underline) is commonly used instead of a space.  Additionally, most users choose something 
easy like bjones or bobj.  The @ symbol (shift 2) means at and separates the user name from the 
machine name. 
 
 (c)  After the @ comes the domain name.  This is the name of the machine that the user is using.  
The first part is the name of the computer at the location.  Some places, usually schools, have more than 
one server computer, so the first name is the specific computer.  Next, separated by a period ( . ), is the 
name of the institution, in this case af for Air Force.  Finally is mil meaning that this computer is in the 
military domain.  Other domains are edu for education, gov for government, com for commercial, net for 
network, and org for organization.  These domains only apply to US computers; other countries use 
slightly different systems.  Most computers outside of the US have a two-digit code at the end, such as fi 
for Finland.  You can identify where the computer is located by the code. 
 
 (d)  Another example, maryjane@blue.ut.edu.ca would be said "Mary Jane at blue dot UT (say "U" 
"T") dot EDU (rhymes with "met you") dot CA ("C" "A")."  So, the address is for Mary Jane at the 
University of Toronto (ut) in Canada (ca) on the computer named Blue.  In the domain of education that 
sounds pretty complicated, but it really isn't. 
 
 (e)  The Universal Resource Locator (URL) is another type of address.  URLs are common when 
referring to the location of a file and not a specific person.  A common URL looks something like this:  
http://www.apple.com/pub/PowerMac/power.mov.  This URL points to a file called "power.mov" located 
on the Web. 
 
 (f)  The http:// part means that the document is part of a hypertext link; www means World Wide 
Web; next is the machine name, which in this case is Apple in the commercial domain; and next is the 



STP 11-25M13-SM-TG 

A-58 

specific directory where the file is located.  In the UNIX world, files are stored in directories instead of 
folders.  These directories can be nested inside each other just like folders.  So in our example, the file 
power.mov is located in the PowerMac (/PowerMac) directory, which is inside the public (/pub) directory. 
 
 (g)  Again this may seem complicated, but it is a standard used by all computers on the Internet so 
you only need to learn one standard. 
 
 (h)  You may also see URL that look like ftp:// .  These are like http:// addresses, but they point to 
files that can be downloaded, and not hypertext documents. 
 

(2)  Internet etiquette.  
 
 (a)  As we have discussed, the Internet is a new place for most people so there are new sets of 
common courtesies to learn.  We have already discussed email, and the fact that since email does not 
involve as much forethought as snail mail, we may have a tendency to be less than cordial.  Since you 
cannot see the writer or hear the tone of voice, it's easy to misconstrue the meaning of things.  Internet 
users have developed smileys to help convey emotions.  Smileys are simple pictures drawn with 
characters on the keyboard.  When viewed from the side, they look like little faces. 
 

• This is a regular smiley:   :-)      There are many variations of this smiley.   
 
• Here is a winkey or a winking smiley:   ;-)   
 
• Now a smiley sticking his tongue out:   :-p   
 
• Here is an unhappy smiley:   :-(   

 
 (b)  Smileys are used in email, newsgroups, and on the IRC.  They allow you to add a bit of feeling 
to an otherwise unemotional medium.  A well placed smiley can make the difference between making 
someone happy or making an enemy. 
 
 (c)  Another etiquette concern is flaming.  Flaming is sending hate email or posting derogatory 
messages on newsgroups.  Flaming usually results when two people disagree or when someone posts 
something that angers people.  While flaming (sometimes called Flame Wars) can be fun to watch, it 
really wastes a lot of time and space on other people's computers and should be avoided.  If you do 
accidentally upset someone and find yourself being flamed, it is best to either ignore it or send a nice 
apology. 
 

(d)  Next we have frequently asked questions (FAQ), which is a list questions.  FAQs are posted 
throughout the Internet, usually on newsgroups.  When you are using a new part of the Internet for the 
first time, it is best to look for the FAQ, before asking questions.  It can be time-consuming and tiring for 
everyone involved having to answer the same questions over and over to every new user.  This brings us 
to lurking. 
 

(e)  Lurking is watching and reading before jumping into an on-line conversation.  Whether it be a 
newsgroup discussion or a channel on the IRC, it is best to read what others are saying before jumping 
in with your comments.  This allows you to see exactly what is being discussed and at what level the 
discussion is on.  Although lurking is good for beginners, remember the Internet is all about people and 
to use the full potential, you must participate. 
 

(3)  File transfer.  
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 (a)  As we have already learned, file transfer (or FTP) is used to move files from one computer to 
another.  Of all the different uses of a computer with a modem, file transfer is probably used the most.  
We will want to quickly send and receive photos and other types of images from distant locations to our 
home bases.  There are two principal ways to transfer files. 
 
 (b)  The first way involves using the Internet.  To use this method, both parties must have Internet 
access and must agree on an FTP site.  There are many FTP sites that allow users to store files on their 
computers, and most Internet access providers allow users to do this.  So the originator would log onto 
the Internet, telnet to the agreed upon computer, and FTP the files to it.  Then, at their convenience, the 
receivers can telnet to the computer and FTP the file to their own computer.  This method is convenient 
because either party can do it at their leisure.  The only problem with this method is security.  When the 
files are on a public computer, they are available to anyone with Internet access.  There are two ways to 
work around this.   
 

• First the file can be encrypted.  There are many commercially available encryption programs that 
will encrypt up to DES standards.  This allows the sender to encrypt the file, and only the 
receiver, who has the key code, can decode and use the file. 

 
• Another way to ensure secure communications is to have a secure Internet computer to FTP the 

file.  Most large companies and government agencies have computers attached to the Internet.  
If the receiver has access to a computer permanently attached to the Internet, they can set up a 
password and user name for the sender.  Then the sender simply telnets to the secure computer 
and FTPs the file. 

 
 (c)  The second way to transfer files through telephone lines is to set up a direct connection.  This 
method involves the sender calling the receiver's computer directly (or the other way around, it really 
doesn't matter who calls who).  You can use regular terminal software to do this, but then there has to be 
someone at the receiver's computer to initiate the receipt of the file.  Most people who transfer files this 
way use special software that allows them to control the remote computer.  When using this software, 
you can see a window of the remote computer's desktop, and you can control it as if you were sitting in 
front of it.  To transfer the files, you simply drag them from your computer to the remote window.  Apple 
Remote Access and Timbuktu Remote are two programs for the Macintosh that allows you to remotely 
control a computer. 
 

(4)  Compression. 
 

(a)  Many files, especially photographic images, can be rather large.  Imagine a picture that is 8 MB 
in size; at 28.8 Kbps, it would take almost 50 minutes to transfer the picture.  This can get rather 
expensive if you pay by the hour, not to mention tying up phone lines.  Compression programs were 
developed to squash the file to a much smaller size.  This smaller size obviously takes less time to 
transfer and saves money.  Compression programs compress images by analyzing the binary 
information that makes up the colors or tones.  Since there may be large areas of the same color in a 
picture, the computer can bunch all of this information together and save space. 
 
 (b)  Compression programs are defined by their compression ratio—how much they can squash a 
file.  The higher the ratio, the more compression and the smaller the compressed file.  Lossy and Loss-
Less are two types of compression programs.  Lossy yields the best compression ratio, but may lose 
image quality. 
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 (c)  Lossy compression involves a loss of quality, meaning that the decompressed image will not 
look as good as the original.  A common lossy compression is called JPEG.  JPEG stands for Joint 
Photographic Experts Group, which is a group of professionals in the photo field who created the 
compression type. 
 
 (d)  When using JPEG, you are presented with several quality options.  The options correspond to 
the image quality.  For example, if you choose the Best Quality option, you will not loose as much quality 
as if you had chosen the Fair Quality, but the file is not as small either. 
 
 (e)  JPEG compression works by sampling a small area of an image (usually a 64 x 64 pixel square) 
and analyzing the contents of the area.  JPEG uses mathematical formulas to average the color in the 
sampled area.  It then deletes the original color and replaces it with the average.  By doing this on the 
entire image, it can greatly reduce the size of the file; but as we have said, JPEG is a Lossy compression 
so the uncompressed file may not be as good a quality as the original. 
 
 (f)  Loss-less compression does not degrade the image quality.  Stuffit Deluxe is a program that 
does loss-less compression.  This application, and many similar programs, can be used for any file, not 
just images.  This is useful for transferring any file from computer to computer. 
 
 (g)  While using the Internet and other on-line services, you may encounter many different file types.  
Most files have a three-letter extension on the end of the file that represents the type of compression.  
Stuffit Deluxe is capable of expanding almost any of these files, so it or the shareware program Stuffit 
Expander is a must for anyone who regularly uses on-line services. 
 
A-10.  ETHICS 
 

a.  Today's electronic technology.   
 
(1)  The ethical and legal issues surrounding photography, retouching, and digital imaging are 

issues of great debate.  Being military photographers, you will have access to an abundance of images 
and footage not available to the civilian media.  It is the responsibility of the military to make guidelines 
and rules for policy of manipulating military images. 
 

(2)  The importance of ethics in electronic imaging will grow extensively as computer image 
processing technology expands.  Already, desktop scanners and software packages are common in the 
electronic media world.  Soon, so will digital cameras.  Anyone with a properly configured personal 
computer can extend the limits of a traditional camera. 
 

b.  The accompanying dilemma. 
 
 (1)  It's apparent that digital photography has reached the masses at all levels of the civilian and 
military sectors, which has created a dilemma—to retouch or not to retouch.  As more people edit 
photographs on computers, photographers are finding it difficult to maintain control over their work.  
When the photographer's point of view as an eyewitness is lost, variance between fact and fiction is 
easily misinterpreted.  Possibilities are almost endless as to what enhancements and manipulations can 
be made on the computer. 
 
 (2)  Many photographers have reacted negatively to computer technology after years of seeing their 
works reproduced without permission.  Many of today's photographers are hesitant to allow electronic 
copies of their images into a publishing world that has become unconcerned about photographic 
copyrights and the ethics of retouching.  Yet computer imaging also offers great promise—new markets, 
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wider and easier distribution of photographs, the ease of transferring an image, and more effective 
storytelling through multimedia publishing on CD-ROMs. 
 

c.  The ethics of retouching.  It used to be said that the camera never lies.  That was before digital 
photography.  Now, we are in a new age of picture-perfect image processing.  With this new breed of 
computer imaging comes the tempting power of electronic retouching.  Some have called it disturbing 
and corrupt.  Others argue that it is merely a more powerful extension of the creative darkroom. 
 

d.  Photographs as accurate historical records. 
 
 (1)  In the past, documentary photographs were proclaimed as authentic, factual pieces of 
information.  Digital Imaging technology changed that understanding; however, the basis for a believable 
documentary photograph still remains. 
 
 (2)  Photojournalists were considered reporters with cameras, recording events as eyewitness 
observers.  They document powerful and unusual events capable of invoking strong emotions.  
Regardless of branch of service, documentary photography will depict a factual account, and in no way 
can these images or footage be altered. 
 

f.  The ethics of digital manipulation. 
 
 (1)  As photographers we have the responsibility to document society and to preserve its images as 
a matter of historical record.  It is clear that the emerging electronic technologies provide new challenges 
to the integrity of photographic images.  This technology enables the manipulation of the content of an 
image in such a way that the change is virtually undetectable.  The National Press Photographers 
Association, a respected civilian news organization, has released the following statement: 
 

"We believe photojournalist guidelines that are currently in use should be the criteria for 
judging what may be done electronically to a photograph.  Altering the content of a 
photograph, in any degree, is a breach of the ethical standards recognized by the NPPA." 

 
 (2)  Although, military photographers do not necessarily belong to organizations such as this, the 
policies that they adhere to are good for us as well. 
 

f.  Photographs are not reality. 
 
 (1)  A photograph is a three-dimensional object that is placed on a two-dimensional plane that is 
made up of bits of silver or dyes that communicate information about a moment in time.  There are 
properties used in photographing and printing these two-dimensional objects which, with common use  
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and agreement, have come to be accepted as reality.  There are some extent patterns of grain, light, 
cropping, of dodging and burning, and so forth, which have come to be associated with the intention of 
truth and accuracy. 
 
 (2)  These principles are not yet accepted as a whole by the media, television broadcasters, or 
magazines.  Tastes, ethical standards, social expectations, and perception of nature of truth evolve.  TV 
Guide can juxtapose various images to ridicule a point with minimum complaint, but when a magazine 
with the stature of National Geographic alters an image, it damages its creditability. 
 
 (3)  There have been numerous instances of editors choosing to spruce up a certain image, like an 
image of the Challenger space shuttle mishap.  The San Jose Register was mocked when they inserted 
clouds into a photo of the Challenger explosion that they felt was not dramatic enough.  To sum it up, 
there can be no one set of standards applicable to all users of photography at all times.  Any set 
standards must be site specific. 
 
 (4)  What is needed is a set standard that can be utilized worldwide.  It has been suggested that the 
use of a symbol (M) for electronically manipulated photos be used to identify the images that have been 
altered in any way.  But that can also be considered as prejudicial by only identifying the electronically 
altered photographs and illustrations. 
 
 (5)  There are several degrees of change.  Major or essential changes are those that change the 
nature of the image.  Minor changes are usually just technical changes, such as spotting out dust and 
scan lines.  Most technical changes are considered ethical, while major changes are considered 
unethical. 
 
 (6)  To put George Bush into a picture from Yalta would be a major change.  Whereas moving the 
pyramids a little closer together, though massive in reality, is only a minor change since it does not 
change the basic information of the picture.  The pyramids picture is no longer an accurate photograph 
but the essential information has not changed. 
 

g.  Electronically manipulation functions.  The following is a list of specific electronic manipulation 
functions and a discussion of each in terms of electronic versus digital manipulation.  Photo labs, 
schools, newspapers, and magazines wishing to set ethical standards for their publications need to look 
at these seven areas where abuse can occur and then decide what is the appropriate response for their 
circumstances. 
 

(1)  Contrast control.  We are use to controlling contrast and photographers know that they can 
give an apparent sharpness by increasing contrast.  Contrast control is a basic, traditionally accepted 
form of darkroom manipulation.  You will find it hard to dispute contrast control, which is widely accepted 
in both traditional and electronic darkrooms. 
 

(2)  Dodging and burning-in.  These are two of the most basic printing skills of a good 
photographer.  Too much burning-in is today considered unacceptable in the traditional darkroom and 
will also be unacceptable in an electronic darkroom.  One of the fears of photographers is that untrained 
eyes in the production department will dodge and burn for them and take the interpretive function from 
the photographer.  This is a valid fear, but it only becomes an ethical fear when the dodging and burning 
change the meaning of the photograph or misrepresents reality. 
 

(3)  Cropping.  Cropping is considered by most to be ethical.  By convention, we allow the 
photographer or editor to define the area we are allowed to view with four sides of his or her choosing.  
These sides become the limits of the image and nothing else can be added or eliminated from the 
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defined scene.  However, cropping can become unethical in both types of darkrooms if important parts of 
an image are removed and distort the actual events. 
 

(4)  Cut and paste. 
 
 (a)  Cut and paste, or cloning, is one of the greatest fears.  For some reason, the concept of a 
"Decisive Moment" does not seem to apply to computers.  One of the most basic tenants held by news 
photographers is the inviolate nature of the moment.  If you miss the picture, you miss the picture.  You 
do not add a ball to a picture from a football game or move the ball around in the frame.  Some might 
say, National Geographic used this logic on the pyramids, "just a few feet to the right and the 
photographer would have had the shot".  We are not in the business of making photographs from spare 
parts.  To destroy the precise relationships within an image at one certain point in time is to change the 
truth of a picture, or at least its accuracy.  To move a pyramid or to add a football or remove a Coke can 
is to change the nature of photojournalism.  The reading public expects photojournalists to adhere to this 
principle. 
 
 (b)  Cutting and pasting images has always been with us, but is far easier to accomplish using 
electronic means.  The ethical concerns are the same, but the seamlessness of the changes makes 
them more tempting.  We need to remember that just because we have a new tool does not make the act 
of cutting and pasting any more ethical than before. 
 
 (c)  The cloning function has its use in allowing us to remove dust spots and scan lines.  It is 
considered ethical to use Spottone or a pencil to manually remove this sort of technical imperfection and 
it should be allowed electronically.  The key word being technical. 
 

(5)  Color correction.  Color correction done on a global scale is considered a correct procedure in 
all color printing.  The eye adjusts to color temperature changes, but film does not.  However, it is usually 
considered unethical to change one color or one part of the picture all by itself since the eye does not 
work that way. 
 

(6)  Sharpen.  Sharpening causes a new dilemma as it is the only electronic manipulation that has 
not been seen before.  Sharpening does not bring into focus an out of focus picture.  Rather, it gives the 
appearance of sharpness by increasing the contrast between pixel groups.  To decide if it is ethical to 
sharpen, we have to ask does the sharpening change the accuracy of the information in the image and 
does the sharpening change the integrity of the moment.  

 
(7)  Flopping. 

 
 (a)  It has always been possible to put a negative in the enlarger backwards, but it is considered 
unethical to do this in the darkroom by most papers and will continue to be unethical at the electronic 
picture desk. 
 
 (b)  This particular case leads to another vexing problem.  Photographers generally will not flop a 
negative.  If someone without a photographer's background is given the ability to flop an image, he or 
she might not have the background needed to know why it is wrong.  Photographers have developed an 
interest in ethics now because people outside their world are gaining access to their work and they are 
afraid of the consequences.  It is necessary for photographers to learn all there is to learn about 
electronic photography and keep as much of the creative function in their own hands as they can.  To do 
this they must follow the process from camera to print, thinking of the printed final product and not the 
photographic print itself. 
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 (c)  In the final analysis, credibility is the bottom line.  If we try to deceive the public, whatever we do 
electronically to the photograph is wrong.  If we attempt to bring the most accurate representation of 
reality as we can create to the reader or observer, we have acted ethically on behalf of our profession.  If 
we produce accurate information, we have succeeded. 
 
A-11.  DEPARTMENT OF DEFENSE POLICY ON MANIPULATION OF 
PHOTOGRAPHS 
 

a.  DoD Policy.  On December 9, 1994 the Deputy Secretary of Defense signed a memorandum 
which provides DoD policy on the alteration of official photographic and video images.  Photographic and 
video imagery has become an essential tool of decision-makers at every level of command and in every 
theater of military operations.  Mission success and ultimately the lives of our men and women in uniform 
depends on this imagery being complete, timely and above all, highly accurate.  Anything that weakens 
or casts doubt on the credibility of this imagery within or outside the DoD will not be tolerated.  The 
emergence of digital technology has significantly increased the capability of Defense imagery.  Since 
current federal regulations and DoD directives do not specifically address the deliberate alteration of 
official photographic records, I believe guidance is required.  I am providing the guidance by establishing 
the following as DoD policy on the alteration of official photographic and video imagery. 
 
 (1)  The alteration of official defense imagery by persons acting for or on behalf of the DoD is 
prohibited except as outlined below: 
 
 (a)  Photographic techniques common to traditional darkrooms and digital imaging stations such as 
dodging, burning, color balancing, spotting, and contrast adjustment that are used to achieve the 
accurate recording of an event or object are not considered alterations. 
 
 (b)  Photographic and video image enhancement, exploitation and simulation techniques used in 
support of unique cartography, geodesy, intelligence, medical, RDT&E (Research, Development, Test, 
and Evaluation), scientific, and training requirements are authorized if they do not misrepresent the 
subject of the original image. 
 
 (c)  The obvious masking of portions of a photographic image in support of specific security and 
criminal investigation requirements is authorized. 
 
 (d)  The use of cropping, editing, or enlargement to selectively isolate, link, or display a portion of a 
photographic or video image is not considered alteration.  However, cropping, editing, or image 
enlargement which has the effect of misrepresenting the facts or circumstances of the event or object as 
originally recorded constitutes a prohibited alteration. 
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 (e)  The digital conversion and compression of photographic and video imagery is authorized. 
 
 (f)  Photographic and video post-production enhancement, including animation, digital simulation, 
graphics, and special effects, used for dramatic or narrative effect in education, recruiting, safety and 
training illustrations, publications, or productions is authorized under either of the following conditions: 
 

• The enhancement does not misrepresent the subject of the original image. 
 
• It is clearly and readily apparent from the context or from the content of the image or 

accompanying text that the enhanced image is not intended to be an accurate representation of 
any actual event. 

 
 (2)  Official Defense imagery includes all photographic and video images, regardless of the medium 
in which they are acquired, stored or displayed, that are recorded or produced by persons acting for or 
on behalf of DoD activities, functions, or missions. 
 

b.  Copyright law. 
 
 (1)  Laws seldom keep pace with changes in society.  Those laws that govern the ethics of 
enhancement and manipulation of images are no different. 
 
 (2)  Copyright is a form of legal protection for original works of authorship fixed in any tangible 
medium of expression.  The courts have interpreted the law to include computer software, photographic, 
artistic, literary, dramatic, musical, and other intellectual works. 
 
 (3)  Copyright law gives the owner of a copyright the exclusive right to reproduce the image, arrange 
derivative (not original) works, distribute copies, or perform and display the work in public.  While there 
are legal exceptions such as fair use and compulsory license clauses, original authors are extended 
considerable protection.  The US Copyright Office, part of the Library of Congress, oversees copyright 
law. 
 

c.  Protected works.  Copyright protects original works of authorship that are fixed in a tangible 
form of expression.  Copyrightable works include— 
 

• Literary works. 
 
• Musical works. 

 
• Dramatic works, including any accompanying words. 

 
• Pantomimes and choreographic works. 

 
• Pictorial, graphic, and sculptural works. 

 
• Motion pictures, and other audiovisual works. 

 
• Sound recordings. 

 
• Architectural works. 
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d.  The law for works created in 1978 or later.  A work created on or after January 1, 1978, is 
automatically protected from the moment of its creation and is ordinarily given a term enduring for the 
author's life, plus 50 years after the author's death.  In the case of a "joint work prepared by two or more 
authors who did not work for hire," the term lasts for 50 years after the death of the last surviving author's 
death. 
 

e.  Key elements of the laws.  Fixation, originality, and expression are the three basic factors that 
must be present for US copyright law to protect a new work.  All three must be considered when 
determining copyright ownership. 
 

(1)  Fixation is the creation of a work in a tangible, lasting form and occurs at the moment of 
creation. 
 

(2)  Originality is the conception in the author's mind; this is also essential. 
 

(2)  Expression is the final key.  Expression of ideas can be copyrighted, but ideas themselves 
cannot. 
 

f.  Permissible copying. 
 
 (1)  The Copyright Act also defines permissible copying.  A work can be copied for limited private 
use in the quest for knowledge if it is not distributed or displayed and if the owner is not harmed.  Works 
can be copied for fair use if the commercial value of the original is not exploited or if the reproduction is 
necessary for scholarly discussion or analysis of the work. 
 
 (2)  A teacher also may make copies of short published works or periodicals for educational use if 
specific criteria are met.  In other instances, multiple copies can be made for handouts in a classroom. 
 

g.  How to copyright a work.  Whenever a work is created, these copyright laws automatically 
cover it.  However, if you feel that you may need to go to court over a possible infringement of your 
copyright, you must register the copyright with the Copyright Office in Washington, DC.  This is simply a 
matter of filling in the appropriate forms and sending copies of the work for their records.  The only time 
you must do this is when you feel that there may be illegal copying of your work.  The courts have 
awarded higher damage payments to people who have actually registered their works.  The bottom line 
is that you do not need to do anything to copyright a work; it is automatically protected when you create 
the work. 
 

h.  How does copyright affects DoD personnel? 
 
 (1)  As a member of the Armed Forces or an employee of the Federal Government, any images or 
works that you create on the job are property of the government.  This means that you have no rights to 
these images.  Also, any work that you do on your own time using either government film or equipment 
belongs to the government.  You must be very careful to only use personally owned equipment and 
supplies when freelancing or shooting images that you may want to keep or eventually sell. 
 
 (2)  Just as the copyright laws prevent you from using equipment for your own gain, they also protect 
you from performing illegal copying.  As we have said, it is against the law to copy another person's 
work.  For this reason, you cannot be ordered to do this illegal copying.  We must educate our superiors 
on copyright laws. 
 (3)  When can we copy copyrighted works?  As we have said, it is appropriate to copy (in limited 
amounts) works for training purposes and presentations.  It is also acceptable to copy works for the 
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quest for knowledge or research.  Keep these limitations in mind and use your best judgment when 
determining whether or not to copy something. 
 

i.  Software piracy. 
 
 (1)  One last ethical consideration is software piracy.  While most people feel that it is wrong to steal 
a computer or other piece of hardware from their workplace, it is common for employees to copy 
software taken from work onto their home computers.  We must understand that this is just as wrong. 
 
 (2)  While software is not as tangible as hardware, it is just as valuable.  Many hours of labor, 
research, and development go into each software application.  We must understand that to copy an 
application to an unauthorized computer is stealing it from the manufacturer. 
 

(3)  Additionally, moving disks from computer to computer also increases the risks of transporting 
computer viruses, which are small, hidden programs than can destroy data.  Viruses are written to hurt 
computers and are usually copied along with software.  By not illegally copying software, we also are 
reducing the chances of spreading computer viruses. 
 
 (4)  The government has taken a firm stance on the illegal copying of software.  There are many 
laws covering the subject, and heavy ($100,000 or more) fines and prison terms are the penalty for 
software piracy. 
 

j.  Ethics policies. 
 
 (1)  Some newspapers use written policies. While numerous branches of the US government, 
including The White House, now rely on personal computers to process images, few organizations 
queried in 1993 had devised formal ethics policies. 
 
 (2)  Are written ethics policies necessary?  Yes.  Should there be room for interpretation?  Of course, 
but photographs, like words, should be edited with consistency.  Is it necessary to enforce policies?  If 
necessary.  One prepress employee left the job to "pursue other interests" shortly after retouching a 
news photograph. 
 
 (3)  Since we all have different perceptions about what is ethical and what isn't, organizations should 
not allow individual employees to impose varying values on the group.  Consistent policies should be the 
goal, with individual artists and photographers having pivotal roles in identifying ethical guidelines. 
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APPENDIX B 
 

DRAFTING TOOLS AND TECHNIQUES 
 
 
B-1.  INTRODUCTION 
 

Computers have radically changed the life of an illustrator in the past several years.  Many 
projects that were very time consuming are now accomplished with greater accuracy and in less 
time with the aid of a computer.  As great as the computer can be, there will still be projects or 
situations that require the old fashion approach.  This appendix gives you insight into the “tricks 
of the trade.” 
 
B-2.  TOOLS 
 

a.  T-squares.  As the name implies, it is a T-shaped instrument that consists of a 
straightedge (blade) firmly attached to a perpendicular (right angle) end (head).  The shaft is 
placed on top of the head so that the head will fit against the table edge, while the blade rests 
on the table surface.  T-squares vary in length from 15 to 72 inches, with the 36-inch length 
being the most common.  There are T-squares designed with adjustable heads, which allows 
the blade to be set at different angles.  The T-square is used to draw horizontal lines and serves 
as a base for the triangle when vertical and inclined lines are drawn. 
 

b.  Metal straightedges.  Metal straightedges are used for cutting and drawing long 
straight lines. 
 

c.  Triangles.  Triangles are used in combination with the T-square to draw vertical and 
inclined lines. 
 

d.  Rulers or scales.  Rulers or scales may be made of wood, plastic, metal, or a 
combination of materials.  They vary in shape, style of division, and scale graduations.  The 
Architect and the Engineer are the two most common scales. 
 

e.  Protractors.  Protractors are used to measure or lay out angles.  They may be circular 
or semicircular.  Protractors most commonly found in graphic shops are graduated in ½- degree 
increments.  Semicircular protractors are generally labeled from 0 to 180 degrees in both 
directions.  Circular protractors may be labeled from 0 to 360 degrees or they may be labeled 
from 0 to 90 degrees in four quadrants. 
 

f.  Irregular curves.  Irregular curves are also referred to as French curves.  They come in 
a variety of shapes and sizes.  They are used to draw noncircular curves such as ellipses, 
spirals, and parabolas.  Curves are drawn by locating points along the intended curve, then 
using the French curve to draw a series of lines to connect the points in a smooth, flowing line. 
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g.  Cased instruments.  Drafting tools may be purchased individually, but normally come 
as a set.  The case protects the instruments from abuse as well as from the elements if the 
lining is treated with an agent to prevent tarnishing or corroding.  When tools are not in use, 
they should be periodically cleaned with a soft cloth and lightly oiled.  The joints should NOT be 
oiled. 
 

(1)  Compasses are used for drawing circles and arcs.  The large compass in a set is 
normally 6 inches long.  The legs are hinged at the top so that they can be set at any desired 
position.  The leg that has the pencil or pen attached usually has a hinged joint in the middle of 
the leg, enabling the pen point to be set at an angle perpendicular to the paper for better ink 
flow.  The other leg containing the needlepoint may or may not have a similar joint. 
 

(2)  Dividers look like compasses, except there is a needlepoint in both legs.  They are 
used to measure off a series of equal distances or to divide lines into segments of equal parts. 
 

h.  Erasers. 
 

(1)  A rubber eraser (ruby red) is an all-purpose eraser.  This eraser should be tested on a 
scrape of the paper you are working on because it may stain the paper. 
 

(2)  A kneaded eraser is gray in color and must be kneaded before using.  This eraser is 
used for pencil, chalk, pastel, and charcoal drawings. 
 

(3)  An ink eraser is hard and abrasive.  This eraser is aggressive, so exercise care when 
using. 
 

(4)  An art gum is a crumbly eraser that is free of grease.  Its main purpose is to remove 
pencil lines from ink-line work. 
 

(5)  A vinyl eraser is also referred to as a plastic or drafting eraser.  This eraser is available 
in a solid block shape or in a pencil-shaped, retractable version. 
 

(6)  A paper-wrapped eraser is pencil shaped and may be soft or hard.  It is intended for 
small areas and may be cut to shape. 
 

(7)  A dry cleaning pad is no more than a loosely woven bag filled with gum bits.  It is used 
to clean large areas. 
 

(8)  A steel eraser is used to remove heavy deposits of ink or paint, by using a gentle hand 
motion.  When most of the ink or paint is removed, you should switch to a more conventional 
method. 
 

i.  Erasing shields.  An erasing shield is a small plate of thin spring steel that has various 
shaped holes punched out.  These opened holes make it possible to erase unwanted lines, 
while leaving other work untouched. 
 



STP 11-25M13-SM-TG 

B-3 

j.  Templates.  Commercially available templates can be major time savers.  They allow 
you to accurately reproduce a shape time and again.  Most templates are transparent plastics, 
which allows for easier aligned.  If the template is used for inking, ensure it is either designed 
with an inking edge or raise the template with a few pieces of drafting tape on the underside. 
 

k.  Ink pens. 
 

(1)  In your drafting tool set you will probably find a ruling pen.  A ruling pen consists of two 
steel blades (called nibs) attached to a handle.  A setscrew is used to adjust the distance 
between the nibs, thereby adjusting the line width.  The pen’s reservoir must be filled with a 
dropper.  A ruling pen is used with a straightedge.  It should NOT be used for freehand work.  It 
is possible to damage the nibs by pulling the pen in the wrong direction, forcing the nibs apart.  
Ruling pens may be more “old fashion,” but they are not without merit. 
 

(2)  Technical fountain pens or technical pens may be thought of as self-contained ruling 
pens.  Technical pens are designed to use with a straightedge, like ruling pens.  Unlike ruling 
pens, technical pens may be used for freehand drawing.  Another major advantage to technical 
pens is the ink reservoir.  Depending on the style, the reservoir is either built into the barrel of 
the pen or is a translucent plastic cartridge attached to the body of the pen.  This large ink 
capacity allows the technical pen to be used for a much longer time before refilling.  Technical 
pens are not adjustable.  Sizes may range from 0.026 to 0.2 inches, depending on the 
manufacture.  Complete pen sets may be purchased, as well as individual pens. 
 

l.  Pencils.  Pencils are thinking tools, which allow ideas to be quickly translated into 
images and changed.  Any pencil will do in a pinch, but drawing pencils have several 
advantages over common, everyday pencils.  The main advantage is the different degrees of 
lead available.  The degree of hardness or softness affects the value and type of line produced. 
 

(1)  Graphite pencils are labeled according to the hardness or softness of the lead.  There 
are 14 common grades.  The diameter of the lead is an indication of the hardness or softness of 
the lead.  Soft lead must be thicker than hard lead to help prevent the lead from crumbling.  
Although there is a common grading scale, there is not a standard in place for the different 
grades.  A HB from one manufacture might be much lighter or darker than a HB from another 
manufacture.  Although a drawing pencil is a great tool to “think with,” it does have properties 
that you need to keep in mind.  Lines drawn with a graphite pencil may have a shine to them, 
which is especially true of areas that are overworked.  This must be kept in mind if the image is 
reproduced on a copier.  This shine will reflect the light, causing the reproduction to be lighter 
than the original in some areas.   
 
 (2)  Charcoal pencils produce a dense, matte black line.  A charcoal drawing provides a 
truer reproduction and does not have the range that pencils have.  It is limited to about five 
different grades. 
 

(3)  Colored pencils may be waterproof (wax based) or water soluble (watercolors in a 
stick).  Each has a different purpose, as well as a different effect.  Experiment with each to find 
its uses and limits. 
 

(4)  Nonreproducible blue pencils are intended for layout work.  As long as the lines are 
drawn lightly, the light blue color “disappears” when photographed.  Scanners and copiers may 
be more sensitive; experiment before using a nonreproducible blue pencil on a project. 
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NOTE:  It is imperative to keep your tools clean and serviceable.  There is nothing  
more annoying than to get to the end of a project and have it ruined because your  
tools were not cleaned. 

 
B-3.  TIPS, TECHNIQUES, AND TIDBITS 
 

a.  T-squares. 
 

(1)  Place work on the left side of the drawing board near the head of the T-square (if you 
are right-handed).  Hold the head of the T-square with your left hand to prevent it from moving 
while drawing.  Keep work as close to the head of the T-square as possible.  The farther you go 
down the blade the greater the chance the blade will be out of square. 
 

(2)  Always draw lines along the upper edge of the blade. 
 

(3)  Tip the head down slightly to lift the blade up off the drawing surface before 
repositioning the T-square.  Do not drag it through the drawing. 
 

(4)  To check a T-square, draw a straight line.  Turn the T-square over and redraw the line 
with the same edge.  If the blade is warped, the lines will not coincide.  If it is not square, mark 
the blade so that it is not used as a T-square.  A T-square should be checked before beginning 
a new project (or after a mishap). 
 

(5)  Hang T-squares by the hole at the end or lay it on a flat surface so that it rest flat and 
does not warp.  Handle T-squares with care because if dropped even once, it may be knocked 
out of square and become useless. 
 

b.  Triangles.  Right angle triangles are used in conjunction with T-squares or straight- 
edges to draw vertical and/or inclined lines.  The two most common triangles are 45 degrees 
and 30-60 degrees.  Triangles are treated with the same respect as T-squares.  Although they 
are less likely to lose their accuracy, they can warp. 
 

c.  Pens. 
 

(1)  Ruling pens. 
 

(a)  Before using a ruling pen, ensure the pen is clean.  The ink will flow improperly if there 
is any dried ink on the blades. 
 

(b)  Adjust the nibs to the desired width before filling with ink. 
 

(c)  Use a dropper to fill the reservoir to about 3/16 of an inch from the tip.  DO NOT overfill; 
this could cause a blot or an uneven line.  Never fill a pen over a project.  Murphy’s law always 
kicks in when you can least afford it. 

(d)  Before drawing with a freshly filled pen, carefully remove any excess ink from the 
outside of the nibs and test for line quality on a scrap piece of paper.  Adjust the setscrew if 
necessary. 
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(e)  Hold the ruling pen with the setscrew pointed away from you.  Ensure that both nibs are 
touching the paper (perpendicular to the paper).  Tilt the pen 60 or 70 degrees in the direction 
you will pull the pen.  You are leaning into the line. 

 
(f)  If the pen handle is tilted toward the guide, the outer nib will lift off the paper.  If the nibs 

are pressed too hard against the guide, you will force the nibs closer than they were set, 
changing the line width.  If the pen handle is tilted away from the guide, the nibs will touch the 
guide and ink may bleed under the guide. 
 

(g)  When inking a line with a T-square, make long lines with a movement of your entire arm 
by sliding your pen hand along the blade.  Just before reaching the end of the line, slow down 
and use a hand movement to keep the line precise. 
 

(h)  Draw horizontal lines from left to right if you are right-handed, starting at the top of the 
drawing and working down.  If you are left-handed, draw from right to left, still working from top 
to bottom. 
 

(i)  Allow lines to dry before drawing any intersecting lines.  Watch carefully as you draw 
one line across another.  If the ink starts to run down the dry line under your guide, lift the pen 
quickly and carefully move the guide. 
 

(j)  Clean pens by dipping the tip in pen cleaning solution or in water mixed with a little 
ammonia.  Wipe the blades carefully and thoroughly, inside and out, with a soft, lintless cloth. 
 

(k)  Clean the pen if the ink becomes sluggish and line quality is suffering during a project. 
 

(l)  Always put the pen away clean, with the nibs well separated to release the tension on 
the steel. 
 

(2)  Technical pens. 
 

(a)  You must hold the pen perpendicular to the paper at all times.  If you do not, the point 
will wear unevenly and the pen becomes useless. 
 

(b)  If a pen is in need of a serious cleaning— 
 

• Fill a container with the recommended cleaning solution or warm water and detergent.  
The container needs to be deep enough to allow the pen tip to be completely covered 
without touching the bottom. 

 
• Cut an X in a thin piece of cardboard that is large enough to cover the container of 

cleaning solution.  Slip the pen through the X until the tip is completely submerged but 
not touching the bottom of the container. 

 
• The next day you should be able to carefully disassemble the pen.  Wrap the tip with a 

soft cloth and gently twist the tip to the left and right to work it free. 
 

• Separate the tip elements, taking care not to bend the fine wire on the plunger, and 
clean them. 
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• If the tip is still clogged and you are unable to clear the obstruction by gently tapping the 
tip on a folded soft cloth, as a very last resort, VERY CAREFULLY thread the wire back 
into the tip.  If you are not careful, you will snap the wire off, making the pen useless.  
Do this only as a last resort. 

 
• After ensuring that all parts are clean, completely dry and reassemble the pen. 

 
(3)  Miscellaneous. 

 
(a)  Ink a line once.  Never go back and forth over a line. 

 
(b)  Always test a pen on a scrap of the project paper.  Different papers absorb ink 

differently. 
 

(c)  Gently shake technical pens up and down to get them started.  You should hear the 
plunger moving inside the pen.  If you do not hear a clicking sound, the pen probably needs 
cleaning. 
 

(d)  Always put the top back on the ink bottle SECURELY after using.  Never assume 
“everybody knows it’s open.”  That is just a disaster waiting to happen when you can least afford 
it. 
 

(e)  Wash hands frequently or wear thin cotton gloves when working with ink, especially in 
writing calligraphy.  The oil on your skin will leave spots on the paper, causing the ink to skip 
and bleed. 
 

(f)  If the paper you are working on is causing markers or pens to bleed, try spraying light 
coats of fixative on the paper first.  Experiment with the fixative and paper. 
 

(4)  Compasses. 
 

(a)  When starting to ink a line with a compass, lean the compass into the direction you are 
drawing. 
 

(b)  Pencil points should be sharpened to a long, tapering chisel point using a sandpaper 
sharpening block. 
 

(c)  The pen or pencil point should be slightly shorter than the compass point.  The marking 
points should just touch the paper when the compass point is set into the paper. 
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(d)  To use a compass without leaving a hole in the paper, try to— 
 

• Lightly mark where the center of the circle will be on the illustration board. 
 

• Rubber cement a small square of the illustration board over the center of the circle. 
 

• Draw the circle. 
 

• Remove the square and clean up any rubber cement left behind. 
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APPENDIX C 
 

THREE-DIMENSIONAL DRAWING 
 
 
C-1.  INTRODUCTION 
 

Geometrically parallel lines are lines that extend in the same direction and are equidistant 
for their length.  But this is not how we see things in the real world.  If you stand in the middle of 
railroad tracks that stretch out in front of you and look down their length, the tracks “appear” to 
get closer and eventually to touch.  This optical illusion is what creates the illusion of three-
dimensional depth in a drawing.  The intent of this appendix is to define the terms you will need 
to know in order to understand linear perspective; to explain the rules and principles which will 
help you to execute a convincing three-dimensional drawing; and to discuss the three types of 
perspective. 
 
C-2.  TERMS 
 

a.  Plan and elevation.  In perspective drawing, the top view is called a plan view and the 
front and side views are called the front and side elevations. 
 

b.  Horizon line (HL).  The eye level of the artist and, therefore, of the viewer as well.  This 
line changes as you raise or lower your viewpoint, which may allow you to see more or less of 
the horizontal planes that lie between you and the horizon. 
 

c.  Vanishing point (VP).  A point on the horizon line at which parallel lines seem to meet.  
It is also known as the center of vision (CV).  The number of vanishing points constitutes the 
type of perspective, as their name implies.  That is, one-point perspective has one vanishing 
point; two-point perspective has two vanishing points; and three-point perspective has three 
vanishing points. 
 

d.  Baseline (BL).  A horizontal line, parallel to the horizon line, that represents the edge of 
the ground plane on which the object rests. 
 

e.  Point of sight (PS).  The point on the horizon line that is directly opposite or in front of 
the viewer. 
 

f.  Station Point (SP).  The fixed position or vantage point of the artist or viewer in relation 
to the subject.  It is one of the most important items in perspective drawing because it controls 
the perspective of the drawing. 
 

g.  Picture plane (PP).  An imaginary vertical plane placed between the observer and the 
object, usually at right angles to an observer's line of vision.  Think of this as an imaginary glass 
wall that is between you and the subject.  On this glass wall you can trace all the visible edges 
of the object.  Although impractical, it does illustrate some of the principles of perspective.  In 
reality, your glass wall is made of paper and instead of tracing, you project it onto the paper. 

h.  Visual rays.  These are the projectors from the points or edges of the object to the 
vanishing point(s).  These are your construction guides. 
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C-3.  ESSENTIAL ELEMENTS OF PERSPECTIVE 
 

a.  All straight lines seen in perspective remain straight, no bowing or curving takes place. 
 

b.  Vertical lines in perspective remain vertical in relation to the picture plane, except when 
objects are viewed from above or below.  When this is the case, vertical lines appear to slant, 
converging near the top or bottom; however, they remain straight. 
 

c.  Parallel lines of a plane which inclines or declines have vanishing points above or below 
the horizon line. 
 

d.  The farther away an object is from the baseline of the picture plane, the closer to the 
horizon it appears.  The top surface becomes less visible. 
 

e.  Horizontal lines are parallel to an object that is drawn to the same point on the horizon. 
 

f.  The illusion of depth in a drawing can also be created by the relative sizes of the objects, 
their placement (overlapping), and the value of the lines and tones with which they are drawn.  
Though visual principles (overlapping and line tone) do not have a direct bearing on linear 
perspective, they are just as important in making a finished still-life drawing look three-
dimensional.  
 

(1)  The most common example of relative size is a series of telephone poles.  They are 
exactly the same size, yet they appear to get smaller the farther away they are from the viewer.  
When creating a realistic drawing of a series of identical objects, you need to forget that the 
objects are the same size and focus on their apparent sizes and positions relative to one  
another.  Of course the context in which an object is seen also has a bearing on the illusion of 
depth.  In Figure C-1 the circles appear to be a collection of different sized circles.  Figure C-2 
gives more of an illusion of depth. 
 

 
 

Figure C-1.  A collection of different circles. 
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Figure C-2.  Circles that project an illusion of depth. 
 

(2)  The placement of objects is yet another means of creating depth in a drawing.  By 
overlapping one object with part of another, you give the illusion of depth.  If an object is “in front 
of” another, then the viewer “knows” that it is closer than the one behind it. 
 

(3)  Although linear perspective deals with the relationship of the value of the lines with 
which an object is drawn can indicate its distance from the viewer.  The eye “reads” a dark line 
more quickly than a faint one.  An object that is dark in value appears to come forward visually.  
See Figure C-3. 
 

 
 

Figure C-3.  Values of dark objects. 
 

(4)  Tone as well as line can create a three-dimensional quality in a drawing.  Depending on 
the overall value of the drawing, either the lights or the darks will pull forward.  In a light 
rendering, the darks would be noticed first; whereas in a dark rendering, the lights would be 
noticed. 
 

(5)  These are only a few of the visual principles that will help create illusion of depth in your 
drawings, in addition to the knowledge of perspective. 
 



STP 11-25M13-SM-TG 

C-4 

g.  Knowledge of the three basic types of perspective will enable you to create a realistic 
drawing, utilizing from one to three vanishing points.  The important thing to keep in mind is that 
a fixed position (station point) for the artist’s point of view is mandatory, no matter how many 
vanishing points you use.  A drawing created from more than one station point confuses the 
viewer and appears to defy commonsense.   
 
C-4.  ONE-POINT PERSPECTIVE 
 

a.  One-point perspective occurs when all parallel horizontal lines vanish to a single point 
(point of sight) located on the horizontal.  In one-point perspective, the height and width 
dimensions of an object are parallel to the picture plane; which is why you might hear one-point 
perspective referred to occasionally as parallel perspective.  This perspective is used when an 
object is being viewed straight on, not at an angle.  In this view, only the depth dimension must 
be put in perspective.  This dimension must have a vanishing point; the height and width do not 
have vanishing points since they are parallel to the picture plane.  In Figure C-4, you see the 
undersides of the boxes are above the horizon line and are visible, but when the boxes are 
below the horizon line, their top planes are visible.  The front planes remain parallel to the 
picture plane, regardless of whether they are above or below eye level.  One-point perspective 
is useful when constructing rooms.  The ceilings, walls, and floors always recede to one 
vanishing point, no matter where you are standing. 
 

b. The plan-view method to one-point perspective is discussed in steps (1) through (11).  
 

NOTE:  See Figure C-4 for steps (1) through (3). 
 

(1)  Establish the horizon line, depending on whether the object is illustrated above or 
below eye level. 
 

(2)  Locate the picture plane somewhere on the drawing surface so that it will not interfere 
with the drawing.  The picture plane can be placed off the drawing paper, as long as the picture 
plane and the drawing paper are secured to the drawing surface and will not shift out of 
position.  The picture plane can be the same line as the horizon line.  With experience you will 
quickly recognize where things need placing to get the view that you want. 
 

(3)  Draw the plan view.  Although the plan view can be drawn above or below the picture 
plane, it is easier to draw it resting on the picture plane. 
 

 

P P 

H L 

PLAN 
VIEW

 
 

Figure C-4.  Plan view method to one-point perspective. 
 

NOTE:  See Figure C-5 for steps (4) through (6). 
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(4)  Draw the baseline, placing it below the picture plane, but parallel to it. 
 

(5)  Locate the station point, placing it at a distance not less than twice the width of the 
object (obtain this measurement from the plan view).  You can also place it two or three times 
the object’s greatest length from the nearest point of the plan view.  If it is placed any closer, 
distortion of the perspective drawing will result.  The station point can be located directly in front 
of or to the side of the plan view. 
 

(6)  Project the width of the plan view to the baseline. 
 
 

 
Figure C-5.  Projecting the width of the plane view to the baseline. 

 
 NOTE:  See Figure C-6 for steps (7) through (11). 
 

 

 

 

 

 
  

 
 

Figure C-6.  Projecting a line from plan view to station point. 
 

(7)  Draw the front view of the object on the baseline.  Remember that if the front of the plan 
view is touching the picture plane, the front view of the object will be true size.  If the plan view 
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were behind or in front of the picture plane, the front view of the object would be smaller or 
larger, respectively. 
 

(8)  Project a vertical line from the station point to the horizon line.  This intersection locates 
the vanishing point. 
 

(9)  From the corners of the front view (D, E, F, and G), draw visual rays to the vanishing 
point. 
 

 (10)  Project a line from point E (the back corner of the object) of the plan view to the 
station point.  Where this line intersects the picture plane (point H), draw a perpendicular line 
from point H to intersect the visual rays (points J and K).  This accurately locates the back 
corners and defines the depth of the object.   
 

 (11)  Darken the object outlines and remove construction lines. 
 
C-5.  TWO-POINT PERSPECTIVE 
 

a.  Two-point perspective is the most common type and exists when the object is sitting at 
an angle to the picture plane.  In two-point perspective there are two vanishing points, one to 
the right of the object and one to the left.  When you are constructing objects in a still-life 
drawing, having a working knowledge of two-point perspective becomes essential.  This is 
because it is rare that you will find every object placed with its front plane parallel to the picture 
plane, which is necessary for one-point perspective. 
 

b. The plan view of two-point perspective is discussed in steps (1) through (15).   
 

NOTE:  See Figure C-7 for steps (1) and (2). 
 
(1)  Draw the horizon line and baseline. 

 
(2)  Draw the picture plane line near the top of the paper, so it is not in the way of the 

perspective drawing. 
 

PLAN VIEW 

FRONT VIEW

 

P

 

P

H

 

L

B L  
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Figure C-7.  Plane view of two-point perspective. 

 
NOTE:  See Figure C-8 for steps (3) through (11). 

 
 

G

A
B

C
O PP

HLVPL

2

VPR

1

Y 90

 
 

Figure C-8.  Plane view lines drawn in two-point perspective. 
 

(3)  Draw an arbitrary perpendicular line downward from the picture plane.  Where this line 
touches the picture plane (point O), locate the nearest corner of the object.  Locate the station 
point at the other end of the vertical line. 
 

NOTE:  Remember to place the station point at a distance not less than twice the 
total width of the object.  Locate the station point at the other end of the vertical  
line.  Remember to place the station point at a distance not less than twice the total 
width of the object from point O.  In this case, the distance is about twice the 
distance of G. 
 (4)  Draw the plan view of the object in the desired position with the nearest corner at point 

O.  In this case, the object was drawn at an angle of 30 degrees with the horizontal.  Other 
angles commonly used are 15, 45, and 75 degrees.  Usually you place the side of the object 
with the most detail along the axis with the smallest angle, because more of the surface can be 
seen along this axis. 
 

(5)  Draw a line from the station point, parallel to the side (OP) of the plan view to where it 
intersects the picture plane at 1. 
 

(6)  Draw a perpendicular line from 1 to the horizon line.  This line locates the right 
vanishing point (VPR). 
 

(7)  Draw a line from the station point, parallel to the side (OR) of the plan view to where it 
intersects the picture plane at 2. 
 

(8)  Draw a perpendicular line from 2 to the horizon line.  This line locates the left vanishing 
point (VPL).  The angle formed by the lines drawn from the station point to points 1 and 2 is 
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equal to 90 degrees.  Remember that lines SP1 and SP2 must be parallel to the sides of the 
object. 
 

(9)  Draw lines from the corners of the plan view (O, A, B, C) to the station point. 
 

(10)  Where these lines intersect the picture plane, project perpendicular lines downward to 
the ground line. 
 

(11)  From point Y, the intersection of line OSP and the ground line, extend visual rays to 
both vanishing points.  These lines define the lower limits (base) of the object. 
 

NOTE:  See Figure C-9 for steps (12) through (15). 
 
(12)  Taking dimension from the orthographic views (left-hand corner of the figure), 

measures the vertical distance along line OY.  As discussed in one-point perspective, 
measurements can be placed or taken as long as a view, edge, or point is touching the picture 
plane.  These measurements can only be taken or placed along the edge of the object that 
touches the picture plane. 
 

(13)  After you make the height measurements along line OY, project these points to the 
vanishing points. 
 

(14)  The edges and corners of the object outline are defined where the visual rays 
intersect the perpendicular projectors. 
 

(15)  Darken the object outlines. 
 

 
G

A
B

C

O
P P

H LVPL

2

VPR

1

Y 90

NOTE:  If this angle is not 90 degrees, the object will be 
distorted.  

 
 

Figure C-9.  Measurements taken from the orthographic views. 
 
C-6.  THREE-POINT PERSPECTIVE 
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In three-point perspective, the object is placed so that none of its principle edges are 
parallel to the picture plane.  This means that each of the three sets of parallel edges (length, 
height, and width) will have a separate vanishing point.  When constructing a three-point 
perspective drawing, you will need to use your artistic ability to place the vanishing points, 
particularly the vanishing point for the vertical lines.  A good rule to follow is that small objects 
usually look better if the vanishing points are well separated.  However, sharp diagonal lines are 
important to emphasize the expansion of an object.  In this instance, the close proximity of the 
vanishing points to each other strengthens the “large-size” effect. 
 
C-7.  CIRCLES 
 

a.  When observed in perspective drawings, circles appear as ellipses.  An ellipse can be 
sized and placed in a perspective drawing by constructing it within a square.  The square is 
essential to an accurate drawing, because a curve has no direct measurements.  The vanishing 
points are easily determined for a square.  The curves can be easily determined within the 
confines of the square. 
 

b.  Although the object’s face or surface containing the circular form should be parallel to 
the picture plane for ease in drawing, many times this cannot be done.  Figure C-10 (Views A 
through E) shows the proper layout of a circle drawn in one-point and two-point perspectives.  
The following steps will assist you in drawing a circle in one-point perspective. 
 

(1)  Draw a circle with the desired dimensions (View A). 
 

(2)  Draw a square circumscribing the circle.  Construct the center lines and diagonals 
inside the square.  The intersections of the circle, the centerlines, and the diagonals will give 
you eight checkpoints for drawing the circle in perspective.  (See View B). 

(3)  Draw the square in one-point perspective and include centerlines and diagonals  
(View C). 
 

(4) Draw the circle through the checkpoints (View D). 
 

c.  Use the same steps to draw the circle in two-point perspective as in one-point 
perspective.  The only difference is the additional vanishing point.  View E shows steps (3) and 
(4) in one-point perspective in projecting the checkpoints and drawing the circle. 
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VIEW A

VIEW B

SP

PP

VP
VIEW C

VIEW D

EYE LEVEL

PP

SP

Circle in two-point perspective

Circle in one-point perspective

VIEW E

 
 

Figure C-10.  Proper layout of a circle drawn in one-point and 
two-point perspectives. 
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APPENDIX D 
 

LETTER GRAPHICS PROJECTS 
 
 
D-1.  INTRODUCTION 
 

Words are as important to the multimedia illustrator (25M) MOS as the colors we choose in 
creating illustrations; in some aspects even more important.  Lettering is something that we 
have been doing for years, but how well you letter is the issue.  You will need to letter charts, 
graphs, signs, and posters effectively and efficiently.  The graphics in your projects may be 
beautifully executed; but if the lettering is poor, you can rest assured that is all your audience 
will remember about your work, not the message.  There are several different ways to produce 
lettering for a project.  This appendix covers lettering basics and freehand, prepared, and 
mechanical lettering. 
 
D-2.  LETTERING BASICS 
 

a.  Styles.  Serif and Sans-serif are the two major distinctions in lettering.  These two basic 
groups have numerous lettering styles. 
 

(1)  Roman.  Ancient Romans developed and refined our capital letters when they carved 
letters in stone.  As a guide, they painted the letters to be carved using a flat brush always held 
at the same angle.  When they moved the brush vertically, it made a thick stroke.  When they 
moved it horizontally, it made a thin stroke.  As a result, Roman letters were composed of thick 
vertical strokes and thin horizontal strokes.  The thin lines have cross-strokes at the end called 
serifs.  Serifs lend unity to Roman letters, blending them together and making them easy to 
read.  Roman letters are most commonly used for the text of magazines, newspapers, and 
books because most people are familiar with them and because they are the easiest to read, 
particularly in small size and lengthy articles.  Dignity, refinement, and stateliness are some of 
the qualities attributed to Roman letters. 
 

(2)  Text.  Text may be referred to as "old English" and was among the first type styles 
used.  It is both difficult to read and to construct by nonmechanical methods.  Words consisting 
of all capital letters in either script or text are virtually illegible.  Their most common application 
is religious in nature, such as prayer books; another common use is as titles of certificates.  
Limit the use of this style to a few lines and avoid works with all capital letters.  Figure D-1 
displays some of the variations of text letters in use today. 
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T ext typeface
Certificate of A ppreciation
A V O I D T H I S
This is Got hic Let t er ing
This IS Gothic Lettering
Copperplate Gothic  

 
Figure D-1.  Variations of text letters used today. 

 
(3)  Script and Cursive.  Script and cursive are classified together.  Script letters have 

small connecting links called kerns that link the letters together, giving the lettering an 
appearance of handwriting.  Cursive letters do not have these kerns.  Cursive type is patterned 
after old-fashioned hand lettering, while script imitates the old slanting handwriting.  Both script 
and cursive have the characteristics of elegance and charm.  For these reasons, a common use 
is to letter invitations and announcements.  You can also use them to lend elegance to display 
work. 
 

(4)  Gothic.  Compare the Gothic style to the Roman style.  Observe that both the 
horizontal and vertical strokes are the same thickness on the Gothic style, and that it does not 
have any serifs.  The Gothic style is plain.  Because of its simplicity, refer to the Gothic letter as 
the block letter, particularly in the smaller sizes.  See Figure D-1. 
 

(5)  Italics.  Italics is not a style in and of itself, but a variation of Roman, Gothic, 
Contemporary, and certain other lettering styles.  Italics are slanted versions of letter styles.  
Refer to Figure D-2 and compare the Copperplate Gothic italic style to the Copperplate Gothic 
style shown in Figure D-1.  Italics are used to add contrast and interest to lettering projects.  
One common use of italics is to draw interest to that portion of the project lettered in italics.  You 
also use italics to identify water features on maps.  Italics were originally used for text; however, 
this variation is difficult to read in lengthy articles and have fallen into disuse for this purpose. 
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Roman Typeface
Roman Typeface
Italic

 
 

Figure D-2.  Variations of Roman, Gothic, Contemporary, and certain  
other lettering styles in italics. 

 
(6)  Swash lettering.  Another style variation is Swash lettering, which is similar to italics. 

Swash lettering is embellished with swirls and curves called swashes.  These swashes provide 
an alternative to italics as a method of adding contrast, emphasis, or inviting attention to certain 
portions of a lettering project.  See Figure D-3. 
 

S wash
S wash
S wash

S wash

 
 

 
Figure D-3.  Swash lettering. 
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b.  Terms and definitions. 
 

(1)  Serifs.  Serifs are thin, short strokes at the top and bottom of letters and are typically 
part of Roman letters. 
 

(2)  Sans-serifs.  This style refers to any style that does not have serifs. 
 

(3)  Stem.  The stem is the straight, vertical line that forms the basis for most letters of the 
alphabet. 
 

(4)  Fillet.  A fillet is a thick downward stroke usually made with a broad nibbed pen which 
is held parallel to the line of lettering. 
 

(5)  Hairline.  A hairline is a thin stroke either horizontal or vertical.  You can produce a 
hairline with a thin nibbed pen.  You can also produce one by holding a broad nibbed pen 
parallel to the line of work and moving it horizontally. 
 

(6)  Ascender.  The ascender is the stem of lower-case letters that extend above the body 
of the letter. 
 

(7)  Descender.  The descender is that portion of lower-case letters that extends below the 
body. 
 

(8)  Bowl.  The bowl (also referred to as the counter) is the white space inside the curved 
portions of letters. 
 

(9)  Swell.  The swell (also referred to as the curve) is the curved portion of letters.  Make 
the swell slightly wider than the stem; otherwise, it will appear thinner. 
 

(10)  Cross bar.  The cross bar is the thin cross stroke on lower-case letters f and t, and 
the horizontal stroke of some upper-case letters, such as the T and E. 
 

(11)  Negative space.  The space in and around letters. 
 

(12)  Void.  The space inside a letter. 
 

(13)  Upper case and lower case.  These designations were established when all 
typesetting was performed by hand.  The typesetters divided the letters and put them into two 
types of cases.  They stored the capital letters in the upper case and the small letters in the 
lower case. 
 

c.  Units of measure.  Type size has two units of measure called points (for height) and 
pica (for line length).  Points describe the height of letters.  One point is equal to 1/72 of an inch.  
For example, a letter ½-inch high is 36 points, ¼-inch high is the top of a capital letter to the 
bottom of a small letter.  Pica describes the length of a line of letters.  A pica is 1/6 of an inch; 
thus, there are six picas to the inch. 
 

d.  Lettering weight.  Letters are also classified based on the relative weight of the lines 
you use to construct them.  The three weights are light, medium, and bold.  There is no unit of 
measure for these terms. 
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e.  Height to width ratio.  Another classification of letters is a function of their height to 

width.  These classifications are condensed and extended. 
 

(1)  Condensed letters are narrow compared to their width. 
 

(2)  Extended letters are wide compared to their height.  Use extended letters as a means 
of adding prominence. 
 
D-3.  FREEHAND LETTERING 
 

a.  Freehand lettering is done by hand using basic strokes and no mechanical aids.  It may 
be done with a pencil, pen, marker, or brush.  In order for lettering to be effective, it must be 
legible.  There are a few guidelines that will ensure that your lettering is effective.  The first and 
foremost is practice.  It has been said, “You, too, can be a calligrapher if you have perseverance 
and live long enough.”  This roughly translates into practice, practice, and more practice.  
Lettering is more than putting individual characters on a page; it is a mastering of the interaction 
of the different shapes within words.  So practice with words and sentences. 
 

b.  Lettering must be uniform.  If not, the viewer will be distracted; keying in on what is 
“wrong” and not the message.  The overall project quality is sacrificed if one letter is extended 
or wide and all others are condensed or thin.  The same applies if any of the letters are a 
different size, style, or height.  The easiest way to help ensure uniformity (along with practicing) 
is to use a lettering guide.  A guide can either be penciled directly onto the project or placed 
underneath the sheet of paper.  The latter of the two is most effective when doing flip chart 
briefings. 
 

NOTE:   Although these guidelines are based on the use of a square-tipped pen  
(Speedball C), they apply to the other tools as well. 

 
c.  The cap line (top), the waistline (middle), the baseline (bottom), and the drop line (below 

the baseline) are the four guidelines for lettering (see Figure D-4).  A vertical guide may be used 
in conjunction with a horizontal guide and is only used to keep a vertical slant consistent, not as 
a spacing guide. 
 

Army Training
CAP
WAIST
BASE
DROP  

 
 

Figure D-4.  Four guidelines for lettering. 
 

(1)  The space between the lines will differ, depending on the nib width and the style of 
lettering used.  A common setup is 3-5-3; three nib widths from drop line to baseline, five nib 
widths from baseline to waistline, and three nib widths from waistline to cap line. 
 

(2) Use the checklist in Table D-1 to evaluate your lettering: 
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Table D-1.  Evaluation checklist for lettering. 
 
• Vertical slant is consistent throughout the project. 
 
• The pen or marker is held at a 30-degree angle to the baseline, except 

for the thick left-hand verticals of v, w, x, and y.  For these verticals, use a 
45-degree angle. 

 
• The bodies of letters touch both the baseline and the waistline. 
 
• The cross bars of t and f are drawn either on the waistline or directly 

below, touching the waistline. 
 
• The two halves of m and w are equal. 
 
• Arches are based on the arc of the letter o. 
 
• Stroke joins occur at the same height in letters of the same formation 

group, such as letters h, n, m, and r. 
 
• Crossbars for letters A and F are just below the waistline; A more so than 

F.  Letters E, P, and R have crossbars on the waistline.  Letters B and H 
are just above the center. 

 
• The vertical for letter G starts below the waistline. 
 
• If the Z’s top stroke is not slightly smaller and centered over the bottom 

stroke, it should be aligned left and right with the bottom stroke. 
 
• Letters K and X intersect just above the waistline.  Letter Y intersects at 

the waistline. 
 
• The V element of letters A, M, V, W, X, and Y are symmetrical and 

vertical. 
 
• All curves relate to a circle. 

 
 

(3)  For any lettering project to appear balanced, the white space, or negative space, must 
appear equal.  Determining spacing is a matter of taste and feeling.  If letters are set equidistant 
from each other, the effect is uneven and very undesirable.  Vary the spacing between adjacent 
letters, depending on whether they have straight sides (H/I/M/N), slanted sides (A/V/W), round  
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sides (O/Q/C/G), or open sides (L/J).  The greatest distance should be left between straight 
strokes.  A curved stroke is placed closer to a straight stroke.  Two curved strokes are placed 
even closer to each other.  An open letter (C/L/J/T) is placed as close to another letter as 
possible without touching.  In some cases the letters might need to overlap, such as a capital R 
placed next to a capital T. 
 

(4)  Another issue that impacts legibility is spacing between words.  Generally speaking, 
there must be enough space to separate words from one another, but not so much as to cause 
us to read one word at a time.  Use a small o (the size of the text you are using) as a spacing 
guide. 
 

(5)  Centering lines is an effective means of drawing attention to information.  One method 
to center your work is to letter the line on a piece of scratch paper using the desired size and 
style.  Once written, it is just a matter of measuring the distance from the center to the beginning 
of the line and transferring that measurement to the project.  Figure D-5 provides a comparison 
between work placed in the optical center (the text on the right) with work placed in the true 
center (the text on the left).  Notice that the work in the true center appears below the center, 
while the work in the optical center appears balanced. 
 

SOLDIER’S
TRAINING

PUBLICATION

SOLDIER’S
TRAINING

PUBLICATION

OPTICAL CENTERTRUE CENTER  
 

Figure D-5.  A comparison between work placed in the optical center 
with work placed in the true center. 

 
d.  Pen and ink are widely used for calligraphy and lettering of many types of projects.  

Pens can be a high-quality technical fountain pen, a standard fountain pen, Speedball lettering 
pens, or a flexible quill pen.  Inks range from low pigment writing ink to a high pigment opaque 
India or drawing inks to inks of many colors.  We will deal with Speedball pens.  Speedball pens 
come in four point or nib styles, designated by a letter.  Following the letter designator is a 
number denoting the size.  The lower the number, the larger the pen line weight.  Pen sizes 
range from 0 to 6.  See Figure D-6. 
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STYLE “A“ SQUARE

STYLE “B” ROUND

STYLE “C“ OBLONG

STYLE “D“ OVAL

“A” pens have a flat square tip making strokes of 
uniform width and square ends.  This nib is 
suitable for Square Gothic and Block letters.

“B” pens have a round tip making uniform strokes
with round tips.  This nib is suitable for Gothic
letters and uniform lines.

“C” pens have a chisel-shaped point which makes
thick and thin strokes.  This nib is ideally
suited to make Roman and Old English text letters.

“D” pens are similar to a “B’ but have an oval
shaped point which is suitable for thick and
medium thin strokes.  The lettering most suited
for this nib is Bold Roman, texts, and ita lics.

 
 

Figure D-6.  Four point- or nib-style Speedball pens. 
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NOTE:  Check the text for correct spelling before lettering with the marker.   
If a mistake is made, a typing label can cover it, allowing for neat corrections. 

 
e.  Marker lettering is one of the quickest and easiest methods of lettering.  This type of 

lettering is used for very short deadlines or informal projects and often used in flip chart 
presentations.  Standard magic markers are the most common and inexpensive, while artist 
markers are high quality, available in a wide range of colors, sizes, and point shapes, and cost 
much more. When using markers, draw guidelines the same as for pen and ink lettering and 
very lightly draw in the text. 
 

(1)  Standard markers come in small and medium sizes.  The small marker has a fine point 
and is used for 1/4- to 3/4-inch lettering and for drawing small lines.  The medium marker has a 
45-degree angled point and is used to make larger letters (3/4 to 3 inches) and for drawing 
thicker lines. 
 

(2)  Larger markers MUST be held at a constant angle while lettering to produce uniform 
letters; if not, lettering effectiveness is lost.  Markers MUST be tightly closed to help prevent 
drying out.  Once the lettering is completed, erase all guidelines. 
 

f.  Brush lettering is a highly flexible form of lettering used with water or oil media.  Like 
other skills, it requires time and practice to master.  Brush letter size varies from 1/4 inch to 10 
feet and greater, encompassing all lettering styles.  Brush lettering is used for posters, vehicle 
markings, signs, and training aides. 

 
(1)  The hairs, ferrule, and handle are the three major parts of brushes.  Round, bright, and 

flat are the three brush shapes used for lettering (see Figure D-7). 
 

A.  A ROUND

B.  A BRIGHT

C.  A FLAT

D.  A QUILL
 

 
 

Figure D-7.  Brush shapes. 
 

(a)  Round.  Hairs come to a point, either blunt or sharp.  The blunt rounds are suited for a 
Gothic style letter when used with even pressure.  The sharp round is suited for a cursive style 
letter made by varying the pressure on the brush.  If more pressure is added, the brush creates 
a broader stroke.  If less pressure is used, the brush creates a finer stroke.  A high quality round 
has a fullness of the hairs when wet, while the hairs of a poor quality round appear concave at 
the sides.  Poor quality brushes also may appear ragged. 
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(b)  Bright.  The shape is flat with sharp corners, a round ferrule, and hairs are one and 
one-half times longer than their width.  The bright shape is ideal for lettering show-cards, 
posters, and small signs. 
 

(c)  Flat.  Its shape is flat with square corners, a flat ferrule, and hairs two and one-half 
times longer than their width.  The flat shape holds more paint than a bright shape, which allows 
more painting between resupplying the brush with a medium.  A quill brush is a specialized flat 
lettering brush for sign painting.  Because of its extra long hair design, the brush has 
tremendous flexibility, holding a comparatively large supply of paint.  The hairs of the quill brush 
are in a rolled, plastic ferrule held in place by a piece of twisted wire.  The hairs are natural 
animal hairs for resiliency (not stiff synthetics).  Quill brushes are often used with a tool called a 
Maul stick.  It is a long, straight dowel with a fat, non-skid end.  Hold the small end of the stick 
so the fat end rests on the project, while the brush hand rests on the stick.  The stick steadies 
the painting hand, adds to stroke control, and assists in painting straight lines. 
 

NOTE: The natural hairs of a quill should never be cut off or trimmed with  
a razor because the hairs will split. 

 
(2)  Brush lettering media (or paint) is either oil or water-based.  These media consist of 

pigment, carrier (supports the elements), and binder (holds it all together).  Some media have 
binders that dry waterproof (latex, enamels, acrylics, and some inks), lending themselves to 
outdoor or permanent requirements.  Others are not waterproof (for instance, watercolors, 
washes, and some inks), which limit their use.  All of these media will require compatible 
thinners to assist with consistency and/or cleanup. 
 
 
 
 
 
 
 
 

 
 
(a)  The paints, brushes, or project may be ruined if the thinners are not properly used.  

Chemical thinners are harsh on brushes and hands when used regularly. 
 

(b)  Brushes used in oil paints or lacquers may be filled with linseed oil, shaped, and placed 
on their side to prolong the life after cleaning.  Brushes should never rest on their hairs.  Motor 
oil is a temporary but expedient oil to use.  The oil prevents remaining paints and varnishes from 
hardening, which causes the brushes to become useless.  The oil must be cleaned out of the 
brush and changed after a month or so of non-use. 
 

(c)  Wash hands thoroughly with soap and water and follow-up with skin cream or 
moisturizer to prevent damage to your hands from paint thinners. 
 

CAUTION 
 
As with most chemical thinners, alcohol is flammable 
and must be used away from open flames in a well-
ventilated area.  Care must be taken not to remove 
undercoats of latex paint. 
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(3)  When lettering on an enamel or lacquered surface with oil-based or lacquer paints, 
guidelines can be drawn using a grease pencil.  Once the lettering has dried, the guidelines can 
be removed with mineral spirits and a soft rag.  Be sure to do a test before attempting the 
project. 
 
D-4.  PREPARING TO LETTER 
 

a.  Gather the materials so they are on hand.  Squarely tape the paper to the board using a 
T-square.  This allows you to accurately and lightly draw in the guidelines. 
 

b.  Adjust the drawing board to a comfortable angle.  The drawing board should not be flat 
on the table.  This position restricts arm movement and causes you to strain to see what you are 
doing.  Prop the board against the front table edge and rest the base of the board in your lap, if 
need be.  The board should be at an angle somewhere between 30 and 45 degrees.  Setting 
your project up in this manner allows for a constant point of view and provides you with the most 
comfortable position to work. 
 

c.  Set up the pens and ink and scrap paper on the right side of your board if you are right-
handed; use the left side if you are left-handed.  This prevents you from having to cross over the 
project with a filled pen, lessening the chance of an accident. 
 

d.  Charge the pen with ink with an eyedropper or a brush.  You can dip the pen into the 
ink, but it is difficult to control the ink.  After refilling the pen reservoir, make trial strokes on a 
piece of scrap paper.  This is a project saver if too much or not enough ink is in the nib.  This 
also allows you to see if any foreign items cause any variance in line quality.  When using these 
pens, you must always PULL the pen.  If you try to push the pen, the tip may dig into the paper 
or board, possibly ruining the project and/or the pen. 
 

e.  Thoroughly mix the pigment and water with a soft brush until it is the right consistency of 
ink.  Load the pen with a brush.  Test the paint flow on a piece of scrap paper.  If the paint is too 
thin, the color is light.  If the paint is too thick, it may not flow from the pen correctly. 
 

f.  Use the same type of scrap paper as the project.  This allows you to see how the surface 
accepts the ink before you attempt to letter on the actual project.  Unsized or waterleaf paper 
absorbs ink like a blotter, causing the letters to bleed.  Uneven sizing causes bleeding in 
patches.  If the paper is slippery, the pen is difficult to control and the ink pools at the bottom of 
the letters. 
 

g.  Lay out the guidelines.  If necessary, letter on scrap paper.  Take measurements from 
the scrap and transfer them to the project.  It is better to measure twice and get it right then to 
rush through the layout process only to realize at the end a mistake was made in the layout.  If 
time permits, lay out the lettering in pencil.  Have someone check the spelling. 
 

h.  Letter the project. 
 

(1)  If a mistake is made with ink, correct the error when the ink is dry.  You can lightly 
scrape the error with a steel eraser, reburnish the surface and re-ink, or paint over the error with 
whiteout and re-ink. Try this on a scrap of the project paper first.  You may need to experiment a 
little to get the desired result.  The key is to avoid making a mistake. 
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(2)  Once the project is completely dry, erase all guidelines.  A white vinyl eraser works 
well.  Again, use the scrap paper first.  This isn’t the time for surprises.  Once you are finished 
with the pen, thoroughly clean it with pen cleaner and pat the nib dry with a paper towel or lint-
free cloth. 
 
D-6.  PREPARED LETTERING 
 

a.  Prepared lettering comes printed on sheets ready to apply or on sheets of adhesive 
plastic or vinyl.  Vinyl letters only require being punched out and applied correctly.  Because of 
their ease of use, they were adapted for a wide range of projects.  Their most common use is for 
vehicle and drive identification on tactical vehicles. 

 
(1)  A lettering sheet is a sheet of waxed acetate with letters printed in reverse on the back.  

These sheets come with a protective backing sheet that prevents the letters from getting 
scratched or coming off on another sheet.  Always store lettering sheets with the backing sheet 
applied.  Do not leave sheets exposed to the air because this causes them to dry out much 
quicker.  If need be, place them in a large manila envelope and indicate on the outside the style 
and sizes. 
 

(2)  Though the letters are of excellent quality, they should only be used for small jobs.  
They are time consuming and the number of letters per sheet is limited. 
 

(3)  To use a lettering sheet, determine the type and size of letter to use and the location for 
placement.  Lightly draw in the guideline, only the baseline is needed.  Place just the sheet with 
the lettering on the project, facing letters out so that they can be read.  Align one letter at a time 
evenly against the guideline and burnish into place with a plastic-burnishing rod.  Field 
expedience may call for any rod-like object with a narrow, rounded end.  The handle on a 
paintbrush might work.  Pencils should NOT be used as a burnisher because they soil the 
sheets with graphite and may end up soiling your project.  If a letter needs removing, press 
scotch tape carefully over the letter and lift, and the letter comes with it.  (Magic tape seems to 
work best.)  Once the lettering is completed, carefully erase the guidelines and use an erasing 
shield if necessary. 
 
 
 
 
 
 
 
 

 
b.  If camera-ready line art is being done, guidelines can be lightly drawn with a non-photo 

blue pencil.  This prevents a need to erase unless the original illustration is displayed.  Old 
lettering sheet letters either fall off or require extreme burnishing.  Pay close attention for this 
may damage your project. 

c.  When lettering is centered, place the center letter on the center of the line of lettering 
and finish from there outward. 
 

d.  Vinyl letters are adhesive-backed and range in size from 1/4 to 12 inches high.  The 
larger sizes are available for special uses and are more expensive.  Vinyl letters come in 

CAUTION 
 
Be careful not to burnish over an adjacent letter.  
When removing the lettering sheet, both letters may 
stick together or be removed, or they may not align 
perfectly. 
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various thickness, colors, and finishes.  They can be used for signs, charts, automobile 
markings, and much more. 
 
D-7.  MECHANICAL LETTERING 
 

a.  Mechanical lettering is done by mechanical means or with machines. 
 

(1)  Leroy is a drafting equipment company trade name that makes a mechanical lettering 
set.  Because the Leroy set is so popular, it has become the norm when referring to mechanical 
lettering sets (see Figure D-8).  Wrico and Keufel and Esser are two other high-quality lettering 
sets on the market.  These sets produce many neat, clean, uniform styles and sizes of lettering, 
which range from 1/8 to 2 inches.  The sets are easy to master with minimum practice, but are 
time-consuming when compared to other mechanical methods.  These sets consist of a scriber, 
pens, and templates with grooved letters; masking tape and a T-square are needed extra items.  
The checklist identified in Table D-2 is based on the Leroy mechanical lettering set, though any 
set can be used by following the manufacturer's manual. 
 
 

 
 

 
Figure D-8.  Leroy lettering set. 
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Table D-2.  Leroy checklist. 
 

• Determine project-lettering requirements. 
 

• Affix project squarely to a drawing surface with masking tape. 

• Draw in the guidelines. 
 

• Choose a template and place on the upper edge of the T-square. 
 

• Select and attach the required pen (technical fountain pens may be 
used). 

 
• Adjust T-square, template, pen, and scriber to properly position the 

lettering on the guidelines. 
 

• Letter the project.  Erase the guidelines once lettering is completed 
and ink is dry. 

 
 

 (2)  Kroy or Merlin pressure-lettering machines consist of a lettering font or wheel with 
various styles and sizes of raised letters and a pressure or dry carbon transfer process 
machine.  The system imprints character sizes (8 to 36 points) and styles on 1/2-inch paper or 
plastic strips.  The strips come in various colors or can be clear and have an adhesive back with 
a protective, peel-off plastic coating.  The machines can be simple, one character at a time, or 
automatic machines equipped with computer memory, editing functions, and a display screen. 
 

b.  Table D-3 list tips on doing mechanical lettering. 
 

Table D-3.  Mechanical lettering tips. 
 
• To prevent a T-square from slipping, apply masking tape to both ends 

to hold it in place. 
 

• To prevent the project from getting soiled from the template sliding 
along the T-square, place a sheet of clean paper between the project 
and the template. 

 
• If clogs occur in tiny pens in the set, lift scriber from project and rotate 

the cleaning pin.  For technical fountain pens, remove scriber from 
project, cover pen with a cloth or paper towel, and shake gently.  In 
either case after checking for good ink flow on scrap paper, continue to 
letter. 

 
• To correct mistakes made in ink, let the ink dry and remove mistake 

gently with a steel eraser.  Reburnish the surface before re-inking. 
 

• Typewriters can be used to make labels for charts, graphs, fliers, and 
viewgraph markers.  Most modem typewriters have changeable 
typefaces and variations in the small sizes.  Though typewriter use is 
quick and easy, the small character size limits its use. 
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APPENDIX E 
 

ELECTRONIC PAGE LAYOUT 
 
 
E-1.  INTRODUCTION 
 
 Ten years ago, research was conducted by reading books and scrolling through 
microfiche—effective computer hardware and software for electronic page layout were a vision 
in the future.  Today, however, most companies, researchers, publishing firms, and editors are 
turning to the electronic medium for information retrieval, archival purposes, print production, 
and instantaneous communications.  Although there are many software packages available for 
designing page layouts, this appendix covers PageMaker's applications for creating and 
producing publications for both print and electronic delivery.  
 
E-2.  CREATING A PAGE LAYOUT 
 

a.  While there are many templates to choose from, the most common way to create a 
layout is by using custom page designs.  To start a custom layout, choose New from 
PageMaker’s File menu.  You will be presented with a dialog box asking for page dimension, 
borders, and other related options.  One of the options is called Facing Pages.  If this box is 
checked, you will create double-page spreads, with each page the size you specify.  If Facing 
Pages is not checked, you will get one-sided pages.  Fill in the information and click OK. 
 

b.  Most page layout applications (and illustration programs) work on a principle of master 
pages.  A master page is the page where you set up all the important information that will 
dictate overall appearance.  Any information placed on the master page appears on every 
consecutive page.  Most designers put their columns and guides on the master page.  Headers, 
footers, page numbers, and graphics that you want on every page are also placed on the 
master page. 
 

(1)  You can review and edit master pages by clicking on their icon in the lower left corner 
of the document window. 
 

(2)  To use a master page in a document, choose Display Master Items from the Layout 
menu.  This allows you to turn the master items on or off on individual pages. 
 

c.  Grids help to keep the layout simple and elegant.  Use the software to automatically 
create columns and then to manually place horizontal grid lines at even increments; one inch 
works well.  This gives you a system on nonprinting columns and grids that allow you to align 
objects. 
 

(1)  It is much easier to read short lines of text in columns than to read lines that are the 
width of the page.  While setting up the grid, create columns with a small space between them.  
These columns are for reference and are not set in stone.  Some situations need to have the 
text flow across columns to tie a layout together. 

(2)  To set up columns in PageMaker, choose Columns Guides from the Layout menu.  A 
dialog box appears.  Enter the number of columns needed and the space required between the 
columns.  Do not put too much or too little space between the columns.  PageMaker then draws 
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the appropriate column guides on the page.  You can manually change the width of the columns 
by dragging the column guides from side to side. 
 

d.  The second step in creating a grid is setting up horizontal guides.  Horizontal guides are 
used exactly like column guides, but are horizontal.  To add horizontal guides, ensure the rulers 
are displayed.  (Choose Rulers from the Guides and Rulers menu, which is under the Layout 
menu.)  If the rulers are displayed, simply move the cursor into the ruler area and drag out from 
there.  A guideline will be attached to the cursor that can be dragged up or down into position.  If 
no guideline appears, make sure that Guides is selected in the Guides and Rulers menu.  Once 
a guide is placed, it can be moved by moving the cursor to the guide, clicking on it, and 
dragging it to the new location.  To remove a guide, click and drag it off the document area. 
 

(1)  Guides are not limited to horizontal.  To place a vertical guide, drag out from the ruler 
on the left side of the document window.  A vertical guide appears and can be manipulated and 
placed exactly like a horizontal guide.  Vertical guides are useful for aligning objects that are not 
placed exactly on a column guideline. 
 

(2)  Snap to Guides is another option under the Guides and Rulers menu.  Snap to Guides 
means that when objects are placed, they will align with the nearest guide and will resist moving 
from that position.  This is useful whenever you want to align several objects along a particular 
guide. 
 

(3)  Guides can be locked so they are not accidentally moved or deleted.  To lock a guide, 
choose Lock Guides from the Guides and Rulers menu. 
 
E-3.  PLACING OBJECTS 
 

a.  Incorporating different types of objects, text, pictures, hand drawn art, tables, and 
graphs into one document is what page layout is all about. 
 

(1)  Text can be either written in the application software or imported from a word 
processor.  To write text in PageMaker, choose the text tool from the Tool Palette and click 
where you want the text to begin.  Exact positioning is not critical; the text can be freely 
repositioned.  Type the body of text.  Fonts, size, and style can be changed, as well as kerning, 
tracking, and leading by using the functions under the Type menu.  PageMaker is better suited 
for short text (headlines, captions), while a word processor is designed to handle large bodies of 
text. 
 

(a)  Moving a body of text is as simple as clicking and dragging.  Select the arrow pointer 
tool and click on the body of text to be moved.  A box outlines the body of text.  As long as the 
left mouse button is held down, the selected body of text moves with the cursor movements.  
The line length can be adjusted by clicking on the points on either end of the box, and the 
handles at the top and bottom of the box can be used to change the vertical size of the block of 
text.  Also, the entire text box can be rotated to any angle by clicking on the rotate tool and 
dragging around to the desired position. 

(b)  To import text created in another application, select Place from the File menu and 
navigate to the desired document and click OK.  The cursor icon changes to the text place icon.  
Move it to where the text is to begin and click.  PageMaker creates a text box on the page to  
contain the text.  If the text is longer than the length of the page, the bottom handle is red.  To 
continue the text flow, click on the red handle and the icon again appears as a text placement 
icon.  Move to where the text is to continue and click again.  Do this as many times as 
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necessary to place all of the text.  An easier way to place a piece of long text is to select 
Autoflow from the Layout menu before placing the text onto the document.  With Autoflow 
selected, PageMaker flows the text across all of the pages, creating new pages as necessary to 
accommodate all of the text. 
 

(c)  With the text in place, it can be handled exactly like the text created in PageMaker.  
Document editing and story editing are two options for editing text.  Document editing is clicking 
on the text with the text tool and editing.  Story editing is used to edit large stories and acts like 
a mini word processor.  To use the story editor, choose Edit Story from the Edit menu.  A 
window with the text appears and you can edit it just like a word processor.  PageMaker also 
gives the option of editing the original text by choosing Edit Original from the Edit menu.  This 
option launches the original application the text was created in and allows you to edit there. 
 

(2)  Adding pictures, especially color photos, can make even the most boring layout more 
exciting.  Adding images is exactly like adding text.  Choose Place from the File menu and 
navigate to the appropriate file and click OK.  The cursor changes to the imager placement icon.  
Move to where the image is to be placed and click.  Images must be in PICT, Photo CD, TIFF, 
or Postscript format to be placed in PageMaker. 
 

(3)  Hand drawn art created in programs such as Illustrator or Freehand follow the same 
procedures for placing text and photos.  The art can be moved or resized after placement. 
 

(4)  Professionally drawn clip art is also placed like other types of graphics.  Additionally, 
you can create a library of art that can be saved and used repeatedly. 
 

(a)  To create a library using art cataloged with Adobe Fetch, first select the art in Fetch and 
choose Include Thumbnails from the Copy Reference and Edit menus in Fetch.  Next, switch to 
PageMaker and select Library Palette from the Window menu.  To place the items into the 
library, select Import Fetch Items from the Options menu in the Library Palette.  The Fetch items 
now appear. 
 

(b)  To use items from the library, drag the art from the palette to where you want it placed 
on the page.  PageMaker then copys the original item into the layout. 
 

(c)  The library is not only for clip art.  Any importable item can be copied and placed into 
the library by clicking on the + icon.  The library is useful when you want to use the same piece 
of art or graphic more than once throughout a document.  Libraries can be saved and reused, 
which is helpful when you want to use the same consistent graphics throughout a large 
publication, such as a book or magazine. 
 

(5)  PageMaker can import tables and graphs created in other applications.  PageMaker 
cannot, however, edit the data in a table or graph once it is placed, because it imports them as 
graphics.  The table/graph can be resized and repositioned, but the data cannot be changed. 

(a)  To import a table or graph, create the table in Word or Excel.  Go to the Table menu 
and turn off Gridlines.  Choose Select Table from the Table menu, selecting the entire table.  
Press Ctrl + c to copy the selected table.  Switch to PageMaker.  In PageMaker, click on the 
pointer tool.  Choose Paste Special from the Edit menu.  Choose PICT from the dialog box and 
press Paste.  The cursor becomes a graphic placement icon.  Click where the table goes. 
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(b)  Once the table is copied onto the document, it can be enlarged, reduced, stretched, or 
repositioned.  To change the data, you must change the original graph or table in the application 
it was created in and then repeat the steps for importing it. 
 

(c)  PageMaker 6.0 comes with its own Table Editor application.  Choose Insert Object from 
the Edit menu and then choose Adobe Table.  This application works much like Microsoft Graph 
and can be used to place the tables that can be edited after placement. 
 

b.  PageMaker has four drawing tools.  These tools are not intended to replace a good 
illustration application or clip art supply, but to create basic graphic shapes. 
 

(1)  The diagonal-line tool is used to draw diagonal lines.  Simply click on the tool and then 
drag from where you would like the line to start to where the line should end. 
 

(2)  The straight-line tool is used to draw straight lines.  Again, click on the tool and drag in 
the direction the line should go.  Lines will be confined to a 45-, 90-, or 180-degree angle. 
 

(3)  The rectangle tool is used to draw squares and rectangles.  Choose the tool and then 
drag the desired sized rectangle on your document.  To draw symmetrical squares, hold down 
the shift key while dragging. 
 

(4)  The oval/circle tool works just like the rectangle tool, but produces ovals or circles. 
 

c.  PageMaker offers several options to modify the drawn shapes.  These options are found 
under the Element menu. 
 

(1)  The first option is Line.  This is where you control the thickness and style of lines drawn 
with PageMaker tools, and affects the lines that make up the edges of circles and squares.  To 
change the line style of an object, first select the object using the pointer tool.  Once selected, 
choose the style and width of the lines.  There are many pre-made lines to choose from, or 
choose Custom to create your own. 
 

(2)  The Fill option is used to fill in objects drawn with PageMaker.  The Fill menu provides 
options for colors at the top of the menu and fills texture patterns at the bottom. 
 

(a)  The Paper option fills the selected object with the same color as the background paper.  
This is useful for covering part of another object with a blank piece of paper.  Choose Define 
Color under the Element menu to change the color settings.  You can set the color of the paper, 
as well as the color model (RGB or CMYK) and the color palette under the Define Color option. 
 

(b)  Fill and Lines is another option used to define objects. You can change the fill and line 
styles by using this command with one dialog box.  The color of the fill can be set by using the 
pull down menu in the dialog box. 

(3)  The Rounded Corners option is used to define the shape of the corners of the objects.  
When selected, a dialog box of six different corner options appears.  Simply click on one and 
then click OK.  The new corner style is applied to all selected objects.  The styles range from 
just slightly dull corners to very rounded curved edges. 
 
E-4.  TEXT WRAP 
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Text Wrap is a common design technique.  Text wrap means to have the text flow around 
an object according to set specifications, instead of having the text flow on top of the object.  
Text wrap is used to control the text flow around regular and irregular shaped objects.  To use 
this function, select the object you would like to wrap text around.  Next, choose Text Wrap from 
the Element menu.  The dialog box gives the options of no wrap, standard rectangular text 
wrap, and custom wrap. 
 

(1)  No text wrap.  This option is the default setting.  No text wrap is used when you want 
the text to cover up the graphics or vice versa.  This option is useful when printing a graphic 
behind text, such as a watermark. 
 

(2)  Standard text wrap.  This option wraps the text around a regular-shaped object.  
Standard text wrap is used to wrap text around a photo, table, or regular-shaped graphics.  
When this option is selected, there are other options available.  There are three Text Flow icons 
directly below the wrap options.  These icons are used to control how the text flows, either 
jumping over the object or wrapping the text around the sides.  You also must enter the standoff 
amount in the bottom of the dialog box.  This is the amount of white space left between the text 
and the object. 
 

(3)  Custom wrap.  This option is used to wrap text around irregular-shaped objects or to 
produce jagged shaped text blocks.  This function is useful when placing graphics that have 
irregular shaped edges.  Custom wrap produces interesting designs, but may be harder to read. 
 

(a)  The custom wrap option is always subdued in the Text Wrap dialog box.  To access the 
custom wrap function, you must first select the Standard text wrap option and then return to the 
document and create the custom wrap.  When you have selected an object that has the 
standard text wrap applied, there is an extra dotted box surrounding the object.  This box 
defines the standoff text wrap borders. 
 

(b)  To create a custom shape, move the control points located at the corners of the 
standoff box.  Control points can also be added to make the custom box any size or shape.  To 
add a point, click once at the new handle location.  To move an entire section of the standoff 
border, drag the section.  To remove a control point handle, drag the unwanted point onto 
another handle point.  If you now return to the Text Wrap dialog box, you will see that the 
Custom icon is selected.  The standoff distance can still be changed in the dialog box. 
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E-5.  LAYERS 
 

PageMaker works on a layering principle.  Each object on the page is a layer that can be 
sent to the back or brought to the front.  Depending on the attributes of the object, it will either 
hide objects that it is on top of (in front of) or be hidden by layers in front of it.  To move an 
object through the layers, select it and then choose either Bring to Front or Send to Back from 
the Element menu. 
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APPENDIX F 
 

HYPERTEXT MARKUP LANGUAGE (HTML) 
 

 
F-1.  INTRODUCTION 
 

a.  It is not possible to address the entire web authoring software packages available today.  
This appendix covers a very basic approach to producing a webpage.  You are encouraged to 
use a commercial package and to experiment.  For the sake of instruction, Netscape is used as 
the example of a web browser. 
 

b.  Webpages are World Wide Web documents that use HTML to create different effects to 
the various components of the document.  HTML is a collection of platform independent codes 
or tags used to set attributes, styles, links, and so on, within the document and was designed to 
be user friendly.  You do not have to be a programmer to use or understand it.  If you can edit a 
document, you can create a webpage. 
 

c.  There is a multitude of web authoring software packages available, but they are not 
necessary.  An HTML document can easily be created in a plain text editor, such as NotePad.  
In some cases, it may actually be easier to cut and paste than to launch and use an authoring 
package. 
 

d.  A webpage may be strictly text or a composite of text, images, sounds, and animation.  
In the generic sense, an HTML document is text with tags inserted to specify how the text is 
displayed by the browser, as well as to identify the various elements of an HTML document; 
elements being heads, tables, paragraphs, and so on. 
 
F-2.  HTML TAGS 
 

a.  An HTML tag uses a left angle bracket (<), a tag name, and then the right angle bracket 
(>).  Between the < character and the > character is the tag name and depending on the tag, 
the attributes.  Not all tags support attributes.  Some attributes are required and some are 
optional. 
 

(1)  Tag names and attributes are not case sensitive, but some attribute values are. 
 

(2)  Tags have a simple format.  The tag name must come first and then the attributes.  It 
does not matter what order the attributes are in, as long as they come after the tag name. 
 

(3)  Normally, tags are paired to indicate the beginning and ending of the tag instruction.  
The end tag is an exact copy of the beginning tag, but with a slash (/) before the text within the 
brackets. 
 

(4)  Not all tags are recognized by all browsers, which is why there is usually a statement 
somewhere on the webpage to the effect, “this site is best viewed with (Browser X).”  If a 
browser does not recognize a tag, the browser usually ignores the tag. 

b.  At a minimum, a document will contain a section for the head and one for the body.  The 
head is the title section.  The body is the actual text, paragraphs, tables, photographs, and other 
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elements.  The required tags for any HTML document are <html>, <head>, <title>, and <body>.  
Table F-1 shows an example of a basic HTML document. 
 

Table F-1.  Basic HTML document. 
 
<html> 
<head> 
<TITLE>A Basic HTML Document</TITLE> 
</head> 
<body> 
<H1>It Doesn’t Take a Rocket Scientist</H1> 
<P>This is the new frontier for Illustrators.  We will be able to share our 
talents with the world and never leave our desks.  This is the first 
paragraph.</P> 
<P>This is the second paragraph.</P> 
</body> 
</html> 
 

 
c.  HTML tags tell the browser that the file contains HTML-coded information.  All HTML 

documents must be saved with the .html extension.  If your system only recognizes an 8.3 
filename, use .htm as the extension. 
 

(1)  The HEAD element identifies the first section of the HTML document.  It contains the 
title element. 
 

(2)  The title element contains the title of the document.  When drafting a title, bear in mind 
that the title is what is displayed on someone’s hotlist or in a booklist.  Try to create a title that is 
unique to that page, descriptive, and relatively short. 
 

(3)  The body element is the second section in a document and also the largest.  The body 
is where everything else is placed.  There are other elements that are found within the body 
element. 
 

(a)  Headings come in sizes 1 to 6, with 1 being the largest and 6 the smallest.  A heading 
tag is written as <H#>Heading text </H#>; # is any number between 1 and 6. 
 

(b)  Paragraphs are indicated with a <P> tag.  A web browser ignores any indentations 
and/or blank lines in the source text (your saved file).  Without the <P> tags, the body becomes 
one large paragraph. 
 

(c)  HTML files ignore carriage returns.  The length of a line is not extremely important, 
though it is better to keep them to fewer than 72 characters.  The browser condenses multiple 
spaces into a single space.  If there is a line break in the source file, a web browser ignores 
them and starts a new paragraph only when it finds another <P> tag. 
 

(d)  The </P> closing tag can be omitted, except for the last paragraph.  A web browser 
understands that a new <P> tag is the beginning of a new paragraph and the previous 
paragraph is ended. 
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(e)  Using the <P> and</P> tags to define a paragraph allows you to center the paragraph, 
including an attribute statement in the source file.  Table F-2 shows an example of an attribute 
statement. 
 

Table F-2.  Attribute statement. 
 
<P ALIGN=CENTER> 
The text for the paragraph that will be centered goes here. 
 
</P> 
 

 
(f)  To make a source file easier to read and help you edit it, put headings on separate lines, 

use a blank line or two to help identify the start of a new section, and separate paragraphs with 
blank lines as well as a <P> tag.  The browser ignores the extra lines.  
 

d.  HTML supports numbered, unnumbered, and definition lists.  Lists can be nested (lists 
within lists), but this feature can be confusing, so use it sparingly. 
 

(1)  Definition lists are tagged with (normally) <DL>.  The definition term is tagged <DT>.  
The definition’s definition is tagged <DD>.  Table F-3 shows an example of a definition list. 
 

Table F-3.  Definition list. 
 
<DL> 
<DT> HTML 
<DD> hypertext Markup Language is a collection of platform-independent 
styles, indicated by tags that define the various elements of a webpage. 
<DT> WWW 
<DD> World Wide Web 
</DL> 
 
Reads as: 
HTML 
 Hypertext Markup Language is a collection of platform-independent 
styles, indicated by tags that define the various elements of a webpage. 
WWW 
 World Wide Web. 
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(2)  Numbered lists, also referred to as an ordered list, use the tag <OL>.  The individual 
items are tagged with <LI>; a closing </LI> tag is not necessary.  Use the tag </OL> to close a 
numbered list.  Table F-4 shows an example of a numbered or ordered list. 
 

Table F-4.  Numbered/ordered list. 
 

<OL> 
<LI>PLDC 
<LI>BNCOC 
<LI>ANCOC 
</OL> 
 
Reads as: 
1.  PLDC 
2.  BNCOC 
3.  ANCOC 

 
 

(3)  Unnumbered lists are very similar to numbered lists.  They are tagged with <UL> and 
also use <LI> for the individual items on the list.  Table F-5 is an example of an unnumbered 
list. 
 

Table F-5.  Unnumbered list. 
 
<UL> 
<LI>Red 
<LI>Yellow 
<LI>Blue 
</UL> 
 
Reads as: 
Red 
Yellow 
Blue 

 
 

(4)  The COMPACT attribute can be used in the event that the definitions are short.  Table 
F-6 shows an example of a definition list using the COMPACT attribute. 
 

Table F-6.  Definition list using the COMPACT attribute. 
 
<DL COMPACT> 
<DT>URL- 
<DD>Uniform Resource Locators 
</D> 
 
Reads as: 
URL-  Uniform Resource Locators 
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(5)  Nested lists are lists within a list.  Table F-7 shows an example of a nested list. 
 

Table F-7.  Nested list. 
 

<UL> 
<LI>CONUS SITES 
<UL> 
<LI>Fort Bragg 
<LI>Fort Gordon 
<LI>Fort Meade 
<LI>Fort Huachuca 
<UL> 
<LI>OCONUS SITES 
<UL> 
<LI>Graffenwoeher 
<LI>Yongsom 
<LI>Fort Shafter 
 
Reads as: 
 
CONUS SITES 

Fort Bragg 
Fort Gordon 
Fort Meade 
Fort Huachuca 

OCONUS SITES 
Graffenwoeher 
Yongsom 
Fort Shafter 

 
 

e.  Links allow a reader to “jump” to another section or to another document.  The tag for a 
link is <A>, which stands for anchor.  To place a link in an HTML document, perform the steps 
listed below. 
 

(1)  Begin the anchor with <A (use a space after the A). 
 

(2)  Specify the document (file) linking to by entering the parameter HREF =“filename” 
followed by a closing right angle bracket (>). 
 

(3)  Type in the text that identifies the hyperlink in the current document. 
 

(4)  End the anchor with the ending tag </A>.  There is no space needed before the ending 
anchor tag. 
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(5)  Table F-8 shows the source code for a link. 
 

Table F-8.  Link source code.  
 
<A HREF=“packlist.htm”>Packing List</A>    
 
This line brings up the packing list when a viewer 
clicks on the phrase Packing List. 
 

 
f.  Address tags provide the viewer with a means of contacting the webmaster via e-mail, as 

well as provide the document’s revision date.  It is normally the last item in a file.  An address 
line might look like the example shown in Table F-9. 
 

Table F-9.  Address line. 
 
<ADDRESS> 
Your Web Site Title/Any Higher Headquarters that 
must be identified/ webmaster@emh2.army.mil / 
revised Month Year 
</ADDRESS> 
 
A Mailto tag allows the reader to send e-mail to a 
specific person or mail alias.  To create a mailto link, 
enter  
<A HREF=“mailto:name@army.mil”>Name</A> 
 

 
g.  Background color can be defined in the same manner as text, links, visited links, and 

active links by specifying the attributes of the <BODY> tag. 
 

h.  Background graphics also use the <BODY> tag, but stipulate which file to tile.  The tag 
for a background image includes an attribute statement such as <BODY 
BACKGROUND=“filename.gif”>. 

 
i.  Table F-10 provides additional HTML tags with a brief description of each. 
 

Table F-10.  HTML tags. 
 
<!-- text -->  

Comment text out of the HTML code. 
 
<A ATTRIBUTE> picture/text </A>; 

Adds an anchor to picture/text. Possible ATTRIBUTEs are: 
HREF="#anchor_name"  

          Link this to anchor_name within this document.  
HREF="URL"  

          Link this to URL.  
HREF="URL#anchor_name"  

          Link this to anchor_name within URL.  
 

Table F-10.  HTML tags (continued). 
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<A ATTRIBUTE> picture/text </A> (continued); 
HREF="URL?search_string"  

          Link this to search for search_string within URL.  
METHODS  
NAME="anchor_name"  

          Make an anchor at this spot that is called anchor_name.  
REL  
REV  
TITLE  
URN  

 
<ADDRESS> address </ADDRESS>  
     Present address information.  
 
<B> text </B>  
     Makes text bold.  
 
<BASE>  
     Specify the name of file in which the current document is stored. This is usually placed in the head 
of the document.  
 
<BLOCKQUOTE> . . . </BLOCKQUOTE>  
     Defines a section as being quoted from another source.  
 
<BODY> . . . </BODY>  

Defines the body of an HTML document.  
 
<BR>  

Force a line break (use two for a blank line).  
 
<CITE> . . . </CITE>  

Cite some material.  
 
<CODE> . . . </CODE>  

Display this as HTML code.  
 
<DD> definition  

Display a definition in a definition list or glossary. See <DL> and <DT>. (Commonly used to make 
lists without bullets or numbers).  

 
<DFN> definition </DFN>  

Display a definition.  
 
<DIR> . . . </DIR>  

Display a directory of items. (Usually headed by bullets.) See <LI>.  
 
<DL> . . . </DL>  

Make a definition list or glossary. See <DD> and <DT>. (Commonly used to make lists without 
bullets or numbers).  
 
 

 
Table F-10.  HTML tags (continued). 

 
<DT> term  
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Display a term in a definition list or glossary. See <DD> and <DL>.  
 
<EM> text </EM>  

Make text have emphasis.  
 
<FORM ATTRIBUTE> . . . </FORM>  

Define an online form. The information is sent to a query server to search for or collect information 
for a database. See <INPUT>, <OPTION>, 

<SELECT>, and <TEXTAREA>. Possible ATTRIBUTEs are:  
ACTION="URL"  

          The URL of the query server.  
METHOD=method  

          The method used by form, either get or post.  
 
<H1> text </H1>  

Make text header style 1. The most prominent header style.  
 
<H2> text </H2>  

Make text header style 2.  
 
<H3> text </H3>  

Make text header style 3.  
 
<H4> text </H4>  

Make text header style 4.  
 
<H5> text </H5>  

Make text header style 5.  
 
<H6> text </H6>  

Make text header style 6. The least prominent header style.  
 
<HEAD> . . . </HEAD>  

Defines the head of an HTML document.  
 
<HR>  
 Place a horizontal rule or separator between sections of text.  
 
<HTML> . . . </HTML>  

Defines an HTML document.  
 
<I> text </I>  

Make text italic.  
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Table F-10.  HTML tags (continued). 
 
<IMG ATTRIBUTE>  

Load an inline image (on browsers that support it). Possible ATTRIBUTEs are:  
ALIGN=alignment  

          How to align the picture with the text, possible alignments are top, middle, or bottom.  
ALT="text"  

          Alternative text if browser does not support images, or image cannot be loaded.  
ISMAP  
SRC="URL"  

          The URL of the image.  
 
<ISINDEX>  

Specify index file. This is usually placed in the head of the document.  
 
<KBD> key </KBD>  

Display key as a key from the keyboard.  
 
<LI> item  

Display item in a list. See <DIR>, <MENU>, <OL>, and <UL>.  
 
<LINK ATTRIBUTE>  

Specify relationships to other documents. This is usually placed in the head of the document. 
Possible ATTRIBUTEs are:  

REV=relationship  
          The relationship of this file to the other one. The relevant relationship is made.  

HREF="URL"  
          The URL of the file pointed to by the link.  
 
<LISTING> . . . </LISTING>  

Define as a computer listing, embedded tags are ignored.  
 
<MENU> . . . </MENU>  

Display a menu of items. (Usually headed by bullets.) See <LI>.  
 
<NEXTID>  
     Set a variable name. Attribute: variable name. This is usually placed in the head of the document.  
 
<OL> . . . </OL>  

Display an ordered list or glossary. (Headed by numbers.) See <LI>.  
 
<P> . . . </P>  

Define this area as a paragraph, and format accordingly.  
 
<PLAINTEXT> . . . </PLAINTEXT>  

Define this area as plain text.  
 
<PRE> . . . </PRE>  

Define this area as preformatted text, and display as is. May include some tags.  
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Table F-10.  HTML tags (continued). 
 
<SAMP> . . . </SAMP>  

Make sample output.  
 
<STRONG> text </STRONG>  

Make text have strong emphasis.  
 
<TITLE> title </TITLE>  

Define the title of the document. Note this is not a header. This is usually placed in the head of the 
document.  
 
<TT> text </TT>  

Display text in a typewriter text.  
 
<U> text </U>  

Display text underlined.  
 
<UL> . . . </UL>  

Display an unordered list or glossary. (Usually headed by bullets.) See <LI>.  
 
&#ascii;  

Display ASCII character corresponding to ascii.  
 
&Aacute;  

Display capital A, acute accent (Á).  
 
&aacute;  

Display small a, acute accent (á).  
 
&Acirc;  

Display capital A, circumflex accent (Â).  
 
&acirc;  

Display small a, circumflex accent (â).  
 

&AElig;  
Display capital AE diphthong (ligature) (Æ).  

 
&aelig;  

Display small ae diphthong (ligature) (æ).  
 
&Agrave;  

Display capital A, grave accent (À).  
 
&agrave;  

Display small a, grave accent (à).  
 
&amp;  

Display ampersand (&).  
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Table F-10.  HTML tags (continued). 
 
&Aring;  

Display capital A, ring (Å).  
 
&aring;  

Display small a, ring (å).  
 
&Atilde;  

Display capital A, tilde (Ã).  
 
&atilde;  

Display small a, tilde (ã).  
 
&Auml;  

Display capital A, dieresis or umlaut mark (Ä).  
 
&auml;  

Display small a, dieresis or umlaut mark (ä).  
 
&Ccedil;  

Display capital C, cedilla (Ç).  
 
&ccedil;  

Display capital c, cedilla (ç).  
 
&Eacute;  

Display capital E, acute accent (É).  
 
&eacute;  

Display small e, acute accent (é).  
 
&Ecirc;  

Display capital E, circumflex accent (Ê).  
 
&ecirc;  

Display small e, circumflex accent (ê).  
 
&Egrave;  

Display capital E, grave accent (È).  
 
&egrave;  

Display small e, grave accent (è).  
 
&ETH;  

Display capital Eth, Icelandic (Ð).  
 
&eth;  

Display small eth, Icelandic (ð).  
 

 



STP 11-25M13-SM-TG 

F-12 

Table F-10.  HTML tags (continued). 
 
&Euml;  

Display capital E, dieresis or umlaut mark (Ë).  
 
&euml;  

Display small e, dieresis or umlaut mark (ë).  
 
&gt;  

Display greater than sign (>).  
 
&lt;  

Display less than sign (<).  
 
&Iacute;  

Display capital I, acute accent (Í).  
 
&iacute;  

Display small i, acute accent (í).  
 
&Icirc;  

Display capital I, circumflex accent (Î).  
 
&icirc;  

Display small i, circumflex accent (î).  
 
&Igrave;  

Display capital I, grave accent (Ì).  
 
&igrave;  

Display small i, grave accent (ì).  
 
&Iuml;  

Display capital I, dieresis or umlaut mark (Ï).  
 
&iuml;  

Display small i, dieresis or umlaut mark (ï).  
 
&nbsp;  

Display nonbreaking space ( ).  
 
&Ntilde;  

Display capital N, tilde (Ñ).  
 
&ntilde;  

Display small n, tilde (ñ).  
 
&Oacute;  

Display capital O, acute accent (Ó).  
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Table F-10.  HTML tags (continued). 
 
&oacute;  

Display small o, acute accent (ó).  
 
&Ocirc;  

Display capital O, circumflex accent (Ô).  
 
&ocirc;  

Display small o, circumflex accent (ô).  
 
&Ograve;  

Display capital O, grave accent (Ò).  
 
&ograve;  

Display small o, grave accent (ò).  
 
&Oslash;  

Display capital O, slash (Ø).  
 
&oslash;  

Display small o, slash (ø).  
 
&Otilde;  

Display capital O, tilde (Õ).  
 
&otilde;  

Display small o, tilde (õ).  
 
&Ouml;  

Display capital O, dieresis or umlaut mark (Ö).  
 
&ouml;  

Display small o, dieresis or umlaut mark (ö).  
 
&quot;  

Display double quote (").  
 
&szlig;  

Display small sharp s, German (sz ligature) (ß).  
 
&THORN;  

Display capital THORN, Icelandic (Þ).  
 
&thorn;  

Display small thorn, Icelandic (þ).  
 
&Uacute;  

Display capital U, acute accent (Ú).  
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Table F-10.  HTML tags (continued). 
 
&uacute;  

Display small u, acute accent (ú).  
 
&Ucirc;  

Display capital U, circumflex accent (Û).  
 
&ucirc;  

Display small u, circumflex accent (û).  
 
&Ugrave;  

Display capital U, grave accent (Ù).  
 
&ugrave;  

Display small u, grave accent (ù).  
 
&Uuml;  

Display capital U, dieresis or umlaut mark (Ü).  
 
&uuml;  

Display small u, dieresis or umlaut mark (ü).  
 
&Yacute;  

Display capital Y, acute accent (Ý).  
 
&yacute;  

Display small y, acute accent (ý).  
 
&yuml;  

Display small y, dieresis or umlaut mark (ÿ).  
 

 
F-3.  CONSTRUCTING THE HTML DOCUMENT 
 

a.  Creating a directory for the webpage. 
 

(1)  Select images for the webpage. 
 

(a)  Scan in the artwork or photograph(s) using Adobe PhotoShop. 
 

(b)  Resize the image(s), changing the resolution to 72 dpi. 
 

(c)  Change the color mode to indexed colors (8 bit, adaptive, diffusion). 
(d)  Name and save the file(s) in the webpage directory. 
(2)  Using a graphic software package (such as Adobe PhotoShop), create a .gif file to be 

used as the webpage background.  Save the file in the webpage directory. 
 
(3)  Open a text editor, such as NotePad. 

 
(4)  Enter all tags and text. 
(5)  Save the file in the web directory using either an .htm or .html extension. 
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(6)  Open the file in the browser and review it for correctness and compliance with the 
Guidance for the Management of Army Websites. 
 

(7)  Make any necessary corrections. 
 

(8)  Put the document on the web server and check the formatting and each link.  Files may 
be sent to an HTML validation service (check with the local Directorate of Information 
Management (DOIM) to verify the titles conform to accepted HTML standards. 
 

(9)  Update files as necessary. 
 
b.  Creating the webpage using a browser. 

 
(1)  Launch Netscape Navigator 3.0 Gold. 

 
(2)  Close the browser window. 

 
(3)  Select FILE from the main menu bar. 

 
(4)  Choose NEW DOCUMENT from the pull-down menu. 

 
(5)  Click on BLANK from the fly-out menu. 
 
c.  Changing the Netscape webpage editor settings. 
 
(1)  Select OPTIONS from the main menu bar. 

 
(2)  Select EDITOR PREFERENCES from the drop-down menu.  The EDITOR 

PREFERENCES dialog box appears. 
 

(3)  Select the PUBLISH tab from the EDITOR PREFERENCES dialog box. 
 

(4)  Uncheck the MAINTAIN LINKS and KEEP IMAGES WITH DOCUMENTS boxes. 
 
d.  Placing a background image on your webpage. 
 
(1)  Click the APPEARANCE tab from the EDITOR PREFERENCES dialog box. 

 
(2)  Click on the BACKGROUND IMAGE CHOOSE FILE button. 

 
(3)  Locate the background file from the webpage directory. 
 
(4)  Click OK. 
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e.  Creating a table. 
 

(1)  Click on the TABLE button on the tool bar.  The CREATE TABLE dialog box appears. 
 
(2)  Click OK. 
 
f.  Placing art, text, or photo in the table. 
 
(1)  Place the cursor in the upper left corner of the table and click. 

 
(2)  Choose the INSERT IMAGE option from the tool bar.  The FORMAT/IMAGE dialog box 

appears. 
 

(3)  Click the IMAGE FILE CHOOSE FILE button. 
 

(4)  Locate and select the file to be inserted and click the OPEN button. 
 

(5)  Place the cursor in the lower left corner of the table and click. 
 
g.  Saving the webpage. 
 
(1)  Select FILE from the main menu bar. 

 
(2)  Choose the SAVE option.  The SAVE FILE dialog box appears. 

 
(3)  Name the file using the .htm or .html extension. 

 
(4)  Save the file in the webpage directory. 

 
(5)  Open the file in the browser and review it for correctness and compliance with the 

Guidance for the Management of Army Websites. 
 

(6)  Put the document on the web server and check the formatting and each link.  Files may 
be sent to an HTML validation service (check with local DOIM) to verify the titles conform to 
accepted HTML standards. 
 

(7)  Update files as necessary. 
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APPENDIX G 
 

ORGANIZE GRAPHICS WORK FLOW 
 
 
G-1.  INTRODUCTION 
 

Providing the very best product possible for a client is usually not a problem when it is the 
only project in house, but this is rarely the case.  Usually there are several projects of various 
complexities and deadlines being worked on at the same time.  A graphic shop can quickly 
become very hectic and chaotic if there isn’t a system in place to keep things under control.  As 
the NCOIC of a graphic shop, you are responsible for the quality and timeliness of the products 
your shop produces.  You may find it useful to include in the shop’s standing operating 
procedure (SOP) a section for performance standards and quality assurance.  Having 
measurable performance standards or checks in place will help ensure that all products meet 
established standards.  The issue of timeliness will require that you are constantly aware of 
what is going on in your shop. 
 
G-2.  ESTABLISHING A WORK FLOW SYSTEM 
 

a.  To be successful, the NCOIC must control the work flow, which means controlling the 
resources necessary to get the job done.  Factors that affect the work flow include— 
 

• Length of time it takes to complete a particular task or job. 
 

• Amount of work already in house. 
 

• Personnel and their respective abilities. 
 

• Equipment. 
 

• Schedule of outside activities, such as training, maintenance, and duties that cannot be 
rescheduled. 

 
• Priority of incoming jobs. 

 
b.  Incoming priorities can be very disruptive.  To ignore a work schedule is risking loss of 

production time, work efficiency, and worker morale.  The supervisor’s task is to help customers 
and try to meet deadlines, but not at the expense of other customers or unit efficiency or morale.  
Granted, there are jobs that cannot wait, but it is how they are handled that make or break 
morale.  The shop’s overall productivity level is eventually affected when supervisors frequently 
accept jobs with an extremely short suspense without regard to their workers.   

 
c.  You should not try to keep track of everything in your head.  Besides being a daunting 

task, you may not always be present.  It is better to establish some sort of work flow system, 
establishing procedures that everyone is aware of and can follow.   
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(1)  For increased effective work flow, write a procedures section in your SOP, detailing step 
by step how to take in a work order and fit it into the work schedule. 
 

(2)  If examples of completed procedures or products are needed, prepare an annex section 
to your SOP.  In the annex include samples with illustrations that show desired standards, 
providing sufficient information so your shop understands what is expected of them.  Table G-1 
shows an example of a procedure. 
 

Table G-1.  Example of a procedure. 
 
1.  Check a written work order request (DA Form 3903-R). 
 

• Security classification. 
 

• Complete address of requesting unit or activity. 
 

• Account numbers or fund site numbers (if applicable). 
 

• Requester and alternate point of contact (POC), as well as their phone numbers. 
 

• Justification for request. 
 

• Validation signatures. 
 
2.  Accepting work order. 
 

• Security classification within the shop’s validation. 
 

• Feasibility of work requested, type of job, and suspense date. 
 

• Complete explanation of requested work, to include any necessary attachments. 
 

 
G-3.  CONTROLLING THE WORK FLOW 
 

a.  Work flow is the orderly and predictable progression of the customer’s request, from 
filling out DA Form 3903-R to the product completion.  Any shop’s workload will vary from taxing 
to meager.  As the NCOIC, you are challenged to do what you can to even out the highs and 
lows, so that the shop is not overloaded part of the time and underworked the rest of the time.  
Further, you must see that the workload is shared fairly by everyone in the shop.  No one should 
carry more or less then his or her fair share of the workload. 
 

b.  Using the following means can control the work flow: 
 

(1)  Although not a fool proof way to maintain the work flow, the job status board will tell you 
at a glance what is in house, when it is due, who is working the project, and classification.  The 
key to a job status board is to keep it current.  Without regular review, it can set you up for 
failure.  Most supervisors review the status board each morning and again after lunch, making 
any necessary changes.  Jobs that are lagging behind or were delayed get immediate attention. 
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(2)  Work is prioritize based on mission/classification (security). 
 
(a)  Too often supervisors leave the priority of work to customers.  This generally means the 

work orders manage you, rather than you managing the work orders.  The appropriate priority 
should be supported with sufficient rationale to be manageable. 
 

• Priority.  Work that directly supports the accomplishment of a primary mission of the 
requesting organization as reflected in its mission statement. 

 
• Urgent.  Work that directly supports the accomplishment of a secondary mission of the 

requesting organization as reflected in its mission statement. 
 

• Routine.  Work of an official nature required by the requesting organization that is not in 
direct support of its primary or secondary missions. 

 
(b)  Whether the requester needs the work completed in a few hours, the next day, or next 

month has no bearing on which priority block is checked.  The only factor used when 
determining priority is how the work supports the mission of the requesting organization. 
 

(3)  Original visual information (VI) productions, products, and their associated 
administrative records are controlled throughout their life cycle.  Activity VI managers maintain a 
system for numbering individual product items in keeping with current regulations (AR 25-1).  
There are a number of helpful records to assist the production supervisor. 
 

(a)  The work order log is a record of jobs in house; jobs completed, and jobs holding.  The 
work order log is used in conjunction with the job status board.  This record may be used to 
keep track of expenditures, both in man-hours as well as consumables, for reporting at the end 
of a given period.  A column is left blank to record totals at the end of each month, quarter, or 
semiannual period. 
 

(b)  DA Form 3903-R is a work request that details the work to be accomplished.  It also 
serves as the record of authorization or authority to do work of an official nature as certified by 
the requester or authorized signature.  The back of the form serves as an assignment record, a 
work flow record, and a “paper trail” of the people handling a particular job.  Finally, it serves as 
a record of consumables.  This record is used to complete an annual activity report. 
 

(c)  The Annual Visual Information Report (VI Annual Report) is used to report production in 
a consolidated format to the Army Visual Information Management Office.  All work 
accomplished during a year is recorded using the feeder form DA Form 3903-R. 
 

(4)  The work order number serves to keep a consecutive numbering system to track job 
orders in house.  It can serve to locate jobs while in production and once completed and to 
record the number or jobs accomplished over time.  It can be used to tie the job order log, the 
job order, and the status board together for a smooth running operation. 
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APPENDIX H 
 

EVALUATING A GRAPHIC PROJECT 
 
 
H-1.  INTRODUCTION 
 

Layout and composition denote the selection and arrangement of the appropriate elements 
within a picture, so as to express the illustrator’s idea clearly and effectively.  The success of a 
picture depends on how well these elements are put together. 
 
H-2.  LAYOUT AND COMPOSITION 
 

a.  Composition is nothing more than combining basic form and space, arranging the 
elements of the picture to produce a harmonious whole.  As simple as this may sound, it is not a 
process that can be taken lightly.  In composing any illustration, you need to ask the same 
questions before you begin, “What are the elements important to in the illustration and what is 
the message, idea, or concept that you are trying to get across?”  Good illustrations are the 
result of careful planning and the sketching of many basic ideas to find the right composition for 
that particular illustration. 
 

b.  An illustration should begin with thumbnail sketches.  These sketches are small, quickly 
drawn ideas that give just enough detail to visualize the concept.  They are used to work out 
general layout details such as composition, balance, movement, and continuity.  If a layout 
looks awkward as a quick sketch, it isn’t going to improve when details are added.  This is the 
time to stretch your imagination and experiment with different approaches.  After you are done 
with your thumbnails and you find that they all look basically alike, then you haven’t done what 
you set out to do; brainstorm with your pencil. Take a break and go at it again with a willingness 
to be open and a bit more bolder.  When you get a good variety of thumbnail sketches, there 
should be one or two in the group that is a little off the wall (proof that you were not in a rut!).  
Though they might be too radical to use, do not immediately abandon them.  Study them to see 
if there is an element or two that you can salvage.  Above all else do not lock yourself into a 
format (all thumbnails looking alike) until you know the layout has all the elements needed to 
make the illustration a success. 
 

c.  After selecting one or two of the most promising thumbnail sketches, the next step is to 
draw a more detailed sketch or a rough.  The rough should be as close to full size as allowable.  
Take a critical look at the roughs to check the layout for unity, balance, and rhythm and to 
ensure that your focal point has dominance over the other elements.   Step back and look at the 
illustration’s color.  As far as the basics are concerned, this is the time to fine-tune the layout.  
Even if all the individual elements work in and of themselves, ensure they work together to give 
the desired overall effect.  At this point, you might want to bring in the customer.  It is better to 
deal with changes during the rough stage then after the final is started. 
 

d.  With a pencil layout, check and recheck any measurements and proof the text.  When 
you are sure that everything is correct, then proceed to ink and color.  Once you have gone over 
the roughs with the customer and know in which direction you are heading, it is time to begin 
work on the final illustration.  After the final illustration is completed, check it again to ensure the 
project is accurate and clean before calling the customer for pickup. 
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H-3.  TERMS 
 

a.  Design. 
 

(1)  Unity.   Sense of oneness as whole or blocks of information logically grouped, aligned, 
and consistently used throughout the illustration. 
 

(2)  Balance.  Symmetrical/asymmetrical, a stability produced by even distribution of weight 
on each side of a vertical axis. 
 

(3)  Rhythm.  Repetition or progress that creates and maintains interest and helps 
establish eye flow. 
 

(4)  Dominance.  The main focal point, that element which attracts your attention. 
 

b.  Text. 
 

(1)  Proofing.  Checking spelling, capitalization, punctuation, double words, and so on. 
 

(2)  Hierarchy.   Using size, color, and/or position to determine the most important 
text/information. 
 

(3)  Legibility.  Use font (style), size, color, and spacing to make text characters easy to 
identify. 
 

(4)  Readability.  Use font (style), size, color, and spacing to make blocks of text easy to 
read. 
 

c.  Graphics. 
 

(1)  Color (tone/value).  Use of color, consideration of color properties (hue, value, 
intensity, and temperature), consideration of color harmonies, value (relative lightness or 
darkness), intensity (brightness of colors), and temperature. 
 

(2)  Quality (sharpness/clarity).  Having a clear and distinct form and detail. 
 

(3)  Size.  How the final size applies to the design and/or how the image’s final content 
interacts with the design and text. 
 

(4)  Appropriateness.  Graphics, fonts, colors, and layout compliment the message. 
 

(5)  Overall effect.  How the combination of different elements are used to clearly convey 
the intended message. 
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APPENDIX I 
 

STILL PHOTOGRAPHY EDITING AND 
PROCESSING SYSTEM (SPEPS) 

 
 
I-1.  INTRODUCTION 
 
 This appendix covers the description and deployment of the SPEPS. 
 
I-2.  DESCRIPTION 
 
 a.  The SPEPS is a state-of-the-art, still image editing and processing system consisting of 
commercial-off-the-shelf/nondevelopmental items.  (See Figures I-1 and I-2.) 
 

 
 

Figure I-1.  SPEPS. 
 

 
 

Figure I-2.  SPEPS with commercial-off-the shelf/nondevelopmental equipment. 
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 b.  The SPEPS is shock-mounted into a climate-controlled S-250 shelter for transportation 
over unimproved roads and for operation in tactical environments worldwide (see Figure I-3).  
The system consists of but not limited to the components listed in Table I-1. 
 

Table I-1.  SPEPS components.  
 
• Automated data processor with CD-ROM. 
 
• Video monitor. 

 
• Flatbed scanner. 
 
• 35mm slide scanner. 
 
• Modem. 
 
• Communications interfaces. 
 
• Color printer. 
 
• Writable compact disk. 
 
• Bernoulli or zip drive. 
 
• Selected software. 
 
• Accessories. 

 
 
 

 
 

Figure I-3.  The S-250 shelter. 
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c.  The system is compatible with existing joint combat camera (COMCAM) center 
equipment and with each military department’s COMCAM equipment. 

d. The SPEPS is utilized to process, manipulate, reproduce, store, and transfer electronic 
still photographic images before, during, and after combat operations, in support of visual 
information (VI) missions, training exercises, news coverage, combat operation decision-making 
processes, and historical documentation. 
 

e.  The SPEPS will transmit and receive high-resolution color images via electronic transfer 
and magnetic medium compatible with commercial publishing standards in a distribution format 
acceptable to the American Forces Information Service (AFIS).  SPEPS capabilities are listed in 
Table I-2. 

 
Table I-2.  SPEPS capabilities. 

 
• Creates and imports electronic still images from 

peripheral devices. 
 
• Electronically edits and manipulates still images. 
 
• Adds text, captions, and graphics to still images. 
 
• Stores images electronically in mass storage devices. 
 
• Produces prints and transparencies (up to 8.5 inches x 

11 inches). 
 
• Transmits and receives still images over available 

landlines and satellite telecommunications systems.  
(See Figures I-4 and I-5.) 

 
• Scans and imports color images from 35mm slides or 

negatives and up to 8.5 inches x 11 inches 
transparencies or documents. 

 
• Is rack- or shelf-mountable in vehicle-mounted shelters. 
 
• Captions and slates image prior to transmission. 
 
• Operates in hot, wet, and cold climates. 
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Figure I-4.  Satellite telecommunications system. 
 
 

 
 

Figure I-5.  Satellite system in operation. 
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I-3.  DEPLOYMENT 
 

a.  Prior to deployment, SPEPS is provisioned initially with sufficient electromagnetic media, 
maintenance, and cleaning material (at least 60 days) for full operation.  The SPEPS must— 
 

• Be transportable by aircraft, rail, or marine transport. 

• Require no more than a two-man carry for any single travel case when fully loaded.  

• Have shipping cases with standard military tie-down and security or locking devices that 
provide sufficient shock isolation and crush or puncture protection to safeguard 
equipment during shipment. 

 
• Be mission capable from travel configuration within 30 minutes of arrival.  (See  

Figures I-6 and I-7.) 
 

 
 

Figure I-6.  Fully loaded travel case. 
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Figure I-7.  Mission capable travel case. 

 
b.  The SPEPS can interface with available telecommunications systems and satellite 

systems and complies with the Joint Photographic Expert Group (JPEG) VI standard. 
 

c.  The SPEPS is compatible with the Electronic Still Photography System, Motion Video 
Acquisition System (MVAS), Motion Video Editing System (MVES), Visual Information Satellite 
Ground Station (VISGS), and Live Video Satellite Ground Station (LVSGS). 
 

d.  The SPEPS operates from standard power sources (110/220 volts, 50/60 Hz) and must 
have power conditioning and surge suppression for system components.  (See Figure I-8.) 
 

 
 

Figure I-8.  Standard 110/220 volts power source. 
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APPENDIX J 
 

PROJECT EVALUATION CHECKLIST 
 

PROJECT STANDARD           GO NO-GO 
COMPOSITION 

1. Rule of thirds            ____ ____ 
 2. Perspective 

a. One point (parallel perspective)       ____ ____ 
b. Two point (angular perspective)       ____ ____ 

  c. Three point (oblique perspective)       ____ ____ 
  d. Linear/nonlinear perspective        ____ ____ 
  e. Circle in perspective          ____ ____ 
  f. Aerial perspective          ____ ____ 
  g. Horizon line-eye level          ____ ____ 

 h. Picture plane            ____ ____ 
 i. Natural forms           ____ ____ 

 3. Distractions             ____ ____ 
 4. Size relationship            ____ ____ 
 5. Vertical and horizontal formatting (horizontal format 

 for VTGs, TVs, 35mm slides)         ____ ____ 
 6. Basic shapes/forms           ____ ____ 
 7. Proportion             ____ ____ 
 8. Contour              ____ ____ 
 9. Shading              ____ ____ 

10. Contrast              ____ ____ 
 11. Size               ____ ____ 
 12. Visual effectiveness           ____ ____ 
 13. Overall effectiveness           ____ ____ 
 
MEDIA   
 1. Tone media (any combination of two or more colors)    ____ ____ 
 2. Line media (any media which uses only black and  

  white to create an image)          ____ ____ 
 
COLOR THEORY   
 1. Properties of color   

 a. Hue              ____ ____ 
 b. Intensity             ____ ____ 
 c. Value             ____ ____ 
 d. Temperature            ____ ____ 

 2. Additive              ____ ____ 
 3. Subtractive             ____ ____ 
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PROJECT STANDARD           GO NO-GO 
COLOR THEORY (continued) 
 4. Color harmony and discords 

 a. Achromatic            ____ ____ 
 b. Monochromatic           ____ ____ 
 c. Analogous            ____ ____ 
 d. Complementary           ____ ____ 
 e. Split Complements          ____ ____ 
 f. Triads             ____ ____ 

 
Value 
 1. Tint               ____ ____ 
 2. Shade              ____ ____ 
 3. Gradation (tonal graduations)         ____ ____ 
 
Mixture by Juxtaposition 
 1. Hue               ____ ____ 
 2. Mixture              ____ ____ 
 3. Neatness             ____ ____ 
 
Simultaneous Contrast 
 1. Visual blending            ____ ____ 
 2. Neatness             ____ ____ 
 3. Visual effects            ____ ____ 
 
Color Temperature   
 1. Warm              ____ ____ 
 2. Cool              ____ ____ 
 
DESIGN 
Principles of Design   
 1. Unity  

 a. Proximity            ____ ____ 
 b. Repetition            ____ ____ 
 c. Continuation            ____ ____ 
 d. Verity             ____ ____ 

 2. Balance  
 a. Formal (symmetrical) balance        ____ ____ 
 b. Informal (asymmetrical) balance       ____ ____ 
 c. Radial balance           ____ ____ 
 d. Crystallographic balance         ____ ____ 
 e. Static balance           ____ ____ 
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PROJECT STANDARD           GO NO-GO 
Principles of Design (continued) 
 3. Rhythm              ____ ____ 
 4. Proportion             ____ ____ 
 5. Movement             ____ ____ 

6. Dominance             ____ ____ 
 
Thumbnails to Develop and Improve Design Quality   
 1. Eye movement            ____ ____ 
 2. Eye path             ____ ____ 
 3. Positioning of elements          ____ ____ 
 
Roughs to Improve Original Ideal of Thumbnail 
Sketches   
 1. Size of element            ____ ____ 
 2. Loose but gives a true feel         ____ ____ 
 3. Color/tone suggested           ____ ____ 
 4. Typography             ____ ____ 
 
Comprehensive Rendering to Enhance 
Design and Graphic Accuracy   
 1. Precision             ____ ____ 
 2. Color effect             ____ ____ 
 3. Format most effective           ____ ____ 
 
LETTERING   
 1. Legibility 

 a. Uniformity            ____ ____ 
  (1) Height            ____ ____ 
  (2) Inclination           ____ ____ 
  (3) Spacing (letters, words, lines)       ____ ____ 
 b. Proportion            ____ ____ 
 c. Stability             ____ ____ 
 d. Type style            ____ ____ 

 
PAGE LAYOUT  
 1. Style              ____ ____ 
 2. Appropriateness            ____ ____ 
 3. Consistency             ____ ____ 
 4. Balance              ____ ____ 
 5. Unity              ____ ____ 
 6. Spreads              ____ ____ 
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PROJECT STANDARD           GO NO-GO 
PAGE LAYOUT (continued) 
 7. Format              ____ ____ 
 8. Grid               ____ ____ 
 9. Margins              ____ ____ 
 10. Columns             ____ ____ 
 11. Rules (horizontal or vertical)         ____ ____ 
 12. Type (size and style)           ____ ____ 
 13. Headlines (titles)            ____ ____ 
 14. Subheads             ____ ____ 
 15. Captions             ____ ____ 
 16.  Color              ____ ____ 
 17. Artwork              ____ ____ 
 
USE OF MATERIALS   
 1. Fits subject matter/concept         ____ ____ 
 2. Fits project needs/requirements        ____ ____ 
 
SHOP PRACTICES   
 1. Follows directions           ____ ____ 
 2. Follows safety precautions         ____ ____ 
 3. Maintains clean and safe work area       ____ ____ 
 4. Cleans tools and equipment in accordance with  
  manufacture’s recommendations and shop SOP     ____ ____ 
 5. Proper use of equipment and material        ____ ____ 
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APPENDIX K 
 

DRAWING THE HUMAN FORM 
 
 
K-1.  INTRODUCTION 
 

In drawing any subject, you must be willing to go through the basic procedures, one step at 
a time.  Those steps are form, proportion, contour, and shading.  Each portion of the drawing 
must be given some special consideration as it compares with the rest of the figure.  Learning to 
draw the human figure is important because 85 percent of all illustrations for posters and 
drawings contain the human figure. 
 
K-2.  FIGURE PROPORTIONS 
 

a.  Proportion is defined as the relative size and location of one form to another.  Figure 
proportions for illustrations should not be measured in inches, feet, meters, and so forth, but 
how large one form is to another, visually.  The closer something is, the larger; the farther away 
it is, the smaller.  Though figure proportions vary from person to person, you must start with 
basic rules and a unit of measurement.  Draw what you see, beginning with the entire form and 
proportions and worry about details later.  If necessary, start with a bubble or stick figure. 
 

b.  The basic unit of measurement for the human body is the head.  The vertical height of 
the head from chin to the top of the skull is used for vertical measurements.  The width of the 
head from cheekbone to cheekbone is used to make all horizontal measurements.  For 
example, the average human figure is 6-1/2 to 8 heads high and 2-1/2 to 3 heads wide.  Head 
specifics and portraiture are discussed later. 
 

c.  Proportions of the “ideal” human figure are eight heads high and three heads wide.  
These proportions give the figure a taller, more statuesque appearance.  These rations are 
mainly for learning figure proportions and should be remembered and practiced, but they do not 
consider the foreshortening technique. 
 

d.  After the height of the standing figure is decided, it should be divided into eight equal 
parts to make the figure slightly taller and slimmer than the average person.  (See Figure K-1.)  
As shown in Figure K-1, the other seven heads are divided as follows:  
 

(1)  One-third of a head for the neck. 
 
 (2)  Two and two-thirds heads for the torso (from the bottom of the neck to the crotch). 
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Figure K-1.  Ideal figure proportion. 
 

e.  The structural differences between the male and female are more in the bones and 
muscle tissue than anywhere else.  (See Figure K-2.)  The bones of the female are smaller than 
the bones of the male.  The female body appears much smoother and less muscular, although 
the female has the same muscle structure as the male.  This appearance is caused by genetic 
differences, plus females have a heavier covering of fatty tissue over the entire body. 
 

(1)  Figure K-2 shows the differences between the average male and female figures.  The 
male’s shoulders are about three heads wide, while the females are only two heads wide. 
 

 
 

Figure K-2.  Male and female figure differences. 
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(2)  The female’s hips are proportionally the same as the male, but the female’s torso is 
smaller.  (See Figure K-3.)  Also, her ankles, wrists, and fingers are proportionally thinner than 
the male. 
 

(3)  The female’s lower legs taper to thinner ankles and smaller feet than do the male.  In 
profile, the female figure is narrower than the male.  Other differences include her smoother 
muscles, higher waistline, longer torso (Figure K-3), shorter legs, and shallow pelvis.   
Note the greater distance between the pelvis and rib cage of the female.  The illustrator notices 
these subtle differences. 
 

 
 

Figure K-3.  The torso. 
 

f.  An easy way to draw the human torso is to reduce it to two cylinders; the upper cylinder 
is twice the height of the lower cylinder.  (See Figure K-4.) 

 
(1)  The chest, abdomen, and pelvis are the three central masses of the torso and are 

connected by the spinal column.  (See Figure K-4.).  The chest consists of the rib cage, 
shoulder, and collarbone.  The shape of the rib cage is a modified cone-shaped mass.  The 
shoulders hold the arms.  Due to the muscles over the shoulder and collarbone, the rib cage 
appears broader than it actually is.  The abdomen is a soft, fleshy, movable part of the upper 
portion of the torso.  The chest and pelvis are stable masses.  The pelvis is the lower part of the 
torso.  It serves as a base for the legs. 
 

(2)  The study of anatomy (muscles and bones) is a must for a successful illustrator.  It 
gives the illustrator an understanding of the structure or frame around which to build a visually 
accurate illustration. 
 

g.  The arm is based in the shoulder girdle.  It has one bone in the upper arm halfway 
down. 
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Figure K-4.  Body masses connected by the spinal column. 
 

(1)  From the front, the arm wedges downward and enters the forearm just below the 
elbows.  When the thumb is turned away from the body, the mass of the forearm is oval in 
shape, becoming round when the thumb is toward the body because the bones of the forearm 
cross.  From the back, the mass of the shoulder enters the arm on the side; and at the elbow, 
the arm and forearm are like a hinge joint. 
 

(2)  The upper and lower arms are modified cylinders of approximately equal length (Figure 
K-5).  The cylinders for the arms are much like the cylinders used for the construction of the 
torso, only much narrower.  The cylinders forming the arms may be drawn at greater angles in 
relation to each other than the cylinders forming the torso, because the arm bends much more 
than the torso. 
 

 
 

Figure K-5.  The arm. 
h.  Other than the face, the hands are the most expressive parts of the human body and 

should receive special attention when being drawn.  The illustrator should be able to make 
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excellent drawings of hands, using his own as models.  Since there is very little flesh on the 
hand, except on the palm side, the illustrator should have a good knowledge of the bone 
structure to draw it well.  Using a form envelope to enclose the many small forms is of great 
help.  (See Figure K-6.) 
 

 
 

Figure K-6.  Hand construction using form envelopes. 
 

(1)  Observe in Figure K-6 that the palm without the fingers is nearly square, and that the 
fingers are about as long as the palm.  When the fingers are extended, the hand is about three-
quarters as long as the forearm or is equal to the distance from the chin to the hairline.  In 
drawing hands, be sure to draw them large enough. 
 

(2)  The hands are not as easily reduced to basic forms as are the torso, arms, or legs.  
However, they can be shown as a form envelope or as a combination of simple forms that 
represent many smaller forms with reasonable accuracy.  Figure K-7 shows how a combination 
of a cube and wedge shape represents the hand.  The cubic form symbolizes the palm of the 
hand, while the tapering wedge represents the fingers.  The finger wedge is about the same 
size as the cubic area of the palm. 
 

 
Figure K-7.  The hand. 

 
i.  The leg has two parts, the thigh and the shin, which correspond to the upper arm and 

forearm of the upper body.  The thigh extends from the pelvis to the knee, and the shin from the 
knee to the foot.  The thighbone is the longest and strongest bone of the body.  The column of 
the thigh and shin diminish in thickness as it descends to the ankle.  From either side a wedge 
shape overlaps the rounded form of the thigh, and this again overlaps the form above and below 
the knee joint.  (See Figure K-8.) 
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Figure K-8.  The leg. 
 

j.  The feet have about the same number of bones as the hands, but the proportions are 
different.  The feet are as long as one-half the distance from the knees to the bottom of the feet.  
Feet can also be constructed using form envelopes.  (See Figure K-9.) 
 
 

 
 

Figure K-9.  The foot and form envelopes. 
 

(1)  Notice that the outside anklebones are slightly lower than the inside anklebone.  The 
high part of the foot is at the inside, between the ankle and the big toe.  As you can see, the foot 
slopes toward the toes and also toward the outside edge.  
 

(2)  The foot has very little movement.  Most of its action is accomplished through the 
movement of the anklebones and between the joints of the toes and the foot. 
 

k.  Joints are what hold the arms and legs together.  These are ball and socket joints, and 
hinged joints. 
 

(1)  The ball and socket joint (Figure K-10, View A) is extremely flexible.  The shoulders and 
hips have this type of joint, which allow rotation in practically any direction.  The wrist and ankle 
permit a similar rotary movement, although they are not ball and socket joints. 
 

(2)  The hinge joints at the elbow and knee work like a door hinge.  They allow the forearm 
and lower leg to bend and straighten.  (See Figure K-10, View B.) 
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VIEW A VIEW B  
 

Figure K-10.  Joints. 
 
K-3.  HEAD FORM 
 

a.  The basic form of the head is a modified sphere, shaped much like an egg.  Horizontal 
and vertical lines are used in placing the facial features (Figure K-11, View A).  A guideline 
located at half the distance from the eyes to the chin locates the bottom of the nose (Figure  
K-11, View B).    

HAIR
LINE

3/3

2/3

1/3

1 2 3 4 5

VIEW A VIEW B

 
 

Figure K-11.  The head. 
 

(1)  The eyes are located on a horizontal centerline with the eyebrows slightly above the 
eyes (Figure K-12, View A).  The top of the nose is located on the horizontal centerline (Figure 
K-12, View C).  The mouth is located on a line drawn two-thirds the distance from the chin to the 
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bottom of the nose (Figure K-12, View C).  The head rests securely on the neck, lower portion of 
the head (Figure K-12, View C). 
 

 
 

Figure K-12.  Construction views of the head. 
 

(2)  The side view of the head is slightly different from the front view (Figure K-12, Views B 
and D).  In a side view, the head can be tilted with the neck toward the rear and slanted.  The 
ear is just behind the vertical centerline with its top and bottom located on the same guidelines 
that were used for the front view.  The eye is located in a slightly indented position again on the 
horizontal centerline.  The nose projects out from the edge of the head’s basic form.  The jaw 
curves down from the ear. 
 

(3)  Consider the following important points when constructing the head and refer again to 
Figures K-11 and K-12. 
 

(a)  The nose is generally an eye length wide. 
 

(b)  The head at the brow is five eye lengths across. 
 

(c)  The eyes are one eye length apart.  Each eye should be about one-half as high as it is 
long. 
 

(d)  The bases of the nose, cheekbone, ear lobe, and skull lie on a line drawn across the 
head (Figure K-12). 
 

(e)  Lines drawn from the inside corners of the eyes to the ends of the nostrils should give  
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a check on the placement of these two features.  The lines should be parallel. 
 

(f)  The mouth is approximately two eye widths across; its corners should be almost directly 
beneath the center of the eye. 
 

(g)  The features are developed with careful attention being paid to the ear, since it is now 
the most pronounced visible feature.  Very little of any forward feature is seen, but that which is 
seen should be drawn carefully and accurately. 
 

b.  One of the most expressive features of the face, the eye has two lids that curve like 
short visors over the eyeball.  The upper lid curves wider across the circumference of the 
eyeball, while the lower lid turns on a shorter arc around the base of the eyeball.  Both lids have 
lashes.  The inner and outer corners of the eyelids are completely different in design.  At the 
outer corner, the upper lid overhangs the lower lid.  At the inner corner, the lids do not touch 
when the eye is open, but are separated by a narrow area of pinkish membrane.  (See Figure K-
13.) 
 

 
 

Figure K-13.  The eye. 
 

(1)  The profile of the eye is difficult to draw.  The illustrator must remember that the eye is 
round and the lids fit around it.  The slope of the walls of the eye is downward and inward from 
the forehead to the cheekbone. 
 

(2)  The exposed part of the eye is always moist.  The moisture reflects light and causes a 
distinct highlight.  The location of this highlight depends on the direction of the light.  This factor 
helps to make a drawing appear lifelike. 
 

c.  The nose is thin and narrow at the top and wide at the bottom.  The upper half has a 
bony structure, while the lower half consists of cartilage (an elastic tissue) which is flexible and 
responds to the actions of the facial muscles. 
 

(1)  The lower part of the nose consists of five pieces of cartilage (Figure K-14).  Pieces one 
and two form the tip; three and four form the nostrils.  Piece five forms the hook of the nose to 
separate the nostrils and descends lower than the nostrils. 
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Figure K-14.  The nose. 
 
 (2)  The nostril cavities are almost triangular but vary in size and slant outward toward the 
back of the nose. 
 

d.  The mouth, like the eyes, is capable of expression and movement.  The upper lip is 
thickest in the center and thins with a downward curve to the corners, which are depressed.  
The upper lip is comparatively flat and angular, while the lower lip is convex and rounded.  The 
center section of the upper lip thrusts forward and rests in the center of the lower lip when the 
mouth is closed. 
 

(1)  The lower lip is recessed beneath the upper lip and when seen in profile, the lips are 
located on a line sloping backward from near the top of the nose to the furrow at the top of the 
chin (Figure K-15). 
 

 
 

Figure K-15.  The mouth and chin. 
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(2)  Slight depressions or hollows that form where the corners of the mouth meet the lower 
cheek are usually more pronounced in the male face. 
 

(3)  In a smile or laugh, the corners of the mouth are pulled back and the upper lip appears 
to be straighter, as the lower lip becomes more curved.  When the mouth is in an open, smiling 
position, the upper teeth are visible; rarely are the lower teeth seen except in extreme mouth 
actions. 
 

e.  The chin bulges forward at its center.  From the front, the chin usually appears to be 
nearly straight across with a depression in the center.  The shape of the chin usually matches 
the character of the rest of the facial features. 
 

f.  The ear is a mass of cartilage and soft flesh.  It is wider at the top rim and narrower at 
the bottom.  Most ears have a hanging fleshy portion called a lobe.  In the middle of the ear is a 
bowl shape that is surrounded by whorls and curves of flesh-covered cartilage. 
 

(1)  The outer wider rim, the inner rim shaped like a bent Y, the bowl area, and the fleshy 
lobe are the four major shapes the ear.  (See Figure K-16.) 
 

 
 

Figure K-16.  The ear. 
 

(2)  Correct positioning of the ear is one of the most important phases of drawing the ear.  
When drawing the ear, the construction lines are the same for the ear and nose, because both 
are the same size.  When seen in profile, the ear is located directly behind the vertical line that 
divides the head in two.  When seen from the front, the ear slants downward and parallel to the 
side of the head.  (See Figures K-11 and K-12.) 
 
K-4.  FIGURES IN MOTION 
 

a.  Drawing the figure in motion requires you to pay strict attention to the principles of 
drawing (form, proportion, contour, and shading), and specifically, how forms on the figure relate 
to each other.  You must practice perspective and foreshortening.  This will assist in giving 
credibility and life to your illustrations. 
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(1)  Perspective is the artistic study of space.  If your figure will be moving through space, 
you must understand this movement and how accurately your illustration represents your view 
of it.  Quite often this is shown using techniques of foreshortening. 
 

(2)  Figures K-17, K-18, and K-19 give you an idea of how foreshortening and figure 
placement assist in giving the illusion of depth and impression of movement to your illustrations. 
 

(3)  Foreshortening techniques  show forms, objects, or figures at an angle.  (See Figures 
K-17 and K-18.)  Mastery of this skill helps create the illusion of depth in your illustrations.  If 
your subject is in a position other than one of attention or if your view is at an angle, proportional 
measurements will differ.  You must practice to achieve or maintain visual accuracy in your 
drawings (Figure K-19). 
 
 

 
 

Figure K-17.  Walking and running. 
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Figure K-18.  A running figure showing the foreshortening effects  

encountered in perspective. 
 
 
 

 
 

Figure K-19.  Figures in perspective with foreshortening techniques. 
b.  In most of your documentation illustrations, the figures are clothed.  You can enhance 

your ability to draw figures by studying clothed figures or photographs and drawing them for 
practice.  This is called the study of drapery. 
 

(1)  The shape of the figure, the action of the figure, and the cut of the garment control the 
folds in clothing. 
 

(2)  The crushed and hub are two types of folds.  A crushed fold is found where there is 
more fabric than space for it, such as the bent inner elbow.  A hub fold radiates from a point of 
support such as the shoulders or hips.  (See Figure K-20.) 
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Figure K-20.  Examples of folds. 
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APPENDIX L 
 

DA FORM 5164-R 
(HANDS-ON EVALUATION) 

 
The DA Form 5164-R allows the trainer to keep a record of the performance measures a soldier 
passes or fails on each task.  Instructions for using this form follows: 
 
Prior to evaluating— 
 

• Obtain a blank copy of DA Form 5164-R which you may locally reproduce on 8½-inch 
by 11-inch paper. 
 

• Enter the task title and 10-digit number for the task from the evaluation guide of the SM 
task summary. 
 

• In column (a), enter the number of each performance measure from the evaluation  
guide. 
 

• In column (b), enter the performance measure corresponding to the performance  
measure number in column (a).  (You may abbreviate this information if necessary.) 
 

• Enter the feedback statement from the evaluation guide just below the last performance 
measure. 
 

• Locally reproduce the partially completed form if you are evaluating more than one  
soldier on the task or the same soldier on more than one task. 
 
During the evaluation— 
 

• Enter the date just before evaluating the soldier’s task performance. 
 

• Enter the evaluator’s name and the soldier’s name and unit. 
 

• For each performance measure in column (b), enter a check in column (c) 
PASS or column (d) FAIL as appropriate. 
 

• Compare the number of performance measures the soldier passes (and if applicable, 
which ones) against the task standard shown in the Evaluation Guidance statement.  If the  
standard is met or exceeded, check the GO block under STATUS; otherwise, check the NO-GO 
block. 
 
Figure L-1 is a sample of a completed DA Form 5164-R. 
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Figure L-1.  Sample of a completed DA Form 5164-R. 
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GLOSSARY 
 

Section I 
Acronyms and Abbreviations 

 
 
AC alternating current/Active Component/assistant commandant 
 
ACCP Army Correspondence Course Program 
 
ADB Apple Desktop Bus 
 
AFIS American Forces Information Service 
 
agate 5-1/2 point type 
 
AIT Advanced Individual Training 
 
AL angle line 
 
ANCOC Advanced Noncommissioned Officer Course 
 
AR Army Regulation/Army Reserve 
 
ARNG Army National Guard 
 
ARPANET Advanced Research Project Agency Network 
 
ASA American Standards Association 
 
ASCII America standard code for information interchange 
 
ATM Adobe Type Manager 
 
BBS Bulletin Board System 
 
BNCOC Basic Noncommissioned Officer Course 
 
BT basic training 
 
CCD charge coupled device 
 
CD compact disk 
 
CD-ROM Compact Disk-Read Only Memory 
 
CISC Complex Instruction Set Computing 
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CMF career management field 
 
CMYK cyan, magenta, yellow, and black 
 
CP control panel 
 
CPU central processing unit 
 
CRM camera-ready mechanical 
 
CRT cathode ray tube 
 
CT control terminal 
 
CV center of vision 
 
cyan blue-green color 
 
DA Department of the Army 
 
Dia diameter 
 
DINFOS Defense Information School 
 
DL delay lines/distance learning 
 
DoD Department of Defense 
 
EMIC Electronic Multimedia Imaging Center 
 
EPMS Enlisted Personnel Management System 
 
EPROM Erasable Programmable Read Only Memory 
 
F fail 
 
FAQ frequently asked questions 
 
FM field manual/frequency modulation/file maintenance 
 
FORSCOM Forces Command 
 
FOUO for official use only 
 
FTP file transfer protocol 
 
GSA General Services Agency/General Support Agency 
 
GUI graphical user interface 
 
HR hand receipt 
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HTML Hypertext Markup Language 
 
IAW in accordance with 
 
INMARSAT International Maritime Satellite 
 
IRC Internet Relay Chat 
 
ISO International Standards Organization 
 
ITEP Individual Training Evaluation Program 
 
LAN local area network 
 
LPI lines per inch 
 
LTTC Lowry Technical Training Center 
 
LVSGS Live Video Satellite Ground Station 
 
LZW Limpel-Ziv-Welch 
 
MACOM Major Army Command 
 
Mac Macintosh 
 
METL mission essential task list 
 
MHz megahertz 
 
MOPP mission oriented protection positive 
 
MOS military occupational specialty 
 
MOSC military occupational specialty code 
 
MS-DOS Microsoft Disk Operating System 
 
MTP Mission Training Plan 
 
MVAS Motion Video Acquisition System 
 
MVES Motion Video Editing System 
 
NCO noncommissioned officer 
 
NCOIC noncommissioned officer in charge 
 
nib pen point 
 
NPPA National Press Photographers Association 
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NSF National Science Foundation 
 
NSN nonstandard number 
 
OCR optical character reader/optical character recognition 
 
OJT on-the-job training 
 
OPFOR Opposing Forces 
 
OPORD operation order 
 
P pass 
 
PBO property book officer 
 
PCS permanent change of station 
 
PLDC Primary Leadership Development Course 
 
PMCS preventive maintenance checks and services 
 
POC point of contact 
 
POI program of instruction 
 
PP passage point 
 
PS packet switch/point of sight 
 
PSYOP psychological operations 
 
R right/radius 
 
RC Reserve Component/remote control 
 
RDT&E research, development, test, and evaluation 
 
RIP Raster Image Processor 
 
RISC Reduced Instruction Set Computing 
 
SA semiannually (frequency code) 
 
SC Signal Corps/single-channel 
 
SCSI small computer system interface 
 
SIMMs single in-line memory modules 
 
SM/TG soldier's manual/trainer's guide 
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SMCT Soldier's Manual of Common Tasks 
 
Soc social 
 
SOJT supervised on-the-job training 
 
SOP standing operating procedure 
 
SP start point/station point 
 
SPEPS Still Photography Editing and Processing System 
 
SQT skill qualification test 
 
SSA supply support activity 
 
SSSC Self-Service Supply Center 
 
STF Special Task Force 
 
STP soldier training publication 
 
STSL sustainment training skill level 
 
SWOP stand web offset proofing 
 
TASC Training and Audiovisual Support Center 
 
TC technical coordinator/training circular 
 
TCP-IP Transmission Control Protocol-Internet Protocol 
 
TDA table of distribution and allowance 
 
TEC Training Extension Course 
 
TM technical manual 
 
TOE table of organization and equipment 
 
TRADOC Training and Doctrine Command 
 
UPS universal power supply 
 
URL universal resource locator 
 
US United States 
 
USAR United States Army Reserve 
 
USAREUR United States Army, Europe 
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USASMA United States Army Sergeants Major Academy 
 
USFK United States Forces, Korea 
 
VGT viewgraph transparency 
 
VI visual information 
 
VIRIN visual information record identification number 
 
VIS visual 
 
VISGS Visual Information Satellite Ground Station 
 
VM virtual memory 
 
VP vanishing point 
 
VPL vanishing point left 
 
VPR vanishing point right/verbal processing register 
 
VRAM Video Random Access Memory 
 
WAIS Wide Area Information Server 
 
WAN wide area network 
 
WWW World Wide Web 
 
 

Section II 
Terms 

 
acetate 
A tough, transparent, or semitransparent sheet that comes in varying thickness, especially 
useful as an overlay in color separation. It is also used for friskets in retouching, animated 
drawings, displays, and so forth. Treated acetate is especially prepared so that it will readily 
take inks, paint, and the like. 
 
actinic light 
Rays of light, especially the short waves of the spectrum, such as green, blue, and ultraviolet, 
which cause chemical changes in light-sensitive photographic emulsions. 
 
action lines 
In cartooning, extra lines drawn around or following a figure or an object to indicate its motion. 
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additive process 
Process by which white light can be produced by starting with darkness and combining colored 
lights until white is obtained. 
 
adhesive 
Various types of glues, gelatin, or casein used as a binder in various painting techniques. 
 
advancing colors 
Colors which appear to come forward, such as red, orange, and yellow. See and compare 
receding colors. 
 
aesthetic 
Pertaining to the beautiful, particularly in art. 
 
Airbrush 
A small spray gun for retouching prints. Uses oil free air at 30 to 40 psi (209 to 276 KPa). 
 
airbrushing 
Act of using an airbrush to produce art or to improve the appearance of art. It is a graphic arts 
technique that stands by itself as a specialty. Airbrushing is used extensively in retouching 
photographs for fine reproduction. 
 
amberlith 
Amber-colored masking and stripping film coated on a polyester baking sheet. Amberlith is a 
registered trademark of the Ulano Company. 
 
analogous colors 
Colors closely related to one another, such as blue, blue-green, and green. 
 
anatomy 
The study of the bone and muscle structure of humans and the animals with particular regard to 
its effect on the appearance of structure forms and contours. 
 
anhydrous ammonia system 
System used in the developing section of some whiteprint machines. Ammonia gas, stored in a 
high-pressure tank, is fed through a low pressure line into the developing chamber. There it is 
mixed with water from a separation source and vaporized. The vapor then rises between and 
through perforated rollers to develop the material. This system makes possible the use of 
remote and multiple ammonia-supply facilities. 
 
arc 
To move the camera in a slightly curved dolly or truck. 
 
area (picture) 
The flat surface within the borders. 
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Army Training and Evaluation Program (ARTEP) 
The US Army's collective training program.  ARTEP establishes unit training objectives critical to 
unit survival and performance in combat.  They combine the training and the evaluation 
processes into one integrated function.  The ARTEP is a training program and not a test.  The 
sole purpose of external evaluation under this program is to diagnose unit requirements for 
future training. 
 
arrowhead 
Indicator shaped like an arrowhead and used at the end of a line to direct attention to an object 
or a point of reference in conjunction with callout number, letter, or other symbol. 
 
art 
In the graphic arts field, any line drawing, photograph, or continuous-tone of halftone illustration. 
Only two kinds are so considered for reproduction purposes; line and halftone. The term "art" is 
commonly used to mean any copy or text. 
 
artgum 
A soft eraser free from grit, used for cleaning drawings. 
 
artwork 
Illustrations, drawings, photographs, renderings, paintings, sketches, and copy of any kind 
except text copy that is being prepared or used for reproduction. 
 
asymmetrical 
Not symmetrical or formal in balance. Also symmetry. 
 
asynchronous 
In art, recurrences or repeated operations in unrelated patterns, not synchronous. 
 
attitude 
The mental state of a person that influences behavior, choices, and expressed opinions. 
 
audio sound 
The part of a television that you hear, as opposed to video, the part you see. 
 
background art 
Design, texture, or pattern, or other form of artwork used to create a background effect for type 
and illustrations. 
 
balance 
A pleasing arrangement of the different parts of the opposing elements. In informal balance 
these parts or elements are not arranged symmetrically. In formal balance the arrangement is 
symmetrical. 
 
ball-and-socket joint 
An extremely flexible joint in the body that can be swung around in all directions; for example, 
the shoulder and hip joints. 
 
bar chart 
Graphics representation comparing numerical values by means of rectangles of equal width. 
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binary 
A numbering system using only the digits 0 and 1. Also called base 2. 
 
binary word 
A related group of ones and zeros that has meaning assigned by position, or by numerical value 
in the binary system of numbers. 
 
black and white 
The term for a drawing and a painting rendered in black and white only. Also, black and white 
with intermediate tones of gray. 
 
bleed 
Printing a picture without leaving any margin between the picture and the page edge. Also, the 
excess borders on the artwork and printing plate extending beyond the final trimmed edge of 
printed sheet. And, the capillary action of a liquid medium spreading under a surface when 
touched. 
 
blending 
A method of drawing or painting in which one color or tone merges into another. Also, the 
process of mixing or incorporating one color or tone with another one. 
 
block diagram 
A schematic drawing. 
 
block in 
Indicating with preliminary lines the broad outline of the objects or shapes in a picture. 
 
block out 
The act of eliminating an unwanted section in a picture. 
 
board 
An electronic term for the fiber-board material on which the printed circuit and electronic 
components are mounted, most generally inside a cabinet. May control one or several functions. 
 
board art 
Any artwork, especially original art, mounted on heavy board stock. 
 
body type 
Type used for the main body of a piece of printed matter. 
 
boldface 
Type which is darker than light and medium type. 
 
booklet 
A pamphlet, generally bound within paper covers. 
 
box 
To enclose a paragraph or heading within borders or rules. 
 
bridge 
A mechanical aid to keep the hand from touching the picture's surface while working. 
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briefing chart 
Also called flip chart. Visual aid that graphically presents a story to an audience. 
 
bright brush 
A short-haired, very flat, chisel-shaped brush which is shorter-haired and thinner than the flat 
brush. 
 
bristol board 
A drawing surface made of fine, tough, flexible cardboard. It is manufactured in several 
thickness and in a variety of surfaces. 
 
bristol brush 
A brush made of hog's hair, used for oil painting. 
 
broadside 
A large, folded advertising piece also called a broadsheet. 
 
brochure 
A bound pamphlet. 
 
brushes, art 
Brushes used for fine artwork, as well as for such applications as show cards, are divided by 
sources into two categories; those manufactured from the red sable, or the less costly grades 
whose hair is taken from squirrels, goats, polecats, other furred animals, and camels. 
 
bullet 
Also called meatball. A symbol used to preface-listed items or a phrase, add emphasis, and 
generally embellish copy. 
 
burnish 
To secure paste-up or mortised copy to the basic reproduction page or to material prepared for 
printing. 
 
burnisher 
An instrument used to smooth, flatten or polish a surface. It may be made of plastic, wood, 
glass, metal, stone or ivory. 
 
busy 
Active; for example, in a picture or layout, it generally denotes excessive or competing detail. 
 
calligraphy 
The art of elegant writing or penmanship. 
 
call-out 
In technical illustrating, to call attention to a part or item in an illustration by indexing it; for 
example, by assigning it a number in the illustration. 
 
cameo paper 
Paper of a dull, smooth finish used frequently for carbon and graphite pencil drawings. 
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camera lucida 
An instrument with prism lenses, used for enlarging or reducing artwork. An image of the 
artwork appears to be projected on the drawing surface and is traced by the artist (see Lucy). 
 
caption 
In general, any heading or title; more precisely, a descriptive title for an illustration or table. 
 
carbon pencil 
A pencil whose marking medium is pressed carbon, rather than the usual graphite or lead. 
 
caricature 
Representation of a person or thing that shows a deliberate exaggeration and distortion of 
features or mannerisms. Caricatures may be good-humored or bitterly satirical. 
 
carpenter's pencil 
A pencil having a wide, flat lead. Ideal for chisel-point lettering or laying in broad tones. Also 
called sketching pencil. 
 
cartoon 
A comic or satiric drawing. Also, artist's drawing or study made as a model to be transferred and 
carried out in paint, tapestry, mosaic, stained glass, or mediums. 
 
casein 
An adhesive prepared from curd or milk and lime, used in the preparation of casein tempera 
paint. Casein paint can be used in various consistencies-thick, like opaque watercolor, or thin, 
like transparent watercolor. 
 
cathode ray tube 
A CRT terminal containing a cathode ray tube that displays user programs and information. 
 
center of interest 
The part of a picture that attracts the most attention. 
 
center spread 
Two facing pages formed by one folded sheet of paper; for example, the center spread of a 
newspaper or pamphlet, or of one signature of a book or magazine. 
 
character 
Any letter, number, punctuation mark, or space in printing matter. The average number of 
characters that can be set in 1 pica (approximately 6 picas to 1 inch) is known as "characters 
per pica." 
 
charcoal 
Specially prepared charred wooden sticks used for drawing on a "toothed" paper. 
 
chartpak 
Trade name for preprinted, pressure-sensitive, adhesive-backed tapes and components made 
by Chartpak. These products are used as paste-ups for charts, graphs, map overlays, 
newspaper borders, printed-circuitry configurations, and layouts of almost any design. 
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chisel point 
A technique of drawing or lettering in which the point of the pencil or other drawing instrument is 
chisel-shaped, producing thick or thin strokes, according to how the instrument is held. 
 
clip file 
A collection of photographs and illustrations of various subject matter, arranged categorically 
and alphabetically.  The file is used by artists and illustrators to assist with an accurate portrayal 
of subject matter included in a piece of artwork. 
 
coated paper 
Also called coated stock. Paper coated with a finely ground filler that produces a fine, smooth 
surface, like the pages of expensive "slick" magazines. 
 
cold composition 
Composition by machines, such as typewriters and photocomposing machines or in any manner 
in which no molten metal is used to form the image. 
 
collage 
The art of arranging and pasting pieces of cloth, newspaper, or other materials on a surface so 
that they form a composition. Also, work made in this manner. 
 
collating 
Gathering single sheets or leaves in sequence. 
 
color 
A sensation caused by light waves of different lengths striking the eye. It includes hue, value, 
and intensity (chroma). (See Munsell color system.) Also, the overall lightness or darkness of 
lettering or type. If the lettering or type has a pleasing, even and consistent tone and pattern, it 
is said to have "good color." 
 
color chart 
An arrangement of colors according to their hue, value, and intensity relationships. Also, paint 
manufacturer's illustrated catalog showing color swatches. 
 
color dimensions 
Hue, value, and intensity; the three ways of measuring any given color. (See Munsell color 
system.) 
 
color harmony 
A unified or aesthetically pleasing effect produced by a combination of colors which are similar 
in one or more aspects. 
 
color interval 
The degree of visual difference between two colors, measured in steps of hue, value, and 
intensity. 
 
color notation 
Notes used on sketches for future reference when painting in color; also, the specification of a 
color by written symbols and numerals based on a color system such as Munsell. 
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color proof 
Engraver's or painter's proof showing the effect of final color in perfect register. 
 
color scale 
A series of colors that exhibits a regular change or gradation in hue, value, or intensity. 
 
color scheme 
The particular group of colors that dominates a picture or creates a color unity within it. 
 
color separation 
Division of colors of a continuous-tone multicolored original or of line copy into basic portions, 
each of which is to be reproduced by a separate printing plate carrying a color. 
 
color sketch 
A rough drawing or layout approximating the color of the final picture. 
 
color symbolism 
The use of color to signify or suggest an emotion, idea, or characteristic. 
 
color wheel 
A circular color diagram. 
 
column 
One of the sections of text or other matter, such as display advertisements, that make up a 
vertically divided page. It is measured horizontally and is usually justified. Each column of a 
page is established by a line measure for justified copy. The term "column" also refers to a 
vertical section of a table. 
 
combination plate 
A plate on which both halftone and linework are combined. 
 
commercial art 
Artwork of any kind that is prepared for predetermined commercial purposes, such as 
advertising and general promotion. 
 
compass 
An instrument for drawing circles, transferring measurements, and so forth. 
 
complementary colors 
Any two opposite hues on the color wheel, such as red and green. 
 
composite 
Made up of several parts; for instance, two or more photographs combined to make a single 
unit. Also, see montage. 
 
composition 
The arrangement of forms, colors, lines, and other pictorial elements. 
 
compositor 
One who composes or sets type. 
 



STP 11-25M13-SM-TG 

Glossary-14 

comprehensive 
Layout of art and type, either in black or in colors, that is used as a presentation for advertising 
or other purposes. 
 
comprehensive sketch 
A finished layout (made to show to a client) in which all of the elements, such as type, 
illustration and spacing, have been carefully delineated. 
 
computer graphics 
Science of using computers to generate and interpret pictures. 
 
construction 
The process of drawing objects so that they appear solid or three-dimensional. Also, see 
drawing through. 
 
contact screen 
Halftone screen made on a film base with a graduated-dot pattern. The screen is placed in 
direct contact with the film or plate to obtain a halftone pattern from a continuous-tone original. 
 
continuous tone art 
Photograph, wash drawing, or oil painting without a halftone-dot screen. 
 
cool colors 
Such colors as green, blue-green, blue, and violet. See and compare warm colors. 
 
cooled color 
A color produced by adding a cool color to a warmer color. 
 
copy 
The process of duplicating a file (data or program) from one storage location to another. 
 
copyboard 
Frame that holds original copy while the copy is being photographed. 
 
crop 
To cut off. In preparing art for reproduction, to indicate where the picture edges should be. 
 
crop mark 
Mark used to define the limit of the reproduction area of an illustration and to establish the 
portion of the image that is to appear in the reproduction. 
 
cropping 
Defining the reproduction image area of line and continuous-tone art by drawing crop marks or 
of continuous-tone art by producing windows in negatives by means of dropout masks. 
 
crow quill 
Also called quill pen. A fine writing and drawing pen. The name is derived from the quill of the 
crow's wing, which was formerly cut to a fine point and used for writing with inks. 
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cube 
In geometry, a solid form of six equal square sides. In form drawing, this term is used loosely 
and refers to any object having a cube-like form, such as a boxcar, room, book, and the like. 
 
cutaway drawing 
A drawing, usually of machinery, where the surface of the object is ostensibly cut away, 
revealing the internal structure. 
 
cycle 
A sequence of operations that is repeated regularly. Also, the time it takes for one such 
sequence to occur. 
 
data 
The general term used to describe numbers, facts, letters, symbols, names, etc., that can be 
processed by a computer. 
 
data points 
Symbols used for plotting events or other information on graphs and charts. 
 
database 
A collection of files, or group of files, containing related data arranged for easy and speedy 
retrieval, by a computer. 
 
deadline 
Final date for delivery of art or copy. 
 
decision graphic 
A graphic done for commanders on which they can base their decisions. 
 
delineate 
In the graphic arts, to give depth to line art by making certain outlines heavier. The word also 
means "to describe in detail." 
 
depict 
To represent by drawing, painting, or other artistic means. 
 
depth 
Thickness, measured downward from the surface of an object. The term "depth" is used only 
with objects having a third dimension, never to describe a plane surface. 
 
design 
A planned or intended arrangement of the elements in a composition. 
 
designer's color 
High-quality opaque watercolors. 
 
detail drawing 
Engineering drawing that gives detailed information on an item. 
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detail view 
In engineering drawing, a view that shows part of the principal view of an item, using the same 
plane and arrangement but in greater detail and on larger scale. 
 
diazo film 
Film used as a flexible transparent base and coated with emulsions of diazo salts and couplers. 
 
diazo paper 
Paper treated with a diazo compound and an azo dyestuff component. 
 
diazochrome projecturals 
Diazo-sensitized films that produce colored-dye images on a transparent plastic base. 
Diazochrome is a trade name of Scott Graphics, Inc. 
 
disk drive 
Typical disk drives are highly reliable random access, moving head memory devices, compactly 
designed for use as peripheral units in large and small, and recently microcomputer systems. 
 
disk file 
An organized collection of records stored on a magnetic disk. 
 
disk storage 
A supplementary data storage area. 
 
disk/diskette 
A round flat plate coated with a magnetic substance on which data for a computer is stored. 
 
display 
The television-like screen used by the computer to display messages and graphic information to 
the operator. 
 
display lettering 
In general commercial art, any prominent lettering. Also, in cartooning, any large or complicated 
lettering other than balloon lettering. 
 
display menu 
The list of displays from which the user selects specific information for viewing. 
 
display type 
Large type used for magazine and newspaper headings, posters, and so forth. 
 
distortion 
Picturing a subject so that it appears changed or twisted out of its natural shape. Sometimes 
used in drawing or painting to heighten the emotional effect. 
 
dividers 
An instrument used for dividing lines into equal segments, transferring measurements, and so 
forth. 
 
dominant 
Principal or most important; as the dominant part or motif of a design or composition. 
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drafting machine 
Machine that combines the function of a T-square or straightedge, a triangle, scales, and a 
protractor in one unit. 
 
drawing 
The art of representing objects, ideas, emotions, and so forth on a surface, using line, tone, or 
color. 
 
drawing through 
Sketching in the structural lines of an object as if it were transparent and you could see through 
it to all sides. 
 
drier 
A substance used to hasten the drying time of paint or printer's ink. 
 
driver 
A transistor output circuit which has an emitter follower configuration. 
 
dropout 
Loss of part of the video signal, which shows up on the screen as white glitches. Caused by 
uneven videotape iron oxide coating (bad tape quality or over use) or dirty heads. 
 
dropout halftone 
(Also called highlight halftones). A halftone reproduction in which the screen dots are eliminated 
in white areas. This is often accomplished by the platemaker photographically, or by re-etching 
in these areas. There are also several processes, such as fluorographic, Kemart, and Kromolite, 
which the artist can use, with the cooperation of platemakers, to prepare artwork. 
 
dry mounting 
Method of mounting photographs without paste or rubber cement. 
 
dry mounting press 
An electrically-heated press used for mounting pictures, photographs, proofs, and so forth. 
 
dummy 
Rough draft or proposal of a piece of printing material, pasted or bound together in the exact 
reproduction size and showing the areas that illustrations and text will occupy. 
 
earth color 
Pigments, such as ochre, Venetian red, Indian red, the siennas, or umber, all made from earth 
minerals. 
 
edge 
The border or outline of a form or shape. If the outline is sharp and distinct, it is called a hard 
edge. If it is diffused or blurred, it is called a soft edge. 
 
element 
A display of a program instruction. 
 
emphasis 
Stress or accent on any part of a design or picture. 
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environment 
In a system context, the environment is anything that is not a part of the system itself. 
Knowledge about the environment is important because of possible interactions between the 
system and the environment. 
 
extension line 
In orthographic, engineering and mechanical drawings, a line used to indicate the extent of a 
dimension. 
 
eye level 
Also called horizon line. The horizontal plane at the artist's eye level, to which that person 
relates linear perspective. 
 
face (type) 
The raised printing surface of type. The term also denotes style of type. 
 
feather 
In a printed or duplicated image, an undesirable bleeding effect in which microscopic feather-
like indications surround the characters. 
 
felt nib pen 
A drawing pen with a felt nib or tip. The ink soaks through the felt from an inside compartment. 
 
ferrule 
The metallic part of a brush which holds the hairs or bristles. 
 
figure 
Line illustration or photograph of any kind used in a publication. A figure may be a graph, a 
chart, an exploded view, a rendering, a halftone, or any other illustration in which artwork or 
photography is used to produce the image. 
 
file 
Generally, file is a collection of information stored as records. Files are stored on peripheral 
memory devices, such as a disk memory or a tape memory. 
 
file maintenance 
Adding, deleting, or changing the contents of records in a file. Also, reorganizing the structure of 
a file to improve access to records or to change the storage space required. 
 
file management 
A term that defines the function of creation, insertion, deletion, or updating of stored files and 
records in files. Also, the operations that are performed on files. 
 
file name 
A means of identifying a file. 
 
file organization 
A method of ordering data records stored as a file, while also providing a way to access stored 
records. 
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film negative 
Photolithograhic negative produced by a process camera. The negative has a film base and 
reflects a translucent (white) image on a black background; it may be a line negative or a 
halftone negative. While it is called a negative, however, the image is right-reading. The term 
negative is derived from the fact that it is camera-produced. 
 
finished art 
Any piece of artwork that is ready for reproduction. 
 
fix 
To spray with fixative. 
 
fixative 
Any clear solution sprayed or coated on artwork or other material, such as reproduction copy, 
that "fixes" or stabilizes the image, rendering it more resistant to wear or smudging. A fixative 
protects and preserves drawings, photographs, documents, and other papers. An example is a 
spray coating that has the trade name Krylon. 
 
flash point 
The coldest temperature at which vapors over a volatile substance ignite in air when exposed to 
open flame. 
 
flat brush 
A flat oil painting brush, thicker and with longer hairs than the bright brush. Generally made of 
white hog bristle or sable. 
 
flat tone 
An area of uniform or even value. 
 
flip card 
In television, one of a series of photographs or drawings, shown in sequence and used to tell a 
story or deliver a message. 
 
flop 
To reverse from right to left, or vice versa. 
 
flowchart 
A graphic representation of the sequence of a specific activity, operation, or algorithm. 
 
flush 
Even with the margin or even with the widest line in the column or page. 
 
focal point 
Center of interest. 
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font, phototypesetting 
Number of typeface designs and typeface sizes in points that can be mixed at any one time in a 
display typesetter machine setup. A photomatrix contains the typeface designs and a lens 
system has the ability to enlarge or reduce in a given number of sizes measured in points. The 
number of typeface designs multiplied by the number of sizes determines the number of fonts. 
For example, a machine setup has a photomatrix drum (or disk) that holds four different type 
designs and the lens assembly contains eight typeface sizes. The number of fonts in the setup 
is 32. 
 
foreshorten 
In illustrating, to depict an object or line in less than its true perspective. 
 
form 
The three-dimensional shape and structure of an object or figure. 
 
format 
General form of a book, brochure, direct-mail piece, or other printed matter, with particular 
reference to composition, layout, size, and general appearance. 
 
freehand drawing 
Drawing without the use of mechanical aids. 
 
frisket 
A semitransparent covering placed over part of a drawing or photograph to protect that part 
while you work on the rest. It is mainly used to shield portions of art while retouching with an 
airbrush. 
 
frontispiece 
An illustration preceding and usually facing the title page of a book. 
 
full-color reproduction 
Printed reproduction approximating all the color of the original art, usually by four-color process 
printing. The four colors commonly used are red, yellow, blue, and black. 
 
full measure 
The entire width of a line of type measured in picas. A line of type set full measure is flush with 
both margins. 
 
gigabyte (GB) 
A unit of measure equal to 1,024 megabytes of data, or 1,048,576 bytes. 
 
glaze 
An application of a transparent color or value over another color or value. 
 
glycerin 
A heavy oil, colorless and odorless, used in preparation of water color pigment. 
 
gothic 
One of a group of alphabets or typefaces characterized by strokes of equal or almost equal 
thickness, and usually without serifs. 
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gouache 
This is the French word for opaque watercolor. In working with this medium, one can use either 
prepared opaque watercolors or add opaque white to standard transparent watercolors; 
sometimes called tempera. 
 
grayscale 
The range of gray tones between black and white. A grayscale monitor is able to display distinct 
gray pixels as well as black and white ones, but not color pixels. 
 
halftone 
Tone pattern of shades from white through black of a continuous-tone image, made by 
photographing the image through a finely ruled glass screen with crossing opaque lines. The 
screening reduces the tones to a dot formation for reproduction by printing. 
 
halftone screen 
Screen placed in front of the negative material in a process camera to break up a continuous-
tone image into a dot formation. There are two types of halftone screens; ruled glass screens 
and contact screens. 
 
hard copy 
Copy of any kind, except on film, that is produced on paper or any substrate that can be used as 
an end item for proofing, checking, revising, or redrawing; typed, printed, or copied matter. Also, 
any form of a printed document such as a ladder diagram program listing, paper tape, or 
punched cards. 
 
harmony 
A pleasing arrangement of picture elements, due to similarity of one or more of their qualities, 
such as shape or size. Also, see color harmony. 
 
hidden line 
Line used to show a hidden feature of a part or article. As used in orthographic, engineering, 
and mechanical drawings, it is designated as a "medium" line and consist of evenly spaced 
short dashes. 
 
hinge joint 
A joint in the body that is limited to back-and-forth movement; for example, the elbow and knee. 
 
holding line 
A line, usually drawn in black on a mechanical. It is to be printed unless otherwise indicated. 
See and compare key line. 
 
horizon line (HL) 
An imaginary horizontal line representing the height of the observer's vision. Also, see eye level. 
 
hue 
1. One of the three basic color attributes, hue is the color itself-red, green, blue, yellow, and so 

on.  
 
2. The attribute of color perception that determines whether the color is red, green, blue, and 

so forth. 
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illustration 
A picture designed to interpret a story or an article. Graphic interpretation of a situation or of an 
idea. 
 
illustration board (artist's board) 
Heavy paperboard manufactured especially for artists, for both oil and watercolor application. 
Standard sizes are, in inches 22 by 30, 22 by 28, 28 by 44, 30 by 40, and 40 by 60. Weights 
vary from thick to heavy. Thick board is about 8-ply; heavy board, 24-to 30-ply. Colors range 
from white gray to snow white. 
 
image area 
Square or rectangular area that encompasses a printed, drawn, or photographed image and the 
white or dark background space around the image. It is enclosed by imaginary perpendicular 
and horizontal lines. 
 
india ink 
Pigment made of lampblack and binding material; also this pigment suspended in water as a 
fluid ink. For good delineation, India ink should be solid black. Some India inks are gray in 
comparison with others. 
 
instruction 
A command that causes a PC to perform one specific operation. The user enters a combination 
of instructions into PC memory to form a unique application program. Also, an individual 
function within the Graphic's programming language which initiates action. 
 
italics 
Script-like letters of type. The italic form has an oblique slant to the right. Used in contrast to the 
Roman form, which is vertical. 
 
ivory black 
A fine black pigment used in various paints. 
 
Joint Photographers Experts Group (JPEG) 
A set of standards developed by this group for compressing and decompressing digitized 
images with computers. 
 
justification 
Spacing of lines of type to a predetermined measure so that the margins are aligned. 
 
juxtaposition 
The placement of colors or forms side by side or close together to accentuate each other. 
 
key 
1. Key light: principle source of illumination.  
 
2. High- or low-key lighting.  
 
3. An electronic effect; the cutting in of an image (usually lettering) into a background image. 
 
kid finish 
Medium-textured surface of art paper or illustration board; also referred to as medium finish. 
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kilo (k) 
A prefix used with units of measurement to designate quantities of 1000. 
 
kilobyte (kb) 
Used to denote size of memory and can be expressed in bytes or words.  
Example: 2K = 2048 bytes. 
 
lampblack 
A very fine black pigment used in various black paints. Watercolor lampblack is especially good 
for transparent wash drawing and in opaque watercolor painting, where it is used together with 
opaque white and grays. It is often used for line drawing with a brush. 
 
layout 
Arrangement of a book, magazine, or other publication so that text and illustrations follow a 
desired format. Layout includes directions for margin data, pagination, margin allowances, 
center headings and sideheads, placement and size of display and body type, and placement of 
illustration. 
 
letterhead 
The printed matter at the head of a sheet of letter paper, usually containing the name and 
address of the organization or person and other appropriate information. Also, sheet of paper 
bearing such a letterhead. 
 
lettering 
Words formed or printed by hand. 
 
letterspacing 
Placing of additional space between the letters of words to expand the length of a line or to 
improve and balance typography. 
 
light box 
A box with a translucent glass top having a light under it, used for tracing. 
 
lightface 
Lightest and thinnest form of a type series; the opposite of boldface. These words are in 
lightface, AND THESE IN BOLDFACE. 
 
limited palette 
A palette with a restricted number of pigments. Also, a palette that lacks one or more of the 
three primary colors (red, yellow, and blue). 
 
line 
transmission circuit 
 
line driver 
A circuit specifically designed to transmit signals over extended distances. 
 
line of direction 
In picture composition, a line the eye follows when looking at the picture. The arrangement of 
the objects in the picture can lead the eye in a particular direction. 
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line and wash 
A technique combining a black line (usually ink) and transparent wash. 
 
line weight 
Thickness of pencil, ink, or other lines in artwork or in ruling. Line weights should be consistent 
within a given group of illustrations regardless of the number of weights used for any one 
illustration. 
 
linseed oil 
An oil obtained by pressing the seeds of a plant, which produces linen fiber. Used as a medium 
in oil painting. 
 
local color 
The actual color of an object without regard to the effect of changing light and shadow  
conditions. 
 
local color value 
The actual lightness or darkness of a color without regard to the effect of changing light and 
shadow conditions. 
 
lowercase 
Small letters of the alphabet (a, b, c, d). The term is also applied to small roman numerals. Also, 
see uppercase. 
 
lucy 
Abbreviation of camera lucida, an instrument used for enlarging or reducing drawings by means 
of tracing what appears to be a projected image. 
 
machine composition 
Type set by machine only. 
 
mahlstick 
A rod held in the palette hand and used to support or steady the painting hand, particularly while 
rendering details. 
 
makeup 
Arrangement of text and illustrations on a page, generally in conformity with standard practices 
of the industry or with particular publication requirements. In cold composition work, it is known 
as layout. Also, see layout. 
 
malfunction 
Any incorrect function within electronic, electrical, or mechanical hardware. Sometimes called 
fault. 
 
mars colors 
Artificial earth colors. 
 
Master 
In validating training materials or tests, refers to an expert at the particular job or task. 
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mat (or matte) 
A cardboard or paper frame for a picture. Also, paper-base mold from which a cheap printing 
plate (stereotype) can be made. And, dull - without luster. 
 
mechanical 
Page of layout prepared as an original for photomechanical reproduction. It may be a single unit 
with all the elements of the finished page ready for single-shot photography, or it may have 
hinged overlays that can be swung into position for making successive exposures of various 
elements on the same negative. 
 
mechanical drawing 
A method of drawing using precision tools, such as triangle, T-square, dividers, and ruler to 
produce mathematically-precise layouts, diagrams, and engineering drawings. 
 
medium 
A liquid with which a paint may be diluted without damaging its adhesive, binding, or film-
forming properties. Also, the mode of expression employed: etching, drawing, painting, and so 
on. And, the actual instrument or material used by the artist; such as oil paint, watercolor, or 
pencil. 
 
memory 
A portion of a computer that is used to store information (either data or programs). The size of a 
microcomputer is often determined by the amount of user memory (measured in k-bytes) in the 
system. 
 
mode 
A selected method of operation. 
 
montage 
Arranging of a number of pictures or designs in combination, often with some overlapping, so 
that they form a composite whole. Also, the arrangement or composition so made. See 
composite. 
 
mount 
To fasten onto a base, such as mounting a picture, photograph, or type proof onto a firm  
cardboard. 
 
mounting and flapping 
Proper protection of line and photographic art requires mounting and flapping. This procedure 
also makes space available for identifying the art and facilities filing. 
 
munsell color system 
A system of color analysis and identification in which color is said to have three components or 
measurable dimensions. They are hue, value, and chroma. Hue is the name of a color; value 
measures lightness or darkness of a color; while chroma (also referred to as intensity) 
measures the strength of a color. 
 
mural 
Any picture painted or fixed on a wall or ceiling. 
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mylar 
Tough, highly stable polyester film used as a base for films for engineering drawings, 
photographic materials, and other applications. Mylar is a registered trade name of DuPont. 
 
neutral color 
Also, color which lacks hue and intensity; for example, black or the grays. Also, a color to which 
a complementary color has been added, causing it to become relatively gray or brown. Such a 
neutralized color may also be referred to as a tertiary color. And, an earth color such as an 
umber or sienna. 
 
opaque 
Impermeable to light; not transparent or translucent. 
 
opaque projector 
A lantern for projecting to the desired size a photograph or other nontransparent copy onto a 
drawing surface. 
 
optical center 
Point slightly above the geometric center of a regular plane. Objects placed at the optical center 
appear to be at the geometric center. 
 
optical spacing 
Arrangement of spacing between letters for legibility and appearance, as opposed to 
mechanical spacing, in which the same space is used between all characters. The spacing 
varies with the shape of the letters to achieve optical equalization. 
 
organization chart 
Block chart or diagram showing the names, titles, departments, and responsibilities of personnel 
in an organization. 
 
output 
On of the main functions of the computer. The processed data or other information that the 
computer display or printers. 
 
paint 
Any liquid medium composed of pigment, binder, and vehicle (carrier). Also, to place on a 
surface to change its color or make an illustration. CAUTION: Care must be taken to prevent 
mixing of incompatible paints and/or chemicals. 
 
pastel 
Color matter mixed with gum to form crayons. The word "pastel" also denotes both such a 
crayon and a picture produced with the crayon. 
 
picture area 
The flat surface within the borders of the picture. 
 
picture plane 
An imaginary plane always placed at right angles to an observer's line of vision and upon which 
the view to be drawn is mentally projected. 
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pixel 
1. Smallest single picture element with which an image is constructed.  
 
2. The light-sensitive elements on a CCD that contain a charge. 
 
pixels per inch (PPI) 
A measure of the density of scanned information in an image. The finer the optics of the 
scanner, the higher the scan resolution. 
 
point 
A standard unit of measure for letters used by printers - 1/72 of an inch; for example, 72 points 
equal 6 picas. 
 
pounce 
Powder-like material for improving the ink-absorbing qualities of reproduction tracing cloths and 
papers. The powder is sprinkled and rubbed on the surface, and the excess is removed by 
brushing with a felt pad or brush. 
 
process 
Continuous and regular production executed in a definite uninterrupted manner. Also, one or 
more entities threaded together to perform a requested service. 
 
program 
1. A specific television show.  
 
2. A sequence of instructions encoded in a specific computer language to perform specific 

predetermined tasks. 
 
3.  A set of instructions the system follows in order to carry out certain tasks. 
 
proportion 
The relative size and location of one form to another, or of one portion of a thing to a whole. 
 
random access memory (RAM) 
Volatile, (that is, it can be erased or lost when the power is turned off) read-write memory in 
which data may be written (stored) or read from (retrieved) directly. 
 
ray 
A line suggesting a beam of light traveling in a given direction. 
 
receding colors 
Colors which appear to move away, or create the illusion of distance; for example blue, green, 
and violet. Compare with cool and advancing colors. 
 
register 
In printing, to align a page so that it exactly backs the page on the reverse side of the sheet; to 
match the position of successive color impressions; also, the alignment of any corresponding 
elements of an image or impression. 
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register marks 
These marks are used to key an overlay to the mechanical or drawing, as in color separations, 
and combination plates. They ensure that the various elements will be in register. 
 
render 
To represent, depict, or portray, as in a drawing or painting; for example, a watercolor rendering, 
a pen and ink rendering. 
 
research file 
A collection of photographs and illustrations of various subject matter, arranged categorically 
and alphabetically. The file is used by artists and illustrators to assist with an accurate portrayal 
of subject matter included in a piece of artwork. 
 
read only memory (ROM) 
Memory which is similar to RAM, except that data cannot be written to it. Data can be read from 
it directly, as in the case of RAM, but ROM is non-volatile; that is, it will retain the information 
stored in it whether power is applied or not. 
 
ross board 
An illustration board that comes in a variety of specially-roughened surfaces that provide crayon 
or brush strokes into broken textures, suitable for line reproduction. 
 
sable brush 
A brush made from the tail hair of the Kolinsky (Asiatic mink), in a flat or round shape, and used 
with mediums, such as oil, watercolor, tempera, or ink. 
 
sandpaper pad 
A pad of sandpaper sheets mounted on a strip of wood. It is used for sharpening pencil lead or 
pastel stick. 
 
sans serif 
Without serifs. This is said of a letter that does not have a finishing stroke or line projecting from 
the end of a main stroke. Modern Gothic faces are typical of typefaces without serifs. 
 
saturation 
The purity or density of a color. 
 
scale 
Portions or relative dimensions. Also, to enlarge, "scale up"; or reduce, "scale down"; the size of 
a picture, layout, and so forth, without changing the original proportions. 
 
scale drawing 
Drawing such as a map, profile, or plan that shows relative sizes and proportions. 
 
sepia 
Dark yellowish-brown color of low brilliance. 
 
sepia intermediate 
Intermediate used in making duplicate transparencies by the whiteprint or diazo process 
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serif 
Finishing stroke or line projected from the end of the main stroke of many letters in many type 
faces. Letters that do not have such terminal strokes are called sans serif. 
 
shade 
A mixture of pure color and black is a shade of that color. 
 
shading 
Adjusting picture contrast; controlling color and black-and-white levels. 
 
shadow 
The pattern of dark projected from an object blocking light. 
 
shape 
The flat silhouette or two-dimensional form of an object. 
 
shelf life 
Length of time before sensitive items such as diazo materials, paint, or chemicals deteriorate 
with age. Many of these materials have limited use because their chemical properties are 
gradually lost. 
 
sight line 
An imaginary line from one of the artist's eyes directly to whatever he is looking at. Also, line of 
sight. 
 
sketch 
A quick drawing usually made preparatory to a more complete drawing or painting. 
 
skill level (SL) 
A number which denotes the level of qualification within the total MOS.  Levels of qualification 
are identified by characters 0 through 5 in the position of the MOS code. 
 
spectrum 
The arrangement of colors side by side as refracted by a prism. 
 
speedball pens 
Lettering and drawing pens manufactured by the Hunt Manufacturing Company, of which 
Speedball is a registered trademark. 
 
speed lines 
Extra lines following a moving figure or object in a cartoon and representing the disturbance the 
movement causes in the atmosphere. 
 
sphere 
A form, perfectly round from all points of view. 
 
split complement 
A hue and both colors on either side of its complement. 
 
station point (SP) 
The artist's point of observation in making a perspective drawing. 
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still life 
An artist's pictorial arrangement of inanimate objects. Also, a picture whose subject does not 
move. A photograph of a subject can be considered a still life. 
 
stipple 
A line technique using a series of dots to create the illusion of tone in a line drawing. The closer 
the dots, the darker the resultant value. 
 
straightedge 
A bar or instrument of wood, plastics, or metal, with one or more straight, long edges, used in 
artwork. 
 
stripping 
Cutting out and placing in position. Also, removing all or part of text copy or an illustration by 
replacing the material with something else, particularly with reference to production copy. 
 
stump 
A pencil-shaped roll of paper used to blend pencil, pastel, or crayon tones. 
 
stylus 
A scraping instrument, usually with a sharp-pointed or chisel edge. It is used on shading sheets, 
scratchboard, and so forth. 
 
subtractive color process 
A process of forming colors by mixing pigments which absorb certain colors and reflect others. 
See additive process. 
 
symbol 
A graphic device that represents something else; for example, a form, color, sign or emblem 
used in a picture to represent an idea. 
 
tasks 
A set of instructions, data, and control information capable of being executed by a soldier in job 
specific duties, or by a CPU to accomplish a specific purpose. 
 
technique 
The method of using a tool or medium. Also, the characteristic appearance of a medium, for 
instance, an " oil technique." And, sometimes used to designate the style of a particular artist. 
 
tempera 
Although originally this term applied to paint in which dry pigments were mixed with an 
emulsion, such as egg yolk, it now refers to opaque watercolors in general. 
 
template 
In testing, the answer key used to grade tests.  It can be a score sheet with correct answers 
listed or it can be electronic and used with an optical scanner to score tests. 
 
tertiary color 
Any intermediate hue which contains some part of each of the three primary colors (red, yellow 
and blue). 
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text 
Typewritten or printed matter forming the main body of work, as opposed to front and back 
matter, illustrative material, tables, extracts, and so forth. 
 
texture 
Surface texture: in painting or drawing, the suggestions of the feel or appearance of a surface, 
such as rough, smooth, mat or dull, glossy, hard or soft. 
 
third dimension 
Effect of depth or bulk achieved by an artist on a flat surface. 
 
three-dimensional 
Possessing width, height, and depth. This is said of drawn objects that look solid, and 
illustrations that have the illusion of distance, as opposed to flat. 
 
thumbnail sketch 
Page layout showing the allocation of space for headings, photographs or line artwork, and text 
copy. 
 
tint 
A mixture of pure color and white. 
 
tone 
A value. Also, the predominating value of a picture, suggesting its key. And, a color mixed with 
gray. 
 
tooth 
The texture of a paper allowing it to take ink, pencil, pastel, and so forth. 
 
topography 
The art or practice of graphic delineation in detail, as on charts or maps, showing relative 
positions and elevations. 
 
tracing paper 
A thin, transparent or translucent paper used for transferring drawings from one surface to 
another by tracing. It is also used for overlays and preliminary drawings. 
 
translucent 
The property of a material which permits light to pass through it, but does not permit objects to 
be seen clearly through it. 
 
transparency 
Any transparent material that bears an image. 
 
transparent 
The property of a material that permits objects to be seen clearly through it. 
 
T-square 
A ruling guide with a 90-degree crosspiece at one end. Held against the straight side of the 
drawing board, it is used in making horizontal lines. 
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turnaround time 
The time it takes to complete a project from the time the work request was originally received, 
through review and any changes, to the time of pickup notification. Also, the time it takes a 
communications module to receive, interpret, act upon, and reply to an upcoming message. 
 
turpentine 
A solvent, distilled from the sap of pine or from pine wood, used to thin oil paints and to clean 
brushes. 
 
typography 
The art of type selection and arrangement. 
 
upper case 
The capital letters of the alphabet (A, B, C, and so forth). 
 
value 
The lightness and darkness of a color. Also, relative lightness and darkness of a picture as 
represented in tones, shading, line, balance, layout, and so forth. 
 
value scale 
The complete range of values from white to black. 
 
vanishing point (VP) 
A point at which receding parallel lines appear to come together in a perspective drawing or 
photograph. 
 
varnish 
A solution made of resin in a volatile medium. 
 
vehicle 
A liquid used as the carrier of pigment in the paint. 
 
warm colors 
Associated with heat or fire: for example, red-violet, red, and orange. See and compare cool 
 colors. 
 
wash 
Any medium properly thinned until transparent. 
 
wash drawing 
Watercolor painting in which the color is applied only in washes 
 
watercolor 
A dry pigment bound by an adhesive, usually gum arabic, and applied, greatly reduced by 
water, to a surface (usually white paper) in a transparent fashion. Also, a painting made with 
watercolor pigment. 
 
white lead 
The fine opaque white pigment used in flake white and Cremnitz white oil paints. It is poisonous 
if taken internally. 
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word processing 
The ability to enter, manipulate, correct, delete, and format text; an application which is widely 
used in microcomputers. Word Processors are used to write letters; and to prepare documents 
such as magazine articles, manuscripts, and books; to name only a few of their applications. 
 
word spacing 
Adjustment of spacing between words, particularly to extend or shorten a line in order to 
achieve justification. 
 
work station 
Location of job equipment grouped together facilitating computer-assisted product 
implementation and completion. The station may contain: CRT screen, computer, printer(s), and 
so forth. 
 
working drawing 
A thorough preliminary drawing usually done on tracing paper and then transferred to the 
working surface for the finished rendering. 
 
Zip-a-Tone 
A transparent adhesive sheet covered with various patterns, dots, or lines. Tonal effects can be 
created by applying this sheet to areas of the drawing. The resultant piece of art can be 
reproduced in line. 
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